SoftMax® Pro

Data Acquisition and Analysis Software

Version 7.0

User Guide

5049092 A
July 2016



SoftMax Pro Software User Guide

This document is provided to customers who have purchased Molecular Devices equipment, software,
reagents, and consumables to use in the operation of such Molecular Devices equipment, software,
reagents, and consumables. This document is copyright protected and any reproduction of this
document, in whole or any part, is strictly prohibited, except as Molecular Devices may authorize in
writing.

Software that may be described in this document is furnished under a non-transferrable license. It is
against the law to copy, modify, or distribute the software on any medium, except as specifically
allowed in the license agreement. Furthermore, the license agreement may prohibit the software
from being disassembled, reverse engineered, or decompiled for any purpose.

Portions of this document may make reference to other manufacturers and/or their products, which
may contain parts whose names are registered as trademarks and/or function as trademarks of their
respective owners. Any such usage is intended only to designate those manufacturers’ products as
supplied by Molecular Devices for incorporation into its equipment and does not imply any right and/or

license to use or permit others to use such manufacturers’ and/or their product names as trademarks. REGISTERED
COMPANY

Each product is shipped with documentation stating specifications and other technical information.
Molecular Devices products are warranted to meet the stated specifications. Molecular Devices makes
no other warranties or representations express or implied, including but not limited to, the fitness of
this product for any particular purpose and assumes no responsibility or contingent liability, including
indirect or consequential damages, for any use to which the purchaser may put the equipment
described herein, or for any adverse circumstances arising therefrom. The sole obligation of Molecular
Devices and the customer's sole remedy are limited to repair or replacement of the product in the
event that the product fails to do as warranted.

For research use only. Not for use in diagnostic procedures.
The trademarks mentioned herein are the property of Molecular Devices, LLC or their respective owners. These trademarks may not
be used in any type of promotion or advertising without the prior written permission of Molecular Devices, LLC.

Patents: http://www.moleculardevices.com/productpatents

Product manufactured by Molecular Devices, LLC.

1311 Orleans Drive, Sunnyvale, California, United States of America 94089.
Molecular Devices, LLC is ISO 9001 registered.

©2016 Molecular Devices, LLC.

All rights reserved.

2 5049092 A


http://www.moleculardevices.com/productpatents

Contents

5049092 A

Chapter 1: Installation and Setup ... .. .. 7
Computer System Requirements ... ... 8
Installing the SoftMax Pro Software .. ... . . 9
Uninstalling SoftMax Pro Software ... ... 14
Starting the SoftWare ... 14
Registering the Software ... . . 15
Selecting and Connecting to an Instrument ... ... 16
Troubleshooting Instrument Connections ... ... ... .. ... 18
Setting Instrument Calibration Options .. ... ... 19
Using a Barcode Reader ... . 19
Unlocking the SpectraMax Paradigm Instrument ... ... ... ... 20
GettiNg Help oo L 22
ObtaINING SUP PO - e 23

Chapter 2: User Interface Overview ... ... 25
General Workflow Overview . ... ... . 25
Main WindoW 28
NaVIgatioN Tree | L 29
WOrKSPace VieWS . 31
Ribbon Toolbar .. 34
Application MeNU . 53
Quick-Access Toolbar ... 54
Integrated Web Browser . il 55
Using Automation Mode . .. 56

Chapter 3: File and Application Management ... .. . .. ... ... 59
File TYPOS il 59
Creating a New Data File ... ... 63
Opening a Data File .. . 64
Saving Data Files ... 65
Copying and Pasting Data ... ... ..ol 66
Managing Protocol Files .. ... . 67
Creating a New Protocol File ... .. 73

3



SoftMax Pro Software User Guide

Opening a Protocol File ... oo L 74
Saving Protocol Files ... ... 75
Setting Auto Save OpPtioNS .. .. 76
PriNtING 80
EXporting Plate Data ... 85
Importing Microplate Data . ... o 99
Setting Application OptioNs ... . 104
Chapter 4: Workspace Sections .. ... .. ..., 107
Using a NOte SeCtiON .. 108
UsSiNg @ Plate SeCtioN .. 118
Using a Cuvette Set Section ... . 129
Using @ Group SeCtioN .. 139
Using a Graph Section ... 149
Chapter 5: Read Modes and Read TyPeS ... ... it 151
Supported Read Ty PeS . ..o 151
Absorbance Read Mode ... . .. 154
Fluorescence Intensity Read Mode .. ... ... i 160
Luminescence Read Mode ... ... .. . 166
Time-Resolved Fluorescence Read Mode ... .. ... ... 171
FRETRead Mode ... .. 178
HTRF Read Mode .. . 179
Fluorescence Polarization Read Mode ... .. ... ... ... 185
AlphaScreen Read Mode ... . L 189
Western Blot TRF Read Mode ... ... ... . .. 193
Imaging Read Mode ... . 197
Chapter 6: Supported Instruments and Detection Cartridges ............................ 201
Supported INStrUMENtS o 201
Supported Detection Cartridges ... ... ... oo 218
Chapter 7: Collecting Data ... ... ... e 235
Creating a ProtoCol ..o oo 235
Selecting Instrument Settings ... . . 236
Instrument Settings ... 246
Defining and Running a Workflow ... . 297

4 5049092 A



5049092 A

Configuring a Microplate Template ... ... . 301

Creating an Absorbance Mode Protocol ... ... o ... 312
Creating a Fluorescence Intensity Mode Protocol ......... ... .. .. ... ... ......... 314
Creating a Luminescence Mode Protocol .. ... . .. . 322
Creating a Time-Resolved Fluorescence Mode Protocol ... .. ........................ 324
Creating a FRET Mode Protocol . ... ... e 327
Creating a Fluorescence Polarization Mode Protocol ... ... ... .. ... ......... 329
Creating an AlphaScreen Mode Protocol ... o . 331
Creating a Western Blot TRF Mode Protocol ... .. ... . 333
Creating an Imaging Mode Protocol ... ... . 336
Saving the Settings to a Protocol File . ... ... .. 338
Collecting Data from a Microplate ... ..., 339
Collecting Data From @ CUVEtte ... oo e 350
Collecting Data from a Membrane Holder ... ... . . . 352
Chapter 8: Analyzing Data ... ... . 355
Calculations and Numerical Precision ... .. ... .. . ... 356
Setting the Data Display Options ... . 358
Doing Data RedUcCtion .. ... 367
Viewing Data in a Three-Dimensional Graph ... .. .. . 382
Graphing Data ... 388
Viewing Western Blot Membrane Data ... .. ... i i 443
Saving Datain a PDF File .. oo 451
Chapter 9: Maintaining and Calibrating an Instrument ... ... . ............... 455
Calibrating the Microplate Reader ... ... . . 455
Configuring the Filters for the EMax and Vmax Microplate Readers _................. 456
Adjusting the Lamp for the EMax Plus Microplate Reader ............................. 456
Using the Instrument Information Dialog . ... ... . . . 457
Viewing Instrument Software SUpPOrt ... .. 465
Chapter 10: Using SoftMax Pro GxP Software Features _.................................. 467
Setting Up User Accounts for SoftMax Pro GxP Software ............................... 468
Connecting a User Accounts File ... 469
Logging onto SoftMax Pro GxP Software .. ... ... .. . . 472
Viewing the User Information ... 472
Changing the User PasswWord . ... ... 474
5



SoftMax Pro Software User Guide

Working with GXP Statements ... ... . 475
Viewing the GxXP Audit Trail ... L 482
Locking and Unlocking Sections ... .. . . 484
GlOSSaANY . .l 485
INDOX il 501

6 5049092 A
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SoftMax® Pro Data Acquisition and Analysis Software controls Molecular Devices®
spectrophotometers and absorbance, luminescence, and fluorescence microplate readers
and detection platforms. For a complete list of the instruments supported by this release of
the SoftMax Pro Software, see Supported Instruments on page 201.

The software provides extensive data calculation and analysis capabilities under a Good
Manufacturing Practices (GMP), Good Laboratory Practices (GLP) work environment for
pharmaceutical, biotechnology, academic, hospital, and government customers.

Over 120 assay protocols are included in the software to speed life science research and drug
discovery assay development and screening. Researchers can customize experiment
protocols, analyze and display data, and create meaningful reports. The straightforward yet
powerful programming capabilities of the SoftMax Pro Software can further enhance
specialized data collection and analysis needs through custom assay development.

SoftMax Pro Software is widely integrated with industry-leading robotics systems.

The SoftMax Pro Software can collect data from one or more microplates and storeitin a
single data file, using the same or different instrument settings for different microplates.
Assays requiring a read in two or more read modes or read types can be combined in a single
experiment and run with a single command in the software, by defining separate microplate
reads and enabling Auto Read. See Enabling Auto Read on page 340.

This guide describes features available in SoftMax Pro Software version 6 and later. SoftMax
Pro Software 6 is available for a computer using the Windows 7, Windows 8, or Windows 10
operating system.
This section contains the following topics:

e Computer System Requirements on page 8

e [nstalling the SoftMax Pro Software on page 9

¢ Uninstalling SoftMax Pro Software on page 14

e Starting the Software on page 14

e Registering the Software on page 15

e Selecting and Connecting to an Instrument on page 16

e Setting Instrument Calibration Options on page 19

e Troubleshooting Instrument Connections on page 18

e Unlocking the SpectraMax Paradigm Instrument on page 20

e Getting Help on page 22
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Computer System Requirements

The SoftMax Pro Software version 7.0 can be installed on a computer with the following
system specifications.

Table 1-1: Minimum and Recommended Requirements for SoftMax Pro Software

Item Minimum Recommended
Processor Single-core, 2 GHz or faster Quad core or faster
Operating system | Windows 7 (SP1 or newer), 32-bitor | Windows 7 (SP1 or newer), 32-bit or

64-bit (x86 or x64) and

.NET Framework 4.6

(.NET Framework 4.6 is installed
automatically by the SoftMax Pro
Software installer if required.)

64-bit (x86 or x64),

Windows 8, 32-bit or 64-bit (x86 or
x64), or

Windows 10, 32-bit or 64-bit (x86 or
x64)

The SoftMax Pro MiniMax Imaging
Edition must be installed on a 64-bit
operating system.

Data connection

RS-232 serial port or
USB 2.0 port
(depending on the instrument)

USB 2.0 ports

For instruments that require an RS-232
serial port, you can use a USB 2.0 port
with a Keyspan USB-to-serial adapter.
Keyspan USB-to-serial adapters have
been field tested and given approval
by Molecular Devices.

Memory

2 GB RAM

4 GB RAM

If running on a virtual machine,
Molecular Devices recommends a
minimum of 6 GB RAM. For
automation, Molecular Devices
recommends a minimum of 8 GB
RAM.

Hard drive

500 MB of available space

1 GB of available space, or more

Graphics display

Graphics display adapter
1024 x 768 or higher-resolution
display

32-bit graphics display with 256 MB
video RAM

1280 x 1024 or higher-resolution
display

Software
installation and
activation

CD/DVD drive
Internet connection
or external USB drive

CD/DVD drive
Internet connection
or external USB drive

Note: Installing and using the SoftMax Pro Software on the Windows XP operating
system is no longer supported. The software is neither tested nor validated on

Windows XP.
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To prevent data loss, turn off all sleep and hibernation settings for the hard disk, the CPU,
and the USB ports. Also, disable automatic Windows Updates. You can update Windows
manually when the instrument is not being used by the software. You can set these options
in Windows Control Panel. See Required Computer Settings on page 11.

The SpectraMax MiniMax 300 Imaging Cytometer is shipped with a computer that meets
greater minimum computer system specifications than those required for the standard
installation of the SoftMax Pro Software. See Optimizing Your Computer for Image
Acquisition on page 337.

Installing the SoftMax Pro Software

5049092 A

Note: Molecular Devices recommends that you disable your anti-virus program
before installing SoftMax Pro Software, as it might interfere with the installation
process.

To install the SoftMax Pro Software:
1. Make sure that all connected instruments are powered off.
2. Start theinstallation program.

¢ Ifyou downloaded the software installation, double-click the
SoftMaxPro7.0Setup.exe file to start the installation program.

* Ifyou areinstalling from a USB flash drive, insert the SoftMax Pro Software flash
drive into a USB port, and then navigate to the flash drive and double-click
SoftMaxPro7.0Setup.exe.

e Ifyou are installing from a CD, insert the SoftMax Pro Software CD into the CD-ROM
drive. If the installation program does not automatically start, navigate to your CD-
ROM drive and double-click SoftMaxPro7.0Setup.exe.

3. Select the edition of the SoftMax Pro Software that you need to install.

e The SoftMax Pro Standard Edition supports most Molecular Devices microplate
readers. This edition does not support the SpectraMax MiniMax 300 Imaging
Cytometer. For a complete list of the instruments supported by this release of the
SoftMax Pro Software, see Supported Instruments on page 201.

e The SoftMax Pro MiniMax Imaging Edition must be installed to support the
features of the SpectraMax MiniMax 300 Imaging Cytometer. This edition requires a
64-bit operating system.

e The SoftMax Pro GxP Edition supports using the software in a regulated
environment. This edition does not support the SpectraMax MiniMax 300 Imaging
Cytometer. For information about using the features of this edition, see Using
SoftMax Pro GxP Software Features on page 467.

Note: You must have the correct license for the edition of the software that you
need to install.
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4. Follow the on-screen instructions to finish installing the software.
5. Before starting the software, power on the connected instruments.

Note: If you have anti-virus programs installed, Molecular Devices recommends that
you add the SafeNet HASP License Manager Service (hasplms.exe) to the list of trusted
applications.

Installing the Software Remotely or From a Command Line

You can install the SoftMax Pro Software silently from a command line. Make sure that you
install the correct edition of the software.

e Tosilently install the SoftMax Pro Standard Edition, type the command:
SoftMaxPro7.0Setup.exe /s

¢ Tosilently install the SoftMax Pro MiniMax Imaging Edition, type the command:
SoftMaxPro7.0Setup.exe /s EDITIONIMAGING=TRUE

e Tosilently install the SoftMax Pro GxP Edition, type the command:
SoftMaxPro7.0Setup.exe /s EDITIONGXP=TRUE

To view and follow the wizard during the installation, omit /s in the command line.

To uninstall the software, without regard to edition, type the command:
SoftMaxPro7.0Setup.exe UNINSTALL=YES

% Note: Some IT environments, such as those using remote installation with
deployment tools like SCCM, require an installer in MSI format. To obtain a copy of
the MSl installer, contact Molecular Devices technical support. See Obtaining Support
on page 23.
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Required Computer Settings

Allowing your computer to hibernate or turn off during data acquisition can interrupt the
transfer of data from the instrument to the software and result in data loss.

To prevent data loss, turn off all sleep and hibernation settings for the hard disk, the CPU,
and the USB ports. Also, disable automatic Windows Updates. You can update Windows
manually when the instrument is not being used by the software.

You can set these options in Windows Control Panel.

Open Control Panel.

Click Hardware and Sound.

Under Power Options, click Change when the computer sleeps.

Click Change advanced power settings.

In the Power Options dialog, set Hard disk > Turn off hard disk after to Never.
Set Sleep > Sleep after to Never.

Set Sleep > Hibernate after to Never.

Set USB settings > USB selective suspend setting to Disabled.

Click OK.

Return to the home screen of Control Panel.

© o N o Uk~ WN R

(R
= o

Click System and Security.

[ER
N

Under Windows Update, click Turn automatic updating on or off.

[N
w

Under Important Updates, make sure that Install updates automatically is not selected.
Select one of the other options.

14. Click OK.
15. Close Control Panel.

Decimal Symbol Must be a Period

For the SoftMax Pro Software to properly parse or execute calculations, the regional options

“n

for the computer must use the period symbol (“.”) for the decimal symbol. This can be an
issue if the Region and Language setting for the computer is something other than English.

To set custom regional settings, go to Control Panel > Regional and Language.

11
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Manually Installing USB Drivers in Windows 7

For some Windows 7, 64-bit operating system installations, automatic installation of the USB
instrument driver for some instruments does not occur due to elevated security settings.

If the SoftMax Pro Software cannot connect to your instrument after installing the software,
try shutting down the software and then restarting Windows.

If restarting Windows does not permit access to the instrument, then do the following steps
to install the driver:

1. Open Control Panel.

Click Hardware and Sound.

Under Devices and Printers, click Device Manager.

In Device Manager, double-click the unknown device with the yellow warning icon.
Click the Driver tab and then click Update Driver.

Click Browse my computer for driver software.

N o v bk~ wN

Click Browse and select the SoftMax Pro Software installation folder.

The default installation path is:

C:\Program Files (x86)\Molecular Devices\SoftMax Pro 7.0

8. Inthe Windows Security warning, click Install this driver software anyway.

Granting TCP/IP Access to MDC File Server

When using the SoftMax Pro GxP Software with MDC File Server in a Windows 7, 64-bit
operating system, the Windows Firewall sometimes prevents user access to MDC File Server
through TCP/IP.

To grant user access through TCP/IP, create a new inbound rule and a new outbound rule in
the Windows Firewall Advanced Settings.

Accessing Windows Firewall Advanced Settings

1. Open Control Panel.

2. Click System and Security.
3. Click Windows Firewall.
4

In the left pane, click Advanced settings to open the Windows Firewall with Advanced
Security dialog.
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Creating a New Inbound Rule

1.

L ©® N o Uk~ WN

In left pane of the Windows Firewall with Advanced Security dialog, click Inbound
Rules.

In the right pane, click New Rule.

In the New Inbound Rule Wizard, click Port.
Click Next.

Click TCP.

Click Specify local ports.

Type 9001 in the field.

Click Next.

Complete the rest of the wizard based on your network configuration and access rules
defined by your system administrator.

Creating a New Outbound Rule

1.

L © N o Uk~ W

In left pane of the Windows Firewall with Advanced Security dialog, click Outbound
Rules.

In the right pane, click New Rule.

In the New Outbound Rule Wizard, click Port.
Click Next.

Click TCP.

Click Specify local ports.

Type 9001 in the field.

Click Next.

Complete the rest of the wizard based on your network configuration and access rules
defined by your system administrator.

13
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Uninstalling SoftMax Pro Software

Before uninstalling the program, make sure to back up your data and saved files to a folder
outside of the SoftMax Pro Software folder.

1
2.
3.

Click Start > Control Panel.

Click Programs and Features.

In the list that is displayed, click SoftMax Pro 7.0.

To uninstall the GxP edition, click SoftMax Pro 7.0 GxP.
Click Uninstall or Remove.

Follow the on-screen instructions to finish uninstalling the program.

Note: This is the recommended method of removing SoftMax Pro Software from a
Windows-based computer since it also removes related information from the
Windows Registry.

Starting the Software

To start the software under normal conditions, wait for the connected instrument to
complete its start-up sequence, and then double-click the SoftMax Pro 7.0 icon on your
desktop to start the program. To start the program from the Windows Start menu, click
Start > All Programs > Molecular Devices > SoftMax Pro 7.0 > SoftMax Pro 7.0.

For the GxP edition, double-click the SoftMax Pro 7.0 GxP icon or click Start > All Programs
> Molecular Devices > SoftMax Pro 7.0 GxP > SoftMax Pro 7.0 GxP.

If you are using the SoftMax Pro GxP Software, you are prompted to log on before you can
continue. Type your administrator-assigned user ID and your password, and then click Log
On. See Logging onto SoftMax Pro GxP Software on page 472.

Note: When connecting to the SpectraMax i3x and i3 Multi-Mode Detection
Platforms, the SpectraMax Paradigm Multi-Mode Microplate Reader, or the
FilterMax F3 and F5 Multi-Mode Microplate Readers for the first time, the latest
firmware updates automatically install as needed.

Note: You can start the SoftMax Pro Software with or without an attached
instrument. When no instrument is attached you cannot acquire data. To do
operations that require data you must open an existing data file.

14
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Registering the Software

5049092 A

The software product key is included with the SoftMax Pro Software package. The
instrument serial number is located on a label affixed to the rear of the instrument.

Activating Your Software License
If your license is inactive or is ready to expire, then the Software License Activation dialog is
displayed when you start the SoftMax Pro Software.

If the software is already running, click the Help tab in the ribbon and then click Software

License @@

The Software License Activation dialog lists the current status for each of the available
licenses. For information about the features of your license or to obtain a new license key,
contact your Molecular Devices representative.

To activate your SoftMax Pro Software license, click Activate to open the Activate Online
dialog.
e Ifyou have access to the internet, type the Product Key in the field, click Activate
Online, and then follow the on-screen instructions to activate your license.

* Ifyou do not have access to the internet, then click Activate Offline and follow the on-
screen instructions to activate your license.

To activate offline, you need your product key, a computer that has access to the
internet, and a USB drive for transferring files between the computers.

On the Internet-enabled computer, go to:
https://smplicensing.moleculardevices.com

Follow the on-screen instructions to activate your license.

15
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Selecting and Connecting to an Instrument

16

To select a reader instrument:

1. Click on the Instrument icon on the Home tab. The Instrument Connection dialog is

displayed.
rﬂ Instrument Connection ——— u-‘
Select the instrument to connect to. @
Available Instruments Refresh
Offline

COML : SpectraMax M3

Reader  |spectraMax M5 -

[] simulator On

ok || cancel

L A

In the Available Instruments list, select the communication port to which the
instrument is connected or select Offline.

If the instrument you are connecting to does not show in the list, click Refresh.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument, select Offline and then
select the instrument from the Reader list.

If you are working offline, select Offline and then select the instrument from the Reader
list.

Optionally, to work in simulation mode, select Offline, select the instrument from the
Reader list, and then select the Simulator On check box.

Click OK. An icon for the selected instrument is displayed on the Home tab.

Note: The Information button in the lower-left area of the dialog is provided for
troubleshooting purposes only.
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SoftMax Pro Software supports the following instruments:

SpectraMax i3x and i3 Multi-Mode Detection Platforms on page 202
SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204
VersaMax Microplate Reader, see page 205

SpectraMax Plus 384 Absorbance Microplate Reader, see page 205
SpectraMax M5 and M5e Multi-Mode Microplate Readers, see page 206
SpectraMax M4 Multi-Mode Microplate Reader, see page 207
SpectraMax M3 Multi-Mode Microplate Reader, see page 208
SpectraMax M2 and M2e Multi-Mode Microplate Readers, see page 209
SpectraMax 340PC 384 Absorbance Microplate Reader, see page 210
SpectraMax 190 Absorbance Microplate Reader, see page 210

Gemini XPS Microplate Reader, see page 211

Gemini EM Microplate Reader, see page 211

FlexStation 3 Multi-Mode Microplate Reader, see page 212

FilterMax F5 Multi-Mode Microplate Reader, see page 213

FilterMax F3 Multi-Mode Microplate Reader, see page 214

DTX 800 and DTX 880 Multi-Mode Microplate Readers, see page 214
Vmax Kinetic Microplate Reader, see page 215

EMax Endpoint Microplate Reader, see page 215

EMax Plus Microplate Reader on page 215

StakMax Microplate Handling System, see page 216

A detection cartridge contains its own independent light source, optics, and electrical
components needed to do specific read modes for specific applications.

The read capabilities of the SpectraMax i3x Instrument can be upgraded with user-
installable detection cartridges.

The SpectraMax Paradigm Multi-Mode Microplate Reader requires detection cartridges
to do reads.

See Supported Detection Cartridges on page 218.

17
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Troubleshooting Instrument Connections

If the instrument is properly connected and turned on, the icon for the instrument is
displayed in the Home tab of the SoftMax Pro Software main window, and the correct
instrument is shown as selected.

The instrument icon shows the connection status of the instrument.

Table 1-2: Instrument Connection Status

Instrument Connected

& Instrument Disconnected
% Instrument Simulated

If the instrument status shows as disconnected, make sure that the instrument is powered
on and that the connections between the instrument and the computer are secure.

If the instrument you are connecting to does not appear in the Instrument Connection
dialog, click Refresh.
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Setting Instrument Calibration Options

Note: Air-calibration applies to absorbance reads only. No microplate or cuvette is
required for the instrument calibration. If you are doing a cuvette calibration, the
cuvette chamber must be empty.

During calibration, the instrument steps through all available wavelengths one-by-one to
measure the signal that reaches the detector when there is no sample in the optical path.
The software calculates air-calibration values and stores these values in the firmware. The
stored air-calibration values are used when Speed Read is enabled or Calibrate is disabled in
the Settings dialog. See Speed Read on page 262 and Calibrate on page 285.

To calibrate the microplate reader:
1. Click Calibration on the Operations tab in the ribbon.
2. Inthe Calibration dialog, select either Plate or Cuvette.
¢ To calibrate for microplates, select Plate.
e To calibrate for cuvettes, select Cuvette.
3. Click Calibrate Now.

4. When the calibration indicator shows that the calibration is complete, click Close.

Note: If the Calibration button is not active in the Operations tab, then either the
instrument is not connected to the computer or the connected instrument does not
support the air-calibration process.

Using a Barcode Reader

Abarcode reader is an input device similar a keyboard. When you place the cursorin a text
field and then use the barcode reader to read a barcode, the barcode reader passes the text
embedded in the barcode to the text field.

Before using a barcode reader with the SoftMax Pro Software, make sure that the correct
driver is installed and that the barcode reader is functioning correctly. To test a barcode
reader, open a text editor, such as Notepad, and then use the barcode reader to read a
barcode. Ifthe reader is functioning correctly, the text embedded in the barcode appears in
the text editor.

Barcodes can be created in several different formats, such as MSI or Pharmacode. Make sure
that the barcode reader you are using supports the type of barcode that you need to read.
See the documentation that came with your barcode reader.

Using a barcode reader to input text can be useful for naming a Plate section to match the
barcode affixed on a microplate. See Renaming an Experiment or a Section on page 30.

5049092 A 19
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Unlocking the SpectraMax Paradigm Instrument

When a SpectraMax Paradigm Instrument is first installed, the hardware transport locks
need to be removed as described in the SpectraMax Paradigm Instrument user guide or
unpacking guide. As a safety precaution, internal locks controlled by the software prevent
the drawers from opening until the instrument is detected and initialized by the SoftMax Pro
Software.

Note: Do not install detection cartridges until after you have completed the following
instructions to unlock the drawers and initialize the instrument.

To unlock the drawers and initialize the instrument:

1. Make sure that the hardware transport locks have been removed. See the
SpectraMax Paradigm Instrument user guide or unpacking guide.

A CAUTION! The instrument can be damaged if all the transport locks are not
removed before unlocking the drawers and initializing the instrument.

2. Make sure that all drawers have been pushed back into the instrument, the front panels
have been replaced, and the microplate door is closed.

3. Make sure that the instrument is connected to the host computer and to a power
source, and that the has been installed on the host computer. See the
SpectraMax Paradigm Instrument unpacking guide or user guide.

% Note: If you are using a 9-pin serial-to-USB adapter cable, install the driver for the
adapter on your computer before connecting the cable to the instrument. To
make sure the adapter has been correctly installed, open the Windows Device
Manager and check for the presence of a COM port, and that there are no
conflicts with the COM port.

4. Turn on the power switch on the rear of the instrument.

If the Standby button on the front lower-right corner of the instrument is illuminated,
press the button to take the instrument out of standby mode.

The LEDs on the status panel flash and turn off, and then the amber LED turns on
indicating that the instrument drawers are locked.

5. Start the SoftMax Pro Software. See Starting the Software on page 14.

The amber LED on the status panel turns off and the green LED turns on, indicating a
successful connection between the instrument and the SoftMax Pro Software.

6. After successfully connecting to the instrument, the Instrument Unlocking Procedure
wizard is displayed.
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7. Ifthe Instrument Unlocking Procedure wizard does not open, then use the Instrument
Connection dialog to select and connect to the instrument. See Selecting and
Connecting to an Instrument on page 16.

Note: If the instrument does not show in the Available Instruments list of the
Instrument Connection dialog, then click Refresh above the list.

8. Follow the on-screen instructions in the Instrument Unlocking Procedure wizard to
unlock the drawers and initialize the instrument.

After completing the Instrument Unlocking Procedure wizard, the instrument does an

initialization procedure that moves the optics and microplate drawers to home positions.

The green LED on the status panel turns on, the amber LED flashes and turns off, and then

the green LED remains on. You can install the desired detection cartridges in the instrument.

See "Installing Detection Cartridges" in the SpectraMax Paradigm Instrument User Guide.

To lock the drawers again for shipment, use the Instrument Information dialog. See Using
the Instrument Information Dialog on page 457.
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Getting Help

SoftMax Pro Software has a comprehensive help library. You can open the application help
documents from the Help tab in the ribbon.

e Click SoftMax Pro Help g to view the SoftMax Pro Software Application Help. This
help contains task-oriented information about how to use SoftMax Pro Software. You
can find topics through the table of contents and by using the search function. This
document also features a linked index and glossary.

X)
o Click Formula Reference% to view the SoftMax Pro Software Formula Reference
Guide. This document is broken into four main sections:

The first section provides a general introduction to SoftMax Pro Software formulas.

e Operators describes the different types of operators that can be used to assemble
formulas.

e Functions describes the different types of built-in functions that can be used to
assemble formulas.

e Accessors describes the special functions that provide access to other specific
information.

You can find topics through the table of contents and by using the search function. This
document also features a linked index.

o Click Release Notes to view the SoftMax Pro Software Release Notes for this release
of the software. This document is in PDF format and can be viewed using a PDF viewer
like Adobe Reader.

e Click Contact Us &J to display the SoftMax Pro Software What's New page, view the
Molecular Devices home page, access the knowledge base, or request technical support.

The knowledge base contains documentation supporting Molecular Devices products.
You can use the customer login tools and featured links to help you get the information
you need.

o Click Software License &ﬁ and follow the instructions in the Software License
Activation dialog to activate your SoftMax Pro Software license.

e Click SoftMax Pro 9 in the About section to see release information about this
release of the SoftMax Pro Software application.
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Context-sensitive help is available for the dialogs that have a @ help button.
More documentation in PDF format can be found in the Windows Start menu.

e To view the SoftMax Pro Software User Guide, the Formula Reference Guide, or the
Software Release Notes, click Start > All Programs > Molecular Devices > SoftMax
Pro 7.0 and then click the document you want to view.

e To view user guides for the supported instruments, click Start > All Programs >
Molecular Devices > SoftMax Pro 7.0 > Hardware User Guides and then click the
document you want to view.

These documents are in PDF format and can be viewed using a PDF viewer like Adobe
Reader.

Obtaining Support

5049092 A

Molecular Devices is a leading worldwide manufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products
and to fully supporting our customers with the highest possible level of technical service.

Our support web site, www.moleculardevices.com/support, has a link to the Knowledge
Base with technical notes, software upgrades, safety data sheets, and other resources. If you
do not find the answers you are seeking, follow the links to the Technical Support Service
Request Form to send an email message to a pool of technical support representatives.

You can contact your local representative or contact Molecular Devices Technical Support by
telephone at 800-635-5577 (North America only) or +1 408-747-1700. In Europe call +44 (0)
118 944 8000.

To find regional support contact information, visit www.moleculardevices.com/contact.

Please have your instrument serial number or Work Order number, and your software
version number available when you call.
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If you are familiar with earlier versions of SoftMax Pro Software, adapting to the new
SoftMax Pro Software 6 user interface is quick and easy. The SoftMax Pro Software 6 user
interface provides advanced features and state-of-the-art navigation, analysis, and data
display tools, plus it also supports a version of the classic SoftMax Pro Software interface.

SoftMax Pro Software 6 improves the basic functionality of earlier versions of the software,
and it adds new features that further contribute to the usability of the powerful computing
engine of SoftMax Pro Software.

General Workflow Overview

SoftMax Pro Software lets you set up and run a complete protocol for the supported
instruments. Instrument settings can be saved as a protocol (template) file and used
repeatedly for reading different microplates or cuvettes. All standalone instrument functions
can be controlled using the software.
The following steps give a general overview of the workflow for acquiring and analyzing
microplate data using the SoftMax Pro Software. You might need to modify the workflow as
it applies to your specific application and the standard operating procedures of your
laboratory.
1. Select an instrument. See Selecting and Connecting to an Instrument on page 16.
You can add as many Plate sections or Cuvette Set sections as your experiment requires.
2. Click a Plate section or Cuvette Set section to make it active in the workspace.
The Home tab changes to reflect the tools available for the active Plate section or
Cuvette Set section.
After selecting a Plate section, you can use the Plate Setup Helper to help you set up a
microplate experiment. See Using the Plate Setup Helper on page 27.
&
3. Create a protocol. Click the Settings "% button to set the instrument options. See
Selecting Instrument Settings on page 236.

4. Click OK to save the settings.

As you create the protocol, you might need to click the Template button to add a
microplate template that can include defining groups, blank cells, and a sample series, as
needed for your application. See Configuring a Microplate Template on page 301.
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5. Before starting a read, it is good practice to save your data file. For Imaging reads and

Western Blot reads, you must save your data file before starting the read. See Saving
Data Files on page 65.

Click the Read 0 button to run the protocol and have SoftMax Pro Software collect
and store all raw data received from the instrument. See Collecting Data from a
Microplate on page 339, Collecting Data From a Cuvette on page 350, or Collecting Data
from a Membrane Holder on page 352.

As information is read, the SoftMax Pro Software displays updates showing the new
data. Data is displayed in a grid format that corresponds to the wells in a microplate or
individual cuvettes.

During the read, the read button changes to o You can click this button to stop the
read operation.

SoftMax Pro Software can collect data from one or more microplates or cuvettes and
store it in a single data file, using the same or different instrument settings for different
microplates or cuvettes. For example, microplates containing different samples can be
read using the same or different modes, all within the same experiment.

View and analyze the data. See Setting the Data Display Options on page 358, Doing Data
Reduction on page 367, Graphing Data on page 388, and Viewing Western Blot
Membrane Data on page 443.

You can manipulate or reduce the raw data using dozens of built-in formulas or define
your own analysis structure to quickly and easily summarize the raw data. More than
one reduction can be shown, and results from different microplates and cuvettes can be
compared within the same experiment.

% Note: After you have defined instrument settings, and have optionally customized

the SoftMax Pro Software data file with assay information, reduction settings, custom
columns in Group sections, and summary objects, you can save the file as a Protocol
file type to create an assay template. This template can then be used and distributed
throughout a department or company for highly repeatable data collection and
analysis.
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Using the Plate Setup Helper

When you open a new SoftMax Pro Software file, the Plate Setup Helper is displayed to help
you set up a microplate experiment. You can also open the Plate Setup Helper by clicking

Plate Setup Helper #" in the toolbar at the top of the active Plate section.

& Plate Setup Helper @

Configure: Platel @

Currant Instrumeant: SpectraMax Paradigm

.

i’ Choose a different instrument

% Configure your acquisition setfings
Configure your plate layout
Choose data analysis settings

Choose your display settings

|:| Do not open this Helper with new protocols [ Done ]

The wizard-like Plate Setup Helper visually guides you through the tasks available in the
software to setup a microplate to acquire data. To complete a task, click its button. After you
complete a task, the settings for the task are saved, and you return to the helper to select a
different task. The tasks do not need to be done in the order they are presented in the
helper. However, you must select the instrument before defining your acquisition settings,
since the settings are specific to the instrument.

Configure tells you the name of the active Plate section. Acquisition settings are applied to
the entire Plate section. If you have a plate clone selected, then the layout, analysis, and
display settings are applied to the selected clone. For information about Plate sections, see
Using a Plate Section on page 118.

Current Instrument tells you the name of the currently selected instrument. The image in
the button below it shows you the instrument and its connection status. You must select the
instrument before defining your acquisition settings, since the settings are specific to the
instrument. To choose a different instrument or change its status, click the button. See
Selecting an Instrument on page 36.
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To complete a task, click its button.

» To configure your acquisition settings, click . See Instrument Settings on page 246.

o To configure your plate layout, click

page 301.

. See Configuring a Microplate Template on

o To choose data analysis settings, click . See Doing Data Reduction on page 367.

o To choose your display settings, click @ See Setting the Data Display Options on page

358.

To prevent the Plate Setup Helper from automatically starting each time you open a new
protocol, select the Do not open this Helper with new protocols check box. You can enable
this option again in the SoftMax Pro Options dialog. See Setting Application Options on

page 104.

To close the Plate Setup Helper, click Done.

Main Window

The SoftMax Pro Software window has three main areas: the navigation tree on the left, the
workspace area on the right, and the ribbon toolbar along the top. Also, the application
menu and quick-access toolbar in the upper-left corner give you easy access to file and

application management features.

SoftMax Pro 7.0

Protocols  View  Operaions  Workflow  Help
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& | ... QW G T = [Py
‘emp: 35 °C [, New Note [ New Graph o = & Mask
Spectrahax , Read  Append § Semings Reduction Display Template [Fipaste  gf Export
M5e (Simulated) 3 Delete Selection [ New Cuvette Set & Clone Plate Editor
1 ABS-405 | @~ x
|Bacument, | Comparison | Workflow
Navigation Tree 2 < —
Exptl Platel L @ I @ an
4 [ BasicEngpoint
[ ntro Settings Information -
Platel Endpaint
4l Ben ) 4 Absorbance
(] Platel 12 3 4 5 6 7 & 9 10 1 12 R
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Navigation Tree

The Navigation Tree shows the sections in the data file that is currently open and that are
available for display in your Workspace.

‘4 Abs_Endpoint | What's New £

Mavigation Tree L,':l[a £ Doc

4 ﬂ BasicEndpo...

4, Intro &
4 Al Beprl

[ &, Motes1

Platel

|_|_|_| Standards

|_|_|_| Unknowns |

[[1] unk_pilution

|_|_|_| Control

|_£[ StandardCu...

«,..W

When you save a data file, the name that you give the file is displayed on the tab above the
Navigation Tree. You can have more than one data file open at a time. Each data file can
contain an unlimited number of experiments. Each experiment can contain an unlimited
number sections. Section types include: Notes, Plate, Cuvette Set, Group, and Graph. See
Workspace Sections on page 107.

To change the order of the sections in a experiment, drag the section name to the desired
location. The order of the sections can be moved within an experiment only, and cannot be
moved between experiments.

You can right-click an experiment or section in the Navigation Tree to rename, duplicate, or
delete the section or experiment.

When you duplicate an Experiment, all sections in the experiment are duplicated in a new
experiment, but without data. When you duplicate a Notes or Graph section, an exact
duplicate is made of the section. When you duplicate a Group section, a new group is
created with the same properties as the original section. When you duplicate a Plate section,
the new section contains all the settings from the original section, but without data.

To rename an experiment or a section, see Renaming an Experiment or a Section on page 30.
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Renaming an Experiment or a Section

To rename an experiment or section, right-click the experiment or section in the Navigation
Tree and then click Rename.

Fename Section @

Mew name:

-

Plate

E ok || cancel

Edit the text in the New name field and then click OK.

The new name appears in the Navigation Tree and at the top of the section in the
Workspace.

To rename an experiment or section using the automation interface, see the description of
the setTitle() command in the SoftMax Pro Software Automation API Reference Guide.

* Tip: You can use a barcode reader to input the text embedded in a barcode. See Using
a Barcode Reader on page 19.
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Workspace Views

5049092 A

The SoftMax Pro Software workspace has two main views that change the way the sections
are displayed in the workspace.
* The Document view provides you with a scrollable area for viewing the sections. See
Document View on page 31.
* The Comparison view lets you move the sections around in the workspace to position
them where they are most useful. See Comparison View on page 32.
You can also split the workspace to view multiple data files at the same time. See Using the
View Tab on page 44.

For information about working with the sections in the workspace, see Workspace Sections
on page 107.

The Workflow view provides you with a drag-and-drop workflow editor and tools to run and
monitor a workflow. See Workflow View on page 33.

Document View

Document view displays information in a manner that is similar to previous SoftMax Pro
Software releases. The Document view provides you with a scrollable area for viewing the
sections. To view a section either click on it in the navigation tree or use the scroll bar until
the desired section comes into view.

SoftMax Pro 7.0
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= = - @ | L * Copy Import
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New Graph Mask

Spectrahax Read  Append Semings Reduction Display Template [Fipaste  gf Export
[

(Simulated) 3 Delete Selection [ New Cuvette Set & Clone Plate Editar
1 ABS-405 | @~ x
|Bacument, | Comparison | Workflow
Navigation Tree 2 < S
Exptl Platel » @ @ T @ an A
4 [ BasicEngpoint
[ ntro Settings Information -
Platel Endpaint
4l Ben ) 4 Absorbance
(] Platel 12 3 4 5 6 7 & 9 10 1 12 R
[[f] standsrs A | oow | o0 | oow | oow | coso | com | com | cos | oo | oo | oi | oam | 4 MoreSewings
[11] unkngwns Shake OFF
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Reduction Settings

Exptl Standards A

Standards

o ] ————

For information about working with the sections in the workspace, see Workspace Sections
on page 107.
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Comparison View

To change to the Comparison view, click the Comparison button.

The Comparison view provides you with flexible display options. In Comparison view you can
move the sections around in the workspace to position them where they are most useful.

SoftMax Pro 7.0
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" ABS-405 | @ x
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4[| BasicEndpoint
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4 [ expr1
|
i Exptl Platel A
[ []swandards Sertings Information
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' Use this protocol for endpoint assavs that have unknowns that will have concentrations interpolated from a standard curve. Modify the ]
!1 nstrument setup for the wavelength(s) of interest for your assay. You may also modify the template to include additional standards, i |
unkmowns, and controls. To make modifications, click the plate section to make it active. i =~
< mn ] 3

¢ You can drag sections from the navigation tree and position them in the workspace.

e Sections can overlap.
¢ Double clicking a section in the navigation tree adds that section to the bottom of the

workspace.

For information about working with the sections in the workspace, see Workspace Sections

on page 107.
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Workflow View

To change to the Workflow view, click the Workflow button.

The Workflow view provides you with a drag-and-drop workflow editor and tools to run and
monitor a workflow. In Workflow view you can define a workflow using the defined Plate
sections and instrument settings to run multitask kinetic reads that last hours or days.

m A @8 - SoftMax Pro 7.0

Home Protocols Wiew ‘Operations Workflow

6 Undo | Zoomin  Fitto Screen e
Redo | Zoomout  MiniMap r

Start Pause Cancel Execution

Log

Clear Reset Zoom  Save as Image

4 ABS-405 | @~ x

Document | Comparison _

Search

4 Operations

|t Open Drawer
L SetTemperature

& Shake
4 Timin 1 B
=0 Begin = (%] 5 End
@ Delay -
-]
i Cycle Cycle Read
Cycles: 80 Plate: Platel
Tatal Run Time: 14:10:00 Experiment Exptl

Cycle Interval: 00:03:00

- o -

e Drag tasks from the menu on the left to the timeline on the right.
o Define repeated tasks by placing the tasks in a defined Cycle task.

e Click the workflow options in the ribbon to start, pause, resume, and cancel the
workflow.

For more information, see Defining and Running a Workflow on page 297.
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Ribbon Toolbar

The application ribbon contains tabs with the tools needed to work with SoftMax Pro
Software.

Home Tab

The Home tab always contains the following sections:
¢ Instrument
e Controls and Read Status
e Sections

See Using Instrument Controls in the Home Tab on page 36 and Using Section Controls in the
Home Tab on page 39.

The contents of the Home tab change depending on the section type that is active in the
workspace.

Notes Section Tools

When a Note section is active the Home tab contains:
* Notes Controls
e Formatting Tools

See Using a Note Section on page 108.

Plate Section Tools

When a Plate section is active, the Home tab contains:
e Plate Tools
e Template Tools

See Using Plate Tools on page 119.

Cuvette Section Tools

When a Cuvette Set section is active, the Home tab contains:
e Cuvette Tools
e Template Tool

See Using Cuvette Tools on page 130.

Group Section Tools

When a Group section is active, the Home tab contains:
e Column Tools
e Summary Tools
e Formatting Tools

See Using Column Tools on page 143.
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Graph Section Tools

When a Graph section is active, the Home tab contains:
e Graph Type
e Graph Tools

See Working with Graphs on page 389.

Protocols Tab

The Protocols tab contains the following:
e Protocol Manager
e Community

See Using the Protocols Tab to Manage Protocols on page 42.

View Tab

The View tab contains the following:
e Show/Hide Panel
* Window
* Expand/Collapse Sections

See Using the View Tab on page 44.

Operations Tab

The Operations tab contains the following:
e Instrument Commands
e Instrument Tools
e Calculations
e Automation

See Using the Operations Tab on page 44.

Workflow Tab

The Workflow tab contains the following:
e Execution
e Designer
e Status
See Defining and Running a Workflow on page 297.

GxP Tab

The GxP tab is available only when using the SoftMax Pro GxP Software and contains the
following:

e User Account
e Data
See Using the GxP Tab on page 50.
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Help Tab

The Help tab contains the following:
e Help
e About

See Using the Help Tab on page 51.

Using Instrument Controls in the Home Tab
The Instrument and Controls and Status options on the Home tab contain the following
controls:

e Selecting an Instrument, see page 36
e Reading Data, see page 38

Selecting an Instrument

To select a reader instrument:

1. Click on the Instrument icon on the Home tab. The Instrument Connection dialog is
displayed.

'l - ™y
#| Instrument Connection u
Select the instrument to connect to. @
Available Instruments Refrash

Offline

COML : SpectraMax M5

Reader  |spectraMax M5 -

|:| Simulator On

ok || Ccancel

L o

2. Inthe Available Instruments list, select the communication port to which the
instrument is connected or select Offline.

If the instrument you are connecting to does not show in the list, click Refresh.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument, select Offline and then
select the instrument from the Reader list.
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If you are working offline, select Offline and then select the instrument from the Reader
list.

Optionally, to work in simulation mode, select Offline, select the instrument from the
Reader list, and then select the Simulator On check box.

Click OK. An icon for the selected instrument is displayed on the Home tab.

Note: The Information button in the lower-left area of the dialog is provided for
troubleshooting purposes only.

SoftMax Pro Software supports the following instruments:

5049092 A

SpectraMax i3x and i3 Multi-Mode Detection Platforms on page 202
SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204
VersaMax Microplate Reader, see page 205

SpectraMax Plus 384 Absorbance Microplate Reader, see page 205
SpectraMax M5 and M5e Multi-Mode Microplate Readers, see page 206
SpectraMax M4 Multi-Mode Microplate Reader, see page 207
SpectraMax M3 Multi-Mode Microplate Reader, see page 208
SpectraMax M2 and M2e Multi-Mode Microplate Readers, see page 209
SpectraMax 340PC 384 Absorbance Microplate Reader, see page 210
SpectraMax 190 Absorbance Microplate Reader, see page 210

Gemini XPS Microplate Reader, see page 211

Gemini EM Microplate Reader, see page 211

FlexStation 3 Multi-Mode Microplate Reader, see page 212

FilterMax F5 Multi-Mode Microplate Reader, see page 213

FilterMax F3 Multi-Mode Microplate Reader, see page 214

DTX 800 and DTX 880 Multi-Mode Microplate Readers, see page 214
Vmax Kinetic Microplate Reader, see page 215

EMax Endpoint Microplate Reader, see page 215

EMax Plus Microplate Reader on page 215

StakMax Microplate Handling System, see page 216
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Reading Data

After you have your experiment defined and your prepared microplate or cuvette inserted in
the microplate reader, you can start a read.

Note: Before starting a read, it is good practice to save your data file. For Imaging
reads and Western Blot reads, you must save your data file before starting the read.
See Saving Data Files on page 65.

To start a read, click the plate or cuvette section in the workspace, and then click the Read

w button in the Home tab of the ribbon.

As information is read, the SoftMax Pro Software displays updates showing the new data.
The data display in a grid format that corresponds to the wells in a microplate or individual
cuvettes.

During the read, the read button changes to o You can click this button to stop the read
operation. The read stops immediately.

To stop and restart a Kinetic read while the Plate section is being read, click the Interrupt

button to pause the read, and then click the Append @ button to continue the
Kinetic read from where it left off. When you interrupt a read, the instrument finishes
reading all the selected wells in the microplate and then waits for user input before
continuing. This type of discontinuous kinetic read can help with acquisition development.

After a Kinetic read ends successfully, you can read the same Plate section again and append

the data to the data that already exists in the Plate section by clicking the Append @
button.

Note: If you stop a Kinetic read before it completes, you cannot restart the read or
append data to the read. To use these features, you must either let the read finish on
its own or click Interrupt to pause the read.

SoftMax Pro Software can collect data from one or more microplates or cuvette sets and
store the data in a single data file, using the same or different instrument settings for
different microplates or cuvette sets. For example, microplates containing different samples
can be read using the same or different modes, all within the same experiment.
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Using Section Controls in the Home Tab

The Section controls are displayed on the Home tab in the ribbon. For information about the
section controls, see the following topics:

Creating an Experiment on page 39
Creating a Note Section on page 40
Deleting a Section on page 40

Creating a Plate Section on page 40
Creating a New Graph Section on page 41

Creating a Cuvette Set Section on page 41

Creating an Experiment

To create a new Experiment:

1
2.

3.

Open a data file in the workspace.

If you have more than one Experiment, select the Experiment that you want to duplicate
to make the new Experiment.

Click New Experiment a in Sections on the Home tab in the ribbon.

A duplicate of the selected Experiment is displayed below the selected Experiment in the
Navigation Tree. The sections and settings are duplicated, but the data is not.

To change the name of the experiment, right-click the experiment in the Navigation Tree and
then click Rename. See Renaming an Experiment or a Section on page 30.
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Creating a Note Section

To create a Note section:
1. Select the experiment where you want to add a Note section in the Navigation Tree.

2. Ifyou have more than one section in the Experiment, select the section above where you
want the new Note section to be displayed in the Navigation Tree.

3. Click New Note& in Sections on the Home tab in the ribbon.

Anew blank Note section is displayed below the selected section in the Navigation Tree. See
Using a Note Section on page 108.

To change the name of the Note section, right-click the Note section in the Navigation Tree
and then click Rename. See Renaming an Experiment or a Section on page 30.

Deleting a Section

To delete a section:

1. Select the section or sections that you want to delete in either the Navigation Tree or a
section in the Workspace. To delete an entire Experiment, select the Experiment in the
Navigation Tree.

Note: To select multiple sections, press and hold the Ctrl or Shift key and then
click the sections you want to select in the Navigation Tree.

2. Click Delete Selection % in Sections on the Home tab in the ribbon.

Deleting a section or experiment cannot be undone. When you delete a Plate section, the
data from the Plate section is also deleted.

Creating a Plate Section

To create a new Plate section:
1. Select the experiment where you want to add a Plate section in the Navigation Tree.

2. Ifyou have more than one section in the Experiment, select the section above where you
want the new Plate section to be displayed in the Navigation Tree.

3. Click New Plate [ in Sections on the Home tab in the ribbon.

A blank Plate section is displayed in the Workspace. You can add as many Plate sections as
you need to your data file. See Using a Plate Section on page 118.

To change the name of the Plate section, right-click the Plate section in the Navigation Tree
and then click Rename. See Renaming an Experiment or a Section on page 30.
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Creating a New Graph Section

To create a new graph:

1.

4.

Select the Plate section to relate to the graph in either the Navigation Tree or the
Workspace.

Click New Graph [l in sections on the Home tab in the ribbon.

In the New Graph dialog, set the options for the graph. See Creating a New Graph on
page 392.

When the graph options have been set, click OK.

A new Graph section is displayed below the selected section in the Navigation Tree. See
Using a Graph Section on page 149.

To change the name of the Graph section, right-click the Graph section in the Navigation
Tree and then click Rename. See Renaming an Experiment or a Section on page 30.

Creating a Cuvette Set Section

To create a new Cuvette Set section:

1.

3.

Select the experiment you want to add the Cuvette Set section to in the Navigation
Tree.

If you have more than one section in the Experiment, select the section above where you
want the new Cuvette Set section to be displayed in the Navigation Tree.

Click New Cuvette SetBJ in Sections on the Home tab in the ribbon.

A new blank Cuvette Set section is displayed below the selected section in the Navigation
Tree. See Using a Cuvette Set Section on page 129.

To change the name of the Cuvette Set section, right-click the Cuvette Set section in the
Navigation Tree and then click Rename. See Renaming an Experiment or a Section on page

30.
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Using the Protocols Tab to Manage Protocols

The Protocols tab in the ribbon provides easy access to protocol files that are stored in the
file system. It also gives you access to the SoftMax Pro Software user community for
protocol sharing, exchanging tips and tricks, and networking with other experienced users.

Protocol files are experiment template files that contain microplate well layout assignments
and all other reader configuration information, but no data.

After the SoftMax Pro Software is installed, the Basic Endpoint protocol is set as the default
protocol with the filename default.spr. Whenever you create a new document, the
default.spr protocol file is opened as an untitled document that contains the settings from
the default protocol file.

You can save the settings of the file currently active in the workspace as the default protocol.
After you save the active protocol file as the default, whenever you create a new document,
the settings in the default.spr file that you have saved are loaded into an untitled document.

Several predefined protocols are installed with SoftMax Pro Software and are placed in the
SoftMax Pro Software Protocols folder.

You can use the predefined protocols and you can create your own protocols. For more
information on protocols, see Creating a Protocol on page 235. When you create protocols,
save them into folders on your file system. Name the folders in such a way that you can find
the protocols later.
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The following buttons are provided on the Protocol Manager area of the Protocols tab:

* Click Folder Locations to add the folders containing the protocols you want to use to the

short cut menu you can access by clicking Protocol Manager. See Adding or Removing a
Folder in the Protocol Manager on page 70.

Click Save As Default to overwrite the default.spr file with the protocol setting of the

experiment that is active in your workspace. See Saving a Protocol as the Default
Protocol on page 69.

Note: When you save the file as the default protocol, the data you have collected
in the current experiment remains unchanged. If you want to keep the data, you
need to save the data into a data file.

Click Protocol Manager to open the Protocol Manager shortcut and select a protocol to
be assigned to the open experiment. See Using the Protocol Manager to Open a File on
page 68.

Note: When you add a new plate or cuvette section to an experiment, you can
configure settings using the Settings dialog or apply a pre-defined or saved
protocol to the new section.

The following buttons are provided in the Community area of the Protocols tab:

¢ Click Protocol Home Page to access the SoftMax Pro Software community web site for

protocol sharing, exchanging tips and tricks, and networking with other experienced
users. To access this site, you must have internet access on your computer.

Click Export for Sharing to export the active protocol to an encrypted file format for
sharing with the online community. No data is exported with the protocol. Before
exporting the protocol, make sure that the first Note section has a clear description of
the protocol, since the first Note section will be used as the description of the protocol
on the web site.

After exporting a protocol for sharing, you can upload the exported protocol to the
community web site. Protocols exported for sharing have a .spz extension. Do not
rename the file. The file is encrypted and will not upload properly if it is renamed. To
upload your exported protocol, follow the instructions on the SoftMax Pro Software
community web site.
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Using the View Tab

The View tab in the ribbon contains three sections: Show/Hide Panel, Window, and
Expand/Collapse Sections.

In the Show/Hide Panel section, select or clear the Navigation Tree check box to show or
hide the Navigation Tree in the workspace.

In the Document View section, click an option to change the layout of the tabs in the
workspace.

e Click Single Tab Group El to view one tab group at a time.

o Click New Horizontal Tab Group E to split the workspace horizontally. The selected
tab moves below inactive tabs in the workspace. You can have as many horizontal areas
as you have tabs in the workspace.

o Click New Vertical Tab Group m to split the workspace vertically. The selected tab
moves to the right of inactive tabs in the workspace. You can have as many vertical areas
as you have tabs in the workspace.

In the Expand/Collapse Sections section, click an option to Collapse All Sections or to
Expand All Sections in the workspace.

Using the Operations Tab

Instrument Commands

The buttons that are displayed in the Instrument Commands group depend on the currently
selected instrument.

* Temperature: When connected to an instrument with temperature control, you can set
the temperature in the microplate or cuvette chamber in degrees Celsius. See Setting the
Temperature on page 47.

e Shake: If the selected instrument permits manual shaking of the microplate, then the
Shake button is available. See Shaking the Microplate on page 48.

e Open / Close: For most instruments, you can open and close the microplate drawer
using the software. For some instrument, other drawers can be opened and closed using
the software. See Opening and Closing a Drawer on page 49.
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Instrument Tools

The buttons that are displayed in the Instrument Tools group depend on the currently
selected instrument.

Calibration: The instrument calibration values are stored in the firmware of the
instrument. For information about updating the instrument calibration, see Calibrating
the Microplate Reader on page 455.

Filters: The positions of the filters in the EMax and Vmax Microplate Readers can be
defined using the Filter Configuration dialog. For instructions, see Configuring the Filters
for the EMax and Vmax Microplate Readers on page 456.EMax Plus Microplate Reader

Configure: In the Configuration dialog, you can adjust the intensity of the lamp for each
of the installed filters in the EMax Plus Microplate Reader. You can view the positions
and wavelengths of the installed filters. This dialog also lists other instrument
information like the serial number and firmware version. See Adjusting the Lamp for the
EMax Plus Microplate Reader on page 456.

Initialize: To return EMax Plus Microplate Reader microplate carrier to its home position,
click the Initialize button.

Info: In the Instrument Information dialog, you can view a list of the installed detection
cartridges in a SpectraMax i3x or i3 Multi-Mode Detection Platform orin a

SpectraMax Paradigm Multi-Mode Microplate Reader, or view the installed filters in
FilterMax F3 and F5 Multi-Mode Microplate Readers. This dialog also lists other
instrument information like the serial number and firmware version. For FilterMax F3
and F5 Multi-Mode Microplate Readers, you can configure the excitation and emission
filter slides. See Using the Instrument Information Dialog on page 457.

Refresh: To update the software with the currently installed detection cartridges in a
SpectraMax i3x or i3Multi-Mode Detection Platform or in a SpectraMax Paradigm Multi-
Mode Microplate Reader, or with the currently installed filter slides in FilterMax F3 and
F5 Multi-Mode Microplate Readers, click the Refresh button.
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Calculations

By default, SoftMax Pro Software does continuous recalculation of the data when you read
plates, create or change formulas, or change settings that have an effect on data. At certain
times, it is useful to disable recalculations so that you can edit the Experiment without
waiting for recalculations to be completed.

e Suspend Calculations disables automatic recalculation. While suspended, no
recalculation occurs regardless of what you change, add, or delete from the Experiment.
This is useful when creating or changing column formulas within Group sections.

* Resume Calculations re-enables automatic recalculation.

e When recalculation has been suspended, you might want to see the results of the
changes you have made but might still not want to enable continuous recalculation.
Click Recalculate Now to recalculate all data once without enabling continuous
recalculation.

Under certain circumstances, a calculation status message is displayed in the workspace
footer.

e Calculating is displayed when SoftMax Pro Software is calculating an entire experiment
automatically or when Recalculate Now is selected.

e Calculating Suspended is displayed when the Suspend Calculation is selected.
e Under all other conditions, no message is displayed.

For technical information about SoftMax Pro Software calculations, see Calculations and
Numerical Precision on page 356.

Automation
The following automation commands are available.

e Auto Read: You can automatically read plate sections as they are displayed within an
experiment. See Enabling Auto Read on page 340.

* Plate Stacker: The StakMax Microplate Handling System runs using the StakMax
Software that is integrated with the SoftMax Pro Software. See StakMax Microplate
Handling System on page 216.

e Automation Mode: You can place the software in automation mode, letting the
software accept legacy commands from scripts written for the SoftMax Pro Software
version 5.x automation interface. See Using Automation Mode on page 56.
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Setting the Temperature

When connected to an instrument with temperature control, you can set the temperature in
the microplate or cuvette chamber in degrees Celsius.

To set the temperature:
1. Connectto an instrument that is capable of temperature control.
2. Click Temperature on the Operations tab in the ribbon.

&' Termperature Contral @

-

Adjust the temperature of the plate chamber. @
@ On Plate Chamber 5et Point 35 e
) Off

| ok || cancer |

3. In the Temperature Control dialog, click On.

4. Type the desired temperature in degrees Celsius.

5. Click OK.

The instrument monitors the temperature of the air inside the microplate chamber, and the
software displays the air temperature of the chamber on the Instrument section of the

Home tab. The temperature display is continuously updated with the current air
temperature.

You can set the temperature 2°C or more above the current air temperature in the chamber.
After turning on the temperature control, the chamber can take from 10 to 30 minutes to
reach the desired temperature, depending on the difference between the starting
temperature and the desired temperature.

With the SpectraMax M2, M2e, M3, M4, M5, M5e, and Plus 384 instruments, the
Instrument section of the Home tab shows the temperature within the microplate chamber.
This can be different from the front panel of the instrument that displays the temperature
within the cuvette chamber. The readings should be very similar to each other after both
chambers have reached equilibrium. During warm-up, you might notice a discrepancy in
temperatures, which is normal.
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% Note: The temperature sensors detect the temperature of the air inside the chamber,
not the temperature of the samples in the microplate. If you use the instrument to
warm the samples, Molecular Devices recommends that you use a seal or lid on the
microplate to prevent evaporation of the sample. Using a seal or lid also helps to
maintain uniform temperature. Letting the prepared sample equilibrate inside the
microplate chamber can take an hour or more. You can speed up equilibration by pre-
warming the sample and the assay reagents to the desired temperature before
placing the microplate in the chamber. Validate the data quality to determine whether
the seal or lid can stay on the microplate for the read.

A CAUTION! The SpectraMax Paradigm, SpectraMax i3x, and FilterMax F5 instruments
have an automatic read-height (Z-height) adjustment for fluorescence and
luminescence reads. For top reads, the lens or the microplate can be damaged if the
microplate height is not set properly. If the microplate has a lid on top, you must
indicate that the microplate is lidded and make sure that the microplate height with a
lid is set accurately in the Plate Editor before starting a read.

After turning off the temperature control, you can help the microplate chamber cool to the
ambient temperature by opening the microplate drawer.

Shaking the Microplate

If the selected instrument permits manual shaking of the microplate, then the Shake button
is available in the Instrument Commands section on the Operations tab in the ribbon.

To shake the plate:
1. Insert the prepared microplate into the connected instrument.
2. Click and hold Shake % on the Operations tab in the ribbon.

3. Release the mouse button to stop the shaking operation.

* Tip: You can also have the instrument shake the microplate by holding down the F8
key.
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Opening and Closing a Drawer

For most instruments, you can open and close the microplate drawer using the software.

To open and close the microplate drawer on a connected instrument:

1. Click Open / CIoseEé on the Operations tab in the ribbon to open the microplate
drawer.

2. Insert or remove the prepared microplate in the instrument.

3. With the microplate drawer open on the connected instrument, click Open / Close@
on the Operations tab in the ribbon to close the microplate drawer.

% Note: The microplate carrier on the EMax Plus Microplate Reader moves in and out of
the read chamber during the read, and then returns to the home position after the
read ends. If the microplate carrier does not return to the home position, you can
initialize the carrier to return it to its home position by clicking Initialize in the
Operations tab of the ribbon. See Using the Operations Tab on page 44.

For some instruments, other drawers can be opened and closed using the software. For
example, the three drawers on the FlexStation 3 reader can be opened using the software.
Go to the Operations tab on the ribbon and then click Tips for the tip rack drawer, Reagent
for the compound plate drawer, or Open / Close for the read chamber drawer.

Use the Instrument Information dialog to open and close the cartridge drawers on the
SpectraMax i3x Instrument or SpectraMax Paradigm Instrument or to open and close the
filter drawers on the FilterMax F3 and F5Instruments. See Using the Instrument Information
Dialog on page 457.
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Using the GxP Tab

The GxP tab is available only when using the SoftMax Pro GxP Software. See Using SoftMax
Pro GxP Software Features on page 467.

User Account

The buttons in the User Account group provide access to information and management of
the current user account.

Account Information: The User Account Information dialog provides information about
the current user. See Viewing the User Information on page 472.

User Log On: Click the Log On button to log on after previously logging off. See Logging
onto SoftMax Pro GxP Software on page 472.

User Log Off: Click the Log Off button to log the current user off without closing the
program.
Change Password: The Change Password dialog lets the current user change the

password required for logging onto the software. See Changing the User Password on
page 474.

Select Account Database: The User Accounts Connection dialog lets the GxP Admin
Software administrator define the location of the User Accounts file related to this
installation of the SoftMax Pro GxP Software. See Connecting a User Accounts File on
page 469.

Data

The buttons in the Data group provide access to features that are unique to the SoftMax Pro
GxP Software.

Statements: The Statements dialog lets you view, edit, and add statements. A user with
the proper permission can add an electronic signature to statements. See Working with
GxP Statements on page 475.

Audit Trail: The Audit Trail dialog gives you read-only access to the audit trail for the
open data file, and lets you attach a note to the audit trail. See Viewing the GxP Audit
Trail on page 482.
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Using the Help Tab

SoftMax Pro Software has a comprehensive help library. You can open the application help
documents from the Help tab in the ribbon.

e Click SoftMax Pro Help g to view the SoftMax Pro Software Application Help. This
help contains task-oriented information about how to use SoftMax Pro Software. You
can find topics through the table of contents and by using the search function. This
document also features a linked index and glossary.

x)
o Click Formula Reference% to view the SoftMax Pro Software Formula Reference
Guide. This document is broken into four main sections:
The first section provides a general introduction to SoftMax Pro Software formulas.

e Operators describes the different types of operators that can be used to assemble
formulas.

e Functions describes the different types of built-in functions that can be used to
assemble formulas.

* Accessors describes the special functions that provide access to other specific
information.

You can find topics through the table of contents and by using the search function. This
document also features a linked index.

e Click Release Notes to view the SoftMax Pro Software Release Notes for this release
of the software. This document is in PDF format and can be viewed using a PDF viewer
like Adobe Reader.

e Click Contact Us 8‘) to display the SoftMax Pro Software What's New page, view the
Molecular Devices home page, access the knowledge base, or request technical support.

The knowledge base contains documentation supporting Molecular Devices products.
You can use the customer login tools and featured links to help you get the information
you need.

o Click Software License "Vm and follow the instructions in the Software License
Activation dialog to activate your SoftMax Pro Software license.

e Click SoftMax Pro G in the About section to see release information about this
release of the SoftMax Pro Software application.
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Context-sensitive help is available for the dialogs that have a @ help button.
More documentation in PDF format can be found in the Windows Start menu.

e To view the SoftMax Pro Software User Guide, the Formula Reference Guide, or the
Software Release Notes, click Start > All Programs > Molecular Devices > SoftMax
Pro 7.0 and then click the document you want to view.

e To view user guides for the supported instruments, click Start > All Programs >
Molecular Devices > SoftMax Pro 7.0 > Hardware User Guides and then click the
document you want to view.

These documents are in PDF format and can be viewed using a PDF viewer like Adobe
Reader.

Viewing the On-Screen Help

On-screen help is displayed when the dialog requires specific user interaction. When more

information about the topic is available, click the More Information link to open a help topic
that is specific to the option being set.
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Application Menu

The Application menu in the upper-left corner of the window contains options for working
with files, printing, and managing the application.

Recent Documents
1. AB5_Endpoint.sda

Open

Save

Save As

Auto Save

Print »

Save as PDF

Export

Import ¥

Close File

fr LEEROZT LD

Options Iﬁ Exit SoftMax Pro

Click the Application ﬁ button to open the Application menu and then click a menu
option.
e To create a new blank data file or protocol file, click New. See Creating a New Data File on
page 63 or Creating a New Protocol File on page 73.

e To open an existing data file or protocol file, click Open or select the file from the list of
Recent Documents on the right. See Opening a Data File on page 64 or Opening a
Protocol File on page 74.

e To save an open data file or protocol file, click Save or Save As. See Saving Data Files on
page 65 or Saving Protocol Files on page 75.
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To set up automatic saving options, click Auto Save. See Setting Auto Save Options on
page 76.

To print the sections of an experiment, preview a print job, or set printing options, click
Print and then click the option you want on the right. See Printing on page 80.

To save the defined printed output of a file in portable document format (PDF), click Save
As PDF. See Saving Data in a PDF File on page 451.

To export the data in a data file, click Export. See Exporting Plate Data on page 85.
To import data to a data file, click Import. See Importing Microplate Data on page 99.

The data import feature requires a separate license. To obtain a license for this feature,
contact your Molecular Devices representative.

To close the currently open document in the workspace, click Close File.

To set application options, click Options at the bottom of the menu. See Setting
Application Options on page 104.

To exit the program, click Exit SoftMax Pro at the bottom of the menu.

Quick-Access Toolbar

54

The Quick-Access toolbar is available for your customization. The Quick-Access toolbar
initially is displayed directly to the right of the Application button in the upper-left corner of
the SoftMax Pro Software application window.

Customize Quick Access Toolbar

Show Below the Ribbon -
Idle re ﬂ Mew Experiment

Minimize the Ribbon E}. New Note

Spectrabax

M2e (Simulated) &, Open / Close

Read 1
@ Delete Selection BS

4 Abs_Endpoint | What's New ;

You can move the location to above or below the ribbon and add function buttons that you
want to have quick-access to.

The Quick Access Toolbar initially has buttons to do the following tasks:

Create a new data file

Open a data file

Save a data file

Save (Save as) a data file or protocol file with a new name

The actions button
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Repositioning the Quick-Access Toolbar

The Quick-Access toolbar can be displayed above or below the application ribbon.
To reposition the Quick-Access toolbar:

1. Click the actions button to the right of the Quick-Access toolbar.

2. From the menu that is displayed, click either Show Below the Ribbon or Show Above
the Ribbon.

Adding a Button
To add a function button to the Quick-Access toolbar:

1. Right-click the button you want to add in the ribbon.
2. From the menu that is displayed, click Add to Quick-Access Toolbar.

Removing a Button
To remove a function button from the Quick-Access toolbar:
1. Right-click the button you want to remove in the Quick-Access toolbar.

2. From the menu that is displayed, click Remove from Quick-Access Toolbar.

Minimizing the Ribbon

To minimize the ribbon display:

1. Click the actions button to the right of the Quick-Access toolbar.
2. From the menu that is displayed, click Minimize the Ribbon.
To return the minimized ribbon to the display:

1. Click the actions button to the right of the Quick-Access toolbar.

2. From the menu that is displayed, click Minimize the Ribbon to remove the check mark
next to the option.

Integrated Web Browser

The What’s New tab in the document area contains a built-in web browser to keep you
informed of new or updated products and to give you access to the technical support
knowledge base.

This tab automatically starts each time you start the SoftMax Pro Software. To hide this tab
on start up, select the Hide web browser tab when application starts check boxin the
SoftMax Pro Options dialog. See Setting Application Options on page 104.
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The SoftMax Pro Software automation mode prevents user interaction when the software is
being controlled by the automation interface through third-party automation software or
the StakMax Software. To write scripts to use with the SoftMax Pro Software version 7
automation interface, Molecular Devices recommends that you use the most recent version
of the automation commands as described in the SoftMax Pro Software Automation API
Reference Guide.

To show that the SoftMax Pro Software is in automation mode, a dialog is displayed in front
of the main window.

Application is in Automation Mode
User input has been disabled

Automation Messages:

Client connection:
IP Address: =1 Port: 61518

Terminate| Wil forcefully close client connection.

When the automation software acquires data, the related Plate section is displayed in the
SoftMax Pro Software main window behind the automation mode dialog and displays the
acquired data.

If the automation software encounters an error, an error message is displayed in the
Automation Messages area of the automation mode dialog.

If you need to stop the automation process and regain control of the SoftMax Pro Software,
click Terminate.

To let the software accept legacy commands from scripts written for the SoftMax Pro
Software version 5.x automation interface, go to the Operations tab in the ribbon, and then

in the Automation section click Automation Mode #ﬁ The legacy script must use the
Windows message WM_COPYDATA command. The WM_SETTEXT command is not
supported. Legacy scripts might not work correctly with the new automation interface. If
your legacy script does not work properly, Molecular Devices recommends that you rewrite
the script using the most recent version of the automation commands as described in the
SoftMax Pro Software Automation API Reference Guide.

For more information on automation, see Writing and Running Automation Scripts on page
57, StakMax Microplate Handling System on page 216, or the SoftMax Pro Software
Automation API Reference Guide.
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Writing and Running Automation Scripts

The automation commands in the SoftMax Pro Software can be scripted and run through
the automation API. If you are an experienced automation programmer, consult the
SoftMax Pro Software Automation API Reference Guide for information about the available
commands and their parameters. If you are using the StakMax Microplate Handling System,
the StakMax Software has a built in scripting tool. See StakMax Microplate Handling System
on page 216. The SoftMax Pro Software also supports a Microsoft Excel Add-In to write and
run Excel Workflows.

SoftMax Pro Excel Workflows

The SoftMax Pro Excel workflows are designed to expand the industry-leading handling of
Plate Format Data by the SoftMax Pro Software with Excel-based handling of List Format
Data. You can use SoftMax Pro Excel workflows to run discontinuous kinetic reads,
multiplexed reads, kinetic well scan reads, and temperature-triggered reads.
The SoftMax Pro Automation SDK is the underlying mechanism used by SoftMax Pro Excel
workflows to access SoftMax Pro Software functionality. If you want to write your own
workflows, you need to be familiar with the available Automation Commands. See the
SoftMax Pro Software Automation APl Reference Guide.
Before you can use Excel to create and run automated workflows, you must install the
custom Add-In in Excel. With the Add-In installed you can run or edit the provided workflows
or create your own.
The provided Excel workflows are installed in the same folder as the Excel Add-In files.
e For a 32-bit installation, the workflows are in the following folder:
C:\Program Files\Molecular Devices\SoftMax Pro 7.0 Automation SDK\ExcelAddIn
e For a 64-bit installation, the workflows are in the following folder:
C:\Program Files (x86)\Molecular Devices\SoftMax Pro 7.0 Automation
SDK\ExcelAddIn
The Excel workflow files have an extension of .xIsm.
Before running or editing a provided Excel workflow, save a copy of the workflow on your
computer.

For complete information about setting up and using SoftMax Pro Excel Workflows, see the
SoftMax Pro Software Automation APl Reference Guide.
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The Application menu in the upper-left corner of the SoftMax Pro Software window contains
options for working with files, printing, and managing the application.

option. See Application Menu on page 53.

File Types
SoftMax Pro Software uses two basic file types: data files and protocol files.

Data files

Data files contain the experiment settings, the raw data collected by your reader, and the
data analysis you might have completed.

SoftMax Pro Software 6 can open files created by version 4.0 or later. Before you open a file
you must make sure that your currently selected instrument is the same model as the one
used to create the file, or a model with instrument settings that are compatible with the
model used to create the file.

Note: Files with data acquired from a FlexStation® 3 Multi-Mode Microplate Reader
can be opened for data analysis only.

You can open data files that have the following file extensions:
e .sda (SoftMax Pro Software 6 data files)
e .sdax (SoftMax Pro GxP Software 6 data files)
e .pda (SoftMax Pro Software 4 and 5 data files)
e .eda (SoftMax Pro GxP Software 4 and 5 data files)
See Opening a Data File on page 64.

All SoftMax Pro Software 6 data files are saved with the .sda or .sdax extension. See Saving
Data Files on page 65.

When you create a data file for an imaging experiment or a Western Blot experiment, the
SoftMax Pro Software creates a folder with the same name as the data file. See Image Data
Files and Folders on page 61.

The Auto Save feature can be used to prevent data loss. For more information and a
description of the data file types, see Setting Auto Save Options on page 76.
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Data Export Formats

You can export the data from a SoftMax Pro Software data file using the following file
extensions:

o .xml

txt (list)
.txt (plate)
Xls (list)
Xls (plate)

See Exporting Plate Data on page 85.

Protocol Files
Protocol files are experiment template files that contain microplate well layout assignments
and all other reader configuration information, but no data.
You can open protocol files that have the following file extensions:
e .spr (SoftMax Pro Software 6 protocol files)
e .sprx (SoftMax Pro GxP Software 6 protocol files)
e .ppr (SoftMax Pro Software 4 and 5 protocol files)
o .epr (SoftMax Pro GxP Software 4 and 5 protocol files)
See Opening a Protocol File on page 74.

All SoftMax Pro Software 6 protocol files are saved with the .spr or .sprx extension. Saving a
data file as a protocol file removes the data in the file, leaving only the configuration
information. See Saving Protocol Files on page 75.

Predefined Protocols

Several predefined protocols are installed with SoftMax Pro Software and are placed in the
default protocols folder. During software installation, the Basic Endpoint protocol is set as
the default protocol. Whenever you open a new file, the new file contains the settings from
the default protocol file. To change the default protocol file, see Saving a Protocol as the
Default Protocol on page 69.

You can use the features available in the Protocols tab in the application ribbon to manage
and share protocol files. See Using the Protocols Tab to Manage Protocols on page 42.
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Image Data Files and Folders

Before starting an image acquisition for Imaging mode or a Western Blot scan, you must
save the data file in a location with enough capacity for the image files. You create and save
data files for image-based experiments the same as you do for other experiments. See
Creating a New Data File on page 63.

For best results, save your imaging data file on a secondary internal hard drive. You can use
an external hard drive, but this can slow the data acquisition and is not recommended.

Note: To prevent data loss, do not save your imaging data file on a USB flash drive or
to a network location. These methods are not supported by Molecular Devices.

When you create a data file for an imaging experiment or a Western Blot experiment, the
SoftMax Pro Software creates a folder with the same name as the data file. For example, if
you save the data file with the name Imaging_Data, then a new folder named Imaging_Data
is also created in the same folder where the data file is saved. This folder stores the acquired
images and analysis results.

* Imaging Experiments
ﬁ@l Imaging Data.sda
* Imaging Data
¢ Exptl
* Platel
* IMAGES
¢ RESULTS

The acquired images are stored separately for each microplate in the IMAGES folder in TIFF
format. The image analysis data are stored in the RESULTS folder. For a Western Blot scan,
the RESULTS folder is not created or used.

A CAUTION! Do not manually rename the data file. Do not manually rename, move, or
delete the related folders or files. If you make changes to the structure of these files
and folders, then the SoftMax Pro Software possibly cannot open the data file, or it
can display inaccurate results.

button in the ribbon to open the Application menu, and then click Save As. See Saving Data
Files on page 65.

To delete the acquired images or the analysis data for an Imaging mode read of a microplate,
in the Navigation Tree right-click the Plate section and then click Delete Images or Delete
Cell Data. See Navigation Tree on page 29.

If you delete the TIFF file for a Western Blot scan, the SoftMax Pro Software recreates the
TIFF image from the intensity data stored in the data file.
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Molecular Devices recommends that you always use the file-management tools in the
SoftMax Pro Software to copy or delete your imaging files.

Note: When you save an imaging experiment as a protocol, only the protocol file is
saved. No other folders or files are created. See Creating a New Protocol File on page
73.

Acquiring images in Imaging read mode requires a large portion of computer memory and
resources.

Each acquired image file for an Imaging mode read can be larger than 2 megabytes. Acquiring
the image of a single site in each well of a 96-well microplate can generate 300 megabytes of
image data. A 384-well microplate can generate 1 gigabyte of image data. Acquiring images of
multiple sites increases the data-storage requirement. Molecular Devices recommends that
you use a data management system.

Before starting an image acquisition, minimize the demands on computer memory and
resources by turning off all other programs. When the SoftMax Pro Software has limited
access to computer memory and resources, image acquisition can take a long time. In some
cases, images of some of the wells can be lost.

To prevent data loss, turn off all sleep and hibernation settings for the hard disk, the CPU,
and the USB ports. Also, disable automatic Windows Updates. You can update Windows
manually when the instrument is not being used by the software. You can set these options
in Windows Control Panel. See Optimizing Your Computer for Image Acquisition on page
337.

Molecular Devices recommends that you use Auto Save with imaging data for saving to text
files only. If you use Auto Save to save multiple imaging data files, each new data file is saved
without the related folders required for saving images and analysis results. See Setting Auto
Save Options on page 76.
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Creating a New Data File
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You can create a new empty data file and save it into a folder.

The Application menu New command opens a new data file named Untitled, based on the
default protocol.

To create a new data file:

1.
2.

N o v s~ W

Click New. A new blank file opens and a new tab is displayed above the navigation tree.

Note: Molecular Devices recommends that you name and save the file before you
configure settings and collect data.

Click the Application button to open the Application menu.

Click Save as to open the Save As dialog.

Navigate to where you want to save the file.

Type the file name in the File name field.

In the Save as type list, select Data Files (*.sda).

If you are working with the SoftMax Pro GxP Software, select Data Files (*.sdax).
Click Save.

The name of the data file is displayed on the tab above the navigation tree.

When you create a data file for an imaging experiment or a Western Blot experiment, the
SoftMax Pro Software creates a folder with the same name as the data file. See Image Data
Files and Folders on page 61.
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To open a supported protocol or data file, use the Application menu. SoftMax Pro Software
6 can open files created by version 4.0 or later. However, after you save a file, it is readable
only by the current version.

You can open data files that have the following file extensions:
e .sda (SoftMax Pro Software 6 data files)
o .sdax (SoftMax Pro GxP Software 6 data files)
e .pda (SoftMax Pro Software 4 and 5 data files)
e .eda (SoftMax Pro GxP Software 4 and 5 data files)

% Note: Before you open a file you must make sure that your currently selected
instrument is the same model as the one used to create the file, or a model with
instrument settings that are compatible with the model used to create the file.

Files with data acquired from a FlexStation® 3 Multi-Mode Microplate Reader can be
opened for data analysis only.

SoftMax Pro Software 6 can open files created by version 4.0 or later. If you want to
open a file created in a version earlier than version 4.0, you must first open the file in
SoftMax Pro Software 4.0 or later, and then save it as a version 4.0 or later file.
Instrument compatibility requirements also must be met.

This version of the SoftMax Pro Software saves the new file with a different file extension
from the extension used in previous versions. The file created with the older version can
continue to be used with the older version without affecting the contents of the new file.

After opening a file from a previous version, it is good practice to review the file to make sure
that the conversion went well. In some cases, the file conversion might change instrument
settings, curve fits, or other items that have been updated for version 6.
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To open a data file:

3.
4.
5,

Select Open. The Data Files file type is selected by default.

SoftMax Pro Software 6 can open files created by version 4.0 or later.

When you open a file from a previous version, it is converted to SoftMax Pro Software
version 6 format.

Navigate to the data file you want to open.

Select the file.

Click Open.

Atab with the name of the file opens above the navigation tree, and the file opens in the
workspace.

Saving Data Files
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Use the Application menu Save or Save As commands to save data files.

If you want to save data in PDF format, see Saving Data in a PDF File on page 451.

To save a data file:

iAW

6.

Click Save (for first time file saving) or Save As.

In the Save As dialog, navigate to where you want the file to be saved.

In the File name field, type a name for the file.

From the Save as type field, select Data Files (*.sda).

If you are working with the SoftMax Pro GxP Software, select Data Files (*.sdax).

Click Save.

Molecular Devices recommends that you save your data file frequently. When you want to

click Save to save the file without opening the Save As dialog.

When you create a data file for an imaging experiment or a Western Blot experiment, the
SoftMax Pro Software creates a folder with the same name as the data file. See Image Data
Files and Folders on page 61.
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You can copy plate data from one Plate section to a different Plate section within the same
data file or between different data files. The format of the copied plate data must match the
format of the target Plate section. If you want to copy plate data between Plate sections in
the same file, it might be easier to use the Clone Plate feature. See Cloning a Plate Section on
page 127.

In some cases, you can paste endpoint plate data copied from an external program, such as
a spreadsheet or text editor. When pasting data from an external program, the format of the
copied endpoint data must exactly match the format of the target Plate section. Only
endpoint data can be pasted from an external program.

For more information about Plate sections, see Using a Plate Section on page 118.
To copy data from a Plate section:
1. View the Plate section that has the data you want to copy.

2. Right-click the plate data area and click Copy Plate Data to copy all of the data in the
entire plate.

To paste data in a Plate section:
1. View the Plate section where you want to paste the data.
2. Right-click the plate data area and click Paste Plate Data.
If you are pasting data from an external program, click Paste Data.
3. When pasting over existing data, click Yes in the message box that is displayed.

If the format of the data does not match the format of the target plate, a message is
displayed informing you of this. Click OK to close the message without pasting the data.

After the data is pasted into the Plate section, the Read Information on the right indicates
that the data was pasted and shows the time and date of when it was pasted.
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Managing Protocol Files
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Protocol files are experiment template files that contain microplate well layout assignments
and all other reader configuration information and reduction parameters, but no data.
Protocol files can be useful if you repeat a particular type of experiment frequently.

The Protocols tab in the ribbon provides easy access to protocol files that are stored in the
file system. It also gives you access to the SoftMax Pro Software user community for
protocol sharing, exchanging tips and tricks, and networking with other experienced users.
See Using the Protocols Tab to Manage Protocols on page 42.

Over 120 assay protocols are included in the software to speed life science research and drug
discovery assay development and screening. Researchers can customize experiment
protocols, analyze and display data, and create meaningful reports. The straightforward yet
powerful programming capabilities of the SoftMax Pro Software can further enhance
specialized data collection and analysis needs through custom assay development.

The predefined protocols installed with SoftMax Pro Software are placed in the SoftMax Pro
Software Protocols folder. You can use the Protocol Manager to quickly find and open a
protocol. See Using the Protocol Manager to Open a File on page 68.

During software installation, the Basic Endpoint protocol is set as the default protocol.
Whenever you open a new file, the new file contains the settings from the default protocol
file. You replace the default protocol with the settings from an open file so that future new
files will use those settings. See Saving a Protocol as the Default Protocol on page 69.

Saving a data file as a protocol file removes the data in the file, leaving only the configuration
information. You can add or remove folders in the Protocol Manager to help you find the
protocols you use most often. See Adding or Removing a Folder in the Protocol Manager on
page 70.
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Using the Protocol Manager to Open a File

The predefined protocols installed with SoftMax Pro Software are placed in the SoftMax Pro
Software Protocols folder. You can use one of the predefined protocols, or you can create
your own protocol. For more information on protocols, see Creating a Protocol on page 235.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol.

To open a protocol file in the Protocol Manager:

you can select a protocol to be assigned to a new file.
2. Select Protocol Library > foldername to view the available protocols in that folder.
To open the default protocol, click Default at the bottom of the Protocol Library.
3. Click the protocol you want to open.

When you save the section as a data file the settings from the protocol are saved along
with the data.

Note: When you add a new Plate section or Cuvette Set section to an experiment, you
can configure the instrument settings using the Settings dialog. See Instrument
Settings on page 246.
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Saving a Protocol as the Default Protocol

After the SoftMax Pro Software is installed, the Basic Endpoint protocol is set as the default
protocol with the filename default.spr. Whenever you create a new document, the
default.spr protocol file is opened as an untitled document that contains the settings from
the default protocol file.

You can save the settings of the file currently active in the workspace as the default protocol.

After you save the active protocol file as the default, whenever you create a new document,
the settings in the default.spr file that you have saved are loaded into an untitled document.

Saving a Default Protocol

1. Click Save as Default H to overwrite the default.spr file with the protocol setting of
the experiment that is active in your workspace.

2. Click OK to overwrite the default protocol file with this file. With the exception of
acquired data, all settings and sections (with their contents) are saved as part of the new
default protocol. When you create a new file, it will initially be identical to this current
data file (minus existing data).

Note: When you save the file as the default protocol, the data you have collected in
the current experiment remains unchanged. If you want to keep the data, you need
to save the data into a data file. See Saving Data Files on page 65.
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Adding or Removing a Folder in the Protocol Manager

You can add folders in your file system to those folder where protocols can be stored. See
Adding a Protocol Folder Location on page 70 and Deleting a Protocol Folder Location on
page 72.

Whenever you store protocol files in the added folder, those protocols are available in the
Protocol Manager. See Using the Protocol Manager to Open a File on page 68.

Adding a Protocol Folder Location

To add a protocol folder location to the Protocol Manager:

1. Click Folder Locations é’i to open the Folder Locations dialog.

L_k- Faolder Locatians @
Set Protocol Folder Locations @
Add
| CA\ProgramData\Molecular Devices\SMP61\Protocol
Library
[ ok || cancar |

2. Click Add to browse the file system to the folder to be added.
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Brovwse For Folder @

B Desktop -

* = Libraries

4 8 Adrminldser
» L AppData

m

=] Contacts 4
. Custorn Protocals
g Desktop
4 Downloads
» r Fawarites
& Links

= 2 My Docurnents -

[ Make Mew Folder ] [ (a4 ] [ Cancel

Select the folder where you want to store protocols.

Optionally, click Make New Folder to add a New Folder inside the selected folder and
then type a name for the folder.

Click OK. The selected folder is added to the folder list in the Folder Locations dialog.
Click OK to close the Folder Locations dialog.
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Deleting a Protocol Folder Location

To remove a protocol folder location from the Protocol Manager:

1. Click Folder Locations r—h’i to open the Folder Locations dialog.

2. Click the check box to select the folder location you want to remove.

L_i‘u Folder Locations @
Set Protocol Folder Locations @
[ Add ] [ Remave ]
CAProgramData\Molecular Devices\SMP&1\Protocol
[
Library
Cilsers\AdminUser\Custom Protocols

—T— ———

3. Click Remove. The selected folder is removed from the folder list in the Folder Locations
dialog.
4. Click OK to close the Folder Locations dialog.

Note: Removing a protocol folder location from the Protocol Manager does not
remove the folder or the files from your computer.
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Creating a New Protocol File

You can create a new blank protocol file and save it into a folder.

To create a new protocol file from a predefined protocol in the Protocol Manager, see Using
the Protocol Manager to Open a File on page 68.

To create a new protocol file:

1. Click the Application @i button to open the Application menu.
Click New. A new blank file opens and a new tab is displayed above the navigation tree.
Configure the protocol settings, see Creating a Protocol on page 235.

Note: Molecular Devices recommends that you save and name the protocol file
before you collect data with the settings.

4. Click the Application button to open the Application menu.
5. Click Save as to open the Save As dialog.
6. Navigate to where you want to save the protocol file.
7. Typethefile name in the File name field.
8. Inthe Save as type list, select Protocol Files (*.spr).
If you are working with the SoftMax Pro GxP Software, select Protocol Files (*.sprx).
9. Click Save.
Before using the protocol to collect data, save it as a data file. See Saving Data Files on page
65.
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To open a supported protocol file, use the Application menu. SoftMax Pro Software 6 can
open files created by version 4.0 or later. However, after you save a file, the new file is
readable only by the current version.

You can open protocol files that have the following file extensions:
e .spr(SoftMax Pro Software 6 protocol files)
e .sprx (SoftMax Pro GxP Software 6 protocol files)
e .ppr (SoftMax Pro Software 4 and 5 protocol files)
e .epr (SoftMax Pro GxP Software 4 and 5 protocol files)

% Note: Before you open a file you must make sure that your currently selected
instrument is the same model as the one used to create the file, or a model with
instrument settings that are compatible with the model used to create the file.

SoftMax Pro Software 6 can open files created by version 4.0 or later. If you want to
open a file created in a version earlier than version 4.0, you must first open the file in
SoftMax Pro Software 4.0 or later, and then save it as a version 4.0 or later file.
Instrument compatibility requirements also must be met.

If you need to continue using a protocol file with an older version of SoftMax Pro Software,
then save the file with a different name or in a different location after you open the file with
the current version.

After opening a file from a previous version, it is good practice to review the file to make sure
that the conversion went well. In some cases, the file conversion might change instrument
settings, curve fits, or other items that have been updated for version 6.

To open a predefined protocol in the Protocol Manager, see Using the Protocol Manager to
Open a File on page 68.
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To open a protocol file:

1.

4.
5,
6.

Select Open. The Data Files file type is selected by default.
Select a protocol file type from the list.
SoftMax Pro Software 6 can open files created by version 4.0 or later.

When you open a file from a previous version, it is converted to SoftMax Pro Software
version 6 format.

Navigate to the protocol file you want to open.
Select the file.
Click Open.

An untitled file opens in the workspace with the settings of the selected protocol applied to
it. Before using the protocol to collect data, save it as a data file. See Saving Data Files on
page 65.

Saving Protocol Files
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Use the Application menu Save As command to save a file as a protocol file.

s W oe

6.

Click Save As.

In the Save As dialog, navigate to where you want the protocol file to be saved.

In the File name field, type a name for the file.

From the Save as type field, select Protocol Files (*.spr).

If you are working with the SoftMax Pro GxP Software, select Protocol Files (*.sprx).
Click Save.

Saving a data file as a protocol file removes the data in the file, leaving only the configuration
information.

Before using the protocol to collect data, save it as a data file. See Saving Data Files on page

65.
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When Auto Save is enabled, the collected data is saved automatically to a user-defined
location immediately after each plate read is completed. Auto Save reduces the likelihood of
lost data, particularly when Auto Save is set to save files to corporate network volumes that
are backed up on a regular basis.

You can add as many Auto Save instances as desired, each with its own settings.

% Note: Auto Save settings are saved with each document.

This feature helps prevent data loss when used with automated reads, such as with the
StakMax Microplate Handling System. See StakMax Microplate Handling System on page
216.

Molecular Devices recommends that you use Auto Save with imaging data for saving to text
files only. If you use Auto Save to save multiple imaging data files, each new data file is saved
without the related folders required for saving images and analysis results. See Image Data
Files and Folders on page 61.

To set Auto Save options:

1. Click the Application @ button in the ribbon to open the Application menu and then

click Auto Save Ej to open the Auto Save dialog.

ﬁ Auto Sawve @
Enable automatic file saving after every read cperation. @
Save Data After Read
[ add || Ea | [ Delete |
File Name Location
Data C\ProgramData'\Moleculzr Devices\5MP_Data
[ ok || cancel

To enable Auto Save, select Save Data After Read.
To create a new Auto Save location, click Add.

To modify an existing Auto Save location, select the location in the list and then click Edit.

vic W

When you are finished setting Auto Save options, click OK.
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Defining Auto Save Properties

3 futo Save Froperties @

File Location

() Protocol's Folder
C:\ProgramData\Molecular Devices\SMP_Data B
@) Assigned Folder = ' (LI rowse

File Name
) Protocol's Name

~ Data
@ Assigned Name

File Format
|t (plate) = |
Save Options
Export Data- /@ Raw () Reduced () Both
@ Create a New File
Append Date To File Name
Append Tima To File Name

() Overwrite Existing File

) Append to File

MNumber of Platas Per File 10

[ ok || cance

The Auto Save Properties dialog contains the following options:

File Location

You can choose to automatically save files to the current protocol's folder or to assign a
different folder.

To assign a folder click Assigned Folder and then click the Browse button to locate the folder
where you want to save the data.
File Name

To name the automatically saved file with the current protocol's name, select Protocol's
Name.

To assign a name to the automatically saved file, select Assigned Name and then type a
name for the file. The text in this field is automatically inserted at the start of each
automatically saved file name.
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File Format

Select a data format from the menu. Options include:
e .sdaor.sdax
e .xml

.txt (list)

.txt (plate)

Xls (list)

o xls (plate)

Format options let you specify what type of file is automatically saved. Version 6 supports
the following file formats: SoftMax Pro (.sda), XML (.xml), tab-delimited text (.txt) in list or
plate layouts, and Excel (.xIs) in list or plate layout.

SoftMax Pro File Format

When .sda or .sdax is selected, your data is automatically saved as a proprietary SoftMax Pro
Software file format.

XML File

When .xml is selected, you data is automatically saved in XML format. XML is supported for
data export and Auto Save. XML is the best file format if you plan to import all read data into
other data collection and storage applications—specifically, LIMS (Laboratory Information
Management System) or SDMS (Scientific Data Management System) packages.

Tab-Delimited File

When either .txt (list) or .txt (plate) is selected, your data is automatically saved as a tab-
delimited text file, which can be opened by most word processor, spreadsheet, or database
programs.

Excel

When either .xlIs (list) or .xls (plate) is selected, your data is automatically saved in a format
that can be opened by Microsoft Excel.The Excel output has the same format as a tab-
delimited file with the .xls file extension which lets the file be opened easily by Excel.
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Save Options

The available save options depend on the selected file format for the automatically saved file.
Export Data
For all data formats except .sda, you can you can specify the type of data to save.
o Select Raw to export only the raw data.
* Select Reduced to export only the reduced data.
e Select Both to export both the raw and the reduced data in the same file.
Create a New File

When you choose to create a new file after each read, you can also choose to append the
date and time to the file name.

o Select Append Date to File Name to add the date after the specified file name.

e Select Append Time to File Name to add the time after the specified file name.
If you select to append both the date and the time to the file name, the time follows the
date.

If you do not select to append the date or the time to the file name, files with the same name
are numbered sequentially, for example Data 1, Data 2, and so on.

If you select to append only the date to the file name, SoftMax Pro Software indexes the runs
for that day starting with 1 and increments with each successive run. For example, the first
file named Data that is automatically saved on February 12th, 2014 would be named as Data-
02-12-14 1, while the second automatically saved file would be named Data-02-12-14 2, and
so on.

Overwrite Existing File

This option should be used carefully as overwriting a file can cause loss of data. To help
ensure against data loss, a file can overwrite only itself. If a different file with the same name
exists in the defined autosave directory, the SoftMax Pro Software appends a number to the
end of the file name.

Append to File

If either a .txt or .xls format is selected, you can choose to append the plate data to the
current file. Enter the maximum number of plates to append per file.

If you are reading 10 microplates using the StakMax Microplate Handling System, you can
use Append to File to save the data from all 10 microplates in a single data file.
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Printing

You can print the contents of the currently selected file. You can print all the sections, or
select the sections that you want to print. You can preview the print job before you print it.
You can define the header and footer of the pages and the print quality in the Printing
Options dialog.

Application menu, and then click Print . The following options are displayed on the
right:

e Click Print All —:|ﬂ_1 to print all the included sections in the file. See Printing All Included
Sections on page 81.

o Click Print Preview g to preview the print job before printing it. See Previewing a
Print Job on page 81.

o Click Print Selected % to select the sections that you want to print for the print job.
See Printing Selected Sections on page 82.

o Click Printing Options 5; to define the header and footer of the pages and the print
quality for your print jobs. See Setting Printing Options on page 83.

You can also predefine the sections that you want to exclude from your future print jobs by
disabling printing for the sections in the Navigation Tree. See Disabling Sections from
Printing on page 84.

To print to a PDF file, select the Molecular Devices (PDF Writer) in the Print dialog or open
the Application menu and click Save As PDF. See Defining PDF File Settings on page 452.
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Printing All Included Sections

When you select to print all the sections in the file, all the included sections print in the order
they are listed in the Navigation Tree. If you have excluded a section from printing by
disabling printing for the section in the Navigation Tree, the section does not print. See
Disabling Sections from Printing on page 84.

To print all the included sections in the file:

1.

4.

From the list on the right, click Print All ﬁ

In the Print dialog, select the printer you want to use and set the print settings available
for that printer, including the number of copies that you want to print.

To print to a PDF file, select the Molecular Devices (PDF Writer). See Defining PDF File
Settings on page 452.

Click Print.

Previewing a Print Job

To preview the print job before printing it:

1.

AR

=

From the list on the right, click Print Preview g .
In the Print Preview dialog, you can scroll through the pages and zoom in and out.
Click the Print button in the toolbar at the top of the dialog.

In the Print dialog, select the printer you want to use and set the print settings available
for that printer, including the number of copies that you want to print.

To print to a PDF file, select the Molecular Devices (PDF Writer). See Defining PDF File
Settings on page 452.

Click Print.
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Printing Selected Sections

To select the sections that you want to print:

1. Click the Application E button to open the Application menu, and then click Print

2. Click Print Selected % .

Ifﬁ_’-i' Print Zelected

Select sections to print.

4[] BasicEndpoint
|:| Intro

‘
Motesi
Platel
Standards
Unknowns
Unk_Dilution
Control
StandardCurve

[ Select All H Deselect.ﬂ.il]

==
®

Print

” Cancel l

3. Inthe Print Selected dialog, select the check boxes next to the sections you want to print

and clear the check boxes next to the sections that you do not want to print.

e To select all the check boxes, click Select All.

e To clear all the check boxes, click Deselect All.

e To preview the print job before printing, click Print Preview. See Previewing a Print

Job on page 81.
4. Click Print to print the selected sections.
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5. Inthe Print dialog, select the printer you want to use and set the print settings available
for that printer, including the number of copies that you want to print.

To print to a PDF file, select the Molecular Devices (PDF Writer). See Defining PDF File

Settings on page 452.
6. Click Print.

Setting Printing Options

To define the contents of the header and footer and the quality of the printed output:

1. Click the Application E button to open the Application menu, and then click Print

2. Click Printing Options % .

Q Printing Qptions

Header and Footer

Choose options which affect the appearance of the printed document.

=
@

Left
Header

Experiment Name

Footer
File Path and Name

1
w
i

[] Add Image

[ softMax Pro 6.1

Date and Time Page Mumber
Left Center gh
Print Quality
Improving the print guality may
U increase the amaunt of time
reguired to print @ document.
Draft Better Best =a P

I[ Cancel ]
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3. Inthe Printing Options dialog, define the header and footer of the pages.
e Toinclude the predefined text, select the check box next to the text.
e Toinclude custom text in the header, type the text in the fields.
e Toadd aJPEGimage, such as a logo, to the right side of the header, select the Add
Image check box and then click the Browse button to locate and select the image file.
When printing, the selected image is sized to fit in the image area in the upper-right
area of the page.
4. Adjust the print quality by dragging the Print Quality slider to the desired quality level.

5. Click OK to save the printing options and close the dialog.

Disabling Sections from Printing

To predefine the sections that you want to exclude from your future print jobs:
1. Inthe Navigation Tree, click the section you want to exclude from printing.

2. Click the Disable printing for the selection (:@ icon in the upper-right corner of the
Navigation Tree.
Theicon is displayed to the right of the section in the Navigation Tree.

‘i Abs_Endpoint | What's New £

Mavigation Tree k@ < Doc

o ﬂ BasicEndpo...

4, Intro &
4 L Exptl

|_'\L Motesl

Flatel

[ 1] standards

[[1] unknowns |

[[1] unk_Dilution

|_|_|_| Control

[ standardCu...

«,..WI‘\W

To enable printing the selected section, click the Disable printing for the selection icon
again.

To disable or enable all the sections in an Experiment for printing, click the Experiment to
select it and then click the Disable printing for the selection (@ icon in the upper-right
corner of the Navigation Tree.
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Exporting Plate Data

5049092 A

The Export feature creates a data file from the selected sections in a SoftMax Pro Software
file.

The precision of the data displayed in a Plate section varies based on the space available to
view the characters.

You can customize the data display to Numeric notation or Scientific notation format, and
specify the number of Significant Figures or Decimal Places. These options can be set
separately for raw data and reduced data.

When the number of digits is increased, the font size of the values in the Plate section is
decreased. If the value becomes too long, then the numbers are cut off at the edge of the
wells.

When SoftMax Pro Software exports plate data, the values are not limited by space and can
have more digits for each well.

The values displayed in a Plate section are only a representation of the data. In both the
Plate section and in the exported data, the last digit displayed or exported is rounded based
on the actual data value.

For information on exporting membrane data, see Viewing Western Blot Membrane Data on
page 443.

For information on exporting Imaging data to Microsoft Excel or PowerPoint, see Viewing the
Imaging Data in a Well on page 365.

If you want to export data in PDF format, see Saving Data in a PDF File on page 451.
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To export the data from a file:

1. Click the Application &i button to open the Application menu.

2. Click Export H

3. Inthe Export dialog, select the sections to export:
e Toinclude a section in the export, select the check box next to the section.
e To exclude a section from the export, clear the check box next to the section.
e To export all plate data, select the All Plates check box.
e To export all group data, select the All Groups check box.
e To export all notes data, select the All Notes check box.
4. Click one of the following Plate Data Options:
°* Raw
* Reduced
* Both

% Note: These options apply only if one or more Plate sections are selected.

5. Click the Output Format you want for the export file:
e Columns exports data in a single column of text for each well.
e Plate exports data in a text matrix corresponding to a microplate grid.

e XML exports data in an XML file format. For a copy of the SoftMax Pro XML schema,
contact Molecular Devices Technical Support.

% Note: These options apply only if one or more plate sections are selected.

Click OK to export the data.
In the Save As dialog, navigate to the folder where you want to save the exported data.

In the File name field, type a name for the export file.

L 0 N o

From the Save as type list, select the file type for the export file. For XML exports, only
.xml is available in this list.

10. Click Save to save the file with the exported data.
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Export File Formats

Whether you save the export as a .txt or .xls, the information is presented as tab-separated
values. This topic describes the basic information that is included in these two export
formats.
For a copy of the SoftMax Pro XML schema, contact Molecular Devices Technical Support.
The first line of an export file defines the number of sections (or "Blocks") that are included in
the export using the following format:
° ##BLOCKS=n
where n is the number of sections that are included in the export file.
The selected sections are exported in the order that they are displayed in the SoftMax Pro
Software data file.
Sections are presented in the following format:
e Headerline
The header line contains the type of section, such as Note, Plate, or Group, and the title
of the section as defined in the SoftMax Pro Software data file. Plate sections contain
more information in the header line.
e Data lines
The data lines immediately follow the header line and contain the text or data from the
exported section. The layout and format of the data lines are dependent on many
factors, such as the section type, export type, read mode, and read type.
e Endline
The end line of each section is always defined by the text: “~End
The final line of an export file contains a single field with the original name given to the export
file, and the date and time that the file was last saved.
For more detailed information on export formats, see the following topics:
e Plate Export Formats on page 88
e Group Section Export Formats on page 98

e Note Section Export Formats on page 98
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Plate Export Formats

This topic describes the format of Plate sections that are exported as a .txt or .xls file. For a
copy of the SoftMax Pro XML schema, contact Molecular Devices Technical Support.

e The header line contains the type of section, such as Plate, and the title of the section as

defined in the SoftMax Pro Software data file. Plate sections contain more information in
the header line. See Plate Header Fields on page 88.

The data lines immediately follow the header line and contain the data from the
exported section. The layout and format of the data lines are dependent on many

factors, such as the section type, export type, read mode, and read type. See Plate Data
Lines on page 97.

Plate Header Fields

The fields in the header line for a Plate section help define the data that is presented in the
section. The order and content of the fields are different depending on the read mode used
to collect the data.

The tables that follow define the fields in the header line for the different read modes:

Table 3-1: Header Fields for Absorbance (ABS) Read Mode on page 89

Table 3-2: Header Fields for Fluorescence Intensity (FL) and AlphaScreen (ALPHA) Read
Modes on page 90

Table 3-3: Header Fields for Luminescence (LUM), Time-Resolved Fluorescence (TRF), and
Fluorescence Polarization (FP) Read Modes on page 92

Table 3-4: Header Fields for Imaging Read Modes on page 95
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Table 3-1: Header Fields for Absorbance (ABS) Read Mode

Position Name Description

1. Section type Contains the type of section such as Plate

2. Section name Contains the title of the section as defined in the SoftMax Pro
Software data file

3. Export version Contains the version of the export application used for this
export

4. Export format Contains TimeFormat for Columns output format or
PlateFormat for Plate output format as defined in the Export
dialog

5. Read type Contains the read type used for the acquisition, such as
Endpoint, Kinetic, Spectrum, or Well Scan

6. Read mode Contains the read mode used for the acquisition, such as
Absorbance

7. Data type Contains Raw or Reduced to define the type of data in the
export file

8. Pre-read Always FALSE
Pre-read is not a function of SoftMax Pro Software version 6.x

9. Kinetic points Contains the number of reads done during the acquisition
For Endpoint reads the number is 1

10. Read time Contains the read time in seconds for a Kinetic read

Read pattern Contains the scan pattern for a Well Scan read

Contains no value (blank) for other read types

11. Kinetic interval Contains the interval between reads in seconds for a Kinetic

Well Scan density read

Contains the scan density for a Well Scan read
Contains no value (blank) for other read types

12. Start wavelength Contains the starting wavelength for a Spectrum read
Contains no value (blank) for other read types

13. End wavelength Contains the ending wavelength for a Spectrum read
Contains no value (blank) for other read types

14. Wavelength step Contains the wavelength increment or step for a Spectrum
read
Contains no value (blank) for other read types

15. Number of wavelength | Contains the number of wavelengths read for the acquisition
Contains no value (blank) for Spectrum reads
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Table 3-1: Header Fields for Absorbance (ABS) Read Mode (continued)

Position Name

16.

Wavelengths

Description

Contains the wavelengths used for the acquisition

For multiple-wavelength reads, the values are separated by a
space

Contains no value (blank) for Spectrum reads

17.

First column

Contains the number of the first column read during the
acquisition

18.

Number of columns

Contains the number of columns read during the acquisition

19.

Number of wells

Contains the total number of wells in the microplate, such as
96 or 384

20.

First row

Contains a number corresponding with the first row read
during the acquisition

21.

Number of rows

Contains the number of rows read during the acquisition

22.

Time tags

Contains time-tag information if the exported data has read-
time tags

Table 3-2: Header Fields for Fluorescence Intensity (FL) and AlphaScreen (ALPHA) Read

Modes

Position Name Description

1. Section type Contains the type of section such as Plate

2. Section name Contains the title of the section as defined in the SoftMax Pro
Software data file

3. Export version Contains the version of the export application used for this
export

4. Export format Contains TimeFormat for Columns output format or
PlateFormat for Plate output format as defined in the Export
dialog

5. Read type Contains the read type used for the acquisition, such as
Endpoint, Kinetic, Spectrum, or Well Scan

6. Read mode Contains the read mode used for the acquisition, such as
Fluorescence or Luminescence

7. Bottom read Contains TRUE if reading from the bottom of the microplate
and FALSE if reading from the top

8. Data type Contains Raw or Reduced to define the type of data in the
export file

90
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Table 3-2: Header Fields for Fluorescence Intensity (FL) and AlphaScreen (ALPHA) Read

Modes (continued)

Position Name Description

9.

Pre-read

Always FALSE
Pre-read is not a function of SoftMax Pro Software version
6.x

10.

Kinetic points

Contains the number of reads done during the acquisition
For Endpoint reads the number is 1

11.

Read time
Read pattern

Contains the read time in seconds for a Kinetic read
Contains the scan pattern for a Well Scan read
Contains no value (blank) for other read types

12.

Kinetic interval
Well Scan density

Contains the interval between reads in seconds for a Kinetic
read

Contains the scan density for a Well Scan read

Contains no value (blank) for other read types

13.

Start wavelength

Contains the starting wavelength for a Spectrum read
Contains no value (blank) for other read types

14.

End wavelength

Contains the ending wavelength for a Spectrum read
Contains no value (blank) for other read types

15.

Wavelength step

Contains the wavelength increment or step for a Spectrum
read
Contains no value (blank) for other read types

16.

Number of wavelengths

Contains the number of wavelengths read for the acquisition
Contains no value (blank) for Spectrum reads

17.

Wavelengths

Contains the wavelengths used for the acquisition

For multiple-wavelength reads, the values are separated by a
space

For Fluorescence reads, contains the emission wavelengths
Contains no value (blank) for Spectrum reads or Ex/Em
sweeps

18.

First column

Contains the number of the first column read during the
acquisition

19.

Number of columns

Contains the number of columns read during the acquisition

20.

Number of wells

Contains the total number of wells in the microplate, such as
96 or 384

21.

Excitation wavelengths

Contains the excitation wavelengths used for a Fluorescence
read

For multiple-wavelength reads, the values are separated by a
space

Contains no value (blank) for Spectrum reads or Ex/Em
sweeps
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Table 3-2: Header Fields for Fluorescence Intensity (FL) and AlphaScreen (ALPHA) Read

Modes (continued)

Position Name Description

22. Cutoff Contains Manual or Automatic as defined in the Settings
dialog

23. Cutoff filters Contains the wavelengths of the cutoff filters with the values
separated by a space

24, Sweep wave Contains Excitation Sweep or Emission Sweep as defined in
the Settings dialog

25. Sweep fixed wavelength | Contains the fixed wavelength of an Ex/Em sweep

26. Reads per well Contains the number of times a well is read during a single
reading

27. PMT gain Contains Automatic, High, Medium, or Low as defined in the
Settings dialog

28. Start integration time Contains the time to start integration for a TRF read.
Contains no value (blank) for other read modes

29. End integration time Contains the time to end integration for a TRF read.
Contains no value (blank) for other read modes

30. First row Contains a number corresponding with the first row read
during the acquisition

31. Number of rows Contains the number of rows read during the acquisition

32. Time tags Contains time-tag information if the exported data has read-
time tags

Table 3-3: Header Fields for Luminescence (LUM), Time-Resolved Fluorescence (TRF), and
Fluorescence Polarization (FP) Read Modes

Position Name Description

1. Section type Contains the type of section such as Plate

2. Section name Contains the title of the section as defined in the SoftMax Pro
Software data file

3. Export version Contains the version of the export application used for this
export

4. Export format Contains TimeFormat for Columns output format or
PlateFormat for Plate output format as defined in the Export
dialog

5. Read type Contains the read type used for the acquisition, such as
Endpoint, Kinetic, Spectrum, or Well Scan

6. Read mode Contains the read mode used for the acquisition, such as
Luminescence or Time Resolved
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Table 3-3: Header Fields for Luminescence (LUM), Time-Resolved Fluorescence (TRF), and

Fluorescence Polarization (FP) Read Modes (continued)

Position Name

7.

Data type

Description

Contains Raw or Reduced to define the type of data in the
export file

Pre-read

Always FALSE
Pre-read is not a function of SoftMax Pro Software version
6.X

Kinetic points

Contains the number of reads done during the acquisition
For Endpoint reads the numberis 1

10.

Read time
Read pattern

Contains the read time in seconds for a Kinetic read
Contains the scan pattern for a Well Scan read
Contains no value (blank) for other read types

11.

Kinetic interval
Well Scan density

Contains the interval between reads in seconds for a Kinetic
read

Contains the scan density for a Well Scan read

Contains no value (blank) for other read types

12.

Start wavelength

Contains the starting wavelength for a Spectrum read
Contains no value (blank) for other read types

13.

End wavelength

Contains the ending wavelength for a Spectrum read
Contains no value (blank) for other read types

14.

Wavelength step

Contains the wavelength increment or step for a Spectrum
read
Contains no value (blank) for other read types

15.

Number of wavelengths

Contains the number of wavelengths read for the acquisition
Contains no value (blank) for Spectrum reads

16.

Wavelengths

Contains the wavelengths used for the acquisition

For multiple-wavelength reads, the values are separated by a
space

For Time Resolved reads, contains the emission wavelengths
Contains no value (blank) for Spectrum reads or Ex/Em
sweeps

17.

First column

Contains the number of the first column read during the
acquisition

18.

Number of columns

Contains the number of columns read during the acquisition

19.

Number of wells

Contains the total number of wells in the microplate, such as
96 or 384

93



SoftMax Pro Software User Guide

94

Table 3-3: Header Fields for Luminescence (LUM), Time-Resolved Fluorescence (TRF), and

Fluorescence Polarization (FP) Read Modes (continued)

Position Name

Description

20. Excitation wavelengths Contains the excitation wavelengths used for a Time Resolved
read
For multiple-wavelength reads, the values are separated by a
space
Contains no value (blank) for Spectrum reads or Ex/Em
sweeps

21. Cutoff Contains Manual or Automatic as defined in the Settings
dialog

22. Cutoff filters Contains the wavelengths of the cutoff filters with the values
separated by a space
Contains no value (blank) if no cutoff filter is used

23. Sweep wave Contains Excitation Sweep or Emission Sweep as defined in
the Settings dialog

24. Sweep fixed wavelength | Contains the fixed wavelength of an Ex/Em sweep

25. Reads per well Contains the number of times a well is read during a single
reading

26. PMT gain Contains Automatic, High, Medium, or Low as defined in the
Settings dialog

27. Start integration time Contains the time to start integration for a Time Resolved
read.
Contains no value (blank) for other read modes

28. End integration time Contains the time to end integration for a Time Resolved
read.
Contains no value (blank) for other read modes

29. First row Contains a number corresponding with the first row read
during the acquisition

30. Number of rows Contains the number of rows read during the acquisition

31. Time tags Contains time-tag information if the exported data has read-
time tags
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Table 3-4: Header Fields for Imaging Read Modes

Position Name Description

1. Section type Contains the type of section, such as Plate

2. Section name Contains the title of the section as defined in the SoftMax Pro
Software data file

3. Export version Contains the version of the export application used for this
export

4. Export format Contains TimeFormat for Columns output format or
PlateFormat for Plate output format as defined in the Export
dialog

5. Read type Contains the read type used for the acquisition, such as
Endpoint

6. Read mode Contains the read mode used for the acquisition, such as
Imaging

7. Data type Contains Raw or Reduced to define the type of data in the
export file

8. Pre-read Always FALSE
Pre-read is not a function of SoftMax Pro Software version 6.x

9. Kinetic points Contains the number of reads done during the acquisition
For Endpoint reads the number is 1

10. Read time Contains no value (blank) for Imaging reads

11. Kinetic interval Contains no value (blank) for Imaging reads

12. Start wavelength Contains no value (blank) for Imaging reads

13. End wavelength Contains no value (blank) for Imaging reads

14. Wavelength step Contains no value (blank) for Imaging reads

15. Number of wavelengths | Contains the number of wavelengths, or channels, read for
the acquisition

16. Emission wavelengths Contains the emission wavelengths used for the acquisition
For multiple-wavelength reads, the values are separated by a
space

17. First column Contains the number of the first column read during the
acquisition

18. Number of columns Contains the number of columns read during the acquisition

19. Number of wells Contains the total number of wells in the microplate, such as
96 or 384

20. First row Contains a number corresponding with the first row read
during the acquisition
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Table 3-4: Header Fields for Imaging Read Modes (continued)

Position Name Description

21. Number of rows Contains the number of rows read during the acquisition

22. Excitation wavelength Contains the excitation wavelengths used for the acquisition
For multiple-wavelength reads, the values are separated by a
space

23. Analysis type Contains the analysis type used, such as Discrete Object
Analysis

24, Classification Contains On if classification is used and Off if it is not used

25. Find on Contains the emission wavelength used for finding objects or
fields

26. Measurement Contains the type of measurement selected in the Display
Options dialog, such as Cell Count
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Plate Data Lines

The data lines immediately follow the header line.

e Thefirst column shows the time points for a kinetic read, the data points in a well scan
read, or the wavelengths in a spectrum read. For endpoint reads, this column is blank.

* The second column shows the temperature for the read, if the incubator is used for the
read. If the incubator is off, the value is zero.

The read data starts in the third column. When both raw and reduced data are exported, the
reduced data is displayed below the raw data.

The format of the data depends on whether the data were exported in column format or
plate format.

For column formats, the data are displayed in a single row. The data for multiple time points
for kinetic reads, multiple data points for well scan reads, or multiple wavelengths for
spectrum reads are listed in separate rows. For endpoint, kinetic, or well scan reads with
multiple wavelengths, the data for each wavelength are displayed in subsequent rows below
the previous wavelength. For imaging reads, the data for each measurement arein a
separate row.

Time Temperature |Al A2 A3 B1 B2 B3
0:00:00 #H 1.596 2.479 2.95 3.002 3.103 1.39 ..| wavelength 1
0:01:58 #H 1.564 3.344 2.378 2.744 0.113 3.872 ..
i
Raw Data
0:00:00 i 3.928 3.645 1.956 3.622 2.195 0.519 .| wavelength 2
0:01:58 #H 2.891 3.824 2.782 3.203 1.105 0.281
#H
Al A2 A3 |... |B1 [B2 B3 .
203.45455] -18.91525] -28.13257 106.53005| 82.585516
Reduc

ed Data

Figure 3-1: Kinetic data exported in column format
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For plate formats, the data are displayed in a table to indicate the columns and rows of the
microplate. The data for multiple time points for kinetic reads, multiple data points for well
scan reads, or multiple wavelengths for spectrum reads are listed in separate tables below
the previous table. For endpoint, kinetic, or well scan reads with multiple wavelengths, the
data for each wavelength are displayed in separate tables to the right of the previous table.
For imaging reads, the data for each measurement are in a separate tables to the right of the
previous table.

wavelength 1 wavelength 2
Temperature 1 2 3 1 2 3
0:00:00 #H# 1.596 2.479 2.95 3.103 1.39 1.97
1.024 0.308 3.925 2.381 1.957 3.722
0.195 0.287 2.638 0.967 1.049 1.422
0:01:58 #i 1.564 3.344 2.378 | I 0.113 3.872 0.637
0.82 1.797 1.064 3.58 2.603 0.996
0.421 3.066 3.906 RaW Data 0.915 0.57 2.251
H 1.169 1.092 3.969 1.126 0.004 1.934
1.105 3.022 2.845 1.933 2.834 0.657
3.602 2.033 3.737 0.437 3.242 1.337
1 2 3 .| | 1 2 3
203.45455| -18.91525| -28.13251 1 I"1na =2005] 82.585516) 121.96918
74.597843| 107.62096] -88.65948 Reduced Data 376] -77.66718] -83.94453
-134.6718| 68.810478] -52.5208 | | 24b.51772| 60.674884| 48.51772

Figure 3-2: Kinetic data exported in plate format
Group Section Export Formats

This topic describes the format of Group sections that are exported as a .txt or .xls file. For a
copy of the SoftMax Pro XML schema, contact Molecular Devices Technical Support.

The header line contains the type of section, such as Group, and the title of the section as
defined in the SoftMax Pro Software data file.

The data lines immediately follow the header line and contain the text and data from the
exported section.

e The data from the group table are displayed in a table that contains the column headings
in the first row followed by the data from the table.

e Group summaries, if present, are displayed in the rows at the end of the section.
Note Section Export Formats

This topic describes the format of Note sections that are exported as a .txt or .xIs file. For a
copy of the SoftMax Pro XML schema, contact Molecular Devices Technical Support.

The header line contains the type of section, such as Note.

The data lines immediately follow the header line and contain text and summary formulas
from the exported section.

Images and section images from the Note section are not included in the export file.
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Importing Microplate Data

Note: The data import feature requires a separate license. To obtain a license for this
feature, contact your Molecular Devices representative.

You can import microplate data that was acquired by the SoftMax Pro Software or another
microplate data acquisition software program.

The data import feature can directly import data from files that were exported in Plate
format from version 5.x and 6.x of the SoftMax Pro Software.

Before you can import microplate data that was acquired from a different software program,
you must first use that software program to export the data into a compatible format.
Templates for importing data in the Plate format and a schema for the XML format are
installed with the software.

e To import data from another program in Plate format, the tab-delimited text file must
match the format of an import template. See Using a Plate Format Template for
Importing Data on page 101.

e To import data from another program in XML format, the XML file must be formatted
using the SoftMax Pro Software XML schema. See Using the XML Schema for Importing
Data on page 103.

When you import the microplate data, the SoftMax Pro Software creates a new Plate section
using the section name from the import file. If the named Plate section already exists, then
the imported data overwrites the existing data in the section.

When you import microplate data into an existing Plate section, the SoftMax Pro Software
microplate template and reduction settings in the existing Plate section are preserved if the
imported data are compatible with the settings in the existing section.

If you want to preserve the template and reduction settings, make sure that the name of the
Plate section in the import file exactly matches the name of the Plate section in the SoftMax
Pro Software protocol into which you plan to import the data. If the name of the Plate
section in the text file does not match the name of a Plate section in the protocol, then the
import process creates a new Plate section in the protocol.

Another way to preserve template and reduction settings is to copy the imported data from
the new Plate section and then paste the data into an existing Plate section to use the
template and reduction settings in the section where you pasted the data. See Copying and
Pasting Data on page 66.

Note: To maximize the number of data points used for reduction, the end time
reduction parameter is changed to match the read time from the import file.

5049092 A 99



SoftMax Pro Software User Guide

To import the microplate data:

1.
2.

7.

Open or create a new protocol file.
If required, define a Plate section for importing the microplate data with the same name
as the Plate section in the import file.

Click Import H and then click the data format of the import file.
e To import tab-delimited text data, click Plate Format.
e To import XML data, click XML Format.
In the Open dialog, locate and select the file that you want to import.
Click Open.
The Plate section displays the imported data.
Save the file as a data file. See Saving Data Files on page 65.

After the data is imported into the Plate section, the Read Information on the right indicates
that the data was imported and shows the time and date of when it was imported. For the
GxP edition, the Read Information includes the name of the user who imported the data.

100
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Using a Plate Format Template for Importing Data

The data import feature can directly import data from files that were exported in Plate
format from version 5.x and 6.x of the SoftMax Pro Software.

Before you can import microplate data that was acquired from a different software program,
you must first use that software program to export the data into a compatible format.
Templates for importing data in the Plate format and a schema for the XML format are
installed with the software. To import data from another program in XML format, the XML
file must be formatted using the SoftMax Pro Software XML schema. See Using the XML
Schema for Importing Data on page 103.

The data import templates are installed with the SoftMax Pro Software, and can be found in

a sub-folder of the Program Files folder where the SoftMax Pro Software program is installed.
The default installation path is as follows:

C:\Program Files

(x86)\Molecular Devices\SoftMax Pro 7.0\Plugins\Import-PlateFormat\Templates
The templates are supplied in .xlsx format, but must be saved in .txt format with tab-
separated values before importing the data.

The cells in the template are color-coded. Do not alter the data in cells that have a white
background. Cells with colored backgrounds can be edited. A green background color
indicates cells that require information, and a light yellow background color indicates cells
that optionally can contain information.

You can paste your data directly into the template, or use the template as a model for a
script that converts your data to the acceptable format for importing.

Plate Data Layout
The first line of an import template defines the number of Plate sections (or "Blocks") that
are included in the data file.
o ##BLOCKS=1
Each Plate section is presented in the following format:
e Header lines

The first header line contains descriptive titles for the data in the second header line. The
second header line contains the type of section, Plate, and the title to be given to the
Plate section in the SoftMax Pro Software data file.

The fields in the header lines define the type of read, the number of wells in the
microplate, and the wavelengths used for the read, among other relevant information.
The layout and format of the header lines are dependent on the read type. For more
information, see the template for the read type of your data.
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Data lines

The data lines follow the header lines with a blank row between the header lines and
data lines. The layout and format of the data lines are dependent on the read mode and
read type.

The first column shows the time points for a kinetic read, the data points in a well
scan read, or the wavelengths in a spectrum read. For endpoint reads, this column is
blank.

The second column shows the temperature for the read, if an incubator is used for
the read. If the incubator is off, the value is zero.

The third column is where the read data starts.

The data are displayed in a table to indicate the columns and rows of the microplate
used for the read. The data for multiple time points for kinetic reads, multiple data
points for well scan reads, or multiple wavelengths for spectrum reads are listed in
separate tables below the previous table. For endpoint, kinetic, or well scan reads with
multiple wavelengths, the data for each wavelength are displayed in separate tables to
the right of the previous table.

wavelength 1 wavelength 2
Temperature 1 2 3 1 2 3
0:00:00 ## 1.596 2.479 2.95 3.103 1.39 1.97
1.024 0.308 3.925 2.381 1.957 3.722
0.195 0.287 2.638 0.967, 1.049 1.422
0:01:58 #H# 1.564 3.344 2.378 0.113| 3.872 0.637
0.82 1.797 1.064 3.58 2.603 0.996
0.421 3.066 3.906 0.915] 0.57 2.251
#H# 1.169 1.092 3.969 1.126] 0.004 1.934
1.105 3.022 2.845 1.933 2.834 0.657
3.602 2.033 3.737 0.437| 3.242 1.337

Figure 3-3: Kinetic data in Plate format for importing
End line

The end line follows the data lines with a blank row between the data lines and end line.
The end line of each Plate section is defined by the text: “End
To import data from more than one Plate section in a single text file, include the header lines,
the data lines, and the end line for each Plate section immediately after the end line of the
previous Plate section.
The final line of an import file contains a single field with the original name given to the
import file, and the date and time that the file was saved. This information immediately
follows the end line for the last Plate section in the file.
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Using the XML Schema for Importing Data

To import data in XML format, the XML file must be formatted using the SoftMax Pro
Software XML schema from software version 6.4.1 or newer.

Before you can import microplate data that was acquired from a different software program,
you must first use that software program to export the data into a compatible format.
Templates for importing data in the Plate format and a schema for the XML format are
installed with the software. To import data from another program in Plate format, the tab-
delimited text file must match the format of an import template. See Using a Plate Format
Template for Importing Data on page 101.

The XML schema file for data import (XMLImportSchema.xsd) is installed with the SoftMax
Pro Software, and can be found in a sub-folder of the Program Files folder where the SoftMax
Pro Software program is installed. The default installation path is as follows:

C:\Program Files (x86)\Molecular Devices\SoftMax Pro 7.0\Plugins\Import-XML\Schema

For information about the XML elements and their usages, see the comments in the schema
file.

To import data from more than one Plate section in a single XML file, make sure that all the
Plate sections are between the <platesections> tags and that each Plate section is defined
between a set of <PlateSection> tags.
<PlateSections>
<PlateSection>
[Data from the first Plate section]
</PlateSection>
<PlateSection>
[Data from the second Plate section]
</PlateSection>
</PlateSections>

Figure 3-4: Importing data from more than one Plate section in XML format
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button at the bottom of the menu.

The SoftMax Pro Options dialog contains settings for the following options:

Data Recovery

The Data Recovery option contains an informational setting to inform you that opened
files will automatically be saved to a temporary file every five minutes to assist with data
recovery. This option cannot be turned off. For more information, see Enabling Data
Recovery on page 105.

Web Browser

The Web Browser option contains a setting to let you hide the integrated web browser
tab when the SoftMax Pro Software starts. The web browser automatically starts with
the program when this check box is cleared. For more information, see Integrated Web
Browser on page 55.

Plate Setup Helper

The Plate Setup Helper option contains a setting to prevent the Plate Setup Helper from
automatically starting each time you open a new protocol. The Plate Setup Helper
automatically appears each time you open a new SoftMax Pro Software file when this
check box s cleared. For more information, see Using the Plate Setup Helper on page 27.
Plate Height Warning

The Plate Height Warning option contains a setting to prevent the plate height warning
from automatically being displayed when you start a read. To prevent damage to the
SpectraMax i3 Multi-Mode Detection Platform, the plate height warning is displayed as a
reminder to make sure that the Plate Height for the microplate is defined correctly. The
plate height warning is automatically displayed when you start a read if this check box is
cleared. For more information, see Using the Plate Editor on page 251.

Plate Eject After Read

The Plate Eject After Read option contains a setting to prevent the microplate drawer
from automatically opening after you finish a read. When this check box s cleared, the
microplate drawer opens after a read completes. When this check box is selected, the
microplate drawer remains closed after a read completes.

Remote Control

The Remote Control option contains settings for connecting an Apple mobile device to
control the running software and the connected microplate reader. To allow control by
the mobile app, select the Enable Remote Control check box, make sure that both the
app and the software use the same Port, and type the Host name or IP address of the
computer into the settings in the app. You can download the SoftMax Pro Remote app
from the Apple App Store.
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¢ Calculation

The Calculation option allows the software to do data calculations of the kinetic data
while a kinetic acquisition is in progress. To enable kinetic data calculations during a read,
select the Calculate during acquisition check box and then type the number of kinetic
reads between successive calculations in the Calculate every ___ cycle(s) field.

To close the SoftMax Pro Options dialog and save your settings, click OK.

Enabling Data Recovery

To verify that data recovery is enabled:

1. Click the Application @ button to open the Application menu.
Click the Options button at the bottom of the menu.

In the SoftMax Pro Options dialog, verify that Save open files for data recovery every
five minutes is selected.

4. Click OK to close the dialog.

When Data Recovery is enabled, opened files are automatically saved to a temporary file
every five minutes to assist with data recovery.

Recovering Files

If the SoftMax Pro Software experiences an unexpected application interruption, then when
the SoftMax Pro Software restarts, it lists the files that are available for recovery.

1. Select the file or files you want to recover.

2. Click Close to close the dialog.

3. The selected files open in the SoftMax Pro Software.

The files that are not selected from the list are deleted after the dialog closes.

Saving a recovered file overwrites the original file. If an "untitled" file is recovered and
opened, the SoftMax Pro Software prompts for a file name and location when the file is
saved.
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The workspace can contain five different types of sections.

Note sections are used to record text or to report summary data pertaining to the
experiment. Note sections can contain text and graphics, and can contain images of the
other sections in the file. You can have as many Note sections as you want in the file. For
more information, see Using a Note Section on page 108.

Plate sections are used to collect data from the instrument, and to define data display
and data reduction. You can have as many Plate sections as you want, and each Plate
section can have different instrument settings from the other Plate sections in the file.
For more information, see Using a Plate Section on page 118.

Cuvette Set sections are used to collect data from a cuvette port. You can have as many
Cuvette Set sections as you want, and each Cuvette Set section can have different
instrument settings from the other Cuvette Set sections in the file. For more information
see Using a Cuvette Set Section on page 129.

Unlike other section types, Group sections are created automatically when you create
and assign a Group to a Plate section within the Template Editor dialog (after clicking

Template
page 139.

in a Plate section). For more information, see Using a Group Section on

Graph sections are used to plot information from groups as scatter plots or bar graphs.
You can have as many Graph sections as you want in a file. For more information, see
Using a Graph Section on page 149.

The sections are contained in an Experiment. Experiments can be used as an organizational
tool within the file to maintain separate data sets. You can have as many Experiments as you
want in a file.

Experiments and sections are listed in the Navigation Tree. See Navigation Tree on page 29.

To rename an experiment or a section, see Renaming an Experiment or a Section on page 30.

When you use the AutoRead feature, only the Plate sections within the selected Experiment
are run. See Enabling Auto Read on page 340.

In the SoftMax Pro GxP Software, you can lock the individual sections in an experiment to
prevent changes to them. See Locking and Unlocking Sections on page 484.
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Using a Note Section

Note sections are used to record text or to report summary data pertaining to the
experiment.

You can type text in a Note section, add images, and create summaries containing formulas
for displaying reduced data.

A Summary is part of a Note section or Group section that is generated by a user-entered
formula applied to data in the file. It can also be text or a user-entered constant, such as
certificate value.

Text in Note sections can be formatted (font face, font size, and font style) using the
Notes Controls formatting tools on the Home tab.

Images can be inserted into the Note section including, images from other programs and
section images from the current document.

Note: Each image must be placed in its own frame, and the frame cannot contain
text.

You can create multiple Note sections within the same experiment.

To work in a Note section, see the following topics:

108

Adding a Note Section on page 109

Inserting an Image on page 109

Deleting an Image on page 109

Inserting an Image of a Section on page 110
Refreshing Section Images on page 110
Deleting a Section Image on page 111

Adding Text to a Note Section on page 111
Aligning Text on page 111

Editing Text in a Text Frame on page 112
Formatting Text in a Text Frame on page 113
Positioning a Text Frame in a Note Section on page 114
Resizing a Text Frame on page 114

Deleting a Text Frame on page 114

Adding a New Summary Formula on page 115
Deleting a Summary Formula on page 117

Enabling Syntax Helper on page 116
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Adding a Note Section

To create a Note section:
1. Select the experiment where you want to add a Note section in the Navigation Tree.

2. Ifyou have more than one section in the Experiment, select the section above where you
want the new Note section to be displayed in the Navigation Tree.

3. Click New Note& in Sections on the Home tab in the ribbon.
A new blank Note section is displayed below the selected section in the Navigation Tree.

To change the name of the Note section, right-click the Note section in the Navigation Tree
and then click Rename. See Renaming an Experiment or a Section on page 30.

Inserting an Image

To insert an image into a Note section:

1. With a Note section active in the workspace, click in a blank area of the Note section to
place the cursor in a new frame where you want to insert the image.

Note: Each image must be placed in its own frame, and the frame cannot contain

text.

2. Click Add Image @ in Note Controls on the Home tab in the ribbon orin the toolbar
at the top of the Note section.
3. Inthe Open dialog, browse to locate the image to be inserted.

Select the image and click Open.
The image is displayed in the Note section.

Deleting an Image

To delete an image from a Note section:

1. Click the image to be deleted.

2. Right-click the image and then click Delete.
The image is deleted from the Note section.
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Inserting an Image of a Section

To insert an image of a section from the current data file into a Note section:

1. With a Note section active in the workspace, click in a blank area of the Note section to
place the cursor in a new frame where you want to insert the section image.

Note: Each image must be placed in its own frame, and the frame cannot contain
text.

2. Click Add Section Image in Note Controls on the Home tab in the ribbon or in the
toolbar at the top of the Note section.

3. Inthe Add Section Image dialog, locate the section to be inserted.
Select the section and then click Add Section Image.

The section image is displayed in the Note section.

Note: You can also right-click in the Note section and then click Add Section Image to
select the section from the cascading menus.

Refreshing Section Images

To refresh all the section images in a Note section, click Refresh Section Images © in the
toolbar at the top of the Note section.

All the section images in the Note section are updated to their current state. For example, if
you inserted an image of a Graph section and then made changes to the graph section, you
can refresh the Graph section image in the Note section.

Note: The section images are automatically refreshed periodically, such as when you
open the data file, scroll up and down, switch between Document and Comparison
views, or start to print or print preview the file.
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Deleting a Section Image

To delete a section image from a Note section:

1. Click the section image to be deleted.

2. Right-click the section image and then click Delete.
The section image is deleted from the Note section.

% Note: When you delete a section from the data file, images of that section are also
deleted from the Note sections. When you delete an experiment from the data file,
images of the sections in the experiment are also deleted from the remaining Note
sections.

Adding Text to a Note Section

To add text to a Note section:

1. With a Note section active in the workspace, click in a blank area of the Note section to
place the cursor in a new frame where you want the text.

2. Typethe text you want to be displayed.
3. To exit from the text frame, click somewhere else in the Note section.

Note: You can add more text to a text frame by clicking where you want to add text
within the frame.

Aligning Text
Text in a text frame is aligned on a line by line basis. Each line in the text frame can be aligned

separately.

To adjust the alignment of text within a text frame, click to select the line of text to be
aligned, or click and drag to select multiple lines of text.

The following alignment options are in Formatting Tools on the Home tab in the ribbon:

* To align the line to the left edge, click Align Left =.

e To center theline, click Align Center
e To align the line to the right edge, click Align Right =.
e To left and right justify the line, click Justify =.

e To outdent an indented line, click Decrease Indent =,

e To indent the selected line, click Increase Indent =,
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Editing Text in a Text Frame

To edit text in a text frame:

1. Click on the word or click and drag on a group of words to select the text to be edited.
2. Typetherevised text.

The selected text is replaced with the text you typed.

Copying Text

To copy text in a text frame:

1. Click on the word or click and drag on a group of words to select the text to be copied.
2. Right-click and then click Copy, or press Ctrl+C.

The selected text is placed in the clipboard.

Pasting Text

To paste text from the clipboard into a text frame:

1. Copy textinto the clipboard.

2. Click to place the cursor in the text frame where you want to insert the text.
3. Right-click and then click Paste, or press Ctrl+V.

The text in the clipboard is pasted into the text frame.

Cutting Text

To cut text out of a text frame:

1. Click on the word or click and drag on a group of words to select the text to be cut.
2. Right-click and then click Cut, or press Ctrl+X.

The selected text is cut from the text frame and placed in the clipboard.

Deleting Text

To delete text from a text frame:
1. Click on the word or click and drag on a group of words to select the text to be deleted.
2. Press Delete.

The selected text is removed from the text frame and not placed in the clipboard.
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Formatting Text in a Text Frame

You can format text in a text frame using the formatting tools found in Note Controls on the
Home tab in the ribbon.

Click and drag or double-click text in a text frame to select the text and then click the
formatting tools to do the following functions:

You can also click Undo Previous Action

Calibri -
Select a font face

14 -
Select a font size

Create Subscript *2or Superscript X* characters

Format Bold B, Italic ., or Underline . characters
Add Bullets :=

To add a blank line between lines of bulleted text, click at the end of a line and then press
Shift+Enter to add a soft line break.

Add Numbering =

To add a blank line between lines of numbered text, click at the end of a line and then
press Shift+Enter to add a soft line break.

Change the Font Color (a3

“) or Redo Previous Action ™ for quick formatting

changes.
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Positioning a Text Frame in a Note Section

You can manually position a text frame within the Note section:

1. Click and hold down the mouse button on the border of a text frame.
The four-arrowhead cursor is displayed.

2. Dragthe text to the desired location and release the mouse button.

To automatically position text frames within a Note section:

1. Click on a text frame border to select the text frame.

You can also select multiple text frames, summaries, and images by pressing Ctrl and
then clicking on the frame borders.

2. Click an alignment option in Note Controls on the Home tab in the ribbon.
e To align a single text frame to the left edge of the Note section or align the left edges
of multiple frames to the left-most text frame, click Align Lefts b
e To align a single text frame to the right edge of the Note section or align the right

edges of multiple frames to the right-most text frame, click Align Rights -"ll.

e To align a single text frame to the top edge of the Note section or align the top edges
[—]

of multiple frames to the top-most text frame, click Align Tops T .
e To align a single text frame to the bottom edge of the Note section or align the
bottom edges of multiple frames to the bottom-most text frame, click

Align Bottoms é..

Resizing a Text Frame

To resize a text frame:

1. Click the text frame to select it.

2. Click and hold on the right or left side border of the text frame.
Adouble-ended arrow is displayed.

3. Dragthe boxto the desired size and release the mouse button.

Deleting a Text Frame

To delete a text frame:
1. Click on the border of the text frame to select the text frame.
2. Right-click and then click Delete, or press Delete on your keyboard.

The text frame is deleted from the Note section.
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Adding a New Summary Formula

To add a new Summary Formula to a Note section:
1. Click the Note section to make it active in the Workspace.
2. Click New Summary i in Note Controls on the Home tab in the ribbon.

ﬂfFormuIa Editor @

Enter a formula. For assistance, enable Symtax Helper.

Hide Name

Name

Min5td

Description

Smallest standard value:

Comments

Formula Syntax Helper

Min{MeanValug)

-

Check Syntax

Data Display
Sample

Mumeric notation

() Significant Figures 5 123.457

@ Decimal Places 3

[ ok || cancal |

3. Inthe Formula Editor dialog, in the Name field, type a short descriptive name for the

formula.

% Note: If you plan to reference this formula in a different formula, for example
referencing the formula in a column of a group table, make sure that you do not
use reserved characters or names of operators, functions, or accessors in this
name. For information about reserved characters and words, see “Rules to Follow
When Writing Formulas” in the SoftMax Pro Software Formula Reference Guide.
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4. Optionally, click Hide Name to hide the name of the Summary in the Note section or
Group section.

Optionally, type a brief text Description of the formula to be displayed in the section.
Optionally, type text Comments to annotate the formula.

Optionally, click Syntax Helper to turn on the formula completion tool. See Enabling
Syntax Helper on page 116.

8. Type a Formulato be used for the Summary or column.

Optionally, click Check Syntax check the validity of the formula. A message is displayed
to the left of the button to help you troubleshoot the syntax of the formula.

10. Specify the Data Display characteristics:
e From the drop-down list select either Numeric notation or Scientific notation.

e Click Decimal Places and type the number of places to display or click Significant
Figures and type the number of figures to display.

A preview of the Data Display is displayed in the Sample on the right.
11. Click OK.
For a complete guide to the formulas used in the SoftMax Pro Software, click Formula

x)
Reference% on the Help tab in the ribbon.

Enabling Syntax Helper

For assistance creating formulas in the Formula Editor dialog, click Syntax Helper. To disable
the Syntax Helper, click Syntax Helper to clear the check box.

When you first start typing a formula, a list is displayed below your text as you type. This is
Syntax Helper, a technology that analyzes text as you type and compares it to formulas that
are available for use in the SoftMax Pro Software.

Syntax Helper lets you quickly see what formulas are available and what parameters these
formulas expect to receive.

By default, Syntax Helper is enabled when you start the SoftMax Pro Software. You can
enable and disable this feature whenever you are working in the Formula Editor dialog.
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Editing a Summary Formula

To edit an existing summary formula:
1. Click the summary formula text frame in the Note section to select the text frame.
2. Click Edit Summary i in Note Controls on the Home tab in the ribbon.
You can also double-click the formula to open the Formula Editor dialog.
3. Inthe Formula Editor dialog, make the required edits. See Adding a New Summary
Formula on page 115.
4. Click OK.

Showing or Hiding the Formula in a Summary Formula

Generally, the summary formula in the Note section displays the result of the formula. You
can show or hide the formula as well as the result.

To show the formula in the summary formula:

1. Click the summary formula text frame.

2. Click Show Formulas " in the Note Controls section of the Home tab in the ribbon.
To hide the formula in the summary formula:

1. Click the summary formula text frame.

2. Click Hide Formulas ftﬁ@ in the Note Controls section of the Home tab in the ribbon.

Deleting a Summary Formula

To delete an existing summary formula:
1. Click the summary formula text frame.
2. Click Delete [%]in the Note Controls section of the Home tab in the ribbon.
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Using a Plate Section

A Plate section is used to collect data from the instrument, and to define data display and
data reduction. If you need to read the same physical plate twice with different instrument
settings, then use two Plate sections. You can create as many Plate sections as you need.

The precision of the data displayed in a Plate section varies based on the space available to
view the characters.

You can customize the data display to Numeric notation or Scientific notation format, and
specify the number of Significant Figures or Decimal Places. These options can be set
separately for raw data and reduced data.

When the number of digits is increased, the font size of the values in the Plate section is
decreased. If the value becomes too long, then the numbers are cut off at the edge of the
wells.

When SoftMax Pro Software exports plate data, the values are not limited by space and can
have more digits for each well.

The values displayed in a Plate section are only a representation of the data. In both the
Plate section and in the exported data, the last digit displayed or exported is rounded based
on the actual data value.

{ch
To change the properties of the plate, such as the number of wells, click Settings = %' on
the Home tab in the ribbon to open the Settings dialog, and then click the Plate Type

category to view a list of the available plate definitions. See Plate Type Settings on page 250.

The Template Editor in the Plate section is used to create a map of the contents of the
microplate.

Plate sections have the following areas:
e Tool bar (above the data display)
e Data display (in a microplate grid format)
e Instrument Settings Information and Read Information (to the right of the data display)
e Reduction settings (below the data display)

Ifthe plate grid in the Plate section is colored, then a template has been defined for the Plate
section. Each group defined in the template has a different color and the corresponding
group table has the same color.

For information about using a Plate section, see the following topics:
e Adding a Plate Section on page 119
e Using Plate Tools on page 119
e Using Template Tools on page 128
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Adding a Plate Section

To add a Plate section:
1. Select the experiment where you want to add a Plate section in the Navigation Tree.

2. Ifyou have more than one section in the Experiment, select the section above where you
want the new Plate section to be displayed in the Navigation Tree.

3. Click New Plate  in Sections on the Home tab in the ribbon.

A blank Plate section is displayed in the Workspace. You can add as many Plate sections as
you need to your data file. See Using a Plate Section on page 118.

To change the name of the Plate section, right-click the Plate section in the Navigation Tree
and then click Rename. See Renaming an Experiment or a Section on page 30.

Using Plate Tools

When a Plate section is active in the Workspace, Plate Tools are available on the Home tab
in the ribbon.

Many of the Plate Tools available in Home tab are also available in the toolbar at the top of
the Plate section.

For information about using the Plate Tools, see the following topics:
e Modifying Instrument Settings on page 120
e Modifying Data Reduction Settings on page 120
e Modifying the Data Display on page 121
e Showing Reduced Data in a Three-Dimensional Graph on page 124
e Zooming the Well Display on page 125
e Masking Wells on page 126
¢ Cloning a Plate Section on page 127

e Viewing a Membrane Image on page 127
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Modifying Instrument Settings

Instrument settings are part of the protocol used to collect data. To modify settings for the

selected instrument, select a Plate section or Cuvette Set section in the Workspace and then
Qb

click Settings % on the Home tab in the ribbon.

The Settings dialog is displayed.

&Y Settings \EI

Read Mode | ]

s ¥ M B @

Lum

FL
Read Type | O | . Gan
&
g o) ]

Endpoint Kinetic Spectrum Wiell Scan
Category Semings Information
Wavelengths Wavelength Settings Endpoint
4 Absorbance
Plate Type Lt 405
fead Area MNumber of Wavelengths Lm2 426
PathCheck Lm3 426
Shake Lmil 405 . am Lmd 426
speed Read 4 Plate Typs
Lm2 426 nm
More Settings . 95 Well Standard cirbtm
Lm3 426 . nm 4 Read Area
EntirePlate
Lma4 426 . nm

4 Mare Settings

Shake OF

Calibrate On

Carrizge Spesd Normal
Calumn Priarity

You can specify to up to six different wavelengths. Type the wavelengths in the fields.

More Information

Co )

Use the options in the Settings dialog to define the parameters for acquiring data from a
microplate or cuvette. See Selecting Instrument Settings on page 236.

Modifying Data Reduction Settings

To modify the data reduction settings for a plate or cuvette, click Reduction z on the
Home tab in the ribbon to view the Data Reduction dialog.

The Data Reduction dialog displays only the reduction options that are available for the

instrument you are using, the options that have been selected in the Settings dialog, and the
options defined in the template.

For more information, see Doing Data Reduction on page 367.
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Modifying the Data Display

In an active Plate section or Cuvette Set section, you can change how the data is presented

LA

by clicking Display === on the Home tab in the ribbon orin the toolbar at the top of the
section.

g Display Options @
Specify how data is displayed. @
@ Raw Data ) Reduced Data

Raw Data Units: OD

Reduction:
D with Reduced Number Options: | Number
Raw Data Format Reduced Data Format
| Defauit - Default
Significant Figures 3 Significant Figures 3
Decimal Places 3 Decimal Places 3
Samgple Sample
123.45 12345

[ ok | [ Cancel

The choices available in the Display Options dialog include selecting between Raw Data and
Reduced Data.

For Imaging read mode Imaging Data replaces the Raw Data option.

You can customize the data display to Numeric notation or Scientific notation format, and
specify the number of Significant Figures or Decimal Places. These options can be set
separately for raw data and reduced data.

The Default format determines the number of decimal places to display based on the space
available. For example, for a plate with 96 wells or fewer, each well is limited to five digits,
plus one character for the decimal point, if applicable. For a 384-well plate, each well is limited
to four characters, including the decimal point. If the value requires greater precision than
can fit in the available space, the format changes to scientific notation.
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Raw Data

Selecting Raw Data displays the default data type for the selected read type:
* Endpoint: Raw absorbance, fluorescence, or luminescence values.
» Kinetic: The change in raw OD/RFU/RLU values over time, displayed as a plot.
e Spectrum: Raw OD/RFU/RLU values for the range of wavelengths, displayed as a plot.
e Well Scan: Raw OD/RFU/RLU values as shades of blue to red.
To see a reduced number, select with Reduced Number.

Reduced Data

The reduced data display is based on the selections made in the Data Reduction dialog. See
Doing Data Reduction on page 367.

The reduced number is reported in the Group section when a template has been defined.
e Select Number to view only the reduced number.

o Select Plot for Kinetic reads to display a plot of the raw and reduced data. To also view
the reduced number, select the Reduced Number check box.

o Select Grayscale to display the raw data in eight shades of gray, changing from light, for
values less than or equal to the low limit, to dark, for values greater than or equal to the
high limit. To define the High Limit and the Low Limit for the grayscale map, type values
in the fields. To also view the reduced number, select the Reduced Number check box.

e Select Color Map to display the raw data in eight colors, changing from blue, for values
less than or equal to the low limit, to red, for values greater than or equal to the high
limit. To define the High Limit and the Low Limit for the color map, type values in the
fields. To also view the reduced number, select the Reduced Number check box.

You can view both raw and reduced data or multiple reductions of the same data by cloning
a plate. See Cloning a Plate Section on page 127.
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Imaging Data

The Imaging Data option is available for Imaging read mode only, and replaces the Raw Data
option.

To see a reduced number, select with Reduced Number.

The Data Type list contains the measurement selections from the Image Analysis Settings in
the Settings dialog. See Viewing and Selecting Measurement Statistics on page 273.

The available Data Types for imaging data are as follows:

Object Count gives the total number of objects detected in the image. This
measurement is not used for field analysis of confluent areas.

Field Count gives the total number of confluent areas detected in the image. This
measurement is not used for discrete object analysis.

Object Percentage gives the percentage the objects detected in the image by
classification. This measurement is not used for field analysis of confluent areas.

Covered Area gives the combined area of all the objects or confluent areas detected in
the image as a percentage of the entire image area.

Object Area gives the average area of the objects detected in the image expressed in
umz. This measurement is not used for field analysis of confluent areas.

Field Area gives the average area of the confluent areas detected in the image expressed
in umz. This measurement is not used for discrete object analysis.

Object Roundness gives the average roundness of each object detected in the image. A
shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all.
This measurement is not used for field analysis of confluent areas.

Field Roundness gives the average roundness of each confluent area detected in the
image. A shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round
at all. This measurement is not used for discrete object analysis.

Object Average Intensity gives the average fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).

Field Average Intensity gives the average fluorescent signal intensity of the confluent
areas detected in the image. This measurement is not used for discrete object analysis.
This measurement is not used for transmitted light (TL).

Object Intensity gives the average total fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).

Field Intensity gives the average total fluorescent signal intensity of the confluent areas
detected in the image. This measurement is not used for discrete object analysis. This
measurement is not used for transmitted light (TL).

Total Intensity gives the combined total fluorescent signal intensity of the objects or
confluent areas detected in the image expressed in million intensity counts. This
measurement is not used for transmitted light (TL).
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Showing Reduced Data in a Three-Dimensional Graph

To view a three-dimensional graphical representation of reduced plate data, view the Plate
section and then click the i 3D Graph button in the Plate Tools area of the Home tab in the
ribbon or in the toolbar at the top of the Plate section. See Viewing Data in a Three-
Dimensional Graph on page 382.
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To close the 3D Graph dialog, click Close.
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Zooming the Well Display

The Zoom icon becomes active when the data in a well is available for a zoomed display.

To magnify the display of imaging data in a well, see Viewing the Imaging Data in a Well on

page 365.

To display the Zoom Well dialog:

Chapter 4: Workspace Sections

1. Click the well or cuvette that you want to zoom.

2. Click Zoom “% on the Home tab in the ribbon or Zoom "“A in the toolbar at the top of the

section. You can also double-click the well to open the Zoom Well dialog.

The data from the selected well or cuvette is displayed in a zoomed graph window.
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To print the graph window, click Print.

To scale the display to the data, select Scale to Data.

displayed. See Doing Data Reduction on page 367.

To toggle between reduced and raw data, click Show Reduced or Show Raw.
To modify the reduction settings, click Reduction. The Data Reduction dialog is
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7. To modify the zoom well display settings, click Options. The Zoom Well Options dialog is
displayed.

U Zoom Well Options @
Graph Type Settings @
Show Plot Symbols Show Datz Coordinates
Characteristics
Scales K-Axis ¥-Axis
Auto Scale D |:|
Minimum [0 o
Iaximum 600 14
Grid Lines K-Axis -Axis
Major Grid Lines
Minor Grid Lines T [
[ ok || canca |

* Graph Type Settings lets you enable or disable connected points or plotted symbols
on the graph.

e Characteristics lets you set Auto Scale parameters and choose the minimum and
maximum values for the selected axis. You can also add or remove grid lines from the
display.

To save the settings and return to the Zoom Well dialog, click OK. These changes have
an effect on only the well graph being viewed.

8. To close the Zoom Well dialog, click Close.

Masking Wells

The Mask feature hides selected data so that they are not used for calculations and are not
reported. Masking is commonly used to suppress outliers from data reduction calculations.

Masking can be used as a “what if?” tool. For example, if you have included a group blank in

a template and want to see the data both with and without the blank, masking the group

blanks suppresses the blanking function, while unmasking them enables it again.

To mask wells:

1. Inan active Plate section, click to select a single well or click and drag to select multiple
wells.

2. Click Mask ## in Plate Tools on the Home tab in the ribbon or in the toolbar at the top of
the Plate section.
You can also right-click a well and select Mask from the shortcut menu.

To unmask masked wells, select the wells and then click Mask.
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Cloning a Plate Section

Cloning a plate adds a duplicate copy of the active plate to the Plate section. This can let you
apply multiple templates and reductions to the same set of raw data.

To clone a plate:

1. With the Plate section you want to clone active in the workspace, click Clone Plate & on
the Home tab in the ribbon.

2. Thecloned plate is added to the active plate section.

Exptl Platel » <4 E I @ an !
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You can add as many plate clones as needed for your experiment. The cloned plates are
shown in tabs at the top of the Plate section. The first tab on the left is the original plate.
Clones are listed with the original plate name followed by the number of the clone.

e To make a cloned plate active in the section, click the tab for the cloned plate.
* To delete a cloned plate, click the X in the tab for the cloned plate.

Viewing a Membrane Image

After scanning a membrane for Western Blot data, the data are displayed in the SoftMax Pro
Software as an image. You can use the image tools in the Plate section to zoom, crop,
colorize, and adjust the intensity of the image. You can also select a region of interest (ROI)
and rescan the membrane at a higher resolution. See Viewing Western Blot Membrane Data
on page 443.

Western Blot membrane data are saved as a TIFF image that can be analyzed by the image-
analysis tool of your choice. The SoftMax Pro Software comes with an installed version of the
Imagel software from U.S. National Institute of Health (NIH). See Analyzing a Western Blot
Image on page 450.

To view the membrane image in the Image) software, click “% in the toolbar at the top of the
section and then click ImageJ Editor.

To view the membrane image in your selected image-analysis tool, click “% in the toolbar at
the top of the section and then click External Image Editor. This option is available only if
you have .tif files associated with a program other than Imagel software. The icon used for
this tool changes depending on the selected image-analysis tool. See Defining the Membrane
Image-Analysis Tool on page 451.

Note: The image tools are available only when viewing a Plate section that contains
membrane data.
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Using Template Tools

When a Plate section is active in the Workspace, Template Tools are available on the Home
tab in the ribbon.

ATemplate is a map of the microplate or cuvette that is used to describe the location of
samples in the microplate or cuvette, and it provides the link between raw data and analysis
groups.
Each template contains samples and groups:

e Aset of one or more replicate wells makes up a sample.

e Aset of related samples forms a group.
For example, you can have a group named “Standards” that contains seven samples named
STDO01, STDO2, ..., STD07, and a group named “Unknowns” that contains five samples named
UNKO1, UNKO2, ..., UNKOS5.
Each sample would be generally applied to a column or some other subset of wells on a
microplate, or to one or more cuvettes. Each well designated as being part of a group has

related to it a group name, a sample name (or replicate ID), a sample descriptor (optional),
and a column format for the calculations and data reported in the related Group section.

Samples and groups can exist across multiple Plate sections and Cuvette Set sections as well
as within a single Plate section or Cuvette Set section. Deleting the wells assigned to a group
from the template does not delete the group. To delete a group name in the Template
Editor you must delete the corresponding Group section from the data file.

For information about using the Template Tools, see Configuring a Microplate Template on
page 301.
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Using a Cuvette Set Section

5049092 A

Cuvette Set sections are used to collect data from the cuvette port of the SpectraMax M2
and M2e Multi-Mode Microplate Readers, SpectraMax M5 and M5e Multi-Mode Microplate
Readers, and the SpectraMax Plus 384 Absorbance Microplate Reader. You can use a Cuvette
Set section to define an analysis template and to define data display and data reduction. The
Template Editor in the Cuvette Set section is used to describe the contents of each cuvette
within the Cuvette Set.

You can add up to 96 cuvettes in a single Cuvette Set section or create as many Cuvette Set
sections as you need. Cuvettes are read one at a time.

Cuvette Set sections have the following areas:
e Tool bar (above the data display)
e Cuvette data display
e Instrument Settings Information and Read Information (to the right of the data display)
e Reduction settings (below the data display)

When colors are displayed in the name labels above individual cuvettes, this means a
template has been defined for the Cuvette Set section.

Each group defined in the template has a different color. The icon of the corresponding
group table has the same color.

For information about using a Cuvette Set section, see the following topics:
e Adding a Cuvette Set Section on page 130
e Using Cuvette Tools on page 130
e Using the Template Tool with a Cuvette Set on page 138
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Adding a Cuvette Set Section

To add a new Cuvette Set section:
1. Select the experiment where you want to add a Cuvette Set section in the Navigation
Tree.

2. Ifyou have more than one section in the Experiment, select the section above where you
want the new Cuvette Set section to be displayed in the Navigation Tree.

3. Click New Cuvette SetBJ in Sections on the Home tab in the ribbon.

A new Cuvette Set section is displayed in the Workspace. You can add as many Cuvette Set
sections as you need to your data file. Each Cuvette Set section can have up to 96 cuvettes
defined in the section.

To change the name of the Cuvette Set section, right-click the Cuvette Set section in the
Navigation Tree and then click Rename. See Renaming an Experiment or a Section on page
30.

% Note: When you create a new Cuvette Set section with an existing Cuvette Set section
active in the workspace, SoftMax Pro Software makes a copy of the active Cuvette Set
section and the new Cuvette Set section is a duplicate of the active Cuvette Set
section.

Using Cuvette Tools

Cuvette Tools are displayed on the Home tab when a Cuvette Set section is active in the
workspace. Cuvette Tools include the following:

e Modifying Instrument Settings for Cuvettes on page 131

e Modifying Data Reduction Settings for Cuvettes on page 131
e Modifying the Cuvette Data Display on page 132

e Zooming the Cuvette Display on page 134

e Masking Cuvettes on page 135

e Adding a Cuvette to a Cuvette Set on page 136

e Deleting a Cuvette from a Cuvette Set on page 136

e Copying a Cuvette Set Section on page 136

e Copying and Pasting Cuvette Data on page 137
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Modifying Instrument Settings for Cuvettes

Changing the instrument settings for a cuvette changes the setting for all the cuvettes in the
Cuvette Set section.

To change the instrument settings:

1.

4.

Click the Cuvette Set section to make it active in the workspace.

7o'}
Click Settings "~ in the Cuvette Tools on the Home tab in the ribbon or in the toolbar
at the top of the Cuvette Set section. The Settings dialog is displayed.
Set the instrument settings options as needed. See Selecting Instrument Settings on
page 236.

Click OK.

Modifying Data Reduction Settings for Cuvettes

To change the data reduction settings:

1.

Click Reduction z in the Cuvette Tools on the Home tab in the ribbon or in the toolbar
at the top of the Cuvette Set section. The Data Reduction dialog is displayed.

The Data Reduction dialog displays only the reduction options that are available for the
instrument you are using, the options that have been selected in the Settings dialog,
and the options defined in the template.

2. Change the reduction settings as needed. See Doing Data Reduction on page 367.
3. Click OK.

Note: Changing the data reduction setting for one cuvette, changes the settings for all
the cuvettes in the active Cuvette Set section.
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Modifying the Cuvette Data Display

In an active Plate section or Cuvette Set section, you can change how the data is presented

LA

by clicking Display === on the Home tab in the ribbon orin the toolbar at the top of the

section.
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The choices available in the Display Options dialog include selecting between Raw Data and

Reduced Data.

You can customize the data display to Numeric notation or Scientific notation format, and
specify the number of Significant Figures or Decimal Places. These options can be set

separately for raw data and reduced data.

The Default format determines the number of decimal places to display based on the space
available. For example, for a plate with 96 wells or fewer, each well is limited to five digits,
plus one character for the decimal point, if applicable. For a 384-well plate, each well is limited
to four characters, including the decimal point. If the value requires greater precision than
can fit in the available space, the format changes to scientific notation.
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Raw Data

Selecting Raw Data displays the default data type for the selected read type:
* Endpoint: Raw absorbance, fluorescence, or luminescence values.
» Kinetic: The change in raw OD/RFU/RLU values over time, displayed as a plot.
e Spectrum: Raw OD/RFU/RLU values for the range of wavelengths, displayed as a plot.
e Well Scan: Raw OD/RFU/RLU values as shades of blue to red.
To see a reduced number, select with Reduced Number.

Reduced Data

The reduced data display is based on the selections made in the Data Reduction dialog. See
Doing Data Reduction on page 367.

The reduced number is reported in the Group section when a template has been defined.
e Select Number to view only the reduced number.

e Select Plot for Kinetic reads to display a plot of the raw and reduced data. To also view
the reduced number, select the Reduced Number check box.

o Select Grayscale to display the raw data in eight shades of gray, changing from light, for
values less than or equal to the low limit, to dark, for values greater than or equal to the
high limit. To define the High Limit and the Low Limit for the grayscale map, type values
in the fields. To also view the reduced number, select the Reduced Number check box.

e Select Color Map to display the raw data in eight colors, changing from blue, for values
less than or equal to the low limit, to red, for values greater than or equal to the high
limit. To define the High Limit and the Low Limit for the color map, type values in the
fields. To also view the reduced number, select the Reduced Number check box.

You can view both raw and reduced data or multiple reductions of the same data by cloning
a plate. See Cloning a Plate Section on page 127.

Note: Changing the display setting for one cuvette changes the display settings for all
the cuvettes in the active Cuvette Set section.
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Zooming the Cuvette Display

The Zoom icon becomes active when the data in a cuvette is available for a zoomed display.
To display the Zoom Well dialog:
1. Click the well or cuvette that you want to zoom.

2. Click Zoom “& on the Home tab in the ribbon or Zoom "4 in the toolbar at the top of the
section. You can also double-click the well to open the Zoom Well dialog.

The data from the selected well or cuvette is displayed in a zoomed graph window.
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To print the graph window, click Print.
To scale the display to the data, select Scale to Data.
To toggle between reduced and raw data, click Show Reduced or Show Raw.

o v oA~ Ww

To modify the reduction settings, click Reduction. The Data Reduction dialog is
displayed. See Doing Data Reduction on page 367.
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7. To modify the zoom well display settings, click Options. The Zoom Well Options dialog is
displayed.

U Zaom Well Options @
Graph Type Settings @
Show Plot Symbols Show Datz Coordinates
Characteristics
Scales K-Axis ¥-Axis
Auto Scale D |:|
Minimum [0 o
Iaximum 600 14
Grid Lines K-Axis -Axis
Major Grid Lines
Minor Grid Lines T [
[ ok || canca |

* Graph Type Settings lets you enable or disable connected points or plotted symbols
on the graph.

e Characteristics lets you set Auto Scale parameters and choose the minimum and
maximum values for the selected axis. You can also add or remove grid lines from the
display.

To save the settings and return to the Zoom Well dialog, click OK. These changes have
an effect on only the well graph being viewed.

8. To close the Zoom Well dialog, click Close.

Masking Cuvettes

The Mask feature hides selected data so that they are not used for calculations and are not
reported. Masking is commonly used to suppress outliers from data reduction calculations.

Masking can be used as a “what if?” tool. For example, if you have included a group blank in

a template and want to see the data both with and without the blank, masking the group

blanks suppresses the blanking function, while unmasking them enables it again.

To mask cuvettes:

1. Inan active Cuvette Set section, click to select a single cuvette or hold down the Ctrl key
and click to select multiple cuvettes.

2. Click Mask 2 in Cuvette Tools on the Home tab in the ribbon or in the toolbar at the top
of the Cuvette Set section.
You can also right-click a cuvette and select Mask from the shortcut menu.

To unmask masked cuvettes, select the cuvettes and then click Mask.
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Adding a Cuvette to a Cuvette Set

To add a cuvette to a Cuvette Set section:

1. Click on a Cuvette Set section to make it active in the workspace.
2. Click New =" in Cuvette Tools on the Home tab in the ribbon.
Up to 96 cuvettes can be added to one Cuvette Set section.

The cuvettes in a Cuvette Set are numbered as if they were wells in a microplate. The first 12
cuvettes are numbered Al through A12, and then the next new cuvette is numbered B1. This
representation provides easy access to the data analysis capabilities of the SoftMax Pro
Software.

You can also add cuvettes with the Template Editor. See Using the Template Tool with a
Cuvette Set on page 138.

Deleting a Cuvette from a Cuvette Set

To delete a cuvette from a Cuvette Set section:

1. Inan active Cuvette Set section, click to select a single cuvette or hold down the Ctrl key
and click to select multiple cuvettes.

2. Click Delete I in Cuvette Tools on the Home tab in the ribbon.

Copying a Cuvette Set Section

To make a duplicate copy of a Cuvette Set section:

1. Click the Cuvette Set section you want to duplicate to make it active in the workspace.

2. Click New Cuvette SetBJ in Sections on the Home tab in the ribbon.

3. Anew Cuvette Set section that is a duplicate of the active Cuvette Set section is added to
the Experiment and is displayed on the Navigation Tree.

A new Cuvette Set section is displayed in the Workspace that is a duplicate copy of the active
Cuvette Set section.

You can add as many Cuvette Set sections as you need to your data file. Each Cuvette Set
section can have up to 96 cuvettes defined in the section.
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Copying and Pasting Cuvette Data

You can copy cuvette data from one or more cuvettes in a Cuvette Set section to a cuvette
or cuvettes in the same or a different Cuvette Set section. Data can be copied and pasted
within the same data file or between different data files.

If you want to copy all the cuvette data from one Cuvette Set section to all the cuvettes in a
different Cuvette Set section in the same file, it might be easier to make a duplicate copy of
the Cuvette Set section. See Copying a Cuvette Set Section on page 136.

To copy cuvette data:

1. Inan active Cuvette Set section, click to select a single cuvette or hold down the Ctrl key
and click to select multiple cuvettes.

2. Right-click and select Copy Cuvette Data from the shortcut menu.
3. Thedatais copied into the clipboard.
To paste cuvette data that is stored in the clipboard:

1. Click the cuvette that the data should be pasted into.

2. Ifyou copied data from multiple cuvettes, click the first cuvette where you want to paste
the data. SoftMax Pro Software pastes cuvette data into consecutive cuvettes. For
example, if you copied data from three cuvettes and then click cuvette A6 to paste the
data, the data will be pasted into cuvettes A6, A7, and A8.

3. Right-click and select Paste Cuvette Data from the shortcut menu.

After data is pasted into a cuvette, the Read Information on the right indicates that the data

was pasted and shows the time and date of when it was pasted.
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Using the Template Tool with a Cuvette Set

When a Cuvette Set section is active in the Workspace, the Template Tool is available on the
Home tab in the ribbon.

ATemplate is a map of the microplate or cuvette that is used to describe the location of
samples in the microplate or cuvette, and it provides the link between raw data and analysis
groups.
Each template contains samples and groups:

e Aset of one or more replicate wells makes up a sample.

e Aset of related samples forms a group.
For example, you can have a group named “Standards” that contains seven samples named

STDO01, STDO2, ..., STD07, and a group named “Unknowns” that contains five samples named
UNKO1, UNKO2, ..., UNKO5.

Each sample would be generally applied to a column or some other subset of wells on a
microplate, or to one or more cuvettes. Each well designated as being part of a group has
related to it a group name, a sample name (or replicate ID), a sample descriptor (optional),
and a column format for the calculations and data reported in the related Group section.

Samples and groups can exist across multiple Plate sections and Cuvette Set sections as well
as within a single Plate section or Cuvette Set section. Deleting the wells assigned to a group
from the template does not delete the group. To delete a group name in the Template
Editor you must delete the corresponding Group section from the data file.

When working within a Cuvette Set section, adding template information in the form of
groups automatically adds cuvettes to the active Cuvette Set section.

Up to 96 cuvettes can be added to one Cuvette Set section.

When you open the template editor with a Cuvette Set section active in the workspace, the
template editor window contains 96 wells in the column and row format of a 96-well
microplate. The cuvettes in the template are numbered as if they were wells in a microplate.
This representation provides easy access to the data analysis capabilities of the SoftMax Pro
Software.

For information about using the Template Tools with a Cuvette Set section, see Configuring
a Microplate Template on page 301.
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Using a Group Section

Unlike other section types, Group sections are created automatically when you create and
assign a Group to a Plate section or Cuvette Set section from within the Template Editor
dialog. See Configuring a Microplate Template on page 301.

Reduced numbers from the Plate section or Cuvette Set section are displayed in the Values
column of the Group section tables by default.

Custom reduction formulas require the use of accessors and operators that are understood
by SoftMax Pro Software. For a list of these accessors and operators see the SoftMax Pro
Formula Reference Guide.

Reusing Formulas

Formulas are used in Group columns and custom reductions. Sometimes it is useful to copy
an existing formula or column from one area of the program to a different area, or from one
Experiment to a different Experiment, rather than recreating it. After pasting, formulas can
be edited.

Formulas in contiguous column formulas can be copied and then pasted as a unit.

When a Group section is active in the workspace Column Tools, Summary Tools, and
Formatting Tools are displayed on the Home tab in the ribbon.

For information about using a Group section, see the following topics:

Using the Group Settings Dialog on page 139

Using Column Tools on page 143
e Using Summary Tools on page 147

e Using Formatting Tools in a Group Section on page 149

Using the Group Settings Dialog

The Group Settings dialog lets you define the name for a group of related samples, a
descriptor related to the samples, and the initial column format for the data calculated and
reported in the related Group section.

Whenever a new group is created (whether or not wells are selected in the template), a
Group section is created in your Experiment. To delete a group, you must delete the Group
section. Clearing a group from the Template Editor removes only the assignment of wells to
that group name. It does not delete the group.

To define a new group, see Creating a Group on page 140.

For information about the column formats, see Group Table Column Format on page 142.
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2. Click Template Editor

Creating a Group

1. Click a Plate section or Cuvette Set section to make it active in the workspace.

in Template Tools on the Home tab in the ribbon orin the
toolbar at the top of the active section. This displays the Template Editor.

The Template Editor contains a representation of the rows and columns of the
microplate in the active Plate section.

When you open the template editor with a Cuvette Set section active in the workspace,
the template editor window contains 96 wells in the column and row format of a 96-well
microplate. The cuvettes in the template are numbered as if they were wells in a
microplate. This representation provides easy access to the data analysis capabilities of
the SoftMax Pro Software.

Use your mouse to drag the pointer to select one or more wells to be defined as a group.
In the Groups area, click Add.

To modify an existing group, select the group and click Edit.

i Group Settings @
Define a group of related samples. @
Group Name

Groupdl Set Color... ] :

Group Table Layout

@) Standards () Unknowns () Custom

Graup Table Column Preview

sample |We|| |C0ncen1ﬁﬁon | Values |I‘~‘Iaan\u’alue Std.Dev. | Cv%% |
Add Columns
Sample Descriptor 1 [] sample Descriptor 2
Column Name Concentration Column Name
Units None - Units | None
[ o [ canca |

In the Group Settings dialog, in the Group Name field, type the name to assign to the
group.

If you want to set a color for the group, click Set Color and select the color to be
displayed for the group.
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In the Group Table Layout area, click Standards, Unknowns, or Custom to specify the
column format.

For information about the column formats, see Group Table Column Format on page
142.

When the Standards group type is selected, Sample Descriptorl is automatically
activated and the assumption is that it will be used for concentration information.
However, it could be used for all numerical data, that is, dilution factor or fraction
number. The other two group types do not have sample descriptors by default.

In the Add Columns ares, if it is not selected, click Sample Descriptorl to apply a
descriptor and its units to the group.

Type a short descriptive name for the sample descriptor in the Column Name field.

% Note: If you plan to reference the name of this column in a formula, make sure
that you do not use reserved characters or names of operators, functions, or
accessors in this name. For information about reserved characters and words, see
“Rules to Follow When Writing Formulas” in the SoftMax Pro Software Formula
Reference Guide.

Select a set of units from the list or type them directly in the Units field.
Optionally, click Sample Descriptor2 to define a second sample descriptor.

The Group Table Column Preview shows an example of how the columns will be
displayed in the group table.

Click OK to close the Group Settings dialog.
The selected wells are placed in the newly defined group.
To define a series for the selected wells, click Series. See Creating a Series on page 304.

Click OK to close the Template Editor and apply the template.

Note: No sample descriptor is assigned automatically for the Unknowns column
format. You can assign a sample descriptor to these column formats manually, but
the information is not displayed automatically in the Group section. To see it, create a
new column containing the formula !Sampledescriptor, !factor, or Iconcentration.
For more information about creating columns, see Adding a New Column on page
143.
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Group Table Column Format

The type of Group Table Layout defines the default columns for the data calculated and
reported in the related Group section of the current sample group.

Each of the three column formats (Standard, Unknown, and Custom), creates a different set
of columns in a new or existing group. The following table shows the default columns created
with each selection type.

Table 4-1: Group Type Column Format

Name Formula Standard Unknown Custom

Sample ISampleNames v v v

Wells IWelllDs v v v

Sample# Index

Concentration IConcentration v

Mean Value Average(Values) v

Values IWellValues v

R (Outside If(Values)>='MinStd @Standards’ and v v

Standard Range) Values<='MaxStd@ Standards’,“”,“R”

Result InterpX(STD@ StandardCurve, Values) v v

MeanResult Average(Result) v v

Std.Dev. Stdev(Result) v v v

CV% Cv(Result) v v v

Dilution IFactor v

Adj.Result MeanResult* IFactor v
5049092 A



5049092 A

Chapter 4: Workspace Sections

Using Column Tools

When a column (or the data in a column) is selected in the group table, the Column Tools
that can be used on the selected items are active. Actions not applicable for a selected item
are disabled.

After selecting a column or data in a group table, functions applicable to the selected item
are available by right-clicking to open the Group tools shortcut menu.

For information about using the Column Tools on the Home tab, see the following topics:
e Adding a New Column on page 143
e Modifying a Column on page 144
e Copying Column Contents on page 145
e Pasting Column Contents on page 145
e Cutting Column Content on page 145
e Deleting a Column on page 146
e Autosizing a Column on page 146
¢ Hiding Columns on page 146
e Showing Hidden Columns on page 147
e Hiding Replicates on page 147

Adding a New Column

To add a new column to a group:

1. Click a Group section to make it active in the workspace.

2. Click New _'r in Column Tools on the Home tab in the ribbon.

3. Inthe Formula Editor dialog, in the Name field, type a short descriptive name for the
formula.

% Note: If you plan to reference this formula in a different formula, for example
referencing the formula in a column of a group table, make sure that you do not
use reserved characters or names of operators, functions, or accessors in this
name. For information about reserved characters and words, see “Rules to Follow
When Writing Formulas” in the SoftMax Pro Software Formula Reference Guide.

Optionally, type text Comments to annotate the formula.

5. Optionally, click Syntax Helper to turn on the formula completion tool. See Enabling
Syntax Helper on page 116.

6. Type a Formulato be used for the Summary or column.

Optionally, click Check Syntax check the validity of the formula. A message is displayed
to the left of the button to help you troubleshoot the syntax of the formula.
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8. Specify the Data Display characteristics:
e From the drop-down list select either Numeric notation or Scientific notation.
¢ Click Decimal Places and type the number of places to display or click Significant
Figures and type the number of figures to display.
A preview of the Data Display is displayed in the Sample on the right.
9. Click OK.
e Ifno columns are selected, the column is added at the end of the group on the right.
e Ifyou select a column first, the new column is added to the right of the selected
column.
New columns can contain references to other columns, either in the current section orin a
different one. For example, if you wanted to subtract the mean values in one group from
those in a different group, you could create a new column (in either group) to do this. If the
two groups were named “Group 1” and “Group 2,” for example, and both groups contained
a column entitled “Mean,” you could create a column within “Group 1” that would subtract
the mean values in “Group 2” from those in “Group 1.” The column formula needed to do
this would be:
Mean — (Mean@Group2)

Many possibilities exist for creating and editing column formulas. For a complete discussion,
see the SoftMax Pro Formula Reference Guide.

Modifying a Column

To modify a column formula:
1. Click a Group section to make it active in the workspace.

2. To modify a column formula, double click the column heading to open the Formula
Editor dialog. See Adding a New Summary Formula on page 115.

3. To resize the column width, click and hold the column border and then drag it to the
desired column width.
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Copying Column Contents

To paste content into a column you must first copy applicable content into the clipboard
using the copy operation provided in the Column Tools.

To copy content to the clipboard:

1. Click a Group section to make it active in the workspace.

2. Select the content to be copied.

3. Click Copylaa--]_‘| in Column Tools on the Home tab in the ribbon.

Pasting Column Contents

The content to be pasted into a column must be copied from a different column location and
be present in the clipboard.
To paste content into a column:

1. Click a Group section to make it active in the workspace.

2. Click to select the target column location.

3. Click Paste in Column Tools on the Home tab in the ribbon.

Note: If the Paste button is disabled when you try this operation, there is no
applicable content present in the clipboard. You must first copy content to the

clipboard.

Cutting Column Content

To cut content out of a column:

1. Click a Group section to make it active in the workspace.

2. Select the content to be removed.

3. Click Cut # in Column Tools on the Home tab in the ribbon.

Note: Content that is cut from a column is not placed in the clipboard. To place
content in the clipboard, the content must be copied.
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Deleting a Column

To delete a column:
1. Click a Group section to make it active in the workspace.
2. Click a column title to select the column.

To select multiple columns, hold down the SHIFT key and click to select a range of
columns or hold down the cTRL key and click to select non-contiguous columns.

3. Click Delete Hin Column Tools on the Home tab in the ribbon, or right-click and select
Delete Column from the shortcut menu.

Autosizing a Column

You can autosize a column to set the width of the selected column to hold the longest text
string:

1. Click a Group section to make it active in the workspace.

2. Click a column title to select the column.

To select multiple columns, hold down the SHIFT key and click to select a range of
columns or hold down the cTRL key and click to select non-contiguous columns.

3. Click Auto Size i in Column Tools on the Home tab in the ribbon, or right-click and
select Auto Size from the shortcut menu.

Hiding Columns

To hide one or more columns:

1. Click a Group section to make it active in the workspace.

2. Click Show/Hide.E—:-iJ in Column Tools on the Home tab in the ribbon or above the right
side of the group table.

3. Inthe Show Hide group table columns dialog, clear the check boxes next to the
columns that you want to hide.

e To clear all the check boxes, click Hide All.
* To select all the check boxes, click Show All.
4. Click OK.
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Showing Hidden Columns

To show hidden columns:

1.
2.

4,

Click a Group section to make it active in the workspace.
Click Show/Hide i3 in Column Tools on the Home tab in the ribbon or above the right
side of the group table.

In the Show Hide group table columns dialog, select the check boxes next to the
columns that you want to show.

¢ To select all the check boxes, click Show All.
e To clear all the check boxes, click Hide All.
Click OK.

Hiding Replicates

To hide data for all replicates:

1.
2.

Click a Group section to make it active in the workspace.

Click Hide Replicates “1in the Column Tools on the Home tab in the ribbon.

Using Summary Tools

When a Group section is active in the workspace, the Home tab in the ribbon displays the
Summary Tools.

For information about using the Summary Tools, see the following topics:

Copying and Pasting a Formula on page 147

Deleting a Formula on page 148

Adding a New Formula on page 148

Editing a Formula on page 148

Showing and Hiding the Formulas in a Group Section on page 148

Copying and Pasting a Formula

To copy a formula and paste it into a new summary:

1.

2
3
4,
5
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Click a Group section to make it active in the workspace.

Select the Summary formula to be copied.

Click Copy B in Summary Tools on the Home tab in the ribbon.

Click the location where you want to paste the copy of the Summary formula.

Click PasteEE in Summary Tools on the Home tab in the ribbon.
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Deleting a Formula

To delete a formula:
1. Click a Group section to make it active in the workspace.
2. Click a formula to select the formula to be deleted.

3. Click Delete %lin Summary Tools on the Home tab in the ribbon.

Adding a New Formula

To add a new formula to a Group section:
1. Click on a Group section to make it active in the workspace.

2. Click New Summary i in Summary Tools on the Home tab in the ribbon to open the
Formula Editor dialog. For more information, see Adding a New Summary Formula on
page 115.

3. Typetheformulato be added and click OK.

Editing a Formula

To edit a formula in a Group section:

1. Click a Group section to make it active in the workspace.

2. Click the formula to be changed to select it.

3. Click Edit Summary & in Summary Tools on the Home tab in the ribbon to open the
Formula Editor dialog. For more information, see Adding a New Summary Formula on
page 115.

4. Typethe changes to formula and click OK.

Showing and Hiding the Formulas in a Group Section

Generally, the summary formulas in the Group section display the results of the formulas.
You can show or hide the formulas as well as the results.

To show the formulas in the Group section:

1. Click a Group section to make it active in the workspace.

2. Click Show Formulas "™ in Summary Controls on the Home tab in the ribbon.
To hide the formula in the Group section:

1. Click a Group section to make it active in the workspace.

2. Click Hide Formulas ﬁﬁ in Summary Controls on the Home tab in the ribbon.
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Using Formatting Tools in a Group Section

When a Group section is active in the workspace, the Home tab in the ribbon displays the
Formatting Tools.

You can format the text in the summaries and text frames in the Group section using the
available Formatting Tools. Formatting text in a Group section is similar to formatting text in
a Note section. See the following topics:

e Adding Text to a Note Section on page 111

e Aligning Text on page 111

e Editing Text in a Text Frame on page 112

e Formatting Text in a Text Frame on page 113

e Positioning a Text Frame in a Note Section on page 114
e Resizing a Text Frame on page 114

e Deleting a Text Frame on page 114

Using a Graph Section

5049092 A

Graph sections are used to plot information from groups as scatter plots or bar graphs.

You can create more than one Graph section within a data file, and plots in the Graph section
can be created from any Experiment in the file.

After a graph has been created, new plots can be added and deleted, the axes can be
customized, and the size and type of graph can be changed. The grid lines for the graph can
be enabled or disabled. The default setting has grid lines enabled.

Graph sections are divided into the following areas:
e The body of the Graph section.
e The Legend.

For more information see Working with Graphs on page 389.
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Use the SoftMax Pro Software to define the parameters for the read mode and read type of
your assay.

For more information on the supported read modes, see the following topics:
* Absorbance Read Mode on page 154
* Fluorescence Intensity Read Mode on page 160
e Luminescence Read Mode on page 166
e Time-Resolved Fluorescence Read Mode on page 171
e HTRF Read Mode on page 179
e FRET Read Mode on page 178
e Fluorescence Polarization Read Mode on page 185
e AlphaScreen Read Mode on page 189
e Western Blot TRF Read Mode on page 193
e |Imaging Read Mode on page 197

Application notes with specific application protocol suggestions can be found in the
Information Center and the Knowledge Base on the Molecular Devices web site at
www.moleculardevices.com.

Supported Read Types

For most read modes, endpoint, kinetic, multi-point well-scan, and spectrum microplate
applications can be set up and run with the SoftMax Pro Software. In addition, the
FlexStation 3 reader support the flex read type that can integrate fluid transfer with a kinetic
read.

For more information on the supported read types, see the following topics:
e Endpoint Read Type on page 152
¢ Kinetic Read Type on page 152
e Well Scan Read Type on page 152
e Spectrum Read Type on page 152
e Flex Read Type on page 153
e Membrane Read Type on page 153
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Endpoint Read Type

In an endpoint read, a reading of each microplate well is taken in the center of each well, at a
single wavelength or at multiple wavelengths. Depending on the read mode, raw data values
are reported as optical density (OD), %Transmittance (%T), relative fluorescence units (RFU),
or relative luminescence units (RLU).

Kinetic Read Type

In a kinetic read, the instrument collects data over time with multiple readings taken in the
center of each well at regular intervals. To get the shortest possible interval for multiple-
wavelength Kinetic readings, choose wavelengths in ascending order.

The values calculated based on raw kinetic data include VMax, VMax per Sec, Time to VMax,
and Onset Time. Kinetic readings can be single-wavelength or multiple-wavelength readings.

Kinetic analysis can collect data points in time intervals of seconds, minutes, hours, or days.
The kinetic read interval depends on the instrument setup parameters selected in the
SoftMax Pro Software.

Kinetic analysis has many advantages when determining the relative activity of an enzyme in
different types of microplate assays, including ELISAs and the purification and
characterization of enzymes and enzyme conjugates. Kinetic analysis is capable of providing
improved dynamic range, precision, and sensitivity relative to endpoint analysis.

Peak Pro™ Analysis functions provide advanced peak detection and characterization for
applicable kinetic reads. See the SoftMax Pro Software Formula Reference Guide.

Spectrum Read Type

Depending on the read mode selected, a spectrum read measures optical density (OD),
%Transmittance (%T), relative fluorescence units (RFU), or relative luminescence units (RLU)
across a spectrum of wavelengths.

Well Scan Read Type

A well scan read can take readings at more than one location within a well. A well scan read
takes one or more readings of a single well of a microplate on an evenly spaced grid inside of
each well at single or multiple wavelengths.

Some applications involve the detection of whole cells in large-area tissue culture plates. Well
scan reads can be used with such microplates to permit maximum surface area detection in
whole-cell protocols. Since many cell lines tend to grow as clumps or in the corners of
microplate wells, you can choose from several patterns and define the number of points to
be scanned to work best with your particular application.

Depending on the read mode selected, the values are reported as optical density (OD),
%Transmittance (%T), relative fluorescence units (RFU), or relative luminescence units (RLU).
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Flex Read Type

The fluidics module in the FlexStation 3 reader is designed to aspirate fluids from a
compound source plate and dispense them into an assay plate. Fluid transfer is made
possible with an 8-channel or 16-channel pipettor that is fully automated, including changing
the tips from a tip rack.

In the Flex read type, one to eight or one to sixteen wells in one column of the assay plate are
read repeatedly for a selected total experimental time. At a preselected point or points
during that time sequence, the pipettor can transfer up to three reagents from the
compound plate to the assay plate. The instrument continues to read at the preselected
time intervals before and after each fluid transfer. After completion of reading the column (or
partial column) for a preselected time, the instrument can repeat this cycle with other
columns. All the data are collected in one data file represented as a 96-well or 384-well
microplate.

For example, an experiment with a two-minute run time accommodates a 96-well microplate
in about 24 minutes.

Run time x Number of columns = Plate time

2 minutes x 12 columns = 24 minutes

Membrane Read Type

The Membrane read type is used for a time-resolved fluorescence reading of a Western Blot
membrane. The selected area is read, and a TIFF image is generated with the results of the
read.
The Molecular Devices ScanLater™ Western Blot Assay Kit is a novel system for protein
analysis that is incorporated into a SpectraMax® Paradigm® or SpectraMax® i3x Multi-Mode
Detection Platform. Membranes are incubated with Eu-chelate labeled secondary antibodies
or streptavidin that bind specifically to the target protein-specific primary antibody. For
more information, contact your Molecular Devices representative or search the knowledge
base for ScanLater or Western Blot at www.moleculardevices.com/support.
If you are using the SoftMax Pro GxP Software, you must enable the following permissions to
complete a Western Blot membrane read:

* Read empty plates/cuvettes to start a read.

* Save data files to save the data file before the read.

e Overwrite plate/cuvette data to do a high-resolution ROl read.
See Using SoftMax Pro GxP Software Features on page 467.
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In the Absorbance (ABS) read mode, the instrument measures the Optical Density (OD) of
the sample solutions.

Absorbance is the quantity of light absorbed by a solution. To measure absorbance
accurately, it is necessary to eliminate light scatter. If there is no turbidity, then
absorbance = optical density.

A =logiollo /1) = —log(l/10)
where I, is incident light before it enters the sample, / is the intensity of light after it passes
through the sample, and A is the measured absorbance.

For Absorbance reads, you can choose whether to display absorbance data as Optical
Density (OD) or %Transmittance (%T) in the Reduction dialog.

Optical Density

Optical density (OD) is the quantity of light passing through a sample to a detector relative to
the total quantity of light available. Optical Density includes absorbance of the sample plus
light scatter from turbidity and background. You can compensate for background using
blanks.

A blank well contains everything used with the sample wells except the chromophore and
sample-specific compounds. Do not use an empty well for a blank.

Some applications are designed for turbid samples, such as algae or other micro-organisms
in suspension. The reported OD values for turbid samples are likely to be different when read
by different instruments.

For optimal results, Molecular Devices recommends that you run replicates for all blanks,
controls, and samples. In this case, the blank value that can be subtracted is the average
value of all blanks.

% Transmittance

%Transmittance is the ratio of transmitted light to the incident light for absorbance reads.
T=1/1,
%T = 100T

where [ is the intensity of light after it passes through the sample and /,is incident light
before it enters the sample.

Optical Density and %Transmittance are related by the following formulas:
%T =10"""
OD = 2 - |Og10(%T)

The factor of two comes from the fact that %T is expressed as a percent of the transmitted
light and logy,(100) = 2.

When in %Transmittance analysis mode, the SoftMax Pro Software converts the raw OD
values reported by the instrument to %Transmittance using the above formula. All
subsequent calculations are done on the converted numbers.
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Applications of Absorbance

Absorbance-based detection has been commonly used to evaluate changes in color or
turbidity, permitting widespread use including ELISAs, protein quantitation, endotoxin
assays, and cytotoxicity assays. With absorbance readers that are capable of measuring in
the ultraviolet (UV) range, the concentration of nucleic acids (DNA and RNA) can be found
using their molar extinction coefficients.

For micro-volume measurements, you can use SpectraDrop 24-well Micro-Volume
Microplates and SpectraDrop 64-well Micro-Volume Microplates.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about setting up an Absorbance mode protocol, see Creating an Absorbance
Mode Protocol on page 312.

Absorbance Instruments

The following instruments have absorbance read mode capability:
e SpectraMax i3x and i3 Multi-Mode Detection Platforms, see page 202
e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204

To do absorbance reads, the SpectraMax Paradigm Multi-Mode Microplate Reader
requires the Absorbance Detection Cartridge, see page 219.

e VersaMax Microplate Reader, see page 205

e SpectraMax Plus 384 Absorbance Microplate Reader, see page 205

e SpectraMax M5 and M5e Multi-Mode Microplate Readers, see page 206
e SpectraMax M4 Multi-Mode Microplate Reader, see page 207

e SpectraMax M3 Multi-Mode Microplate Reader, see page 208

e SpectraMax M2 and M2e Multi-Mode Microplate Readers, see page 209
e SpectraMax 340PC 384 Absorbance Microplate Reader, see page 210

e SpectraMax 190 Absorbance Microplate Reader, see page 210

e FlexStation 3 Multi-Mode Microplate Reader, see page 212

e FilterMax F5 Multi-Mode Microplate Reader, see page 213

e FilterMax F3 Multi-Mode Microplate Reader, see page 214

e Vmax Kinetic Microplate Reader, see page 215

e EMax Endpoint Microplate Reader, see page 215

e EMax Plus Microplate Reader, see page 215
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PathCheck Pathlength Measurement Technology

You can enable PathCheck technology in the SoftMax Pro Software Settings dialog by
selecting the PathCheck check box in the PathCheck Settings for absorbance endpoint reads.

The temperature-independent PathCheck® Pathlength Measurement Technology
normalizes your absorbance values to a 1 cm path length based on the near-infrared
absorbance of water.

The Beer—Lambert law states that absorbance is proportional to the distance that light
travels through the sample:

A=¢bc

where A is the absorbance, €is the molar absorptivity of the sample, b is the pathlength, and
cis the concentration of the sample. The longer the pathlength, the higher the absorbance.

Microplate readers use a vertical light path so the distance of the light through the sample
depends on the volume. This variable pathlength makes it difficult to do extinction-based
assays and also makes it confusing to compare results between microplate readers and
spectrophotometers.

The standard pathlength of a 1 cm cuvette is the conventional basis for quantifying the
unique absorptivity properties of compounds in solution. Quantitative analysis can be done
on the basis of extinction coefficients, without standard curves (for example, NADH-based
enzyme assays). When using a cuvette, the pathlength is known and is independent of
sample volume, so absorbance is directly proportional to concentration when there is no
background interference.

In a microplate, pathlength is dependent on the liquid volume, so absorbance is
proportional to both the concentration and the pathlength of the sample. Standard curves
are often used to determine analyte concentrations in vertical-beam photometry of
unknowns, yet errors can still occur from pipetting the samples and standards. The
PathCheck technology automatically determines the pathlength of aqueous samples in the
microplate and normalizes the absorbance in each well to a pathlength of 1 cm. This way of
correcting the microwell absorbance values is accurate to within +4% of the values obtained
directly in a 1 cm cuvette.

\_/
Vertical light path

Horizontal .
light path

N

Cuvette Microplate wells

Figure 5-1: Cuvette and Microplate Well Light Paths
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The 1 cm values can be obtained by using the factory installed Water Constant. PathCheck
technology is used to normalize the data acquired from absorbance endpoint microplate
readings to a 1 cm pathlength, correcting the OD for each well to the value expected if the
sample were read in a 1 cm cuvette.

Water Constant

The Water Constant correction method is supported for absorbance endpoint reads.

The PathCheck technology is based on the absorbance of water in the near infrared spectral
region (between 900 nm to 1000 nm). If the sample is completely aqueous, has no turbidity
and has a low salt concentration (less than 0.5 M), the Water Constant is sufficient. The
Water Constant is determined for each instrument during manufacture and is stored in the
instrument.

Cuvette Reference

The Cuvette Reference correction method is supported by the SpectraMax M2, M2e, M3,
M4, M5, M5e, and Plus 384 readers.

If the sample contains an organic solvent such as ethanol or methanol, we recommend using
the Cuvette Reference. It is important that the solvent does not absorb in the 900 nm to
1000 nm range. To determine whether or not a given solvent would interfere, see the
discussion of interfering substances in Interfering Substances on page 159. When a non-
interfering solvent is added to the aqueous sample, the water absorbance decreases
proportionally to the percentage of organic solvent present. For example, 5% ethanol
decreases the water absorbance by 5% and results in a 5% underestimation of the
pathlength. You can minimize the error by putting the same water/solvent mixture in a
cuvette and using the Cuvette Reference.

To use the Cuvette Reference, place into the cuvette port a standard 1 cm cuvette containing
the agueous/solvent mixture that is used for the samples in the microplate. The cuvette
must be in place when you read the microplate. When you click the Read button, the
instrument first makes the 900 nm and 1000 nm measurements in the cuvette, and then
makes the designated measurements in the microplate. The cuvette values are stored
temporarily and used in the PathCheck calculations for the microplate samples.

Use of Cuvette Reference with the PathCheck Pathlength Measurement Technology is
different from a reference reading of a cuvette in a CuvetteSet section (by clicking the Ref
button in the CuvetteSet section tool bar). The cuvette reference used for PathCheck
calculations (measurements at 900 nm and 1000 nm) does not produce data that can be
directly viewed in a CuvetteSet section and is used only with data in microplates, not
cuvettes. However, you can obtain these values using accessors in the formula editor. See
the IPathCheckLm1000 and !PathCheckLm900 accessor described in the SoftMax Pro
Software Formula Reference Guide.
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% Note: After you have read a plate with PathCheck technology turned on, PathCheck
information is stored permanently in the data file. You have the option of applying, or
not applying, PathCheck technology to the absorbance values. If you do not have
PathCheck technology turned on during the plate read, you cannot apply the
PathCheck Pathlength Measurement Technology feature after the read.

Eliminating the Pathlength-Independent Component

Raw OD measurements of microplate samples include both pathlength-dependent

components (sample and solvent) and a pathlength-independent component (OD of

microplate material). The pathlength-independent component must be eliminated from the

calculation to get valid results that have been normalized by the PathCheck technology. You

can do this using a plate blank or using a plate background constant.

Using a Plate Blank

This method can be used if all samples in the microplate are the same volume and you are

not depending on the PathCheck technology to correct for variability in volumes.

To use this method:

1. Designate a minimum of one well (preferably several) as Plate Blank.

2. Pipette buffer (for example, your sample matrix) into those wells and read along with
your samples. Do not use an empty well for a blank.
The SoftMax Pro Software automatically subtracts the average of the blank wells from
each of the samples. The OD of the microplate material is subtracted as part of the blank.

3. Make sure that Use Plate Blank is checked under Other Options in the Data Reduction
dialog.

Using a Plate Background Constant

If your sample volumes are not identical or if you choose not to use a Plate Blank, then you

must use a Plate Background Constant. Omitting a Plate Background Constant results in

artificially high values after being normalized by the PathCheck technology.

To determine the Plate Background Constant:

1. Filla clean microplate with water.

2. Read at the wavelengths that you will be reading your samples.

The average OD value is the Plate Background Constant. If you intend to read your samples
at more than one wavelength, there should be a corresponding number of Plate Background
Constant values for each wavelength.

% Note: It is important that you put water in the wells and not read a dry microplate for
the Plate Background Constant. A dry microplate has a slightly higher OD value than a
water-filled microplate because of differences in refractive indices. Using a dry
microplate results in PathCheck technology normalized values that are lower than
1 cm cuvette values.
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Interfering Substances

Material that absorbs in the 900 nm to 1000 nm spectral region could interfere with
PathCheck technology measurements. Fortunately, there are few materials that do interfere
at the concentrations generally used.

Turbidity is the most common interference. If you can detect turbidity in your sample, you
should not use the PathCheck technology. Turbidity elevates the 900 nm measurement
more than the 1000 nm measurement and causes an erroneously low estimate of
pathlength. Using Cuvette Reference does not reliably correct for turbidity.

Samples that are highly colored in the upper-visible spectrum might have absorbance
extending into the near-infrared (NIR) spectrum and can interfere with the PathCheck
technology. Examples include Lowry assays, molybdate-based assays, and samples
containing hemoglobins or porphyrins. In general, if the sample is distinctly red or purple,
you should check for interference before using the PathCheck technology.

To determine possible color interference, do the following:
e Measure the OD at 900 nm and 1000 nm (both measured with air reference).
e Subtract the 900 nm value from the 1000 nm value.

Do the same for pure water.

If the delta OD for the sample differs significantly from the delta OD for water, then it is
recommended to not use the PathCheck technology.

Organic solvents could interfere with the PathCheck technology if they have absorbance in
the region of the NIR water peak. Solvents such as ethanol and methanol do not absorb in
the NIR region, so they do not interfere, except for causing a decrease in the water
absorbance to the extent of their presence in the solution. If, however, the solvent absorbs
between 900 nm and 1000 nm, the interference would be similar to the interference of highly
colored samples as previously described. If you are considering adding an organic solvent
other than ethanol or methanol, you should run a Spectrum scan between 900 nm and

1000 nm to determine if the solvent would interfere with the PathCheck technology.

159



SoftMax Pro Software User Guide

Fluorescence Intensity Read Mode

Fluorescence occurs when absorbed light is re-radiated at a longer wavelength. In the
Fluorescence Intensity (FL) read mode, the instrument measures the intensity of the re-
radiated light and expresses the result in Relative Fluorescence Units (RFU).

The governing equation for fluorescence is:

Fluorescence = extinction coefficient x concentration x quantum yield x
excitation intensity x pathlength x emission collection efficiency

Fluorescent materials absorb light energy of a characteristic wavelength (excitation), undergo
an electronic state change, and instantaneously emit light of a longer wavelength (emission).
Most common fluorescent materials have well-characterized excitation and emission
spectra. The following figure shows an example of excitation and emission spectra for a
fluorophore. The excitation and emission bands are each fairly broad, with half-bandwidths
of approximately 40 nm, and the difference between the wavelengths of the excitation and
emission maxima (the Stokes shift) is generally fairly small, about 30 nm. There is
considerable overlap between the excitation and emission spectra (gray area) when a small
Stokes shift is present.
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Figure 5-2: Excitation and Emission Spectra

Because the intensity of the excitation light is usually many tens of thousands of times
greater than that of the emitted light, you must have sufficient spectral separation to reduce
the interference of the excitation light with detection of the emitted light.
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Tip: If the Stokes shift is small, you should choose an excitation wavelength that is as
far away from the emission maximum as possible while still being capable of
stimulating the fluorophore so that less of the excited light overlaps the emission
spectrum, permitting better selection and quantitation of the emitted light.

The Spectral Optimization Wizard in the SoftMax Pro Software provides the best settings
for maximizing the signal to background window, (S-B)/B, while minimizing the optimization
time. You can use this wizard with the SpectraMax i3x Multi-Mode Detection Platform or
with a Tunable Wavelength (TUNE) Detection Cartridge installed in the SpectraMax Paradigm
Multi-Mode Microplate Reader. See Spectral Optimization on page 348.

Relative Fluorescence
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Figure 5-3: Optimized Excitation and Emission Reading Wavelengths

The previous figure shows that the best results are often obtained when the excitation and
emission wavelengths used for reading are not the same as the peak wavelengths of the
excitation and emission spectra of the fluorophore. When the reading wavelengths for
excitation and emission are separated, a smaller quantity of excitation light passes through
to the emission monochromator (gray area) and on to the PMT, resulting in a purer emission
signal and more accurate data.
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The instrument permits scanning of both excitation and emission wavelengths, using
separate tunable dual monochromators. One benefit of scanning emission spectra is that
you can determine more accurately whether the emission is, in fact, the expected
fluorophore, or multiple fluorophores, and not one generated by a variety of background
sources or by contaminants. One more benefit is that you can find excitation and emission
wavelengths that prevent interference when interfering fluorescent species are present.

For this reason, it is desirable to scan emission for both an intermediate concentration of
labeled sample, as well as the background of unlabeled sample. The optimal setting is where
the ratio of the sample emission to background emission is at the maximum.

Fluorescence intensity data is dependent on a number of variables. See Analyzing
Fluorescence Intensity Data on page 164.

Applications of Fluorescence Intensity

Fluorescence intensity is used widely in applications such as fluorescent ELISAs, protein
assays, nucleic acid quantitation, reporter gene assays, cell viability, cell proliferation, and
cytotoxicity. One more major application of this mode is to study the kinetics of ion release.

Some assays use a fluorescent label to selectively attach to certain compounds. The quantity
or concentration of the compound can then be quantified by measuring the fluorescence
intensity of the label, which is attached to the compound. Such methods are often used to
guantify low concentrations of DNA or RNA, for example.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about setting up a fluorescence intensity mode protocol, see Creating a
Fluorescence Intensity Mode Protocol on page 314.
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Fluorescence Intensity Instruments and Detection Cartridges

The following instruments have fluorescence intensity read mode capability:

SpectraMax i3x and i3 Multi-Mode Detection Platforms, see page 202

The read capabilities of the SpectraMax i3x Instrument can be upgraded with user-
installable detection cartridges.

SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204

The SpectraMax Paradigm Multi-Mode Microplate Reader requires detection cartridges
to do reads.

SpectraMax M5 and M5e Multi-Mode Microplate Readers, see page 206
SpectraMax M4 Multi-Mode Microplate Reader, see page 207
SpectraMax M3 Multi-Mode Microplate Reader, see page 208
SpectraMax M2 and M2e Multi-Mode Microplate Readers, see page 209
Gemini XPS Microplate Reader, see page 211

Gemini EM Microplate Reader, see page 211

FlexStation 3 Multi-Mode Microplate Reader, see page 212

FilterMax F5 Multi-Mode Microplate Reader, see page 213

FilterMax F3 Multi-Mode Microplate Reader, see page 214

The following detection cartridges have fluorescence intensity read mode capability:

Tunable Wavelength (TUNE) Detection Cartridge, see page 220
Multi-Mode (MULTI) Detection Cartridge, see page 221

Fluorescence Intensity (FI) Detection Cartridges, see page 225
Fluorescence Intensity (FI) GeneBLAzer Detection Cartridge, see page 226

Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection Cartridge, see page
228

Note: For the SpectraMax i3x Multi-Mode Detection Platform, the detection
cartridges can be used for top reads only.

Fluorescence Intensity Reads with Injectors

Injectors in a microplate reader are used to automatically deliver a specified volume of a
reagent to the wells of a microplate. They are generally used when delivery of the reagent
initiates a reaction that occurs rapidly and results in a luminescent or fluorescent signal that
must be detected quickly.

The SpectraMax i3x Instrument with the Injector Cartridge installed can be set up to inject
and read well by well to reduce signal loss.

Common inject-and-read assays include calcium flux assays.
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Analyzing Fluorescence Intensity Data

Fluorescence intensity data is dependent on a number of variables. Raw data is compared to
a standard curve with known concentrations of a reference label.

A standard curve consists of, at a minimum, a blank sample and a reference standard sample
of known concentration. The raw data can then be expressed in equivalent concentration of
a reference label.

Analyzing and validating fluorescence intensity data generally consists of the following:
e Background Correction and Quantification on page 164
e Detection Limit on page 165

e Linearity and the Linear Dynamic Range on page 165
Background Correction and Quantification

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.
The blank sample reveals the offset underlying each data sample. This offset does not carry
information on the label, and is generally subtracted before data reduction is done.
The blank-subtracted raw data are proportional to the quantity of label in a sample such that
the label concentration is quantified by the following equation.

_ (sample - blank)
el std — blank

concstd

conc

where concgy is the concentration of the standard, and sample, blank, and standard are
average values of replicates for the sample, blank, and standard wells. In the general case
where the standard curve covers a concentration range of more than a few linear logs,
(standard —blank) / conc,, is equivalent to the slope of the standard curve, and so the
concentration of the label is determined by (sample —blank) / (slope of standard curve).

For optimal results, Molecular Devices recommends that you run replicates for all blanks,
controls, and samples. In this case, the blank value that can be subtracted is the average
value of all blanks.
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Detection Limit

The detection limit is the smallest sample concentration that can be measured reliably above
the blank. Determining the detection limit requires taking a number of blank measurements
and calculating an average value and standard deviation for the blanks. The detection
threshold is defined as the average blank plus three standard deviations. If the average
sample value measures above the threshold, the sample can be detected at a statistically
significant level.

The detection limit can be described by the following equation:

3 Stdev

blank

std — blank
conc,,

Det Limit =

where concg, is the concentration of the standard, StDevg,,. is the standard deviation of the
blank replicates, and blank and Std are average values of the replicates for the blank and
standard wells.

Determining the detection limit for an assay requires multiple blanks to calculate their
standard deviation.

Linearity and the Linear Dynamic Range

Within a wide range at moderately high concentrations, blanked raw data is proportional to
the quantity of label in a sample.

The linear dynamic range (LDR) is defined by:

DR =| max conc lin
=lo — .
B1o detection limit

where LDR is expressed as a log, and max conc lin is the highest concentration in the linear
range that can be quantified.

When the standard curve after blank reduction is not linear in concentration at the lower
end, there might be an incorrect or contaminated blank.
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In luminescence read mode, no excitation is necessary as the species being measured emit
light naturally. For this reason, the lamp does not flash, so no background excitation
interference occurs.

In the Luminescence (LUM) read mode, the instrument provides measurements in Relative
Luminescence Units (RLUs).

Luminescence is the emission of light by processes that derive energy from essentially non-
thermal changes, the motion of subatomic particles, or the excitation of an atomic system by
radiation. Luminescence detection relies on the production of light from a chemical reaction
in asample.

To help eliminate background luminescence from a microplate that has been exposed to
light, Molecular Devices recommends dark adaptation of the microplate by placing the
sample-loaded microplate in the instrument for several minutes before starting the read.
For some monochromator-based instruments, the default setting for luminescence is the
“zero order” position where the grating monochromator acts as a mirror that reflects all light
to the PMT detector.

The SpectraMax i3x Instrument bypasses the emission monochromator for luminescence
reads that detect all wavelengths.

If wavelength selection is desired, you can choose the wavelength where peak emission is
expected to occur. Also, multiple wavelength choices let species with multiple components
be differentiated and measured easily.

Luminescence can be read from the top or the bottom of a microplate. Solid white
microplates or white microplates with clear bottoms are recommended for luminescence
reads.

Concentrations or qualitative results are derived from raw data with a standard curve or by
comparison with reference controls. See Analyzing Luminescence Data on page 168.

Applications of Luminescence
Chemiluminescent or bioluminescent reactions can be induced to measure the quantity of a
particular compound in a sample. Examples of luminescent assays include the following:

e Reporter gene assays (the measurement of luciferase gene expression)

e Quantitation of adenosine triphosphate (ATP) as an indication of cell counts with cell-
proliferation, cytotoxicity, and biomass assays

* Enzyme measurements with luminescent substrates, such as immunoassays

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about setting up a luminescence mode protocol, see Creating a
Luminescence Mode Protocol on page 322.
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Luminescence Instruments and Detection Cartridges

The following instruments have luminescence read mode capability:
e SpectraMaxi3x and i3 Multi-Mode Detection Platforms, see page 202

The read capabilities of the SpectraMax i3x Instrument can be upgraded with user-
installable detection cartridges.

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204

The SpectraMax Paradigm Multi-Mode Microplate Reader requires detection cartridges
to do reads.

e SpectraMax M5 and M5e Multi-Mode Microplate Readers, see page 206
e SpectraMax M4 Multi-Mode Microplate Reader, see page 207
e SpectraMax M3 Multi-Mode Microplate Reader, see page 208
e SpectraMax M2 and M2e Multi-Mode Microplate Readers, see page 209
e Gemini XPS Microplate Reader, see page 211
e Gemini EM Microplate Reader, see page 211
e FlexStation 3 Multi-Mode Microplate Reader, see page 212
e FilterMax F5 Multi-Mode Microplate Reader, see page 213
e FilterMax F3 Multi-Mode Microplate Reader, see page 214
The following detection cartridges have luminescence read mode capability:
e Tunable Wavelength (TUNE) Detection Cartridge, see page 220
Multi-Mode (MULTI) Detection Cartridge, see page 221

Glow Luminescence (LUM) Detection Cartridges, see page 227

Dual Color Luminescence (LUM) (BRET2) Detection Cartridge, see page 230

Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge, see page 231

Note: For the SpectraMax i3x Multi-Mode Detection Platform, the detection
cartridges can be used for top reads only.

Luminescence Reads with Injectors

Injectors in a microplate reader are used to automatically deliver a specified volume of a
reagent to the wells of a microplate. They are generally used when delivery of the reagent
initiates a reaction that occurs rapidly and results in a luminescent or fluorescent signal that
must be detected quickly.

The SpectraMax i3x Instrument with the Injector Cartridge installed can be set up to inject
and read well by well to reduce signal loss.

Common inject-and-read assays include luciferase reporter assays.

The Injector Cartridge is DLReady™ certified by Promega for the

Dual-Luciferase Reporter (DLR™) assay system. D L 1'_,1
weady

DLReady, DLR, and the DLReady logo are trademarks of Promega Corporation.
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Analyzing Luminescence Data

The conversion rate of photons to counts is individual for each reader. Therefore, raw data
from the same plate can seem significantly different from one instrument to the next. Also,
the data format used by other manufacturers might not be counts per second and can be
different by several orders of magnitude. It is important to know that the number of counts
and the size of figures is in no way an indication of sensitivity. See Detection Limit on page
169.

Concentrations or qualitative results are derived from raw data with a standard curve or by
comparison with reference controls. A standard curve consists of, at a minimum, a blank
sample and a reference standard sample of known concentration. The raw data can then be
expressed in equivalent concentration of a reference label. The raw data is normalized to
counts per second by dividing the number of counts by the read time per well.

Analyzing and validating luminescence data generally consists of the following:
e Background Correction on page 168
e Detection Limit on page 169
e Sample Volumes and Concentration of Reactants on page 169
e Data Optimization on page 170

Background Correction

The light detected in a luminescent measurement generally has two components: specific
light from the luminescent reaction and an approximately constant level of background light
caused by various factors, including the plate material and impurities in the reagents. The
background can be effectively measured using blank replicates. Blanks should include the
luminescent substrate (chemical energy source) but not the luminescence agent (generally
an enzymatic group which makes the substrate glow).

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.

The blank sample reveals the offset underlying each data sample. This offset does not carry
information on the label, and is generally subtracted before data reduction is done.

For optimal results, Molecular Devices recommends that you run replicates for all blanks,
controls, and samples. In this case, the blank value that can be subtracted is the average
value of all blanks.

To help eliminate background luminescence from a microplate that has been exposed to
light, Molecular Devices recommends dark adaptation of the microplate by placing the
sample-loaded microplate in the instrument for several minutes before starting the read.
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Detection Limit

The detection limit is the smallest sample concentration that can be measured reliably above
the blank. Determining the detection limit requires taking a number of blank measurements
and calculating an average value and standard deviation for the blanks. The detection
threshold is defined as the average blank plus three standard deviations. If the average
sample value measures above the threshold, the sample can be detected at a statistically
significant level.

The detection limit can be described by the following equation:

3 Stdev

blank

std — blank
conc,,

Det Limit =

where concg, is the concentration of the standard, StDevg,,. is the standard deviation of the
blank replicates, and blank and Std are average values of the replicates for the blank and
standard wells.

Determining the detection limit for an assay requires multiple blanks to calculate their
standard deviation.

Sample Volumes and Concentration of Reactants

The concentration of the luminescent agent impacts the quantity of light outputin a
luminescent reaction. Light is emitted as a result of a reaction between two or more
compounds. Therefore, the quantity of light output is proportional to the quantity of the
limiting reagent in the sample.

For example, in an ATP/luciferin-luciferase system, when total volume is held constant and
ATP is the limiting reagent, the blanked light output is proportional to the concentration of
ATP in the sample, at very high concentrations of ATP. Substrate can be used up and become
rate-limiting, providing it is the rate-limiting component. In this case, the non-linearity is an
effect of the assay and not caused by the microplate reader.

Note: Very bright samples can exceed the linear dynamic range of the instrument. If
so, reading can be done using an attenuation filter.
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Data Optimization

The measurement noise is dependent on the read time per sample (time per plate or time
per well). In particular, the detection limit improves when the read time is increased.
Therefore, it is important to specify the read time when comparing measurements.

All low-light-level detection devices have some measurement noise in common. To average
out the measurement noise, optimization of the time per well involves accumulating as
many counts as possible. Within some range, you can reduce noise (CVs, detection limit) by
increasing the read time per well, as far as is acceptable from throughput and sample
stability considerations.

Z'is the standard statistical parameter in the high-throughput screening community for
measuring the quality of a screening assay independent of test compounds. It is used as a
measure of the signal separation between the positive controls and the negative controls in
an assay.

The value of Z' can be determined using the following formula:
3(SD,, ) +3(SD_)

- | Mean —Mean |
c+ [

where SD is the standard deviation, c+ is the positive control, and c—is the negative control.

AZ value greater than or equal to 0.4 is the generally acceptable minimum for an assay.
Higher values might be desired when results are more critical.

Z’is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z" value, you can increase the quantity of
label in the sample, if acceptable for the assay, or increase the read time per well.
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Time-Resolved Fluorescence Read Mode
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Time-resolved fluorescence (TRF) is a measurement technique that depends on three
characteristics that lead to better discrimination between the specific signal, proportional to
the quantity of label, and the unspecific fluorescence resulting from background and
compound interference:

e Pulsed excitation light sources
e Time-gated electronics faster than the fluorescence lifetime
e Labels with prolonged fluorescence lifetime

The time-gating electronics introduce a delay between the cut off of each light pulse and the
start of signal collection. During the delay, the unspecific fluorescence (caused by test
compounds, assay reagents, and the microplate) vanishes while only a small portion of the
specific fluorescence from the label is sacrificed. Enough of the specific signal remains during
the decay period with the added benefit of reduced background.

In Time-Resolved Fluorescence read mode, the instrument detects the extremely long
emission half-lives of rare earth elements called lanthanides such as europium (lifetime of
about 700 ps), samarium (lifetime of about 70 ps), or terbium (lifetime of about 1000 pus).

Applications of Time-Resolved Fluorescence

Time-resolved fluorescence (TRF) is widely used in high throughput screening applications
such as kinase assays, and is useful in some fluorescence immunoassays, such as DELFIA
(dissociation-enhanced enzyme linked fluorescence immunoassay). TRF is also useful in
some assay variants of TR-FRET (time-resolved fluorescence resonance energy transfer) in
which the FRET acceptor label acts as a quencher only and does not emit fluorescence. The
proximity between donor label and acceptor (quencher) is then quantified by the intensity
decrease of the donor label.

DELFIA requires washing steps as in an ELISA, but the TR-FRET assay involving quenching is a
homogeneous microplate assay technique and requires only mixing and measuring—no
wash steps are required. It can also be miniaturized, which makes it useful for high-
throughput screening applications.

The Cisbio Bioassays HTRF (Homogeneous Time-Resolved Fluorescence) technology is a
proprietary time-resolved fluorescence technology that overcomes many of the drawbacks
of standard Fluorescence Resonance Energy Transfer (FRET) techniques, such as the
requirements to correct for autofluorescence and the fluorescent contributions of unbound
fluorophores. See HTRF Read Mode on page 179.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about setting up a time-resolved fluorescence mode protocol, see Creating a
Time-Resolved Fluorescence Mode Protocol on page 324.
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Time-Resolved Fluorescence Instruments and Detection Cartridges
The following instruments have time-resolved fluorescence read mode capability:
e SpectraMaxi3x and i3 Multi-Mode Detection Platforms, see page 202

The SpectraMax i3x Instrument requires detection cartridges to do time-resolved
fluorescence reads.

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204

The SpectraMax Paradigm Multi-Mode Microplate Reader requires detection cartridges
to do reads.

e SpectraMax M5 and M5e Multi-Mode Microplate Readers, see page 206
e SpectraMax M4 Multi-Mode Microplate Reader, see page 207
e SpectraMax M2 and M2e Multi-Mode Microplate Readers, see page 209
e Gemini XPS Microplate Reader, see page 211
e Gemini EM Microplate Reader, see page 211
e FlexStation 3 Multi-Mode Microplate Reader, see page 212
e FilterMax F5 Multi-Mode Microplate Reader, see page 213
The following detection cartridges have time-resolved fluorescence read mode capability:
e Tunable Wavelength (TUNE) Detection Cartridge, see page 220
e Multi-Mode (MULTI) Detection Cartridge, see page 221
e Cisbio HTRF Detection Cartridge on page 223
e Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge, see page 224

Note: For the SpectraMax i3x Multi-Mode Detection Platform, the detection
cartridges can be used for top reads only.

172 5049092 A



5049092 A

Chapter 5: Read Modes and Read Types

Analyzing Time-Resolved Fluorescence Data

Atime-resolved fluorescence (TRF) measurement includes a number of pulses. Each pulse
consists of turning the light source on and off (Excitation Time), pausing for a specified length
of time (Measurement Delay), and measuring the fluorescence intensity of the sample for a
specified length of time (Integration Time). These pulses are repeated several times, as
specified in the protocol parameters.

Analyzing and interpreting TRF data generally consists of the following:
e Blank Correction on page 173
e Data Normalization on page 173

e Data Optimization on page 174
Blank Correction

Although background is significantly lower than with fluorescence intensity measurements,
Molecular Devices recommends that you use blanks or assay controls.

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.

The blank sample reveals the offset underlying each data sample. This offset does not carry
information on the label, and is generally subtracted before data reduction is done.

For optimal results, Molecular Devices recommends that you run replicates for all blanks,
controls, and samples. In this case, the blank value that can be subtracted is the average
value of all blanks.

Data Normalization

TRF raw data changes in magnitude when the timing parameters are changed. However, TRF
data are normalized for a number of 1000 pulses. This means that the sample raw data does
not change when only the number of pulses is changed.

When selecting a fast read mode, the raw data becomes slightly lower because during the
continuous plate movement, some signal is collected under non-optimal focusing
conditions.
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Data Optimization

There are two timing parameters which can be optimized to adjust the performance of the
measurement as desired: time per well and integration time per cycle.

The measurement noise is dependent on the read time per sample (time per plate or time
per well). In particular, the detection limit improves when the read time is increased.
Therefore, it is important to specify the read time when comparing measurements. For TRF,
the read time per well increases with the selected number of pulses. The time between
pulses and the intensity of each pulse, however, can be different on various systems.

All low-light-level detection devices have some measurement noise in common. To average
out the measurement noise, optimization of the time per well involves accumulating as
many counts as possible. Within some range, you can reduce noise (CVs, detection limit) by
increasing the read time per well, as far as is acceptable from throughput and sample
stability considerations.

To further optimize measurement results, optimize the timing parameters. The following
table and figure can be used as guidelines for the selection of timing parameters.
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Table 5-1: Time-resolved fluorescence timing parameters example

Parameter Value Comment
Pulse length 0.100 ms | The period for excitation of the sample, shown as t; in the
following figure.
This is the suggested value for the TUNE, MULTI, and TRF
detection cartridges.
Measurement delay 0.010 ms | The delay to ensure the excitation pulse is no longer
detectable, shown as t, in the following figure.
This is the suggested value for the TUNE, MULTI and TRF
detection cartridges.
Integration time per 0.890 ms | The period for accumulating the signal, shown as t; in the
cycle (pulse) following figure.
This is the suggested value for the TUNE and MULTI detection
cartridges.
Integration time per 1.890 ms [ The period for accumulating the signal, shown as t; in the
cycle (pulse) following figure.
This is the suggested value for the TRF detection cartridge.
ty
t 1
ts

Figure 5-4: Timing parameters for time-resolved fluorescence
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When neglecting the time delay t, compared to the integration time window t;, the
accumulated signal A can be approximated with the following equation:

A/ Ana = (1—exp(—M)) x 100%
In the previous equation, M is the size of the time window (or integration time) divided by
the exponential decay time constant (or the fluorescence lifetime of the label).

M = (integration time) / (fluorescence lifetime)
For example, using Europium, which has a fluorescence lifetime of 700 us, and the suggested
integration time per cycle of 1.890 ms (or 1890 pus), M = 1890/ 700 = 2.7. Inserting this value
of M into the first equation yields A/ A,..x = 93%.
To optimize the integration time per cycle (pulse), the integration time should be set such
that the value of M produces the desired signal. For example, to get more than 86% signal,
select an integration time such that M is greater than 2.0. Using the previous Europium
example and solving for the integration time, the integration time can be set to M (2.0) times
the fluorescence lifetime (700 us), or 1400 us (1.4 ms).
Table 5-2: Achievable accumulated signal percentage compared to M
M 0.25 0.50 0.75 1.00 1.25 1.50 2.00 3.00

A/ Anal%] 22 39 53 63 71 78 86 95

M can be technically limited by the time between pulses. Further gain in signal above some
value of M can be negligible to improve results.

When performing a dual-label Europium-Samarium measurement, there are more timing
parameters. There is some residual cross-talk of the Samarium signal captured in the
Europium emission channel. Samarium has a much shorter fluorescence lifetime, so to
reduce the cross-talk of Samarium in the Europium channel, Europium is measured in a time
window shifted away from the time window for Samarium. This lets the Europium be
guantified without cross contamination from the Samarium. The known Europium
concentration can then be used to remove the Europium cross-contamination in the
Samarium channel.
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Suggested timing parameters for a dual-label Europium-Samarium measurement are listed in
the following table.

Table 5-3: Time-resolved fluorescence timing parameters for dual-label Europium-

Samarium

Parameter Value Comment

Pulse length 0.100 ms | The time interval for flash monitoring
This is the suggested value for the TRF detection
cartridge.

Measurement delay (first 0.010 ms | The delay to ensure the excitation pulse is no longer

window) detectable
This is the suggested value for the TRF detection
cartridge.

Integration time (first window) 0.100 ms | The period for accumulating the Samarium signal
This is the suggested value for the TRF detection

cartridge.

Measurement delay (second 0.140 ms | The read out of the Samarium signal

window) This is the suggested value for the TRF detection
cartridge.

Integration time (second 0.750 ms | The period for accumulating the Europium signal

window) This is the suggested value for the TRF detection
cartridge.
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Fluorescence resonance energy transfer (FRET) is a distance-dependent interaction between
the electronic excited states of two dye molecules in which excitation is transferred from a
donor molecule to an acceptor molecule without emission of a photon.

FRET relies on the distance-dependent transfer of energy from a donor molecule to an
acceptor molecule. Due to its sensitivity to distance, FRET has been used to investigate
molecular interactions. FRET is the radiationless transmission of energy from a donor
molecule to an acceptor molecule. The donor molecule is the dye or chromophore that
initially absorbs the energy and the acceptor is the chromophore to which the energy is
subsequently transferred. This resonance interaction occurs over greater than interatomic
distances, without conversion to thermal energy, and without a molecular collision. The
transfer of energy leads to a reduction in the fluorescence intensity and excited state lifetime
of the donor, and an increase in the emission intensity of the acceptor. A pair of molecules
that interact in such a manner that FRET occurs is often referred to as a donor/acceptor pair.

While there are many factors that influence FRET, the primary conditions that need to be
met for FRET to occur are relatively few:

e The donor and acceptor molecules must be in close proximity to each other.

e The absorption or excitation spectrum of the acceptor must overlap the fluorescence
emission spectrum of the donor.

The degree to which they overlap is referred to as the spectral overlap integral (J).
e The donor and acceptor transition must be approximately parallel.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about setting up a FRET mode protocol, see Creating a FRET Mode Protocol
on page 327.
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FRET Instruments and Detection Cartridges

The following instruments have FRET read mode capability:
e SpectraMaxi3x and i3 Multi-Mode Detection Platforms, see page 202
To do HTRF reads, the SpectraMax i3x Instrument requires the Cisbio HTRF Detection
Cartridge, see page 223.
e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204

To do HTRF reads, the SpectraMax Paradigm Multi-Mode Microplate Reader requires the
Cisbio HTRF Detection Cartridge, see page 223.

e FilterMax F5 Multi-Mode Microplate Reader, see page 213
e FilterMax F3 Multi-Mode Microplate Reader on page 214

Note: For the SpectraMax i3x Multi-Mode Detection Platform, the detection
cartridges can be used for top reads only.

HTRF Read Mode

5049092 A

Homogeneous time-resolved fluorescence (HTRF) is a measurement technique based on
fluorescence resonance energy transfer (FRET) using the advantages of time-resolved
fluorescence (TRF) reading.

Fluorescence resonance energy transfer (FRET) is a distance-dependent interaction between
the electronic excited states of two dye molecules in which excitation is transferred from a
donor molecule to an acceptor molecule without emission of a photon.

FRET relies on the distance-dependent transfer of energy from a donor molecule to an
acceptor molecule. Due to its sensitivity to distance, FRET has been used to investigate
molecular interactions. FRET is the radiationless transmission of energy from a donor
molecule to an acceptor molecule. The donor molecule is the dye or chromophore that
initially absorbs the energy and the acceptor is the chromophore to which the energy is
subsequently transferred. This resonance interaction occurs over greater than interatomic
distances, without conversion to thermal energy, and without a molecular collision. The
transfer of energy leads to a reduction in the fluorescence intensity and excited state lifetime
of the donor, and an increase in the emission intensity of the acceptor. A pair of molecules
that interact in such a manner that FRET occurs is often referred to as a donor/acceptor pair.

While there are many factors that influence FRET, the primary conditions that need to be
met for FRET to occur are relatively few:
e The donor and acceptor molecules must be in close proximity to each other.

e The absorption or excitation spectrum of the acceptor must overlap the fluorescence
emission spectrum of the donor.

The degree to which they overlap is referred to as the spectral overlap integral (J).

e The donor and acceptor transition must be approximately parallel.
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HTRF uses a donor fluorophore with a long fluorescence lifetime, such as Europium. The
acceptor fluorophore acts as if it also has a long fluorescence lifetime. This lets the time-
gating principle of time-resolved fluorescence be applied to the acceptor emission to
separate specific signal from background and signal caused by compound interference.

Time-gating electronics introduce a delay between the flashes and the start of signal
collection. During the delay, the unspecific fluorescence caused by test compounds, assay
reagents, and the microplate vanishes while only a small portion of the specific fluorescence
from the acceptor fluorophore is sacrificed. Enough of the specific signal remains, with the
benefit of reduced background.

Applications of Homogeneous Time-Resolved Fluorescence

Homogeneous time-resolved fluorescence (HTRF) is used in competitive assays to quantify
the binding between two labeled molecules, or the disintegration of a bound complex.
Binding partners can have similar molecular weights as opposed to fluorescence polarization
read modes. HTRF is a homogeneous assay that requires only mixing and measuring—no
wash steps are required. It can also be miniaturized, which makes it useful for high-
throughput screening applications.

The fluorescence ratio related to the HTRF readout is a correction method developed by
Cisbio, for which Cisbio has granted a license to Molecular Devices. Its application is strictly
limited to the use of HTRF reagents and technology, excluding other TR-FRET technologies
such as IMAP TR-FRET calculations of acceptor to donor ratios.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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HTRF Instruments and Detection Cartridges

The following instruments have HTRF read mode capability:
e SpectraMaxi3x and i3 Multi-Mode Detection Platforms, see page 202
To do HTRF reads, the SpectraMax i3x Instrument requires the Cisbio HTRF Detection
Cartridge, see page 223.
e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204
To do HTRF reads, the SpectraMax Paradigm Multi-Mode Microplate Reader requires the
Cisbio HTRF Detection Cartridge, see page 223.

Note: For the SpectraMax i3x Multi-Mode Detection Platform, the detection
cartridges can be used for top reads only.

HTRF is a registered trademark of Cisbio Bioassays.

Analyzing HTRF Data

A Homogeneous Time-Resolved Fluorescence (HTRF) measurement includes a number of
flash intervals. Each flash interval consists of flashing the lamp, pausing for a specified length
of time, and measuring the fluorescence intensity of the sample. These flash intervals are
repeated several times, as specified in the protocol parameters. See Data Optimization on
page 182.
Analyzing and interpreting HTRF data generally consists of the following:

e Data Reduction on page 182

e Data Optimization on page 182
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Data Reduction

Data reduction for HTRF reads consists of two steps.

First, a ratio of the signal measured by the emission from the acceptor label at 665 nm to the
signal measured by the emission of the donor label at 616 nm is calculated and multiplied by
a factor of 10,000. This generates what is called the HTRF ratio.

In the second step, ratios are calculated that represent the relative change in the HTRF signal
compared to that of the assay background, represented by assay controls potentially named
negative or Standard 0. This relative response ratio is called the Delta F and is formatted as a

percentage, although values greater than 100 can be generated.

Data Optimization

The measurement noise is dependent on the read time per sample (time per plate or time
per well). In particular, the detection limit improves when the read time is increased.
Therefore, it is important to specify the read time when comparing measurements. For TRF,
the read time per well increases with the selected number of pulses. The time between
pulses, however, can be different on various systems.

Table 5-4: HTRF timing parameters example

Parameter Value Comment

Number of pulses 30 The number of flashes per read.

Measurement delay 30 us | The delay to ensure the excitation pulse is no longer
detectable.

Integration time per cycle 400 ps | The period for accumulating the signal.

(pulse)

Defining the number of flashes (pulses) cannot be used for comparative purposes because
the flash and intensity rate varies from system to system.

There are two timing parameters which can be optimized to adjust the performance of the
measurement as desired: time per plate or time per well, and integration time per cycle.

All low-light-level detection devices have some measurement noise in common. To average
out the measurement noise, optimization of the time per well involves accumulating as
many counts as possible. Within some range, you can reduce noise (CVs, detection limit) by
increasing the read time per well, as far as is acceptable from throughput and sample
stability considerations.

As the number of flashes (read time per well) is increased, several aspects of the data
improve:

e Delta F values show less variability (better CVs).

e Small Delta F values are better distinguished from noise.

* Noise of background is reduced.
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The second timing parameter which can be optimized is the Integration time per cycle. Care
must be taken in optimizing the integration time to consider noise. Delta F is higher at low
integration times, but noise is also high at low integration times. The optimal integration
time is where noise is minimized while maximizing Delta F.

In the following example, the optimal integration time (read time per cycle) is displayed to be
in the 500 ps to 1000 ps range, as noise is minimized and Delta F is still relatively high. Going
greater than 1000 ps shows a sharp decline in Delta F without apparent improvement in
noise.

HTRF, RCLPEASZ, Delta F and Noise
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Figure 5-5: Relationship Between Integration Time, Noise, and Delta F
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Z'is the standard statistical parameter in the high-throughput screening community for
measuring the quality of a screening assay independent of test compounds. It is used as a
measure of the signal separation between the positive controls and the negative controls in
an assay.

The value of Z' can be determined using the following formula:
3(SDC+ )+ 3(SDC_)

N | Mean_ —Mean_ |

where SD is the standard deviation, c+ is the positive control, and c—is the negative control.

AZ value greater than or equal to 0.4 is the generally acceptable minimum for an assay.
Higher values might be desired when results are more critical.

Z’is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z’ value, you can increase the quantity of
label in the sample, if acceptable for the assay, or increase the read time per well.
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Fluorescence Polarization Read Mode

Fluorescence polarization (FP) mode measures the relative change of polarization of emitted
fluorescent compared to excitation light.

Fluorescence polarization detection is similar to fluorescence intensity, with the important
difference that it uses plane-polarized light, rather than non-polarized light. Plate readers
measure FP of the sample by detecting light emitted both parallel and perpendicular to the
plane of excitation.

By using a fluorescent dye to label a small molecule, its binding to a different molecule of
equal or greater size can be monitored through its speed of rotation.

When molecules are excited with polarized light, the polarization of the emitted light
depends on the size of the molecule to which the fluorophore is bound. Larger molecules
emit a higher percentage of polarized light, while smaller molecules emit a lower percentage
of polarized light because of their rapid molecular movement. For this reason FP is generally
used for molecular binding assays in high-throughput screening (HTS).

Fluorescence polarization mode returns two sets of data: one for fluorescence intensity
parallel (P) to the excitation plane, and the other for fluorescence intensity perpendicular (S)
to the excitation plane. These S and P values are used to calculate the Polarization (mP) and
Anisotropy (r) values in the SoftMax Pro Software.

The Fluorescence Polarization data for a sample is evaluated based on its relative position
between the low and high control values. See Analyzing Fluorescence Polarization Data on
page 186.

Applications of Fluorescence Polarization

Fluorescence polarization measurements provide information on molecular orientation and
mobility, and are generally used to quantify the success of a binding reaction between a
smaller labeled ligand and a binding site at a much larger or immobilized molecule. FP can
also be used to quantify the dissociation or cleavage of the labeled ligand from a binding site.

FP is a homogeneous microplate assay technique and requires only mixing and measuring—
no wash steps are required as in an ELISA. It can also be miniaturized, which makes it useful
for high-throughput screening applications.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about setting up a fluorescence polarization mode protocol, see Creating a
Fluorescence Polarization Mode Protocol on page 329.
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Fluorescence Polarization Instruments and Detection Cartridges

The following instruments have fluorescence polarization read mode capability:
e SpectraMaxi3x and i3 Multi-Mode Detection Platforms, see page 202

To do fluorescence polarization reads, the SpectraMax i3x Instrument requires a
Fluorescence Polarization (FP) Detection Cartridges, see page 229.

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204

To do fluorescence polarization reads, the SpectraMax Paradigm Multi-Mode Microplate
Reader requires a Fluorescence Polarization (FP) Detection Cartridges, see page 229.

e SpectraMax M5 and M5e Multi-Mode Microplate Readers, see page 206
e FlexStation 3 Multi-Mode Microplate Reader, see page 212
e FilterMax F5 Multi-Mode Microplate Reader, see page 213

Note: For the SpectraMax i3x Multi-Mode Detection Platform, the detection
cartridges can be used for top reads only.

Analyzing Fluorescence Polarization Data

Fluorescence polarization mode returns two sets of data: one for fluorescence intensity
parallel (P) to the excitation plane, and the other for fluorescence intensity perpendicular (S)
to the excitation plane. These S and P values are used to calculate the Polarization (mP) and
Anisotropy (r) values in the SoftMax Pro Software.

FP assays in microplates are generally designed with two control samples:

* LOW control sample: minimal polarization value resulting from unbound labeled ligand
only

e HIGH control sample: maximum polarization value resulting from bound labeled ligand
only

The FP data for a sample is evaluated based on its relative position between the low and high
control values. Total intensity can also be determined from the raw data and is proportional
to the quantity of label in a sample.

Analyzing and interpreting fluorescence polarization data generally consists of the following:
e Blank Correction on page 187
e Data Reduction on page 187
e Data Qualification and Validation on page 188
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Blank Correction

Many fluorescence polarization assays use small fluorescent label concentrations in the
lower nm range. In this range, blank controls become significant when compared to samples.

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.

Background wells, containing all assay components minus the fluorophore, should be
tested. If the signal in the background wells is more than 1/10 the signal in the wells
containing fluorophore, then background wells should be run on each assay plate. The
average raw signal from the background's parallel and perpendicular readings must be
subtracted from the raw parallel and perpendicular readings of each sample well before the
mP calculation is done.

For optimal results, Molecular Devices recommends that you run replicates for all blanks,
controls, and samples. In this case, the blank value that can be subtracted is the average
value of all blanks.

Data Reduction

Fluorescence polarization mode returns two sets of data: one for fluorescence intensity
parallel (P) to the excitation plane, and the other for fluorescence intensity perpendicular (S)
to the excitation plane. These S and P values are used to calculate the Polarization (mP) and
Anisotropy (r) values in the SoftMax Pro Software.

Although the raw S and P values are the true actual values returned from the instrument, the
calculated Polarization (mP) and Anisotropy (r) values are treated as the raw data and
become the basis for further reduction calculations.

Polarization (mP) is calculated as follows:

(parallel - (G * perpendicular))
(parallel + (G  perpendicular))

mP = 1000 *

Anisotropy (r) is calculated as follows:

(parallel - (G * perpendicular))

r=
(parallel + (2G * perpendicular))

The G factor, or grating factor, is used in fluorescence polarization to correct polarization
data for optical artifacts, converting relative mP data to theoretical mP data. Optical
systems, particularly with reflective components, pass light of different polarization with
different efficiency. G factor corrects this instrumental bias.
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Data Qualification and Validation

When validating the data of a fluorescence polarization measurement and the assay, the two
factors to look at are the precision value and the Z’ parameter.

The FP precision value is a measure of replicate uniformity determined by the standard
deviation of replicates at a label concentration of 1 nM. Since the precision of a measured
signal also depends on the read time, the read time must also be specified. Alonger read
time leads to a lower (better) precision value.
Z'is the standard statistical parameter in the high-throughput screening community for
measuring the quality of a screening assay independent of test compounds. It is used as a
measure of the signal separation between the positive controls and the negative controls in
an assay.
The value of Z' can be determined using the following formula:

3(sD,, ) +3(SD, )

- | Mean  —Mean |
c+ [

where SD is the standard deviation, ¢+ is the positive control, and c—is the negative control.

AZ value greater than or equal to 0.4 is the generally acceptable minimum for an assay.
Higher values might be desired when results are more critical.

Z"is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z’ value, you can increase the quantity of
label in the sample, if acceptable for the assay, or increase the read time per well.

The assay window is dependent on the fluorophore lifetime and relative size of the receptor
to the ligand. Precision values are better (lower) at higher signals, which normally come from
higher label concentrations.

For a given assay window, Z" is a downward sloping linear function. That is, as precision
values get higher (worse), the Z" value gets lower (worse).

Precision is dependent upon assay characteristics (sample volume, label concentration) and
read time. In many assays, the characteristics are defined and cannot be changed. In this
case, the only way to improve precision is to increase the read time per well.
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AlphaScreen Read Mode
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ALPHA stands for Amplified Luminescent Proximity Homogeneous Assay. AlphaScreen®is a
bead-based chemistry used to study molecular interactions between moieties A and B, for
example. When a biological interaction between Aand B moves beads (coated with Aand B,
respectively) together, a cascade of chemical reactions produce a greatly amplified signal.

The cascade finally resulting in signal is triggered by laser excitation (680 nm), making a
photosensitizer on the A-beads convert oxygen to an excited (singlet) state. That energized
oxygen diffuses away from the A-bead. When reaching the B-bead in close proximity, it reacts
with a thioxene derivative on the B-bead generating chemiluminescence at 370 nm. Energy
transfer to a fluorescent dye on the same bead shifts the emission wavelength into the

520 nm to 620 nm range. The limited lifetime of singlet oxygen in solvent (~4 microseconds)
lets diffusion reach up to only around 200 nm distance. Thus, only B-beads in the proximity
of A-beads yield signal, which indicates binding between moieties A and B.

An AlphaScreen measurement includes a light pulse, by turning on the laser diode for a
specified time, turning off the laser diode, followed by the measurement of the AlphaScreen
signal, as specified in the measurement protocol timing parameters.

% Note: AlphaScreen beads are light sensitive. Beads are best handled under subdued
(<100 lux) or green filtered (Roscolux filters #389 from Rosco, or equivalent) light
conditions. Do incubation steps in the dark.

The raw data can be normalized to counts per second. See Analyzing AlphaScreen Data on
page 191.
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Applications of AlphaScreen
AlphaScreen reagent and assays are used for drug discovery purposes. Examples of

AlphaScreen assays include:

e G-protein coupled receptor (GPCR) assay kits, for cAAMP quantification or IP3
guantification.

e Tyrosine Kinase assays.
e Cytokine detection kits, such as TNF-alpha detection (immunoassay).
AlphaScreen read mode can also capture the Europium emission line of AlphaLISA®.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about setting up a fluorescence polarization mode protocol, see Creating a
Fluorescence Polarization Mode Protocol on page 329.

AlphaScreen Instruments and Detection Cartridges
The following instruments have AlphaScreen read mode capability:
e SpectraMaxi3x and i3 Multi-Mode Detection Platforms, see page 202

To do AlphaScreen reads, the SpectraMax i3x Instrument requires AlphaScreen Detection
Cartridges , see page 222.

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204

To do AlphaScreen reads, the SpectraMax Paradigm Multi-Mode Microplate Reader
requires AlphaScreen Detection Cartridges , see page 222.

Note: For the SpectraMax i3x Multi-Mode Detection Platform, the detection
cartridges can be used for top reads only.

For more information, go to www.perkinelmer.com.
ALPHASCREEN and ALPHALISA are registered trademarks of PerkinElmer, Inc.
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Analyzing AlphaScreen Data

The conversion rate of photons to counts and relative fluorescence units (RFU) is individual
for each reader. Therefore, raw data from the same microplate can seem to be different from
one instrument to the next. Also, the data format used by instrument manufacturers might
be counts normalized per second or not normalized counts, and therefore the raw data can
be different by several orders of magnitude. It is important to know that the number of
counts and the size of figures is in no way an indication of sensitivity. See Detection Limit on
page 192.

The raw data can be normalized to counts per second by selecting the Normalization option
in the Settings dialog. See Creating a Protocol on page 235.

Analyzing and validating AlphaScreen data can consist of the following:
e Background Correction on page 191
e Detection Limit on page 192
e Data Qualification and Validation on page 192

Background Correction

Although background is significantly lower than with fluorescence intensity measurements,
Molecular Devices recommends that you use blanks or assay controls for background
correction. The background can be effectively measured using blank replicates. When
reading a sample with small signal, an interference can occur from the afterglow of a very
strong emitting adjacent sample that was measured just before. Such cross talk can occur
through the wall of a white 384-well plate. To prevent such interference, you can select the
Interlaced Reading option in the SoftMax Pro Software Settings dialog. This option reads
only every other well in a checkerboard pattern, and then reads the microplate again to read
the previously omitted wells.

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.

For optimal results, Molecular Devices recommends that you run replicates for all blanks,
controls, and samples. In this case, the blank value that can be subtracted is the average
value of all blanks.
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Detection Limit

The detection limit is the smallest sample concentration that can be measured reliably above
the blank. Determining the detection limit requires taking a number of blank measurements
and calculating an average value and standard deviation for the blanks. The detection
threshold is defined as the average blank plus three standard deviations. If the average
sample value measures above the threshold, the sample can be detected at a statistically
significant level.

The detection limit can be described by the following equation:
3 Stdev

blank

std — blank
conc,,

Det Limit =

where concg, is the concentration of the standard, StDevg,,. is the standard deviation of the
blank replicates, and blank and Std are average values of the replicates for the blank and
standard wells.

Data Qualification and Validation

Z'is the standard statistical parameter in the high-throughput screening community for
measuring the quality of a screening assay independent of test compounds. It is used as a
measure of the signal separation between the positive controls and the negative controls in
an assay.

The value of Z' can be determined using the following formula:
3(SD,, ) +3(SD_)

- | Mean_ —Mean |
c+ (o

where SD is the standard deviation, c+ is the positive control, and c—is the negative control.

AZ value greater than or equal to 0.4 is the generally acceptable minimum for an assay.
Higher values might be desired when results are more critical.

Z’is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z" value, you can increase the quantity of
label in the sample, if acceptable for the assay, or increase the read time per well.

A CAUTION! The assay plate and the instrument should be kept at room temperature,
since temperature variations cause fluctuations in signal.
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Western Blot TRF Read Mode
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Protein detection is an important task for pharmaceutical and clinical research, and Western
Blots (WB), or protein immunoblots, are one of the most common methods employed for
this purpose. Various techniques are used to detect proteins on Western Blot membranes
including fluorescence, silver staining, and chemiluminescence. However, each technique has
its limitations, and there is a continuous need to improve quantitation, accuracy, and
dynamic range of Western Blots.

The Molecular Devices ScanLater™ Western Blot Assay Kit is a novel system for protein
analysis that is incorporated into a SpectraMax® Paradigm® or SpectraMax® i3x Multi-Mode
Detection Platform. Membranes are incubated with Eu-chelate labeled secondary antibodies
or streptavidin that bind specifically to the target protein-specific primary antibody.
Europium has a long fluorescence lifetime, on the order of 1 msec, and detection is done in
Time Resolved Fluorescence (TRF) mode which significantly reduces background from auto-
fluorescence or other sources of short lifetime emissions. The membranes are placed into a
microplate reader where they are scanned with the ScanlLater Western Blot (WB) Detection
Cartridge.

The method does not involve enzyme detection, and the Eu-chelates are resistant to photo-
bleaching, so the signal remains stable for long periods of time (weeks to months). This
permits repeat reading of membranes and the potential for comparison of band intensities
to known standards for more accurate quantitation.

The TRF detection employs photon counting, so the theoretical dynamic range is >10°. In
practice, however, dynamic range is limited by saturation of binding sites on high-abundant
bands and non-specific binding to background membrane. There is also no camera
blooming, as can occur with chemiluminescence or fluorescence detection, so the system
gives sharp bands and excellent image quality.

The SpectraMax Western Blot system is a simple, sensitive, and stable platform that
provides excellent Western Blot capability in a SpectraMax Paradigm or SpectraMax i3x
Multi-Mode Detection Platform extending the uses of these essential laboratory
instruments.
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Applications
* |dentify the nature of the protein or epitope effectively. Also, it can be used as a tool for
guantitative analysis of protein.
e Use for chromatography components analysis, sucrose gradient analysis.

* Test the endogenous or exogenous expression of phosphoprotein so as to detect the
phosphorylation signal.

e Protein resilience in the function experiment.

e Structure domain analysis.

* Analysis of the protein expression level.

e Analysis of protein content in the serum.

e Analysis of regulatory proteins expressed in the cell cycle.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about setting up a Western Blot TRF mode protocol, see Creating a Western
Blot TRF Mode Protocol on page 333.

If you are using the SoftMax Pro GxP Software, you must enable the following permissions to
complete a Western Blot membrane read:

¢ Read empty plates/cuvettes to start a read.

» Save data files to save the data file before the read.

* Overwrite plate/cuvette data to do a high-resolution ROl read.

See Using SoftMax Pro GxP Software Features on page 467.

Western Blot TRF Instruments and Detection Cartridges

The following instruments have Western Blot TRF read mode capability:
e SpectraMaxi3x and i3 Multi-Mode Detection Platforms, see page 202

To do Western Blot TRF reads, the SpectraMax i3x Instrument requires the ScanlLater
Western Blot (WB) Detection Cartridge.

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204

To do Western Blot TRF reads, the SpectraMax Paradigm Multi-Mode Microplate Reader
requires the ScanLater Western Blot (WB) Detection Cartridge.

The ScanlLater Western Blot (WB) Detection Cartridge can be used for top reads only.
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Analyzing Western Blot TRF Data

After scanning a membrane for Western Blot data, the data are displayed in the SoftMax Pro
Software as an image. You can use the image tools in the Plate section to zoom, crop,
colorize, and adjust the intensity of the image. You can also select a region of interest (ROI)
and rescan the membrane at a higher resolution. See Viewing Western Blot Membrane Data
on page 443.

Western Blot membrane data are saved as a TIFF image that can be analyzed by the image-
analysis tool of your choice. The SoftMax Pro Software comes with an installed version of the
Imagel software from U.S. National Institute of Health (NIH). See Analyzing a Western Blot
Image on page 450.

For best results, use the Molecular Devices ScanLater™ Western Blot Assay Kit that matches
your application.

To ensure successful acquisition of Western Blot data, see the following topics:
e Blocking Nonspecific Binding on page 195
e Handling the Membrane on page 196

Blocking Nonspecific Binding

To reduce noise, use blocking buffer to reduce non-specific protein from binding with the
membrane.

No single-blocking reagent is optimal for every antigen-antibody pair. Some primary
antibodies can exhibit greatly reduced signal or different nonspecific binding in different
blocking solutions. If you have difficulty detecting your target protein, changing the blocking
solution can dramatically improve the performance. If the primary antibody has worked well
in the past using chemiluminescent detection, try that same blocking solution for detection.
Other commonly used blocking buffers other than BSA are 3% casein and 5% non-fat milk.

Milk-based blockers can contain IgG that can crossreact with anti-goat antibodies. This can
significantly increase background and reduce antibody titer. Milk-based blockers can also
contain endogenous biotin or phosphoepitopes that can cause higher background.

To prevent background speckles on blots, use high-quality, ultra-pure water for buffers.

Do not over-block. Extended blocking times can cause loss of target protein from the
membrane.
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Handling the Membrane

To scan the membrane in a SpectraMax Paradigm or SpectraMax i3x Instrument, the
membrane must be placed in a Molecular Devices ScanLater™ Membrane Holder. See
Loading the Membrane into the Membrane Holder on page 335.

Note: Handle membranes by their edges only, using clean forceps. Do not touch the
membrane with gloved or bare hands.

The maximum size for a membrane is 109 mm x 77 mm to let it fit in the membrane holder.

The Western Blot should be prepared using standard blotting procedures for the membrane
being used. For optimal results, use Millipore Immobilon FL (IPFLO0010). If using PVDF, pre-
wet the membrane in 100% methanol.

Use enough antibody volume so that the entire membrane surface is sufficiently covered
with liquid at all times. Use heat-seal bags if the volume is limiting. Do not let an area of the
membrane dry out. Use agitation for all antibody incubations.

Small proteins can pass through the membrane during transfer (“blow-through”). To prevent
this, use a membrane with a smaller pore size or reduce the transfer time.

Allow the blot to dry for a minimum of 1 hour before detection.

Do not wrap the membrane in plastic when scanning.
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Imaging Read Mode
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To use this read mode, you must have the SpectraMax MiniMax 300 Imaging Cytometer
installed with the SpectraMax i3x Instrument.

Imaging read mode does whole-cell imaging assays.

Whole-cell imaging assays are cell-based, or object-based, rather than the single-point
measurements found in other types of microplate reads. These types of assays can yield
more biologically meaningful results that can discriminate the fluorescence related to
objects, such as cells or beads, from the bulk solution within a microplate well.

The measurement is primarily fluorescent with quantification of cell size, shape, area, and
intensity. Label-free quantification is also supported through brightfield, transmitted light
imaging. The camera resolution in the SpectraMax MiniMax 300 Imaging Cytometer is
sufficient to determine the approximate shape of small 8 micron objects, such as blood cells.

Other advantages of these assays include, the direct interrogation of individual cells instead
of whole well or cell lysates that permit controlling for cell numbers and heterogeneity in cell-
based assays. Also, increased sensitivity by both detecting a few fluorescent cells per well, as
well as detecting cells that are, on average, less fluorescent.

The SpectraMax® MiniMax™ 300 Imaging Cytometer 300 is capable of acquiring image data
using transmitted light and two fluorescent channels during the same microplate read. In the
SoftMax Pro Software Settings dialog, you can select the channels that you want to use for
the acquisition. The StainFree™ Cell Detection Algorithm eliminates cell staining for cell
counting and confluency measurements using proprietary transmitted light analysis
technology.

You can obtain imaging data through visual inspection of the image or by using the analysis
tools available in the SoftMax Pro Software. See Analyzing Imaging Data on page 198.
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Applications of Whole-Cell Imaging

Whole-cell imaging assays measure a diverse set of cellular responses, such as fluorescent
protein expression (phosphorylated and total), cell viability (cell toxicity), cell apoptosis, and
cell cycle analysis.

Supported dyes include the following:
o EarlyTox™ Cell Integrity Kit
e Fluorescein isothiocyanate (FITC)
e Calcein AM
o Alexa Fluor 488 or Alexa Fluor 647
e Cy5
e DRAQ5

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

For information about creating Imaging read mode protocols, see Creating an Imaging Mode
Protocol on page 336.

Imaging Instruments and Detection Cartridges
The following instrument has Imaging read mode capability:
e SpectraMaxi3x and i3 Multi-Mode Detection Platforms, see page 202

The SpectraMax® MiniMax™ 300 Imaging Cytometer adds imaging capability to the
SpectraMax i3x Instrument to visually inspect your sample and to run cell-based assays
at cellular or whole-cell resolution.

To do brightfield, transmitted-light imaging, you must install the
SpectraMax Transmitted Light (TL) Detection Cartridge in the detection cartridge drawer.
See Transmitted Light (TL) Detection Cartridge on page 233.

Analyzing Imaging Data
You can obtain imaging data through visual inspection of the image or by using the analysis
tools available in the SoftMax Pro Software.

In fluorescent imaging, the fluorescence in the sample is excited with light of a specified
wavelength. The fluorophore emits at a longer wavelength that is captured in the image.

The software measures the intensity of the emitted fluorescence and estimates the intensity
of the background in the image.

You can select one of the following image analysis types.
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Discrete Object Analysis

Discrete Object Analysis uses proprietary algorithms to analyze separate objects, or cells,
based on multiple parameters including the signal intensity over the background and the
size of the objects.

When you click Discrete Object Analysis, The Wavelength for Finding Objects list appears
below the list of analysis types. Select the wavelength from this list to use to identify the
objects in the well images. You can use transmitted light or a fluorescent wavelength to find
nuclei or easily separable objects in the image. The StainFree™ Cell Detection Algorithm
eliminates cell staining for cell counting and confluency measurements using proprietary
transmitted light analysis technology.

The Image Analysis Settings category on the left expands to show the subcategories that
follow:

e Click Find Objects to enter size and intensity values or use proprietary algorithms with
the provided drawing tools to graphically define the objects and the background areas
for the analysis. See Finding Discrete Objects or Confluent Areas on page 267.

¢ Click Classify Objects to define separate measurements for different types of found
objects, or cells. See Classifying Discrete Objects on page 271.

¢ Click Select Measurements to view the results of the analysis for the selected wells. See
Viewing and Selecting Measurement Statistics on page 273.

Field Analysis

Field Analysis uses proprietary algorithms to analyze confluent areas based on multiple
parameters including the signal intensity over the background and the size of the areas.

When you click Field Analysis, The Wavelength for Finding Confluent Areas list appears
below the list of analysis types. Select the wavelength from this list to use to identify the
confluent areas in the well images. The StainFree™ Cell Detection Algorithm eliminates cell
staining for cell counting and confluency measurements using proprietary transmitted light
analysis technology.

The Image Analysis Settings category on the left expands to show the subcategories that
follow:

¢ Click Find Confluent Areas to use proprietary algorithms with the provided drawing
tools to graphically define the confluent areas and the background areas for the analysis.
See Finding Discrete Objects or Confluent Areas on page 267.
o Click Select Measurements to view the results of the analysis for the selected wells. See
Viewing and Selecting Measurement Statistics on page 273.
The SoftMax Pro Software proprietary algorithms with the provided drawing tools help the
software learn the patterns of the objects that you want to find. Depending on the
complexity of the object patterns, this teaching process can take several iterations before
you get your desired results. See Resolving Common Issues with Drawing and Finding
Objects on page 275.
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Analysis Measurement Parameters

Depending on the needs of your application, you can use one or more of the following
analysis measurement parameters for the region of interest (ROI) in your experiment:

200

Object Count gives the total number of objects detected in the image. This
measurement is not used for field analysis of confluent areas.

Field Count gives the total number of confluent areas detected in the image. This
measurement is not used for discrete object analysis.

Object Percentage gives the percentage the objects detected in the image by
classification. This measurement is not used for field analysis of confluent areas.

Covered Area gives the combined area of all the objects or confluent areas detected in
the image as a percentage of the entire image area.

Object Area gives the average area of the objects detected in the image expressed in
umz. This measurement is not used for field analysis of confluent areas.

Field Area gives the average area of the confluent areas detected in the image expressed
in umz. This measurement is not used for discrete object analysis.

Object Roundness gives the average roundness of each object detected in the image. A
shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all.
This measurement is not used for field analysis of confluent areas.

Field Roundness gives the average roundness of each confluent area detected in the
image. A shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round
at all. This measurement is not used for discrete object analysis.

Object Average Intensity gives the average fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).

Field Average Intensity gives the average fluorescent signal intensity of the confluent
areas detected in the image. This measurement is not used for discrete object analysis.
This measurement is not used for transmitted light (TL).

Object Intensity gives the average total fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).

Field Intensity gives the average total fluorescent signal intensity of the confluent areas
detected in the image. This measurement is not used for discrete object analysis. This
measurement is not used for transmitted light (TL).

Total Intensity gives the combined total fluorescent signal intensity of the objects or
confluent areas detected in the image expressed in million intensity counts. This
measurement is not used for transmitted light (TL).
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Chapter 6: Supported Instruments and Detection

Cartridges

SoftMax® Pro Data Acquisition and Analysis Software controls Molecular Devices®

spectrophotometers and absorbance, luminescence, and fluorescence microplate readers
and detection platforms.

A detection cartridge contains its own independent light source, optics, and electrical

components needed to do specific read modes for specific applications.

e Theread capabilities of the SpectraMax i3x Instrument can be upgraded with user-

installable detection cartridges.

e The SpectraMax Paradigm Multi-Mode Microplate Reader requires detection cartridges

to do reads.

Supported Instruments
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User guides for each of the supported instruments are installed during the SoftMax Pro

Software installation. You can view these user guides from the Windows Start menu at Start

> All Programs > Molecular Devices > SoftMax Pro 7.0 > Hardware User Guides.

SoftMax Pro Software supports the following instruments:

SpectraMax i3x and i3 Multi-Mode Detection Platforms on page 202
SpectraMax Paradigm Multi-Mode Microplate Reader, see page 204
VersaMax Microplate Reader, see page 205

SpectraMax Plus 384 Absorbance Microplate Reader, see page 205

SpectraMax M5 and M5e Multi-Mode Microplate Readers, see page 206

SpectraMax M4 Multi-Mode Microplate Reader, see page 207
SpectraMax M3 Multi-Mode Microplate Reader, see page 208

SpectraMax M2 and M2e Multi-Mode Microplate Readers, see page 209

SpectraMax 340PC 384 Absorbance Microplate Reader, see page 210
SpectraMax 190 Absorbance Microplate Reader, see page 210
Gemini XPS Microplate Reader, see page 211

Gemini EM Microplate Reader, see page 211

FlexStation 3 Multi-Mode Microplate Reader, see page 212
FilterMax F5 Multi-Mode Microplate Reader, see page 213
FilterMax F3 Multi-Mode Microplate Reader, see page 214

DTX 800 and DTX 880 Multi-Mode Microplate Readers, see page 214
Vmax Kinetic Microplate Reader, see page 215

EMax Endpoint Microplate Reader, see page 215

EMax Plus Microplate Reader on page 215

StakMax Microplate Handling System, see page 216
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A detection cartridge contains its own independent light source, optics, and electrical
components needed to do specific read modes for specific applications.

* Theread capabilities of the SpectraMax i3x Instrument can be upgraded with user-
installable detection cartridges.

e The SpectraMax Paradigm Multi-Mode Microplate Reader requires detection cartridges
to do reads.

See Supported Detection Cartridges on page 218.

SpectraMax i3x and i3 Multi-Mode Detection Platforms

The SpectraMax i3x Multi-Mode Detection Platform is a monochromator-based, multi-mode
detection platform. An external computer running the SoftMax® Pro provides integrated
instrument control, data display, and statistical data analysis.

The built-in read modes include:
e UV and Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
* Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.
e Luminescence (LUM), see Luminescence Read Mode on page 166.

The read capabilities of the SpectraMax i3x Instrument can be upgraded with user-installable
detection cartridges. A detection cartridge contains its own independent light source, optics,
and electrical components needed to do specific read modes for specific applications. Up to
four detection cartridges can be installed in the detection cartridge drawer. For information
about the different detection cartridges, see Supported Detection Cartridges on page 218.

For most read modes, endpoint, kinetic, multi-point well-scan, and spectrum microplate
applications can be set up and run with the SoftMax Pro Software.

For more information on the supported read types, see the following topics:
e Endpoint Read Type on page 152
¢ Kinetic Read Type on page 152
e Well Scan Read Type on page 152
e Spectrum Read Type on page 152
e Flex Read Type on page 153
e Membrane Read Type on page 153

The SpectraMax® MiniMax™ 300 Imaging Cytometer adds imaging capability to the
SpectraMax i3x Instrument to visually inspect your sample and to run cell-based assays at
cellular or whole-cell resolution. See SpectraMax MiniMax 300 Imaging Cytometer on page
203.

Depending on the application, the instrument can read 6, 12, 24, 48, 96, and 384-well
microplates. For micro-volume measurements, the instrument supports the SpectraDrop 24-
well Micro-Volume Microplates and the SpectraDrop 64-well Micro-Volume Microplates.
With some detection cartridges, the instrument is capable of reading 1536-well microplates.
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Features of the SpectraMax i3x Multi-Mode Detection Platform include:
e Built-in, 2x2 monochromators for absorbance, fluorescence, and luminescence reads
e Top and bottom read capability
* More capabilities with detection cartridges, including AlphaScreen
e Adjustable read height (Z-height) for top reads
e Up to 1536-well format with some detection cartridges
e Temperature control
e PathCheck Pathlength Measurement Technology

SpectraMax MiniMax 300 Imaging Cytometer

The SpectraMax® MiniMax™ 300 Imaging Cytometer adds imaging capability to the
SpectraMax i3x Instrument to visually inspect your sample and to run cell-based assays at
cellular or whole-cell resolution. The cytometer uses solid-state illumination, a digital camera,
a 4x objective lens, laser auto-focus, and auto-exposure to capture fluorescent or label-free
images of a sample at the bottom of the microplate wells. The cytometer supports 96-well
and 384-well, flat-bottom, clear-bottom microplates.

The measurement is primarily fluorescent with quantification of cell size, shape, area, and
intensity. Label-free quantification is also supported through brightfield, transmitted light
imaging. The camera resolution in the SpectraMax MiniMax 300 Imaging Cytometer is
sufficient to determine the approximate shape of small 8 micron objects, such as blood cells.

The SpectraMax® MiniMax™ 300 Imaging Cytometer 300 is capable of acquiring image data
using transmitted light and two fluorescent channels during the same microplate read. In the
SoftMax Pro Software Settings dialog, you can select the channels that you want to use for
the acquisition. The StainFree™ Cell Detection Algorithm eliminates cell staining for cell
counting and confluency measurements using proprietary transmitted light analysis
technology.

To do brightfield, transmitted-light imaging, you must install the SpectraMax Transmitted
Light (TL) Detection Cartridge in the detection cartridge drawer. See Transmitted Light (TL)
Detection Cartridge on page 233.
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SpectraMax Paradigm Multi-Mode Microplate Reader

The SpectraMax Paradigm Multi-Mode Microplate Reader is a modular multi-mode
microplate reader. User-installable detection cartridges let the microplate reader be
configured for specific applications, and they expand the capabilities of the microplate
reader. The measurement capabilities of the microplate reader are defined by the installed
detection cartridges.

Up to six detection cartridges can be installed in each of the two detection cartridge drawers
of the SpectraMax Paradigm Multi-Mode Microplate Reader.

Most detection cartridges start with an excitation energy source either in the form of long-
life, high-powered LED, a xenon flash lamp, or a laser diode. By concentrating the excitation
energy on the sample through label-specific optics, high levels of sensitivity and performance
are reached.

For information about the different detection cartridges, see Supported Detection Cartridges
on page 218.

Features of the SpectraMax Paradigm Multi-Mode Microplate Reader include:
e Array of detection cartridge capabilities
e Automatic read height (Z-height) optimization for both top and bottom read
e LED intensity adjustment
e Up to 1536-well format
e Temperature control
* Monochromator and filter based options available
e PathCheck Pathlength Measurement Technology
e AlphaScreen
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VersaMax Microplate Reader

The VersaMax™ Microplate Reader provides rapid and sensitive measurements of a variety
of analytes across a wide range of concentrations. You can run both standard
spectrophotometer and microplate reader applications on the same instrument. Read one
sample or up to 96 at a time. Use standard 96-well microplates.

Detection mode includes:

e Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
VersaMax Microplate Reader features include:

e Full spectral range: 340 nm to 850 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for
the widest range of assays.

e Endpoint and Kinetic reads.

SpectraMax Plus 384 Absorbance Microplate Reader

The SpectraMax® Plus 384 Absorbance Microplate Reader has a built-in cuvette port and
microplate drawer. You can run both standard spectrophotometer and microplate reader
applications on the same instrument. Read one sample or up to 384 at a time. Use a
standard cuvette, 12 x 75 mm test tube, or 96-well or 384-well microplate. For more sample
throughput, the SpectraMax Plus 384 Absorbance Microplate Reader can be integrated into
a full robotic system.
Detection mode includes:

e UV and Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
SpectraMax Plus 384 Absorbance Microplate Reader features include:

e Full spectral range: 190 nm to 1000 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for

the widest range of assays.

e Speed read mode: Reads 96-well microplates in just 5 seconds and 384-well microplates
in 16 seconds for ultra-fast sample throughput.

e PathCheck Pathlength Measurement Technology reports the microplate data as
standard 1 cm cuvette values.
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SpectraMax M5 and M5e Multi-Mode Microplate Readers

The SpectraMax M5 and M5e Multi-Mode Microplate Readers are modular, upgradable,
dual-monochromator microplate reader platforms offering a wide range of high performance
multi-mode capabilities ideal for life science research and drug discovery screening.

The SpectraMax M5 and M5e Multi-Mode Microplate Readers offer triple-mode cuvette
port, accurate temperature control, and microplate shaking capability.

Detection modes include:
e UV and Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
* Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.
e Luminescence (LUM), see Luminescence Read Mode on page 166.

e Time-Resolved Fluorescence (TRF), see Time-Resolved Fluorescence Read Mode on page
171.

* Fluorescence Polarization (FP), see Fluorescence Polarization Read Mode on page 185.
Features of the SpectraMax M5 and M5e Multi-Mode Microplate Readers include:

e Three-mode cuvette port for assay development

e Dual monochromator tunability

e PathCheck Pathlength Measurement Technology

e Endpoint, kinetic, spectral, and well-scanning read types

e Comprehensive Data Analysis with SoftMax Pro Software

¢ Validation and compliance

e Automation compatibility
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SpectraMax M4 Multi-Mode Microplate Reader

The SpectraMax M4 Multi-Mode Microplate Reader is a modular, dual-monochromator
microplate reader platform offering a wide range of high performance multi-mode
capabilities ideal for life science research and drug discovery screening.

The SpectraMax M4 Multi-Mode Microplate Reader offers a triple-mode cuvette port,
accurate temperature control, and microplate shaking capability.

Detection modes include:
e UV and Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
* Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.
e Luminescence (LUM), see Luminescence Read Mode on page 166.

e Time-Resolved Fluorescence (TRF), see Time-Resolved Fluorescence Read Mode on page
171.

Features of the SpectraMax M4 Multi-Mode Microplate Reader include:
e Three-mode cuvette port for assay development
e Dual monochromator tunability
e PathCheck Pathlength Measurement Technology
e Endpoint, kinetic, spectrum, and well scan read types
e Comprehensive Data Analysis with SoftMax Pro Software
¢ Validation and compliance

e Automation compatibility
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SpectraMax M3 Multi-Mode Microplate Reader

The SpectraMax M3 Multi-Mode Microplate Reader is a modular, dual-monochromator
microplate reader platform offering a wide range of high performance multi-mode
capabilities ideal for life science research and drug discovery screening.

The SpectraMax M3 Multi-Mode Microplate Reader offers a triple-mode cuvette port,
accurate temperature control, and microplate shaking capability.

Detection modes include:
e UV and Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
* Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.
e Luminescence (LUM), see Luminescence Read Mode on page 166.
Features of the SpectraMax M3 Multi-Mode Microplate Reader include:
e Three-mode cuvette port for assay development
e Dual monochromator tunability

e Automated Absorbance Pathlength Correction with PathCheck Pathlength
Measurement Technology

e Endpoint, kinetic, spectral and well-scanning read types
e Comprehensive Data Analysis with SoftMax Pro Software
e Validation and compliance

e Robotics compatibility
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SpectraMax M2 and M2e Multi-Mode Microplate Readers

The SpectraMax M2 and M2e Multi-Mode Microplate Readers are instruments with two
monochromators, dual-mode cuvette ports, and top-plate and bottom-plate reading
capability (top-reading only on the SpectraMax M2 Multi-Mode Microplate Reader). Area-
well scanning read types and the PathCheck® Pathlength Measurement Technology let
homogeneous and heterogeneous microplate assays be done in one flexible system.

Detection modes include:
e UV and Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
e Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.
e Luminescence (LUM), see Luminescence Read Mode on page 166.

e Time-Resolved Fluorescence (TRF), see Time-Resolved Fluorescence Read Mode on page
171.

Features of the SpectraMax M2 and M2e Multi-Mode Microplate Readers include:
* Multi-detection capability
e Top-read and bottom-read (SpectraMax M2e Instrument only)
e Dual-mode cuvette port
* Two monochromators
e PathCheck Pathlength Measurement Technology and well volume sensors
e Instrument and software validation

e Automation compatible
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SpectraMax 340PC 384 Absorbance Microplate Reader

The SpectraMax® 340PC 384 Absorbance Microplate Reader provides rapid and sensitive
measurements of a variety of analytes across a wide range of concentrations. You can run
both standard spectrophotometer and microplate reader applications on the same
instrument. Read one sample or up to 384 at a time. Use standard 96-well or 384-well
microplates.

Detection mode includes:
* Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
SpectraMax 340PC 384 Absorbance Microplate Reader features include:
e Full spectral range: 340 nm to 850 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for
the widest range of assays.

e PathCheck Pathlength Measurement Technology reports the microplate data as
standard 1 cm cuvette values.

SpectraMax 190 Absorbance Microplate Reader

The SpectraMax® 190 Absorbance Microplate Reader provides rapid and sensitive
measurements of a variety of analytes across a wide range of concentrations. Read one
sample or up to 96 at a time. Use standard 96-well microplates.

Detection mode includes:

e UV and Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
SpectraMax 190 Absorbance Microplate Reader features include:

e Full spectral range: 190 nm to 850 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for
the widest range of assays.

e PathCheck Pathlength Measurement Technology reports the microplate data as
standard 1 cm cuvette values.
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Gemini XPS Microplate Reader

The Gemini XPS Microplate Reader can do a variety of fluorescent applications. The extreme
flexibility and high sensitivity makes the Gemini XPS Microplate Reader useful for
applications within the fields of biochemistry, cell biology, immunology, molecular biology,
and microbiology.

Detection modes include:
e Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.
e Luminescence (LUM), see Luminescence Read Mode on page 166.

e Time-Resolved Fluorescence (TRF), see Time-Resolved Fluorescence Read Mode on page
171.

Gemini XPS Microplate Reader features include:
e Dual monochromators let you select wavelengths in 1 nm increments.
o Cutofffilters reduce stray light and minimize background interference.

e Wavelength scanning ensures that the most sensitive assay conditions are used.

Gemini EM Microplate Reader

The Gemini EM Microplate Reader can do a variety of fluorescent applications. The extreme
flexibility and high sensitivity makes the Gemini EM Microplate Reader useful for applications
within the fields of biochemistry, cell biology, immunology, molecular biology, and
microbiology. The top-read and bottom-read optical design permits measurements for
solution and cell-based assays.

Detection modes include:
e Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.
e Luminescence (LUM), see Luminescence Read Mode on page 166.

e Time-Resolved Fluorescence (TRF), see Time-Resolved Fluorescence Read Mode on page
171.

Gemini EM Microplate Reader features include:
e Dual monochromators let you select wavelengths in 1 nm increments.
e Cutofffilters reduce stray light and minimize background interference.

e Wavelength scanning ensures that the most sensitive assay conditions are used.
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FlexStation 3 Multi-Mode Microplate Reader

The FlexStation® 3 Multi-Mode Microplate Reader combines the performance of a dual-
monochromator, multi-mode microplate reader and an integrated 8-channel or 16-channel
pipettor into one compact bench-top reader. This integrated system provides a multi-
detection platform capable of increasing liquid-handling throughput and flexibility for
biochemical-based and cell-based assays. The system is equally amenable to agonist and
antagonist assay formats. Combining fluid transfer with multi-detection optics provides a
microplate reader capable of doing a broad span of applications for the drug discovery and
research environments.

Detection modes include:
e UV and Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
* Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.
e Luminescence (LUM), see Luminescence Read Mode on page 166.
e Time-Resolved Fluorescence (TRF), see Time-Resolved Fluorescence Read Mode on page
171.
e Fluorescence Polarization (FP), see Fluorescence Polarization Read Mode on page 185.

The dual monochromators in the FlexStation 3 reader let you target the optimal assay
excitation and emission wavelengths, while eliminating the need to change expensive band
pass filters between experiments.

For most read modes, endpoint, kinetic, multi-point well-scan, and spectrum microplate
applications plus the dedicated flex read type can be set up and run with the SoftMax Pro
Software.
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FilterMax F5 Multi-Mode Microplate Reader

The FilterMax F5 Multi-Mode Microplate Reader is ideal for a broad range of applications,
including drug discovery, genomics, proteomics, and cell-based research. The unique
patented design ensures precise performance and sensitivity across all detection modes.

Detection modes include:

UV and Visible Absorbance (ABS) at wavelengths between 230 nm and 650 nm, see
Absorbance Read Mode on page 154.

Fluorescence Intensity (FL) at wavelengths between 230 nm and 700 nm for top reading,
or between 300 nm and 650 nm for bottom reading, see Fluorescence Intensity Read
Mode on page 160.

Glow-type Luminescence (LUM) at wavelengths between 400 nm and 700 nm, see
Luminescence Read Mode on page 166.

Time-Resolved Fluorescence (TRF) at wavelengths between 340 nm and 700 nm, see
Time-Resolved Fluorescence Read Mode on page 171.

Fluorescence Polarization (FP) at wavelengths between 300 nm and 700 nm, see
Fluorescence Polarization Read Mode on page 185.

Fluorescence Resonance Energy Transfer (FRET), see FRET Read Mode on page 178.

Other features of the FilterMax F5 Multi-Mode Microplate Reader include:

A deuterium light source that extends sensitivity into the deep UV band.
Endpoint, kinetic, multiple wavelength, linear scan, and area scan read types
Measurements on samples in 6, 12, 24, 48, 96, 384, 1536-well microplates.
PathCheck Pathlength Measurement Technology

Automatic read height (Z-height) optimization for top read

Temperature control in the microplate chamber during measurements.

Comprehensive Data Analysis with SoftMax Pro Software

The filters used to do measurements are mounted on two types of interchangeable slides.
Oneslide is reserved for excitation filters used in absorbance and fluorescence
measurements, the other is used for emission filters used in fluorescence and some
luminescence measurements. Each slide can hold up to six filters. For more information, see
Configuring Filter Slides on page 458.
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FilterMax F3 Multi-Mode Microplate Reader

The FilterMax F3 Multi-Mode Microplate Reader is ideal for a broad range of applications,
including drug discovery, genomics, proteomics, and cell-based research. The unique
patented design ensures precise performance and sensitivity across all detection modes.

Detection modes include:

* Visible Absorbance (ABS) at wavelengths between 340 nm and 650 nm, see Absorbance
Read Mode on page 154.

e Fluorescence Intensity (FL) for top reading at wavelengths between 340 nm and 650 nm,
see Fluorescence Intensity Read Mode on page 160.

¢ Glow-type Luminescence (LUM) at wavelengths between 400 nm and 650 nm, see
Luminescence Read Mode on page 166.

e Fluorescence Resonance Energy Transfer (FRET), see FRET Read Mode on page 178.
Other features of the FilterMax F3 Multi-Mode Microplate Reader include:

Endpoint, kinetic, multiple wavelength, linear scan, and area scan read types.
* Measurements on samples in 96-well and 384-well microplates.

e Linear and orbital microplate shaking.

e Comprehensive Data Analysis with the SoftMax Pro Software.

The filters used to do measurements are mounted on two types of interchangeable slides.
Oneslide is reserved for excitation filters used in absorbance and fluorescence
measurements, the other is used for emission filters used in fluorescence and some
luminescence measurements. Each slide can hold up to six filters. For more information, see
Configuring Filter Slides on page 458.

DTX 800 and DTX 880 Multi-Mode Microplate Readers

The DTX 800 and DTX 880 Multi-Mode Microplate Readers are earlier models of the
FilterMax F3 and F5 Multi-Mode Microplate Readers. For information about the DTX 800 and
DTX 880 Multi-Mode Microplate Readers, refer to information in this documentation
regarding the FilterMax F3 and F5 Multi-Mode Microplate Readers.
e Forinformation about the DTX 800 Multi-Mode Microplate Reader, see FilterMax F3
Multi-Mode Microplate Reader on page 214.
e Forinformation about the DTX 880 Multi-Mode Microplate Reader, see FilterMax F5
Multi-Mode Microplate Reader on page 213.
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Vmax Kinetic Microplate Reader

The Vmax Kinetic Microplate Reader measures optical density (OD) and can do a kinetic
analysis, the rate of optical density change per minute (milliOD/min). The optical array is
designed to analyze the absorbance of multiple sample sites with 9 mm centers. Read one
sample or up to 96 at a time. Use standard 96-well microplates.

Detection mode includes:

e Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
Vmax Kinetic Microplate Reader features include:

o Filter range: 400 nm to 750 nm

o Filter capacity: 6

e Optical density: single wavelength and dual wavelength

EMax Endpoint Microplate Reader

The EMax Endpoint Microplate Reader measures optical density (OD). The optical array is
designed to analyze the absorbance of multiple sample sites with 9 mm centers. Read one
sample or up to 96 at a time. Use standard 96-well microplates.

Detection mode includes:

» Visible Absorbance (ABS), see Absorbance Read Mode on page 154.
EMax Endpoint Microplate Reader features include:

o Filter range: 400 nm to 750 nm

o Filter capacity: 6

e Optical density: single wavelength and dual wavelength

EMax Plus Microplate Reader

The EMax® Plus Microplate Reader is a filter-based absorbance microplate reader, with eight
standard filters for a wide range of applications. The instrument can read standard 96-well
microplates.

The instrument has a built-in read mode for visible absorbance (ABS) measurements, see
Absorbance Read Mode on page 154.

Endpoint and kinetic read types are supported. See Endpoint Read Type on page 152 and
Kinetic Read Type on page 152.
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StakMax Microplate Handling System

The StakMax® Microplate Handling System is an integrated microplate stacker for use with
Molecular Devices® microplate readers, providing simple, powerful, walk-away benchtop

automation.

The StakMax Software is accessed from the Operations tab in the ribbon. When you click
Plate Stacker, the SoftMax Pro Software is placed in automation mode, and then the
StakMax Software starts and automatically connects to the StakMax Microplate Handling
System. The current status of the instrument is displayed in the status line of the StakMax

Software window.

Q‘: Molecular

(38 stakMax e e

-

—#Devices StakMax
[ Load Plate ] [ Restack, .. ] [ Reset ] _
[Beturn Plate ] [ Dema, .. ] [ sScripting... § Stop Read |

E Stop |
[] Always on Top Emergency Stop

Status:  StakMax connecked

[.ﬁ.lignment...] [ Help ] [ Skakus indow ]

0 e
0 e
0 e

A CAUTION! To prevent data loss, make sure that Auto Save is enabled for each
protocol you want to run before you start the StakMax Software to run automated

reads. See Setting Auto Save Options on page 76.

To exit the StakMax Software, click Done and then click Terminate in the SoftMax Pro

Software Automation dialog.
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Compatible Instruments

The StakMax Microplate Handling System is compatible with the following microplate
readers:

SpectraMax® Paradigm® Multi-Mode Microplate Reader
SpectraMax® M2 and M2e Multi-Mode Microplate Readers
SpectraMax® M3 Multi-Mode Microplate Reader
SpectraMax® M4 Multi-Mode Microplate Reader
SpectraMax® M5 and M5e Multi-Mode Microplate Readers
SpectraMax® L Microplate Reader

Gemini™ EM and XPS Microplate Readers

Newer models of the following readers are compatible with the StakMax Microplate Handling
System:

SpectraMax® Plus 384 Absorbance Microplate Reader
SpectraMax® 340PC 384 Absorbance Microplate Reader
SpectraMax® 190 Absorbance Microplate Reader

VersaMax™ Microplate Reader

For more information about using the StakMax Microplate Handling System, see the
StakMax Microplate Handling System User Guide or the help available in the StakMax
Software.

For information about the SoftMax Pro Software automation mode, see Using Automation
Mode on page 56.
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Supported Detection Cartridges

A detection cartridge contains its own independent light source, optics, and electrical
components needed to do specific read modes for specific applications.
e Theread capabilities of the SpectraMax i3x Instrument can be upgraded with user-
installable detection cartridges.

e The SpectraMax Paradigm Multi-Mode Microplate Reader requires detection cartridges
to do reads.

Note: For the SpectraMax i3x Multi-Mode Detection Platform, the detection
cartridges can be used for top reads only.

The SoftMax Pro Software supports the following detection cartridges:
e Absorbance Detection Cartridge on page 219
e Tunable Wavelength (TUNE) Detection Cartridge, see page 220
e Multi-Mode (MULTI) Detection Cartridge, see page 221
e AlphaScreen Detection Cartridges , see page 222
e Cisbio HTRF Detection Cartridge on page 223
e Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge, see page 224
e Fluorescence Intensity (FI) Detection Cartridges, see page 225
e Fluorescence Intensity (FI) GeneBLAzer Detection Cartridge, see page 226

e Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection Cartridge, see page
228

e Fluorescence Polarization (FP) Detection Cartridges, see page 229

e Glow Luminescence (LUM) Detection Cartridges, see page 227

e Dual Color Luminescence (LUM) (BRET2) Detection Cartridge, see page 230

e Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge, see page 231
e Scanlater Western Blot (WB) Detection Cartridge on page 232

e |Injector Cartridge on page 233

e Transmitted Light (TL) Detection Cartridge on page 233

For complete descriptions and specifications for each of the supported detection cartridges,
see the SpectraMax i3x Multi-Mode Detection Platform User Guide or the
SpectraMax Paradigm Multi-Mode Microplate Reader User Guide.

Custom detection cartridges can be designed to meet the specific needs of your application.
For more information, see your Molecular Devices representative.
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Absorbance Detection Cartridge

The Absorbance Detection Cartridge combines wavelength scanning and a broad spectrum
wavelength range necessary to address a variety of nucleic acids, proteins, ELISAs, and
immunoassays found in the laboratory. The Absorbance Detection Cartridge uses a
monochromator to do absorbance endpoint, kinetic, well scan, and spectrum read types
(wavelength scanning) measurements.

The Absorbance Detection Cartridge consists of two components: a detection component
(ABS-DET) which measures the absorbance, and an excitation component (ABS-MONO)
which sets the absorbance wavelengths. The detection component is installed in the top
read detection cartridge drawer and occupies one (1) detection cartridge slot. The excitation
component is installed in the bottom read detection cartridge drawer and occupies two (2)
detection cartridge slots. The two components must be installed to do absorbance
measurements with the SpectraMax Paradigm Multi-Mode Microplate Reader.

The SpectraMax i3x Multi-Mode Detection Platform does not support the Absorbance
Detection Cartridge.

Typical Applications

e Nucleic Acid Quantitation
¢ Protein Quantitation

o ELISA

* Immunoassay

e Proliferation/Viability

You can create protocols that use the Absorbance Detection Cartridge in the SoftMax Pro
Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Tunable Wavelength (TUNE) Detection Cartridge

The Tunable Wavelength (TUNE) Detection Cartridge enables several detection modes,
including:
e Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.

e Time-Resolved Fluorescence (TRF), see Time-Resolved Fluorescence Read Mode on page
171.

e Luminescence (LUM), see Luminescence Read Mode on page 166.

The spectral optimization feature of the Tunable Wavelength (TUNE) Detection Cartridge can
help to get the maximum signal-to-background ratio for most fluorophores or luminescence
labels that are compatible with the wavelength ranges.

Using a Spectrum read, you can define a fixed excitation wavelength and scan the emission
wavelengths, or define a fixed emission wavelength and scan the excitation wavelengths. The
spectral optimization helps to get the maximum signal-to-background ratio from a
fluorescent or fluorescently labeled analyte. For more information on using the spectral
optimization feature, see the SoftMax Pro Software application help or user guide.

The Tunable Wavelength (TUNE) Detection Cartridge occupies three (3) slots in the detection
cartridge drawer.

The can do the following read types:
* End Point, see Endpoint Read Type on page 152.
e Kinetic, see Kinetic Read Type on page 152.
e Well Scan, see Well Scan Read Type on page 152.
e Spectrum, see Spectrum Read Type on page 152.

You can create protocols that use the Tunable Wavelength (TUNE) Detection Cartridge in the
SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Multi-Mode (MULTI) Detection Cartridge

Optimized for 96-well and 384-well plates, the Multi-Mode (MULTI) Detection Cartridge
enables several detection modes, including:

e Fluorescence Intensity (FL), see Fluorescence Intensity Read Mode on page 160.

e Time-Resolved Fluorescence (TRF), see Time-Resolved Fluorescence Read Mode on page
171.

e Luminescence (LUM), see Luminescence Read Mode on page 166.

The Multi-Mode (MULTI) Detection Cartridge occupies three (3) slots in the detection
cartridge drawer.

The can do the following read types:
* End Point, see Endpoint Read Type on page 152.
e Kinetic, see Kinetic Read Type on page 152.
e Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the Multi-Mode (MULTI) Detection Cartridge in the
SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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AlphaScreen Detection Cartridges

The AlphaScreen® Detection Cartridges use a 680 nm laser diode to provide a sensitive
reading system for AlphaScreen assays. The design isolates each well and enables the
optimal performance for AlphaScreen assays. The detection cartridges also capture the
Europium emission line of AlphaLISA®.

The following AlphaScreen Detection Cartridges are available:

e AlphaScreen 384 Std Detection Cartridge

e AlphaScreen 384 HTS Detection Cartridge

e AlphaScreen 1536 HTS Detection Cartridge
Each AlphaScreen Detection Cartridge occupies one (1) slot in the detection cartridge drawer.
The AlphaScreen Detection Cartridges can do the following read types:

e End Point, see Endpoint Read Type on page 152.

¢ Kinetic, see Kinetic Read Type on page 152.

e Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the AlphaScreen Detection Cartridges in the SoftMax Pro
Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

ALPHASCREEN and ALPHALISA are registered trademarks of PerkinElmer, Inc.
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Cisbio HTRF Detection Cartridge

The Cisbio HTRF Detection Cartridge uses a high-energy Xenon flash lamp for sensitive
reading of HTRF reagents. Also, the standard dual-emission design gives the most accurate
results in short overall read time. This detection cartridge enables time-resolved fluorescence
read modes for europium cryptate and europium acceptors.

The fluorescence ratio related to the HTRF readout is a correction method developed by
Cisbio, for which Cisbio has granted a license to Molecular Devices. Its application is strictly
limited to the use of HTRF reagents and technology, excluding other TR-FRET technologies
such as IMAP TR-FRET calculations of acceptor to donor ratios.

The Cisbio HTRF Detection Cartridge is a dual-emission detection cartridge and occupies two
(2) slots in the detection cartridge drawer.

The Cisbio HTRF Detection Cartridges can do the following read types:
* End Point, see Endpoint Read Type on page 152.
* Kinetic, see Kinetic Read Type on page 152.
e Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the Cisbio HTRF Detection Cartridges in the SoftMax Pro
Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

HTRF is a registered trademark of Cisbio Bioassays.
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Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge

The Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge enables time-resolved
fluorescence read modes for Europium and Samarium. It is ideal for protein interaction,
GPCR, and enzyme activity applications.

The Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge occupies one (1) slot in the
detection cartridge drawer.

The can do the following read types:
e End Point, see Endpoint Read Type on page 152.
* Kinetic, see Kinetic Read Type on page 152.
* Well Scan, see Well Scan Read Type on page 152.
Well scan is not available for dual-label assays.

You can create protocols that use the Time Resolved Fluorescence (TRF-EUSA) Detection
Cartridge in the SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Fluorescence Intensity (Fl) Detection Cartridges

The Fluorescence Intensity (FI) Detection Cartridges use an ultra high power LED for the
excitation of various fluorescent labels, enabling fluorescence intensity read modes. Also, the
standard dual-emission design enables simple, straightforward fluorescence resonance
energy transfer (FRET) measurement.

The following Fluorescence Intensity (FI) Detection Cartridges are available:
e Fluorescence Intensity (FI) (coum-fluor) Detection Cartridge
e Fluorescence Intensity (Fl) (fluor-rhod) Detection Cartridge
e Fluorescence Intensity (FI) (Cy3-Cy5) Detection Cartridge
e Fluorescence Intensity (FI) (CFP-YFP) Detection Cartridge

Other Fluorescence Intensity (FI) Detection Cartridges include the Fluorescence Intensity (FI)
GeneBLAzer Detection Cartridge on page 226 and the Fluorescence Intensity Dual Label (FI-
DL) (MultiTox-Fluor) Detection Cartridge on page 228.

Each Fluorescence Intensity (FI) Detection Cartridge occupies one (1) slot in the detection
cartridge drawer.

The Fluorescence Intensity (FI) Detection Cartridges can do the following read types:
e End Point, see Endpoint Read Type on page 152.
* Kinetic, see Kinetic Read Type on page 152.
e Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the Fluorescence Intensity (FI) Detection Cartridges in the
SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Fluorescence Intensity (FI) GeneBLAzer Detection Cartridge

The Fluorescence Intensity (FI) GeneBLAzer Detection Cartridge is designed for use with
GeneBLAzer assays from Invitrogen. Also, the standard dual-emission design enables
fluorescence resonance energy transfer (FRET) measurement.

The Fluorescence Intensity (FI) GeneBLAzer Detection Cartridge occupies one (1) slot in the
detection cartridge drawer.

The can do the following read types:
e End Point, see Endpoint Read Type on page 152.
* Kinetic, see Kinetic Read Type on page 152.
* Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the Fluorescence Intensity (FI) GeneBLAzer Detection
Cartridge in the SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Glow Luminescence (LUM) Detection Cartridges

The Glow Luminescence (LUM) Detection Cartridges enable luminescence read modes.

The three Glow Luminescence (LUM) Detection Cartridges are individually optimized for 1536-
well, 384-well, or 96-well microplate formats:

¢ Glow Luminescence (LUM) Detection Cartridge
e Glow Luminescence (LUM) Detection Cartridge (384)
¢ Glow Luminescence (LUM) Detection Cartridge (96)

For dual-color luminescence, see the Dual Color Luminescence (LUM) (BRET2) Detection
Cartridge on page 230 and the Dual Color Luminescence (LUM) (Chroma-Glo) Detection
Cartridge on page 231.

Each Glow Luminescence (LUM) Detection Cartridge occupies one (1) slot in the detection
cartridge drawer.

The Glow Luminescence (LUM) Detection Cartridges can do the following read types:
* End Point, see Endpoint Read Type on page 152.
* Kinetic, see Kinetic Read Type on page 152.
e Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the Glow Luminescence (LUM) Detection Cartridges in the
SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection
Cartridge

The Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection Cartridge uses ultra
high-powered LEDs for the excitation of a dual set of fluorescent labels. This detection
cartridge has been optimized for detection of the label set used in the MultiTox-Fluor
Multiplex Cytotoxicity Assay from Promega:

e AFC (amino-fluorocoumarin)
e R110 (rhodamine 110)

The Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection Cartridge occupies
one (1) slot in the detection cartridge drawer.

The can do the following read types:
e End Point, see Endpoint Read Type on page 152.
* Kinetic, see Kinetic Read Type on page 152.
e Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the Fluorescence Intensity Dual Label (FI-DL) (MultiTox-
Fluor) Detection Cartridge in the SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Fluorescence Polarization (FP) Detection Cartridges

The Fluorescence Polarization (FP) Detection Cartridges enable fluorescence polarization
read modes for specific labels, depending on the cartridge.

Fluorescence Polarization (FP) Detection Cartridges are available for the following labels:
e Fluorescence Polarization (FP) (Fluorescein) Detection Cartridge
e Fluorescence Polarization (FP) (Rhodamine) Detection Cartridge

Each Fluorescence Polarization (FP) Detection Cartridge occupies one (1) slot in the detection
cartridge drawer.

The can do the following read types:
e End Point, see Endpoint Read Type on page 152.
* Kinetic, see Kinetic Read Type on page 152.

You can create protocols that use the Fluorescence Polarization (FP) Detection Cartridges in
the SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Dual Color Luminescence (LUM) (BRET2) Detection Cartridge

The Dual Color Luminescence (LUM) (BRET2) Detection Cartridge enables read modes for
luminescence and is designed to provide the optimal performance when used with Perkin
Elmer BRET reagents.

For luminescence measurements that do not require emission filters, see Glow
Luminescence (LUM) Detection Cartridges on page 227.

The Dual Color Luminescence (LUM) (BRET2) Detection Cartridge occupies one (1) slot in the
detection cartridge drawer.

The can do the following read types:
e End Point, see Endpoint Read Type on page 152.
e Kinetic, see Kinetic Read Type on page 152.
e Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the Dual Color Luminescence (LUM) (BRET2) Detection
Cartridge in the SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

BRET is a trademark of PerkinElmer, Inc.
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Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge

The Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge enables read modes
for luminescence and is designed to provide the optimal performance when used with
Promega Chroma-Glo™ reagents.

For luminescence measurements that do not require emission filters, see Glow
Luminescence (LUM) Detection Cartridges on page 227.

The Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge occupies one (1) slot
in the detection cartridge drawer.

The can do the following read types:
* End Point, see Endpoint Read Type on page 152.
e Kinetic, see Kinetic Read Type on page 152.
e Well Scan, see Well Scan Read Type on page 152.

You can create protocols that use the Dual Color Luminescence (LUM) (Chroma-Glo)
Detection Cartridge in the SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

Chroma-Glo is a trademark of Promega Corporation.
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ScanlLater Western Blot (WB) Detection Cartridge

The ScanlLater™ Western Blot (WB) Detection Cartridge enables time-resolved fluorescence
read mode for Western Blot membranes.

The Molecular Devices ScanLater™ Western Blot Assay Kit is a novel system for protein
analysis that is incorporated into a SpectraMax® Paradigm® or SpectraMax® i3x Multi-Mode
Detection Platform. Membranes are incubated with Eu-chelate labeled secondary antibodies
or streptavidin that bind specifically to the target protein-specific primary antibody. For
more information, contact your representative or search the knowledge base for ScanLater
or Western Blot at www.moleculardevices.com/support.

The ScanlLater Western Blot (WB) Detection Cartridge occupies two (2) slots in the detection
cartridge drawer.

Western Blot reads use time-resolved fluorescence read mode with a membrane read type.
See Membrane Read Type on page 153.

You can create protocols that use the ScanLater Western Blot (WB) Detection Cartridge in the
SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

If you are using the SoftMax Pro GxP Software, you must enable the following permissions to
complete a Western Blot membrane read:

* Read empty plates/cuvettes to start a read.
» Save data files to save the data file before the read.
e Overwrite plate/cuvette data to do a high-resolution ROI read.

See Using SoftMax Pro GxP Software Features on page 467.
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Injector Cartridge

The SpectraMax® Injector Cartridge adds injector capability to the SpectraMax i3x
Instrument. You can use the injectors and optics in the Injector Cartridge for luminescence
reads from the top of the sample, or use the injectors in the cartridge along with the built-in
Monochromator in the SpectraMax i3x Instrument for fluorescence intensity reads from the
bottom of the sample. To do a read with injection, you must first install the Injector
Cartridge in the detection cartridge drawer.

The Injector Cartridge is installed in the two rear-most slots (3 and 4) in the detection
cartridge drawer.

You can create protocols that use the Injector Cartridge in the SoftMax Pro Software. See
Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.

To define the settings for a read with injection, you must use the Acquisition View of the
Settings dialog. See Using the Acquisition View on page 240.

Transmitted Light (TL) Detection Cartridge

To do brightfield, transmitted-light imaging, you must install the SpectraMax Transmitted
Light (TL) Detection Cartridge in the detection cartridge drawer. The Transmitted Light (TL)
Detection Cartridge provides white LED illumination for transmitted-light imaging when used
with the SpectraMax MiniMax 300 Imaging Cytometer. The StainFree™ Cell Detection
Algorithm eliminates cell staining for cell counting and confluency measurements using
proprietary transmitted light analysis technology.

The Transmitted Light (TL) Detection Cartridge occupies one (1) slot in the detection cartridge
drawer.

You can create protocols that use the Transmitted Light (TL) Detection Cartridge in the
SoftMax Pro Software. See Creating a Protocol on page 235.

You can use the Protocol Manager in the SoftMax Pro Software to quickly find and open a
predefined protocol. See Using the Protocol Manager to Open a File on page 68.

More protocols and updated protocols can be downloaded from the protocol sharing web
site (www.softmaxpro.org). See Using the Protocols Tab to Manage Protocols on page 42.
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Chapter 7: Collecting Data

A general process for preparing, collecting, and analyzing data is as follows:
1. Startthe SoftMax Pro Software. See Starting the Software on page 14.
2. Select an instrument. See Selecting and Connecting to an Instrument on page 16.

3. Choose a data acquisition protocol. You can use an existing protocol or create a new
one.

e To use an existing protocol, see Opening a Protocol File on page 74.
e To set up a new protocol, see Creating a Protocol on page 235.
Prepare the microplate or the cuvette and insert it into the instrument.

5. Before starting a read, it is good practice to save your data file. For Imaging reads and
Western Blot reads, you must save your data file before starting the read. See Saving
Data Files on page 65.

6. Click the Read u button to read the microplate or the cuvette. See Collecting Data
from a Microplate on page 339, Collecting Data From a Cuvette on page 350, or
Collecting Data from a Membrane Holder on page 352.

Analyze the data. See Analyzing Data on page 355.

Save the acquired data, see Saving Data Files on page 65.

Creating a Protocol

5049092 A

Protocols contain instrument settings, template maps, data reduction, and display options.
Templates are maps to the contents of a microplate or the cuvettes in a cuvette set, and how
the data will be collected and displayed.

Application notes with specific application protocol suggestions can be found in the
Information Center and the Knowledge Base on the Molecular Devices web site at
www.moleculardevices.com.

You can manage protocols using the Protocol Manager on the Protocols tab in the ribbon.
See Using the Protocols Tab to Manage Protocols on page 42.

You can create as many different protocols as you need. You can create a new protocol from
a blank file or by modifying an existing protocol and saving it under a new name.

To create a protocol, follow these steps:
1. Startthe SoftMax Pro Software. See Starting the Software on page 14.

2. Select the instrument to be used with the protocol. See Selecting and Connecting to an
Instrument on page 16.

3. Define the instrument settings to use with the protocol. See Selecting Instrument
Settings on page 236.

Create a template, if applicable. See Configuring a Microplate Template on page 301.
5. Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.
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6. Save the settings to a protocol file. See Saving the Settings to a Protocol File on page 338.
7. Set Display options, if applicable. See Setting the Data Display Options on page 358.

Selecting Instrument Settings

236

The Plate sections or Cuvette Set sections in a file or experiment generally use the same
instrument, but they can have different parameters for the instrument settings.

Use the Settings dialog to configure all parameters for a microplate or cuvette read, such as
the read type (Endpoint, Kinetic, Spectrum, Well Scan, Membrane), the read mode
(Absorbance, Fluorescence, Luminescence, Time Resolved Fluorescence, Fluorescence
Polarization, ALPHAScreen, FRET, Imaging), wavelength settings, microplate type, wells to
read, PathCheck technology, optics settings, shake parameters, timing for Kinetic runs,
speed read, and more.
To select and connect to an instrument see, Selecting and Connecting to an Instrument on
page 16.
To open the Settings dialog:
1. Click a Plate section or Cuvette Set section to make it active in the workspace.

Q
2. Click Settings "% on the Home tab in the ribbon or in the toolbar at the top of the

active section.

The available options in the Settings dialog depend on the instrument, read mode, and read
type that is selected.

For the SpectraMax i3 and i3x Instruments, the Settings dialog has two methods available for
configuring a microplate read.

e The Standard View uses a table-like design, with selectable categories where you can
configure your settings. See Using the Standard View on page 237.

e The Acquisition View uses a workflow design, with drag-and-drop tools to configure
your settings. See Using the Acquisition View on page 240.

To switch between the views, click Standard View or Acquisition View in the lower-left
corner of the Settings dialog.

P
| Standard View Acquisition View

After defining the settings for the protocol, click OK to close the Settings dialog.
To continue creating the protocol see the following:
» Create a template, if applicable. See Configuring a Microplate Template on page 301.
e Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.
e Save the settings to a protocol file. See Saving the Settings to a Protocol File on page 338.

Before starting a read, it is good practice to save your data file. For Imaging reads and
Western Blot reads, you must save your data file before starting the read. See Saving Data
Files on page 65.
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Using the Standard View

The Standard View uses a table-like design, with selectable categories where you can
configure your settings. This view is available for all supported instruments. It does not
support reads with injection. To define the settings for a read with injection, use the
Acquisition View. See Using the Acquisition View on page 240.

Note: If you have defined an Imaging read or a ScanLater Western Blot read, switching
to Acquisition View removes the related settings.
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For the SpectraMax Paradigm, SpectraMax i3, and i3x Instruments, select the optical
configuration or detection cartridge to use. See Selecting the Optical Configuration or
Detection Cartridge on page 239.

For all instruments, select the read mode and read type for the protocol. See Selecting the
Read Mode on page 240 and Selecting the Read Type on page 240.

Select a Category from the list on the left to view and edit the available settings in the center
pane. The Settings Information pane displays the defined settings.

The available options in the Settings dialog depend on the instrument, read mode, and read
type that is selected. For information about the available settings, see the following topics:

e Wavelength Settings on page 247

e Plate Type Settings on page 250

e Read Area Settings on page 255
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After defining the settings for the protocol, click OK to close the Settings dialog.

PathCheck Technology Settings on page 257
TRF Settings on page 258

PMT and Optics Settings on page 258
Timing Settings on page 260

Well Scan Settings on page 261

Shake Settings on page 262

Speed Read on page 262

Well Area Settings on page 263

Image Acquisition Settings on page 264
Image Analysis Settings on page 266

Region of Interest Settings on page 281
Settings for Reads with Injection on page 282
More Settings on page 285

Compound Transfer Settings on page 289
Compound Source Settings on page 292
Pipette Tips Layout Settings on page 293

Compound and Tips Columns Settings on page 293

Triturate Settings on page 296

Before starting a read, it is good practice to save your data file. For Imaging reads and
Western Blot reads, you must save your data file before starting the read. See Saving Data
Files on page 65.
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Selecting the Optical Configuration or Detection Cartridge

Select an Optical Configuration or a Cartridge from those shown at the top of the Settings
dialog.

A detection cartridge contains its own independent light source, optics, and electrical
components needed to do specific read modes for specific applications.

e Theread capabilities of the SpectraMax i3x Instrument can be upgraded with user-
installable detection cartridges.

e The SpectraMax Paradigm Multi-Mode Microplate Reader requires detection cartridges
to do reads.

For the SpectraMax i3x Instrument, you can select Monochromator to use the built-in read
modes. To use an installed SpectraMax MiniMax 300 Imaging Cytometer for imaging reads,
select MiniMax. For transmitted light imaging, you need to install the Transmitted Light (TL)
Detection Cartridge, but do not need to select it in the Settings dialog.

Note: When you select to work Offline in the Instrument Connection dialog, you can
see all the detection cartridges that the SpectraMax i3x Multi-Mode Detection
Platform or SpectraMax Paradigm Multi-Mode Microplate Reader can support.

When you are actually connected to the instrument, you see only the detection
cartridges that are installed in the instrument.

For the SpectraMax i3x Multi-Mode Detection Platform, the detection cartridges can be used
for top reads only.

For information on the available detection cartridges, see Supported Detection Cartridges on
page 218.

After selecting the optical configuration or detection cartridge to use, select the read mode
and read type for the protocol. See Selecting the Read Mode on page 240 and Selecting the
Read Type on page 240.
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Selecting the Read Mode

In the Settings dialog, select the Read Mode for the protocol.

For more information on the supported read modes, see the following topics:

Absorbance Read Mode on page 154

Fluorescence Intensity Read Mode on page 160
Luminescence Read Mode on page 166
Time-Resolved Fluorescence Read Mode on page 171
HTRF Read Mode on page 179

FRET Read Mode on page 178

Fluorescence Polarization Read Mode on page 185
AlphaScreen Read Mode on page 189

Western Blot TRF Read Mode on page 193

Imaging Read Mode on page 197

After selecting the Read Mode, select a Read Type. See Selecting the Read Type on page 240.

Selecting the Read Type

After selecting the Read Mode, select a Read Type for the protocol.

For more information on the supported read types, see the following topics:

Endpoint Read Type on page 152
Kinetic Read Type on page 152
Well Scan Read Type on page 152
Spectrum Read Type on page 152
Flex Read Type on page 153
Membrane Read Type on page 153

After selecting the Read Mode and Read Type, select a Category from the list and edit the
available settings.

After defining the settings for the protocol, click OK to close the Settings dialog.

Using the Acquisition View

The Acquisition View uses a workflow design, with drag-and-drop tools to configure your
settings. This view is available for the SpectraMax i3 and i3x Instruments. It does not support
Imaging reads and ScanLater Western Blot reads. To define the settings for a Imaging reads
and Western Blot reads, use the Standard View. See Using the Standard View on page 237.

Note: If you have defined a read with injection, switching to Standard View removes
the related settings.
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From the top section, select the microplate type and configuration, including the Read Area
and the Read Order. See the following topics:

e Plate Type Settings on page 250

e Read Area Settings on page 255

e Read Order on page 286

The Acquisition Plan section displays the time line of steps that have been defined for the
protocol. The defined steps occur in order from left to right between the Start and End
nodes. When an step has multiple settings, these setting are displayed below the step in the
time line.
e To quickly start an acquisition plan, select a template from the Load Predefined
Acquisition Template list.
e To delete the existing plan and start from scratch, click Clear All.

You can drag Acquisitions, Actions, and Loops from the Toolbox to the time line. The time
line lets you drop nodes only in appropriate places for the specific step. For example, the
Optimization node can be placed only at the beginning of the time line.
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You can double-click Acquisitions, Actions, and Loops in the Toolbox to place the node in
the first appropriate position for that node on the time line.

When you drop an Acquisition node onto the time line, you must select from the available
options.

e Some Acquisition nodes require you to Select Hardware, or the optical configuration for
the read. This can be the Monochromator or a related detection cartridge. See
Supported Detection Cartridges on page 218.

e All Acquisition nodes require you to select the read type, such as endpoint or kinetic.
For more information on the supported read types, see the following topics:

e Endpoint Read Type on page 152
e Kinetic Read Type on page 152

e Spectrum Read Type on page 152
e Well Scan Read Type on page 152

For information about adding Actions and Loops, see Adding Actions and Loops to the Time
Line on page 243.

For information about creating a read with injectors, see Defining Reads with Injection on
page 244.

When you click an editable node, a pencil icon appears. Click the pencil icon to open a
settings window related to that node.

(x]2)

To delete the node, click the red X, if available.

After you finish editing the settings, click the workspace outside of the settings window to
close the window.

For information about the available settings, see the following topics:

e Wavelength Settings on page 247

e Timing Settings on page 260

e Shake Settings on page 262

e Speed Read on page 262

e PathCheck Technology Settings on page 257

e Well Scan Settings on page 261

e PMT and Optics Settings on page 258

e Normalization of AlphaScreen Data on page 288

e Background Correction with Interlaced Readings on page 288
After defining the settings for the protocol, click OK to close the Settings dialog.

Before starting a read, it is a good practice to save your data file. See Saving Data Files on
page 65.

5049092 A



5049092 A

Chapter 7: Collecting Data

Adding Actions and Loops to the Time Line

You can drag Actions and Loops from the Toolbox to the time line. The time line lets you
drop nodes only in appropriate places for the specific action or loop. For example, the Plate
Optimizer node can be placed only at the beginning of the time line.

When you double-click Actions and Loops in the Toolbox, the node is placed in the first
appropriate position for that node on the time line.

The following Actions and Loops are available in the Toolbox.

Table 7-1: Available Actions and Loops

Node Description

B

Shake lets you define options for automated shaking of the microplate in the chamber. See
Shake Settings on page 262.

To shake the microplate at the same time as an injection step, use the Smartinject
technology.

Plate Optimizer causes the Pre-Read Optimization Options dialog to open before the
microplate is read. This step can be placed only at the beginning of the time line. See Show
Pre-Read Optimization Options on page 287.

D

Delay lets you define the number of seconds to wait between steps in the time line. You can
set the delay from 0.001 seconds to 100 seconds. For information on setting a delay after an
injection, see Defining Reads with Injection on page 244.

&

Inject adds a step for injection. See Defining Reads with Injection on page 244.

@

Smartinject™ technology adds a step for injection while shaking the microplate. The
microplate continues to shake through the following delay step, if included, and stops
shaking before the well is read. See Defining Reads with Injection on page 244.

Baseline takes the defined number of baseline reads before the Inject or Smartinject step
of a kinetic read with injection. The baseline data can be subtracted from the reads that
follow the injection. See Defining Reads with Injection on page 244.

For Each Well runs the steps in the time line for each well individually with all the defined
injections, delays, and reads before running the steps again for the next well. The Next Well
node is also added to the end of the time line.
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Defining Reads with Injection

To define the settings for a read with injection, you must use the Acquisition View of the
Settings dialog.

To do a read with injection, you must first install the Injector Cartridge in the SpectraMax i3x
Instrument. You can use the Injector Cartridge for luminescence reads, or use the built-in
Monochromator in the SpectraMax i3x Instrument for fluorescence intensity reads with
injection.
e When you add a luminescence (LUM) step to the time line, select INJECTOR from the
Select Hardware list to use the Injector Cartridge for the read. Aluminescence read with
injection is taken from the top of the microplate.

* When you add a fluorescence intensity (FL) step to the time line select MONO from the
Select Hardware list to use the built-in Monochromator for the read. A fluorescence
intensity read with injection is taken from the bottom of the microplate.

Reads with injection are generally done well-by-well. Double-click For Each Well in the
Toolbox to have the steps in the time line run for each well individually with all the defined
injections, delays, and reads before running the steps again for the next well. The Next Well
node is also added to the end of the time line. Add the steps for your assay between these
nodes.

To add a simple injection step, drag the Inject node to the time line and drop the node
before the LUM Read or FL Read step.

e To shake the microplate after the injection, add a Shake step between the injection step
and the read step.

e To shake the microplate during the injection, use the Smartinject node instead of the
Inject node, and do not add a Shake step. The Smartinject™ technology shakes the
microplate during the injection and continues to shake through the following delay step,
if a Delay node follows the Smartinject node. The microplate stops shaking before the
well is read.

To define the settings for the injection step, click the Inject node or the Smartinject node
and then click the pencil icon to open a settings window. Select the injector to use and type
the number of microliters (pL) to dispense. You can dispense from 1 L to the maximum
allowable volume of the well, based on the selected microplate type. Define the dispense
volume based on the requirements of your assay and the net volume available in the well.
You can add a Delay step after the injection ends and before the read begins, if required. You
can set the delay from 0.001 seconds to 100 seconds.

e Forluminescence reads, there is always a delay of 0.3 seconds after the injection ends
and before the read begins to allow time for the detector to move into position for the
read.

e For fluorescence intensity reads, there is no delay for injector number 1. The read starts
at the same time as the injection unless a Delay step is added. For injector number 2,
there is always a delay of 0.3 seconds after the injection ends and before the read begins.

5049092 A



5049092 A

Chapter 7: Collecting Data

The Delay step compensates for the hardware delay. If the defined delay is longer than the
hardware delay, then the actual delay time is the defined delay time. However, if the defined
delay is shorter than the hardware delay, then the actual delay time is the hardware delay
time. For example, if a luminescence read has a defined delay of 1 second, then the actual
delay time between the end of the injection and the beginning of the read is 1 second.
However, if a luminescence read has a defined delay of 0.05 seconds, then the actual delay
time between the end of the injection and the beginning of the read is 0.3 seconds due to
the hardware delay.

You can take baseline reads before the injection step of a kinetic read by double-clicking
Baseline in the Toolbox. The Baseline step is added to the time line before the injection step.
Click the pencil icon and type the number of baseline reads. You can define from 1to 999
baseline reads. Baseline reads use the settings defined in the LUM Read or FL Read step. The
baseline data can be subtracted from the reads that follow the injection. You can use the
Formula Editor to automate baseline subtraction. See Adding a New Summary Formula on
page 115. More information about baseline subtraction can be found in the Formula
Reference Guide.

The following illustration shows a time line for a luminescence kinetic read with Smartinject
technology. It starts with microplate optimization and does 10 baseline reads before the
injection step. It then delays 1 second after the injection ends before starting the read.

Start ﬁ ﬁ E f@,f @ }‘ﬁ 'l?r End

Optimization  Loop Baseline Seming Smart Inject Delay Seming  LUM Read Lo
Plate Far Each Wel Basafine 10 Settings Delay 1.052cs  LmlAll Next Well
Cotmizer ngector 1- 504l
i
Cartridge
MIECTOR
©
Tirning
Wedl Time: 0:30

nterval- 00:00000.500
Reads: 61
Min Intersal; 00200140

PMT and Optics
niegration 140

% Note: With Smartinject™ technology, the microplate shakes during the injection and
continues to shake through the following delay step. The microplate stops shaking
before the well is read.
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Each Plate section or Cuvette Set section in a file or experiment must use the same
instrument, but can have different parameters for the instrument settings.

Use the Settings dialog to configure all parameters for a microplate or cuvette read, such as
the read type (Endpoint, Kinetic, Spectrum, Well Scan, Membrane), the read mode
(Absorbance, Fluorescence, Luminescence, Time Resolved Fluorescence, Fluorescence
Polarization, ALPHAScreen, FRET, Imaging), wavelength settings, microplate type, wells to
read, PathCheck technology, optics settings, shake parameters, timing for Kinetic runs,

speed read, and more.
To open the Settings dialog:
1. Click a Plate section or Cuvette Set section to make it active in the workspace.
@
2. Click Settings "% on the Home tab in the ribbon or in the toolbar at the top of the
active section.

The available options in the Settings dialog depend on the instrument, read mode, and read
type that is selected.

For the SpectraMax i3 and i3x Instruments, the Settings dialog has two methods available for
configuring a microplate read.

e The Standard View uses a table-like design, with selectable categories where you can
configure your settings. See Using the Standard View on page 237.

e The Acquisition View uses a workflow design, with drag-and-drop tools to configure
your settings. See Using the Acquisition View on page 240.

To switch between the views, click Standard View or Acquisition View in the lower-left
corner of the Settings dialog.

e
| Standard View Acquisition View

For information about the available settings, see the following topics:
e Wavelength Settings on page 247
e Plate Type Settings on page 250
e Read Area Settings on page 255
e PathCheck Technology Settings on page 257
e TRF Settings on page 258
e PMT and Optics Settings on page 258
e Timing Settings on page 260
e Well Scan Settings on page 261
e Shake Settings on page 262
e Speed Read on page 262
e Well Area Settings on page 263
e Image Acquisition Settings on page 264
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¢ Image Analysis Settings on page 266

e Region of Interest Settings on page 281

e Settings for Reads with Injection on page 282

e More Settings on page 285

e Compound Transfer Settings on page 289

e Compound Source Settings on page 292

e Pipette Tips Layout Settings on page 293

e Compound and Tips Columns Settings on page 293
e Triturate Settings on page 296

Before starting a read, it is good practice to save your data file. For Imaging reads and
Western Blot reads, you must save your data file before starting the read. See Saving Data
Files on page 65.

Wavelength Settings

The available wavelength settings vary depending on the selected instrument, read mode,
and read type.

Procedures to optimize excitation and emission wavelengths for a given protocol are
described in the instrument user guides for the microplate readers that support this
function. For more information, see those user guides.

Endpoint, Kinetic, Well Scan, or Flex Reads

Specify the number of wavelengths to read, and then type or select a wavelength value
within the available range for the instrument for each wavelength.

For filter-based instruments, select from the available filters.
Bandwidth

Bandwidth selection is available only for fluoreescence intensity (FL) and luminescence (LUM)
reads the SpectraMax i3 or SpectraMax i3x Multi-Mode Detection Platforms using the built-in
Monochromator.

Select the spectral bandwidth of the wavelength for the read. The selected bandwidth is used
for all the wavelengths in a multiple wavelength read.

For fluorescence intensity reads, select separate bandwidths for the excitation and emission
wavelengths.
Spectrum Reads

Choose a Start and a Stop wavelength value within the available range for the instrument,
and choose a wavelength Step for each increment between reads.

The minimum selectable Step incrementis 1 nm.
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Cutoffs

The choices in this portion of the Wavelengths setting depend on the selections for read type
(Endpoint, Kinetic, Spectrum, or Well Scan) and read mode (Fluorescence, Fluorescence
Polarization, or Time Resolved Fluorescence).

The term cutoff refers to filters used to block unwanted residual excitation light and minimize
background interference.

No emission cutoff filter is used when a Luminescence read mode is selected. With other read
modes, choices are to enable or disable Auto Cutoff with specific filter settings available if it is
disabled (manual cutoff selection). When Auto Cutoffis enabled, the instrument sets the
cutoffs based on the wavelengths chosen for reading. When a Spectrum read type is
selected, a manual setting for the emission monochromator is required, with the default
being no cutoff filter.

Determining a manual setting for a cutoff filter is based on the known value of the Stokes
shift, which is the difference between the wavelengths of the excitation and emission
maxima. If the Stokes shift is small, choose an excitation wavelength that is as far as possible
from the emission maximum while still being capable of exciting the fluorophore. Doing this
causes less of the excited light to overlap the emission spectrum, permitting better selection
and quantitation of the emitted light. See the individual instrument user guides for more
information about cutoff filter settings.
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Imaging Reads

Select one or more wavelengths, or channels, to use for the acquisition. Images are acquired
separately for each wavelength or channel, and can be analyzed separately.

The SpectraMax MiniMax 300 Imaging Cytometer captures images from the bottom of each
microplate well. You can choose to illuminate the sample with white transmitted light from
the top of the microplate using the Transmitted Light (TL) Detection Cartridge, or use
fluorescent excitation from the bottom of the microplate.

)
~—

~—)
O8O

Figure 7-1: Path of Selected Light Sources

Item Description

1 Transmitted Light (TL) Detection Cartridge

2 Path of white light from the Transmitted Light (TL) Detection Cartridge
3 Path of fluorescent excitation

4 Light source for fluorescent excitation

5 Camera lens

To illuminate the sample from the top, you need to have the Transmitted Light (TL) Detection
Cartridge installed in the detection cartridge drawer. See Transmitted Light (TL) Detection
Cartridge on page 233.

For best results with transmitted-light reads, use a microplate with no cover. A clear cover
can be used, if required. For fluorescent reads, you can use a solid cover on the microplate.
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Plate Type Settings

The Plate Type settings determine the display of the wells in the Plate section. Set the plate
type to match the microplate type, the number of wells, the clarity or opaqueness of the
wells, and the round or square shape of the wells in the microplate to be read.

Changing the Plate Type for a Plate section causes the well assignments stored in the
previous template to be discarded. The groups created previously remain, however, so you
can select new wells and apply existing groups to these wells.

The Plate Library includes entries for microplates of various sizes with standard dimensions.
If you are uncertain which microplate to select, then select the Standard plate definition.

You can choose to edit the dimensions of a microplate or add a custom microplate to the
microplate library.

e To edit the dimensions of a microplate in the library, select the microplate from the list
and click Edit Plate to open the Plate Editor dialog.
In the Acquisition View, click @ to open the Plate Editor dialog.

e To add a new microplate to the library, select a microplate from the list and click Edit

Plate or click @ Type a name for the new microplate in the Plate Name field of the
Plate Editor dialog.

e Toinclude a microplate from a predefined microplate description, click Import Plate and
use the file system browser to locate the microplate description file.

% Note: The Import Plate option is available only in the Standard View for the
SpectraMax Paradigm Multi-Mode Microplate Reader, the SpectraMax i3x Multi-
Mode Detection Platform, and the FilterMax F3 and F5 Multi-Mode Microplate
Readers.

e To delete a microplate from the microplate library, select the microplate to be removed
and click Remove.

In the Acquisition View, click @ In the Plate Editor dialog, make sure that the name of
the microplate to be removed is in the Plate Name field, and then click Delete.

For information about defining custom microplate dimensions, see Using the Plate Editor on
page 251.

% Note: Only the custom microplate definitions created or edited in Imaging mode can
be used for Imaging reads. Microplate definitions created, edited, or optimized for
other read modes are not included in the list of available microplates for Imaging
reads.
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When using a SpectraMax Paradigm Multi-Mode Microplate Reader, you can define the
microplate orientation.

Choose the microplate orientation to match the orientation of the microplate in the
microplate drawer.

e Landscape puts the Al location in the upper-left corner closest to the instrument.
e Portrait puts the Al location in the upper-right corner closest to the instrument.
* Opposite Landscape puts the Al location in the lower-right corner farthest from the
instrument.
* Opposite Portrait puts the Al location in the lower-left corner farthest from the
instrument.
If the microplate has a lid, select Is Lidded in the Standard View, or Plate has a lid on top in
the Acquisition View.

CAUTION! If the microplate has a lid on top, you must indicate that the microplate is
lidded and make sure that the microplate height with a lid is set accurately in the Plate
Editor before starting a read.

Using the Plate Editor

Use the Plate Editor to modify the definition of an existing microplate, or to add a new
microplate definition to the Plate Library.

If you opened the Plate Editor from the Acquisition View, you can remove the custom
microplate that is named in the Plate Name field by clicking Delete. The Delete button is
available only for saved custom microplate definitions.

To view the Plate Editor:

1. Click a Plate section to make it active in the workspace.

ch
2. Click Settings "% on the Home tab in the ribbon or in the toolbar at the top of the
active section.
3. Inthe Settings dialog, click the Plate Type category.

In the Plate Type Settings, click Edit Plate.

In the Acquisition View, click @ to open the Plate Editor dialog.

The Plate Editor has fields and check boxes that you can use to define the microplate
dimensions, in millimeters.

Note: SoftMax Pro Software comes with plate definitions for the SpectraDrop 24-well
Micro-Volume Microplates and SpectraDrop 64-well Micro-Volume Microplates.
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Modifying the Dimension of an Existing Plate

To modify the dimension of an existing plate when you do not want to change the name of
the plate:

1. Inthe Plate Type Settings, click the plate in the list and then click Edit Plate.

In the Acquisition View, click @| to open the Plate Editor dialog.
2. Typethe custom dimensions as needed.
3. Click Save.

The changed plate has an asterisk at the end of the plate name.

Importing a Plate Definition

Importing a previously saved microplate definition is available only with the SpectraMax i3
and i3x Multi-Mode Detection Platforms, the SpectraMax Paradigm Multi-Mode Microplate
Reader, and the FilterMax F3 and F5 Multi-Mode Microplate Readers. For the SpectraMax i3x
Multi-Mode Detection Platform, the SpectraMax Paradigm Multi-Mode Microplate Reader,
and the FilterMax F3 and F5 Multi-Mode Microplate Readers.

1. Inthe Plate Type Settings, click Import Plate.

2. Inthe Open dialog, navigate to the location where the microplate definition is saved.
3. Select the Microplate File (*.plt) or Multimode File (*.xml) file type.

4. Select the plate definition file.

5. Click Open to add the plate definition to the list.

Creating a New Plate

1. Inthe Plate Type Settings, click a plate in the plate list then and click Edit Plate.
Defining a new plate can be easier if you select a similar plate from the list before opening
the Plate editor.
In the Acquisition View, click @' to open the Plate Editor dialog.

2. Inthe Plate Editor, in the Plate Name field, type a name for the new plate definition.

3. Typethe dimensions of the new plate as needed.

4. Click Save.

The new plate name is displayed in the plate list.
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Field Name Image Description

Left Edge to Type the distance from the left edge of the plate to the center of

Left Well © well Al in millimeters.

Center g——

Horizontal G'—E' Type the horizontal distance between well centers in millimeters.

Center to

Center L

Top Edge to ﬁ Type the distance from the top edge of the plate to the center of

Top Left Well = well Al in millimeters.

Center L

Vertical = Type the vertical distance between well centers in millimeters.

Center to g O

Center | —

Well Type the diameter of a round well or the width of a square well in

Diameter and millimeters.

Well Shape
Select the Well Shape Square check box if the wells have a square
shape, rather than round.
The setting is available only with the SpectraMax i3 and i3x Multi-
Mode Detection Platforms, the SpectraMax Paradigm Multi-Mode
Microplate Reader, and the FilterMax F3 and F5 Multi-Mode
Microplate Readers.

Well Bottom . Select the Clear well bottom check box if the wells have a clear

Type / | i bottom, rather than opaque.

Thickness
For the SpectraMax i3x Multi-Mode Detection Platform used with a
SpectraMax MiniMax 300 Imaging Cytometer, type the thickness of
the bottom of the well of the microplate. This setting is used to
determine the initial focus distance for Imaging reads.

Well Volume Type the depth of the well in millimeters.

/ Depth “ i This setting is available only with the SpectraMax i3 and i3x Multi-
Mode Detection Platforms, the SpectraMax Paradigm Multi-Mode
Microplate Reader, and the FilterMax F3 and F5 Multi-Mode
Microplate Readers.
For the SpectraMax i3x Multi-Mode Detection Platform used with a
SpectraMax Injector Cartridge, type the working volume of the well
for the microplate in microliters. This setting is used to determine
the maximum allowed dispense volume for reads with injection.

253



SoftMax Pro Software User Guide

Table 7-2: Plate Editor Tools (continued)

Field Name Image Description

Plate Height Eat, Type the height of the microplate in millimeters and also the height
of the microplate with a lid in millimeters.

This settins is used to determine the read height for top readss, and is
available only with the SpectraMax i3 and i3x Multi-Mode Detection
Platforms, the SpectraMax Paradigm Multi-Mode Microplate Reader,
and the FilterMax F3 and F5 Multi-Mode Microplate Readers.

Plate Length . Type the length of the microplate in millimeters.

is available only with the SpectraMax i3 and i3x Multi-Mode
Detection Platforms, the SpectraMax Paradigm Multi-Mode
Microplate Reader, and the FilterMax F3 and F5 Multi-Mode

Microplate Readers.

Plate Width Type the width of the microplate in millimeters.

This setting is available only with the SpectraMax i3 and i3x Multi-
Mode Detection Platforms, the SpectraMax Paradigm Multi-Mode
Microplate Reader, and the FilterMax F3 and F5 Multi-Mode

Microplate Readers.

L Ll

The distance from the left edge of the microplate to the center of well A1 must also include
an offset for the angle of the optics.

To determine the correct settings for these fields, measure the applicable areas of the
microplate in the lab.

CAUTION! To prevent damage to the instrument, the microplate height and read
height must be set accurately before starting a read with a SpectraMax i3 Multi-Mode
Detection Platform.

Microplate definitions are saved in a *.plt file in a sub-folder of the ProgramData folder. A
custom microplate definition is specific to the computer on which it is saved, when a
protocol that has a custom microplate selected is opened on a different computer, the
SoftMax Pro Software gives an option to save the custom microplate definition on the new
computer.
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Read Area Settings

Partial-microplate reading is available for all read types, although it is most useful for fast
kinetic analysis or image acquisition. The time required for kinetic readings or acquiring
images can be significantly reduced using this setting since the instrument does not have to
read the entire microplate.

You can choose to read an entire microplate or a subset of wells.

To select a contiguous, rectangular region on the microplate, use your mouse to drag the
pointer and select the wells to be read.

2 3 4 5 4] 7 B 9 10

O
@
) %
O
@)
@
O
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Columns do not need to start with “1” but must be contiguous.

To read all the wells in the microplate, select the Select All check box.

For the SpectraMax i3 and SpectraMax i3x Instruments, you can select non-contiguous wells
if you are using a Well read order in the Standard View, or have added a For Each Well loop

in the Acquisition View. To select non-contiguous wells, hold down the cTRL key as you click
each well.

If you select a partial microplate reading, only the wells to be read are visible in the data
display, indicating that no data will be collected for the other wells. However, all wells are
displayed in the Template Editor. See Configuring a Microplate Template on page 301.
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Western Blot Membrane Read Area Settings

To scan the membrane in a SpectraMax Paradigm or SpectraMax i3x Instrument, the
membrane must be placed in a Molecular Devices ScanLater™ Membrane Holder. See
Loading the Membrane into the Membrane Holder on page 335.

A high-resolution scan of the entire surface can take approximately 15 minutes. To reduce
the scanning time, you can define a smaller area for the scan.

Select the area to scan from the Target Read Area list.
* Mini Membrane scans an area 85 mm x 65 mm.
* Whole Membrane Holder scans an area 109 mm x 77 mm.

e ROI Selection scans an area based on the region of interest (ROI) defined and acquired in
the Plate section.

If no region of interest has been defined and acquired in the Plate section, then ROI
Selection is not available in the list.

The example in the Read Area settings shows the approximate area to be scanned.

256 5049092 A



5049092 A

Chapter 7: Collecting Data

PathCheck Technology Settings

You can enable PathCheck Technology in the SoftMax Pro Software Settings dialog by
selecting the PathCheck check box in the PathCheck Settings for absorbance endpoint reads.

The temperature-independent PathCheck® Pathlength Measurement Technology
normalizes your absorbance values to a 1 cm path length based on the near-infrared
absorbance of water.

The Beer—Lambert law states that absorbance is proportional to the distance that light
travels through the sample:

A=¢bc

where A is the absorbance, €is the molar absorptivity of the sample, b is the pathlength, and
cis the concentration of the sample. The longer the pathlength, the higher the absorbance.

Microplate readers use a vertical light path so the distance of the light through the sample
depends on the volume. This variable pathlength makes it difficult to do extinction-based
assays and also makes it confusing to compare results between microplate readers and
spectrophotometers.

The standard pathlength of a 1 cm cuvette is the conventional basis for quantifying the
unique absorptivity properties of compounds in solution. Quantitative analysis can be done
on the basis of extinction coefficients, without standard curves (for example, NADH-based
enzyme assays). When using a cuvette, the pathlength is known and is independent of
sample volume, so absorbance is directly proportional to concentration when there is no
background interference.

See PathCheck Pathlength Measurement Technology on page 156.
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TRF Settings

TRF measures fluorescence as a function of time after excitation. You can set the integration
delay before collecting data and the integration time of the fluorescence signal.

* Theintegration delay is the amount of time that elapses between the flash of the lamp
(excitation) and the beginning of data acquisition from the well (emission).

* Theintegration timeis the amount of time that the well is read.

See Time-Resolved Fluorescence Read Mode on page 171.

PMT and Optics Settings

The sensitivity settings can be set in PMT and Optics Settings in the Settings dialog.

PMT sensitivity can be set to Low, Medium, or High. To get optimal PMT response without
saturation, set the PMT gain to High for samples having lower concentration (dim samples),
or use a lower PMT gain for samples having a higher concentration (bright samples).

To define the exact voltage to use for the PMT Gain, select Manual and then type a value in
the field.

The Automatic setting, when available, lets the instrument adjust the PMT voltage
automatically for varying concentrations of sample in the microplate.

The SpectraMax i3x Instrument uses two light sources. The Spectral Fusion™ lllumination
uses the spectral range of a high power Xenon flash lamp intensified by LEDs in the visible
range. Automatic LED power adjustment is used with high PMT Gain when the excitation
wavelength is between 430 nm and 680 nm for high sensitivity across multiple fluorophores.
In multiple-wavelength reads, the PMT Gain is set to High and cannot be changed.

For some instruments, the PMT sensitivity is always set to Automatic for Luminescence
(LUM) and Time Resolved Fluorescence (TRF) read modes. For these instruments, the
PMT Gain setting is not available for these read modes.

For Western Blot membrane scans, you can choose the resolution for the full scan and for a
secondary scan of a region of interest.

e The Default Scan Resolution applies to the entire read area of the membrane defined in
the Read Area settings.
e The ROI Scan Resolution applies to the region of interest (ROI) defined in the Plate
section.
A High resolution scan provides the best results, while a Low resolution scan provides the
fastest read.

The general workflow for acquiring Western Blot data, is to scan the defined read area of the
membrane with a low resolution, and then define a region of interest (ROI) to be scanned at
a high resolution.

For some instruments in certain read modes, you can type the desired number of Flashes
per read. For the SpectraMax i3x Instrument when the excitation wavelength is between
430 nm and 680 nm, 60 flashes is equal to 1 second of integration time.
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For the SpectraMax Paradigm Multi-Mode Microplate Reader, and for some detection
cartridges with the SpectraMax i3x Multi-Mode Detection Platform, you can select On the
Fly Detection options.

On-the-Fly Detection, when enabled, yields considerably faster read times while the
microplate moves continuously as each well is measured, as opposed to when it is disabled
(Off-stop and go) and the microplate stops moving for each read.

To use On-the-Fly Detection, select an option to specify whether the detection method
should be optimized for Performance or Speed.

o Selecting Performance results in a faster read time than not using On-the-Fly Detection,
but not as fast as the Speed mode. Performance provides considerably better results
than Speed for demanding assays.

e Selecting Speed results in the fastest possible read time per microplate. However, there
is a trade-off between the data quality and read speed because each well is sampled for
shorter integration times.

For the SpectraMax Paradigm Multi-Mode Microplate Reader and the FilterMax F5 Multi-
Mode Microplate Reader, and some detection cartridges with the SpectraMax i3x
Instrument, you can set the Integration Time. Type a value in the Integration Time field in
milliseconds, to specify the measurement time per well to be validated.

Select the Read From Bottom check box to have an instrument with bottom-read capability
read up through the bottom of the microplate rather than down from the top.

For the SpectraMax i3x Instrument, the SpectraMax Paradigm Multi-Mode Microplate
Reader, and the FilterMax F5 Multi-Mode Microplate Reader, you can specify the Read
Height.

Read Height specifies the distance in millimeters between the objective lens and the
microplate. You can type a value for the read height in this field.

To have SoftMax Pro Software find the optimized read height before the read, use the Read
Height Optimization feature in the Pre-Read Optimization dialog by selecting the Show Pre-
Read Optimization Options check box in the More Settings tab.

Read Height is available for the SpectraMax i3x Multi-Mode Detection Platform and the
FilterMax F5 Multi-Mode Microplate Reader for top-read only.

CAUTION! To prevent damage to the instrument, the microplate height and read
height must be set accurately before starting a read with a SpectraMax i3 Multi-Mode
Detection Platform.

5049092 A 259



SoftMax Pro Software User Guide

260

Timing Settings

For Kinetic and Flex reads you can define the total run time and the time interval between
reads.

Type values for the Total Run Time and the Interval between readings in hh:mm:ss format.

For the SpectraMax i3x or i3 Multi-Mode Detection Platform and the SpectraMax Paradigm
Multi-Mode Microplate Reader, selecting a Well read order in the Standard View, or adding
a For Each Well loop in the Acquisition View, for a kinetic read lets you define timing
parameters in milliseconds.

The minimum permitted interval values are shown below the Interval field.

The Number of Reads is calculated based on the values in the Total Run Time and Interval
fields.

To read only one time point, click Single Point Read to set the Total Run Time and the
Interval to the same value. This can be useful for running a multitask kinetic read with
alternating read modes within a cycle. See Defining and Running a Workflow on page 297.

The minimum permitted read interval is determined by the instrument, and depends on
many factors including the number of wavelengths, the number of wells being read, and the
distance the instrument’s filter wheel must move. Maximum read intervals also vary by
instrument, for example the SpectraMax M2 Multi-Mode Microplate Reader has a maximum
read interval of 2 hours and 45 minutes, and the SpectraMax Paradigm Multi-Mode
Microplate Reader has a maximum read interval of 18 hours and 12 minutes. If you type a
non-allowed read interval, a message is displayed defining the minimum or maximum
permitted value for the read interval.

* Tip: In some cases, choosing wavelengths in ascending order can get the shortest
possible interval.
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Well Scan Settings

A well scan read can take readings at more than one location within a well. A well scan read
takes one or more readings of a single well of a microplate on an evenly spaced grid inside of
each well at single or multiple wavelengths.

Some applications involve the detection of whole cells in large-area tissue culture plates. Well
scan reads can be used with such microplates to permit maximum surface area detection in
whole-cell protocols. Since many cell lines tend to grow as clumps or in the corners of
microplate wells, you can choose from several patterns and define the number of points to
be scanned to work best with your particular application.

Well Scan reads let readings be taken at more than one location within a well. Well Scan
settings let you specify how a Well Scan is done.

You can specify the scanning pattern and the scanning density.
The number of points that are available depend on the well size of the selected microplate.
Up to four scanning patterns are available, depending on the selected instrument:

e Ahorizontal line

e Avertical line

e Across (which is a combination of a horizontal and vertical line)

o Afill pattern

The fill pattern can be either round or square to match the shape of the well. The image in
the Well Scan settings shows the shape of the well as defined for the selected microplate. See
Plate Type Settings on page 250.

The following are determined by Density:
e The number of points that are read in the line patterns.

e The maximum number of horizontal and vertical points that are included in the cross or
fill pattern.
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Shake Settings

Shake lets you set options for automated shaking of the microplate in the chamber. The
options available for Shake depend on the read type and the instrument.

Before First Read

This setting can be used with all read types. Whether you read at a single wavelength or at
multiple wavelengths, selecting the Before First Read shakes the plate for the set quantity of
time before the first wavelength reading only.

Between Reads
This option is available only when a Kinetic read type is selected.

For readings at a single wavelength, enabling Between Reads shakes the plate for the
specified quantity of time before each reading at that wavelength.

For readings at multiple wavelengths, enabling Between Reads shakes the plate for the
specified quantity of time before each reading at the first wavelength only.

Note: The Before First Read and Between Reads options are available only in the
Standard View. To enable shaking in the Acquisition View, place the Shake node in
the time line where you want the shake to occur.

For the SpectraMax i3x Multi-Mode Detection Platform and the SpectraMax Paradigm Multi-
Mode Microplate Reader, you can specify the method for the microplate shaking operation.
The microplate shaking options include to following:

¢ Intensity: Low, Medium, or High. The actual shake speed is based on the microplate
format.

* Direction: Linear or Orbital patterns.

e Duration: Length of time in seconds.

Speed Read

Enable Speed Read for an Absorbance read to read the plate faster by decreasing the
number of lamp flashes.

The Speed Read option is particularly useful in Spectrum scans and can greatly reduce the
time needed to run the protocol.

For instruments that support software calibration, Speed Read turns off Calibration and
uses the air calibration values stored in the firmware of the instrument. As a result, Speed
Read might not provide as accurate an absorbance measurement at each wavelength of a
scan as with the normal read.
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Well Area Settings

The Well Area Settings for Imaging reads let images be acquired at more than one location,
or site, within a well to form a single seamless tiled image.

Select the number of sites that you want to acquire.

Well Area Settings

) 15ite
) 2 Sites
@ 4 Sites
) 9 Sites
) 12 Sites

If you select to acquire images of more than one site in the well, the images are "tiled"
together into a single image for analysis.

Image acquisition time increases with each site selected. For faster image acquisition, select
fewer sites.
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Image Acquisition Settings

In the Image Acquisition Settings, you can define the exposure time and focus adjustment
for two sample wells. These settings are used for every well in the entire microplate during
acquisition. The exposure and focus adjustment can be set separately for each wavelength,
or channel.

Acquiring Images for Maximum Intensity and Minimum Intensity
Only one site is acquired in each well. If you selected to acquire more than one site, the first
site is acquired.

To acquire the image for maximum intensity:

1. Click E' to the right of the Well field above the maximum intensity image area.
2. Click the microplate well that you expect to have the brightest image.

The well filled with red is used to determine maximum intensity, and the well filled with
blue is used to determine minimum intensity.

3. Click Acquire Max Image and wait for the image to be acquired.

To acquire the image for minimum intensity:

1. Click E' to the right of the Well field above the minimum intensity image area.
2. Click the microplate well that you expect to have the darkest image.
The well filled with red is used to determine maximum intensity, and the well filled with
blue is used to determine minimum intensity.
3. Click Acquire Min Image and wait for the image to be acquired.
For some multi-channel experiments, the brightest and darkest images for one channel can
be different than the brightest and darkest images for another channel. In this case, try to
locate the wells that give you the best results between the different channels.
To view the image for a specific wavelength, click the tab above the image for that
wavelength. To view an image with all the wavelengths, click Composite.
To zoom the acquired image in and out, right-click the image and click Zoom In or Zoom Out.
You can also hold the CTRL key down and press + or -, or use the mouse wheel to zoom in or
out. Drag the scroll bars to move the zoomed image in the image area, or click the image and
drag it into position. To view a larger version of the image area, double-click the image to
open the Zoom Well dialog. See Zooming the Image in a Well on page 338.
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Setting the Exposure Time and Focus Adjustment

The exposure and focus adjustment can be set separately for each wavelength, or channel.
To view the image for a specific wavelength, click the tab above the image for that
wavelength. To view an image with all the wavelengths, click Composite. Set the exposure
and focus adjustment in the row designated for the specific channel.

To have the SoftMax Pro Software determine the best exposure, click Auto Expose. The new
value in the Exposure field is based on the perceived best intensity for the Max Intensity or
Min Intensity image, whichever is brightest. To view what effect the new exposure value has
on the images, acquire the maximum intensity and minimum intensity images again.

To continue to adjust the intensity of the images, type a value in the Exposure field for the
number of milliseconds to hold the camera shutter open. Increasing the exposure time
increases the intensity of the image, while decreasing the exposure time decreases the
intensity of the image. After each adjustment, acquire the images again to view what effect
the change has on their intensity.
The system optics use a laser automatic focus system and software algorithms to find the
initial focus distance for the cells in the microplate wells. You can adjust the focus by typing a
value in the Focus Adjustment field for the number of microns to move the objective lens
closer to or farther away from the sample.

e Increasing the Focus Adjustment value moves the objective lens closer to the sample.

e Decreasing the Focus Adjustment value moves the objective lens farther away from the

sample.

After each adjustment, acquire the images again to view what effect the change has on their
focus.
For transmitted light images, make sure that enough contrast exists between the objects
and the background. The sharper the focus is, the less contrast exists. For best results when
you use a preset drawing analysis, make sure that the objects are brighter than the
background.

These settings are used for every well in the entire microplate during acquisition.
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Image Analysis Settings

In the Image Analysis Settings category, select an analysis type to use.

To acquire images without analysis, click No Analysis.

Discrete Object Analysis

Discrete Object Analysis uses proprietary algorithms to analyze separate objects, or cells,
based on multiple parameters including the signal intensity over the background and the
size of the objects.
When you click Discrete Object Analysis, The Wavelength for Finding Objects list appears
below the list of analysis types. Select the wavelength from this list to use to identify the
objects in the well images. You can use transmitted light or a fluorescent wavelength to find
nuclei or easily separable objects in the image. The StainFree™ Cell Detection Algorithm
eliminates cell staining for cell counting and confluency measurements using proprietary
transmitted light analysis technology.
The Image Analysis Settings category on the left expands to show the subcategories that
follow:
¢ Click Find Objects to enter size and intensity values or use proprietary algorithms with
the provided drawing tools to graphically define the objects and the background areas
for the analysis. See Finding Discrete Objects or Confluent Areas on page 267.
e Click Classify Objects to define separate measurements for different types of found
objects, or cells. See Classifying Discrete Objects on page 271.
o Click Select Measurements to view the results of the analysis for the selected wells. See
Viewing and Selecting Measurement Statistics on page 273.

Field Analysis

Field Analysis uses proprietary algorithms to analyze confluent areas based on multiple
parameters including the signal intensity over the background and the size of the areas.
When you click Field Analysis, The Wavelength for Finding Confluent Areas list appears
below the list of analysis types. Select the wavelength from this list to use to identify the
confluent areas in the well images. The StainFree™ Cell Detection Algorithm eliminates cell
staining for cell counting and confluency measurements using proprietary transmitted light
analysis technology.
The Image Analysis Settings category on the left expands to show the subcategories that
follow:
e Click Find Confluent Areas to use proprietary algorithms with the provided drawing
tools to graphically define the confluent areas and the background areas for the analysis.
See Finding Discrete Objects or Confluent Areas on page 267.
¢ Click Select Measurements to view the results of the analysis for the selected wells. See
Viewing and Selecting Measurement Statistics on page 273.
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The SoftMax Pro Software proprietary algorithms with the provided drawing tools in the
Find Objects or Find Confluent Areas settings help the software learn the patterns of the
objects that you want to find. Depending on the complexity of the object patterns, this
teaching process can take several iterations before you get your desired results. See
Resolving Common Issues with Drawing and Finding Objects on page 275.

Finding Discrete Objects or Confluent Areas

In the Find Objects or Find Confluent Areas settings, the minimum and maximum images
from the Image Acquisition Settings are displayed.

To make it easier to select the objects or areas in the images, view this page in full screen.
o Click *=/to view the page in full screen.

o Click [#™/to restore the page to its original size.

In full-screen view, click the tabs at the top of the page to switch between the different pages
of the analysis settings.

To zoom the acquired image in and out, right-click the image and click Zoom In or Zoom Out.
You can also hold the CTRL key down and press + or -, or use the mouse wheel to zoom in or
out. Drag the scroll bars to move the zoomed image in the image area, or click the image and
drag it into position.

Click the buttons above the image to switch the view of the image between wavelengths,
and to show or hide found objects (or confluent areas) and drawings.

7L 541 (713) | Objects = | Drawing

e When a buttons is filled in, the related wavelength, objects (or confluent areas), and
drawings are displayed in the image.

e When a button is outlined, the related wavelength, objects (or confluent areas), and
drawings are not displayed in the image.

When you click a button above one of the images, it effects the display of both images.
Use the controls below the image to separately adjust the intensity of each wavelength.

From the list on the left, select the wavelength that you want to adjust.

Drag the sliders to adjust the intensity range of the image.

-~ I ]

e The bar on the left controls the low level of intensity.

e The bar on the right controls the high level of intensity.
When you drag a bar, the intensity level is displayed above the bar.

To move the sliders to the outside edges, click the double-arrow button on the left.
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From the list on the right, select the color for the view.

For fluorescent acquisition and discrete object analysis, you can select a Finding Method:

e Click Set Size and Intensity to define the intensity threshold above the background
intensity to be applied separately to each object in the image that meets the defined size
range. This type of analysis helps to detect objects in areas of the image where the
intensity is uneven.

e Click Draw on Images to use the drawing tools to help the software learn the patterns of
the objects that you want to find.

The Set Size and Intensity settings are available for fluorescent acquisition and discrete

object analysis. Click and then click four or more representative objects on the
images that you want to detect as cells. In the Min Width and Max Width fields, type values
to define the size range in microns of the objects to be found. In the Intensity Above
Background field, type a value to indicate the intensity threshold above the background
intensity at which the dimmest object is to be detected. For example, if the background
intensity is 1000 and the intensity of the dimmest object is 1200, type 200. After you enter
new settings, click Apply.

The Grow setting allows you to define the number of pixels to increase the diameter of the
found objects in one wavelength, so that they can be measured at the new size in another
wavelength of the acquisition. For example, if you are using a stain for nuclei, you can find
the object in the first wavelength and then increase the diameter to find the protein of
interest in another fluorescence wavelength. The innovative "grow without touching"
algorithm increases the size of the measured areas without letting the areas touch or overlap
their edges.

Draw on Images is available for every type of image acquisition and analysis. You can use the
drawing tools to help the software learn the patterns of the objects or confluent areas that
you want to find. Depending on the complexity of the object or area patterns, this teaching
process can take some time before you get your desired results.

To use a preset drawing analysis, select the preset from the Settings list. Each preset drawing
analysis is designed to work with specific cell types. Select the preset analysis that works best
with your images. Click Apply to find objects or confluent areas using the preset.

After you have acquired data, you can select Stored Setting from the Settings list to use the
previously defined analysis settings.

To start from scratch, select Create New Setting from the Settings list.
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To select the objects for fluorescent acquisition and discrete object analysis, click
and then click a line width. Click four or more representative objects on the images. This
method is not available for transmitted light acquisition or for confluent area analysis.

To define the objects or confluent areas, click the object or area pen and then click
a line width.
e Fordiscrete object analysis, draw inside the object up to the edge, but do not include
the edge. When the object is filled in with yellow, the drawing is outlined in green. For
best results, fill in four or more representative objects.

e For field analysis, draw across confluent areas, avoiding background. For best results,
draw across four or more representative areas.

To define the background, click the background pen and then click a line width.
Draw on the image to define artifacts and background areas in blue. For best results, define
four or more representative background areas.
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If you draw an object or area incorrectly, click Undo to remove it. If you undo something
that you want to keep, click Redo to restore it. To clear the drawings from the image, click
Start Over.

To erase parts of drawings, click the erase and then click a line width. Drag the
eraser across drawings to remove them.

After you have the objects and areas defined, click Apply to have the software find the
objects or confluent areas in the image. Continue to draw and to apply until you get
satisfactory results. See Resolving Common Issues with Drawing and Finding Objects on
page 275.

After you are satisfied with the found objects or confluent areas, you can classify objects or
view the measurement statistics. See Classifying Discrete Objects on page 271 or Viewing and
Selecting Measurement Statistics on page 273.
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Classifying Discrete Objects

In the Classify Objects settings, the minimum and maximum images from the Image
Acquisition Settings are displayed along with the found objects from the Find Objects
settings. The Classify Objects settings are not available for field analysis of confluent areas.

Note: Before you can classify objects, you must first find objects in the Find Objects
settings. See Finding Discrete Objects or Confluent Areas on page 267.

To make it easier to select the objects in the images, view this page in full screen.
o Click #=/to view the page in full screen.

o Click |#®Ito restore the page to its original size.
In full-screen view, click the tabs at the top of the page to switch between the different pages
of the analysis settings.

To zoom the acquired image in and out, right-click the image and click Zoom In or Zoom Out.
You can also hold the CTRL key down and press + or -, or use the mouse wheel to zoom in or
out. Drag the scroll bars to move the zoomed image in the image area, or click the image and
drag it into position.

Click the buttons above the image to switch the view of the image between wavelengths,
and to show or hide classified objects or selections.

TL 541 (?13} Classifications Selections

e When buttons are filled in, the related wavelengths, classifications, or selections are
displayed in the image.
* When a button is outlined, the related wavelengths, classifications, or selections are not
displayed in the image.
When you click a button above one of the images, it effects the display of both images.
Use the controls below the image to separately adjust the intensity of each wavelength.

From the list on the left, select the wavelength that you want to adjust.

Drag the sliders to adjust the intensity range of the image.

-~ I ]

e The bar on the left controls the low level of intensity.

e The bar on the right controls the high level of intensity.
When you drag a bar, the intensity level is displayed above the bar.

To move the sliders to the outside edges, click the double-arrow button on the left.
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From the list on the right, select the color for the view.

Use the selection tools at the bottom of the page to classify the found objects in the images
into two separate classifications.
Settings Classification Selection

Use Existing Classification
| L | @| Typ=A

| Skip Classification

(@ Create New Classification | O IEJ"‘l'J"‘|’E| Q | Typ=E

Start Over Apply

In Re-Analysis mode, you can select and apply Use Existing Classification to use the
previously defined classification settings.

If you do not want to use classification in your analysis, click Skip Classification.

You can replace the Type A and Type B titles with your own titles for the classifications. Titles
must use only letters, numbers, and spaces, and can be up to 16 characters long, including
spaces. They must start and end with a letter. The titles cannot be the same as each other.
Also, you cannot use "Exclude" as a title, since this is a reserved word.

To start classifying objects from scratch, click Create New Classification.

e To select objects for the first classification, click the red button and then click the objects
in the images.

e To select objects for the second classification, click the blue button and then click the
objects in the images.

e To exclude objects from being classified, click the gray button and then click the objects
in the images. If you exclude objects, you must also use at least one of the classifications
types to include objects.

To deselect a selected object click it again. To remove all the selections from the images, click
Start Over.

After you have several classified objects selected, click Apply to have the software find and
classify the objects in the image. Continue to select and to apply until you get satisfactory
results.

After you are satisfied with the classified objects, you can view the measurement statistics.
Viewing and Selecting Measurement Statistics on page 273.
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Viewing and Selecting Measurement Statistics

In the Measurement Selections settings, a table is displayed with the analysis results for the
minimum intensity and maximum intensity images.

To make it easier to view the measurements table, view this page in full screen.
o Click #=/to view the page in full screen.

e Click [#™to restore the page to its original size.

In full-screen view, click the tabs at the top of the page to switch between the different pages
of the analysis settings.

The results are displayed separately for each measured wavelength and classification, if
applicable. Each measurement row displays two bars and numerical data representing the
Max Intensity or Min Intensity images.

The possible included measurements are as follows:

* Object Count gives the total number of objects detected in the image. This
measurement is not used for field analysis of confluent areas.

* Field Count gives the total number of confluent areas detected in the image. This
measurement is not used for discrete object analysis.

* Object Percentage gives the percentage the objects detected in the image by
classification. This measurement is not used for field analysis of confluent areas.

e Covered Area gives the combined area of all the objects or confluent areas detected in
the image as a percentage of the entire image area.

* Object Area gives the average area of the objects detected in the image expressed in
umz. This measurement is not used for field analysis of confluent areas.

¢ Field Area gives the average area of the confluent areas detected in the image expressed
in umz. This measurement is not used for discrete object analysis.

* Object Roundness gives the average roundness of each object detected in the image. A
shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all.
This measurement is not used for field analysis of confluent areas.

* Field Roundness gives the average roundness of each confluent area detected in the
image. Ashape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round
at all. This measurement is not used for discrete object analysis.

* Object Average Intensity gives the average fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).

* Field Average Intensity gives the average fluorescent signal intensity of the confluent
areas detected in the image. This measurement is not used for discrete object analysis.
This measurement is not used for transmitted light (TL).

e Object Intensity gives the average total fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).
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* Field Intensity gives the average total fluorescent signal intensity of the confluent areas
detected in the image. This measurement is not used for discrete object analysis. This
measurement is not used for transmitted light (TL).

¢ Total Intensity gives the combined total fluorescent signal intensity of the objects or
confluent areas detected in the image expressed in million intensity counts. This
measurement is not used for transmitted light (TL).

To select the measurements that you want to include in the analysis, click Select
Measurements in the lower-right area of the page. This places a Remove button next to each
measurement in the table.

* To exclude a measurement, click Remove.
e Toinclude a measurement, click Add.
e To exclude all measurements, click Remove All.
e Toinclude all measurements, click Add All.
After you have selected the measurements that you want to include and exclude, click Done.

The selected measurements are dynamically added to the data reduction list that you can
use to view data in the Plate section or to add to a Group section for further analysis. See
Using a Plate Section on page 118 or Using a Group Section on page 139.

To view the measurements in an interactive image, data table, and chart, click Show Details.
See Viewing the Imaging Data in a Well on page 365.

If no measurements are displayed, and you did not make changes to the analysis settings
since the last measurement, click Measure to analyze the selected wells. This can be useful if
you change acquisition wells and want to analyze the new wells.
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Resolving Common Issues with Drawing and Finding Objects

The SoftMax Pro Software proprietary algorithms with the provided drawing tools in the
Find Objects or Find Confluent Areas settings help the software learn the patterns of the
objects that you want to find. Depending on the complexity of the object patterns, this
teaching process can take several iterations before you get your desired results.

The SoftMax Pro Software uses a complex algorithm to learn the properties of the cells or
confluent areas in the image. The algorithm examines each pixel and how it relates to its
surrounding area. Cells change shapes and sizes under different conditions such as
confluency. Artifacts can look like cells or confuse the algorithm. Cells that are touching are
more difficult to find than sparse cells in an image. Complex images can require more
drawing examples to create a good training set.

Some common issues with finding cells and confluent areas are as follows:

e Under splitting finds multiple cells or confluent areas that can also include background.
See Resolving Under-Splitting Issues on page 277.

e Over splitting finds portions of cells or confluent areas and can include several found
objects within a single cell or confluent area. See Resolving Over-Splitting Issues on page
278.

e Artifacts can be found and counted as cells or confluent areas. See Resolving Artifact
Issues on page 279.

e Ghosting finds background areas next to cells or confluent areas . See Resolving Ghosting
Issues on page 280.

Molecular Devices recommends that you start with a preset drawing analysis. Select the
preset from the Settings list and then click Apply to find objects or confluent areas using the
preset. Each preset drawing analysis is designed to work with specific cell types. Select the
preset analysis that works best with your images.

For transmitted light images, make sure that enough contrast exists between the objects
and the background. The sharper the focus is, the less contrast exists. To increase the
contrast between the objects and the background, move the lens closer to or farther away
from the microplate.

Adjust the focus in the Image Acquisition Settings. Increasing the Focus Adjustment value
moves the objective lens closer to the sample, while decreasing the Focus Adjustment value
moves the objective lens farther away from the sample. In general, moving the lens closer
makes the objects darker than the background, while moving the lens farther away makes
the objects brighter than the background.

Note: For best results when you use a preset drawing analysis, make sure that the
objects are brighter than the background.
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To create an iterative training set for complex images can require the following steps:

1.

Carefully draw four or more cells or confluent areas that best represent your target
population. Draw inside the cell or confluent area up to the edge, but do not include the
edge.

Define the artifacts and background areas in the image.

Apply the drawing and then try to fix the problems.

Continue to adjust the drawings. After fixing some problems the results can actually look
worse as the algorithm emphasizes the fixes. Keep making adjustments to create a
complete training set.

After the result looks reasonable, scroll and look around the image for other issues.
Stop when you are satisfied or you get diminishing returns. As the training data set
grows, more drawings will have less impact. At some point changes will be of little
benefit.

If, at the end of the process, it is still not right, start again and repeat all the steps.
Sometimes there is something that had an unexpected influence on the algorithm, and
starting over can produce a better result.

If, after trying multiple iterations, ask someone else with experience to try. This person can
possibly notice specific issues, or will draw larger or smaller.
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Resolving Under-Splitting Issues

Under splitting finds multiple cells or confluent areas that can also include background.

Under splitting can be caused by drawing outside of the edge of the cells or confluent areas.
The lines between the cells or confluent areas are interpreted as being part of the cell or
confluent-area structure.

To resolve under-splitting issues, draw inside the cell or confluent area up to the edge, but
do notinclude the edge. You can also use the background pen to draw on the lines between
the cells or confluent areas.
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Resolving Over-Splitting Issues

Over splitting finds portions of cells or confluent areas and can include several found objects
within a single cell or confluent area.

Over splitting can be caused by drawing too small within the cells or confluent areas.
Sometimes over splitting can happen after using the background pen to remove an artifact.

To resolve over-splitting issues, draw inside the cell or confluent area up to the edge, but do
not include the edge.

If over splitting is the result of artifact removal, try erasing the blue from the artifact defined
by the background pen.
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Resolving Artifact Issues

Artifacts can be found and counted as cells or confluent areas.

Artifact issues can be caused by debris or other artifacts in the image where the edges and
surrounding pixels confuse the software.

To resolve artifact issues, use the background pen to define artifacts as background and not
cells or confluent areas.
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Resolving Ghosting Issues

Ghosting finds background areas next to cells or confluent areas .

Ghosting can be caused by the edges of cells or confluent areas and the surrounding pixels
that confuse the software.

To resolve ghosting issues, use the background pen to draw over the area of the ghost. Draw
this area right to the edge of the cell or confluent area. If necessary, use the object pen to
draw on the cell or confluent area so that the drawing goes out to the edge of the cell or
confluent area.
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Region of Interest Settings

You can define a region of the images in all the wells to be analyzed, if needed for your
application. Only the selected region of interest (ROI) is used for the analysis. This can be
useful if cells tend to congregate in the same region of the wells.

To select the well to use for defining the region of interest, click D to the right of the Well
field above the image area. The well filled with red is used to determine the region of interest.
Click the well that you want to use, and then click Acquire All Sites.

To view the image for a specific wavelength, click the tab above the image for that
wavelength. To view an image with all the wavelengths, click Composite.

To zoom the acquired image in and out, right-click the image and click Zoom In or Zoom Out.
You can also hold the CTRL key down and press + or -, or use the mouse wheel to zoom in or
out. Drag the scroll bars to move the zoomed image in the image area, or click the image and
drag it into position.
To define a region of interest:
1. Select the Enable Region Selection check box.

Arectangleis displayed on the image.

Click Resize and then drag the corners of the rectangle redefine the size of the region.

3. Tostartover, click Draw and then drag a new rectangle on the image to define the
region.

To use the entire image for the analysis, clear the Enable Region Selection check box.
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Settings for Reads with Injection

To define the settings for a read with injection, you must use the Acquisition View of the
Settings dialog.

To do a read with injection, you must first install the Injector Cartridge in the SpectraMax i3x
Instrument. You can use the Injector Cartridge for luminescence reads, or use the built-in
Monochromator in the SpectraMax i3x Instrument for fluorescence intensity reads with
injection.

* When you add a luminescence (LUM) step to the time line, select INJECTOR from the
Select Hardware list to use the Injector Cartridge for the read. A luminescence read with
injection is taken from the top of the microplate.

* When you add a fluorescence intensity (FL) step to the time line select MONO from the
Select Hardware list to use the built-in Monochromator for the read. A fluorescence
intensity read with injection is taken from the bottom of the microplate.

The following options are specific to reads with injections.

For Each Well and Next Well

Reads with injection are generally done well-by-well. Double-click For Each Well in the
Toolbox to have the steps in the time line run for each well individually with all the defined
injections, delays, and reads before running the steps again for the next well. The Next Well
node is also added to the end of the time line. Add the steps for your assay between these
nodes.

The following illustration shows a time line for a luminescence kinetic read with Smartinject
technology. It starts with microplate optimization. All the acquisition steps are between the
For Each Well and Next Well nodes.

Start ﬁ ﬁ E f@,f @ }‘ﬁ 'l?r End

Optimization  Loop Baseline Seming Smart Inject Delay Seming  LUM Read Lo
Plate Far Each Wel Basafine 10 Settings Delay 1.052cs  LmlAll Next Well
Cotmizer ngector 1- 504l
i
Cartridge
MIECTOR
©
Tirning
Wedl Time: 0:30

nterval- 00:00000.500
Reads: 61
Min Intersal; 00200140

PMT and Optics
niegration 140
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Inject

To add a simple injection step, drag the Inject node to the time line and drop the node
before the LUM Read or FL Read step.

e To shake the microplate after the injection, add a Shake step between the injection step
and the read step. See Shake Settings on page 262.

e To shake the microplate during the injection, use the Smartlnject™ node instead of the
Inject node, and do not add a Shake step. The microplate shakes during the injection,
continues to shake through the following delay step, if a Delay node follows the
Smartlnject node, and then stops shaking before the well is read. See Smartinject
Technology on page 283.

To define the settings for the injection step, click the Inject node and then click the pencil
icon to open a settings window. Select the injector to use and type the number of microliters
(uL) to dispense. You can dispense from 1 pL to the maximum allowable volume of the well,
based on the selected microplate type. Define the dispense volume based on the
requirements of your assay and the net volume available in the well.

You can add a Delay step after the injection ends and before the read begins, if required. You
can set the delay from 0.001 seconds to 100 seconds. See Delay on page 284.

Smartinject Technology

To shake the microplate during the injection, drag the Smartinject node to the time line and
drop the node before the LUM Read or FL Read step.

The Smartlnject™ technology shakes the microplate during the injection and continues to
shake through the following delay step, if a Delay node follows the Smartinject node. The
microplate stops shaking before the well is read.

To define the settings for the injection step, click the Smartinject node and then click the
pencil icon to open a settings window. Select the injector to use and type the number of
microliters (pL) to dispense. You can dispense from 1 L to the maximum allowable volume
of the well, based on the selected microplate type. Define the dispense volume based on the
requirements of your assay and the net volume available in the well.

You can add a Delay step after the injection ends and before the read begins, if required. You
can set the delay from 0.001 seconds to 100 seconds. See Delay on page 284.
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Delay

You can add a Delay step after the injection ends and before the read begins, if required. You
can set the delay from 0.001 seconds to 100 seconds.

e For luminescence reads, there is always a delay of 0.3 seconds after the injection ends
and before the read begins to allow time for the detector to move into position for the
read.

e For fluorescence intensity reads, there is no delay for injector number 1. The read starts
at the same time as the injection unless a Delay step is added. For injector number 2,
there is always a delay of 0.3 seconds after the injection ends and before the read begins.

The Delay step compensates for the hardware delay. If the defined delay is longer than the
hardware delay, then the actual delay time is the defined delay time. However, if the defined
delay is shorter than the hardware delay, then the actual delay time is the hardware delay
time. For example, if a luminescence read has a defined delay of 1 second, then the actual
delay time between the end of the injection and the beginning of the read is 1 second.
However, if a luminescence read has a defined delay of 0.05 seconds, then the actual delay
time between the end of the injection and the beginning of the read is 0.3 seconds due to
the hardware delay.

Baseline

You can take baseline reads before the injection step of a kinetic read by double-clicking
Baseline in the Toolbox. The Baseline step is added to the time line before the injection step.
Click the pencil icon and type the number of baseline reads. You can define from 1 to 999
baseline reads. Baseline reads use the settings defined in the LUM Read or FL Read step. The
baseline data can be subtracted from the reads that follow the injection. You can use the
Formula Editor to automate baseline subtraction. See Adding a New Summary Formula on
page 115. More information about baseline subtraction can be found in the Formula
Reference Guide.
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More Settings

The More Settings category in the Settings dialog provides more settings options. The
options vary depending on the selected instrument, read mode, and read type.

Calibrate

For Absorbance reads, the Calibrate setting tells the instrument to make an air-calibration
measurement at each wavelength before reading the microplate, as determined by the type
of instrument and the read settings. If you turn calibration off, SoftMax Pro Software uses
the air-calibration values stored in the firmware of the instrument, or the values from the
previous calibration.

For Fluorescence and Luminescence reads, the instrument makes a reference read on the
internal reference chip at each wavelength before reading the microplate. If you turn
calibration off, SoftMax Pro Software uses the default values stored in the firmware of the
instrument, or the values from the previous calibration.

For kinetic readings the calibration measurement is made between readings during a run,
unless the read interval is too short to allow calibration.

If Calibrate is set to On in the More Settings tab, the instrument runs calibration for the
wavelengths specified in the protocol before each read.

These new calibrations overwrite the calibration setting stored in firmware for the current
data acquisition read, and for any subsequent read with calibration turned off. When the
instrument is powered off and on, the calibrations revert to those stored in firmware.

The air-calibration values stored in the firmware for Absorbance reads can be updated using
the Calibration button on the Operations tab in the ribbon. See Calibrating the Microplate
Reader on page 455.

Turning off calibration allows the instrument to begin or complete readings more quickly.
Molecular Devices recommends that you calibrate at your assay wavelengths for at least one
microplate before turning off calibration.

Carriage Speed

Carriage Speed can be slowed down for samples (such as, fragile clots) that can be disrupted
by rapid carriage movement. Select a Carriage Speed of Normal or Slow.
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Read Order

The Read Order options in the More Settings category in the Settings dialog vary depending
on the selected instrument, read mode, and read type.

Read Order Column/Wavelength

Choosing column or wavelength priority determines the order in which a plate is read in
multi-wavelength readings:
¢ In column priority, the instrument reads the entire microplate (or chosen number of
strips) at the first wavelength, and then goes back and reads the microplate at the
second and other selected wavelengths.
¢ |In wavelength priority, the instrument reads all wavelengths for the first column of wells
in the microplate first, and then reads all wavelengths for the second column, third
column, and so on.

Microplate Read Order

* Row reads the entire microplate row-by-row.

e Column reads the entire microplate column-by-column.

e Well reads each well individually with all wavelengths and intervals defined for the read
before reading the next well. This can be useful for spectral scans, area scans, and
specialized, fast-kinetic applications.

For the SpectraMax i3x or i3 Multi-Mode Detection Platform and the

SpectraMax Paradigm Multi-Mode Microplate Reader, selecting a Well read order in the
Standard View, or adding a For Each Well loop in the Acquisition View, for a kinetic
read lets you define timing parameters in milliseconds.

Settling Time

For some instruments, the Settling Time option is available in the More Settings category in
the Settings dialog.

Settling Time is the delay between the motion of the reader and the start of the read. This
delay allows time for the meniscus motion to cease, potentially improving precision,
especially in the low-density, high-volume microplates with fewer than 96 wells.

To specify a settling time, select the Settling Time check box, and then type a time between
100 and 1000 milliseconds.

The specified delay is added between the reading of each column. There is no delay between
each wellin a column.
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Show Pre-Read Optimization Options

For some instruments, Show Pre-Read Optimization Options can be selected in the More
Settings category in the Settings dialog.

In the Acquisition View, Plate Optimization can be added to the beginning of the time line.

Selecting Show Pre-Read Optimization Options causes the Pre-Read Optimization Options
dialog to open before the microplate is read. The available optimization options are
dependent on the read mode.

Microplate Optimization

Microplate dimensions can vary slightly between production lots, which can have a potential
effect on measurement accuracy. SoftMax Pro Software lets labware dimensions be
optimized by determining the centers of the four corner wells on the plate. Each time a
labware type is optimized before a read, a new plate definition is added to the Plate Library
with dimensions from the labware optimization.

If a microplate type is to be used in different plate orientations for measurements, labware
optimization must be done for each plate orientation separately.

Read Height Optimization

The SpectraMax i3x Multi-Mode Detection Platform and the SpectraMax Paradigm Multi-
Mode Microplate Reader feature an objective lens that can be moved up and down to
optimize the read height used in luminescence, fluorescence intensity, fluorescence
polarization, and time-resolved fluorescence protocols. Read height is the distance between
the top (using top reading) or bottom (using bottom reading) surface of the microplate being
read and the surface of the objective lens. Optimizing read height matches the focus of the
optics with the sample volume. This maximizes the raw signal, which yields the highest
precision and maximum sensitivity.

Read Height Optimization is available for the SpectraMax i3x Multi-Mode Detection
Platform for top-read only.

Read Height Optimization is available for the FilterMax F5 Multi-Mode Microplate Reader
for top-read only.

Read Height Optimization is not available for the FilterMax F3 Multi-Mode Microplate
Reader.

Attenuation

Very bright samples can exceed the linear dynamic range of the detection system. To reduce
the intensity, use an attenuation filter for the read.
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Normalization of AlphaScreen Data

For AlphaScreen reads, the Normalization option is available. In the Standard View, this
option is available in the More Settings category of the Settings dialog.

The conversion rate of photons to counts is individual for each detector. Therefore, raw data
from the same plate can seem to be different from one instrument to the next. Also, the data
format used by instrument manufacturers can be counts normalized-per-second or not-
normalized counts, therefore raw data can be different by several orders of magnitude. It is
important to know that the number of counts and the size of figures is in no way an
indication of sensitivity.

The raw data can be normalized to counts per second by selecting the Normalization option.
Background Correction with Interlaced Readings

For AlphaScreen Endpoint reads, the Interlaced Reading option is available. In the Standard
View, this option is available in the More Settings category of the Settings dialog.

Although background is significantly lower with AlphaScreen than with fluorescence intensity
measurements, Molecular Devices recommends that you use blank or assay controls for
background correction. The background can be effectively measured using blank replicates.
When reading a sample with small signal, an interference can occur from the afterglow of a
very strong emitting adjacent sample that was measured just before. Such cross talk can
occur through the wall of a white 384-well microplate. To prevent such interference, you can
select the Interlaced Reading option, which reads only every other well in a checkerboard
pattern, and adds a different plate run to read the previously omitted wells.

For improved results, Molecular Devices recommends that you use replicates for all blanks,
controls, and samples.

This setting is available for the SpectraMax i3x Multi-Mode Detection Platform and the
SpectraMax Paradigm Multi-Mode Microplate Reader with an AlphaScreen Detection
Cartridge installed.

5049092 A



5049092 A

Chapter 7: Collecting Data

Compound Transfer Settings

Compound transfer settings are supported by the FlexStation 3 Multi-Mode Microplate
Reader.

The Compound Transfer settings must be configured correctly. In addition to configuring
precise fluid transfers for your experiments, these settings also helps prevent flooding of the
assay plate.

The settings let you define volumes for up to three transfers. However, you must keep in
mind the actual maximum volume allowed in the wells you are using as you define the
settings. The maximum cumulative volume depends on the assay plate type you select. See
Plate Type Settings on page 250.

For the Endpoint and Kinetic read types, the transfers are done to all the selected wells
before the first read.

For the Flex read type, the transfers are done for a column while that column is being read.
All transfers and reads are done for that column before moving to the next column.

No. of Compound Transfers

You can enable up to three compound transfers in a each column during a read.

From the No. of Compound Transfers drop-down list, select the number of transfers
required for the assay.

e With O selected, no other options are displayed.

e With 1, 2, or 3 selected, color-coded images representing each of the transfers and the
transfer settings are displayed.

Initial Volume

In the Initial Volume field, type a value that equals the largest initial volume in the wells of
the assay plate before the compound transfers.

e For a 96-well microplate, this value can be set from 0 L to 269 pL, although typical values
are about 10 pL to 200 pL.
e For a 384-well microplate, this value can be set from O pL to 120 uL, although typical
values are about 5 pL to 80 L.
If there is no fluid volume in the assay plate before the compound transfers, type 0 this field.
The software defines all wells as having the same initial volume. The software uses this value
to compute the total volume in each well after all fluids have been dispensed. The software
makes this calculation to warn you in the Compound & Tips Columns settings of the
potential for overflow of fluid from the wells. See Compound and Tips Columns Settings on
page 293.
The entered value is saved with the file but the value is displayed only in the Compound
Transfer settings and in the Compound & Tips Columns settings.
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Transfer Settings

After you click one of the color-coded transfer images, that image is displayed with a light
blue background.

¥y 9 9

After you click a transfer image, you can then define the parameters for that transfer.

Note: There are no other indications in the transfer settings for which transfer you are
defining, so pay close attention to which transfer settings you are modifying.

¢ Inthe Pipette Height field, type a value of 1 uL to 300 pL for a 96-well microplate or 1 uL

to 130 uL for a 384-well microplate. This setting determines the volume of fluid in
microliters, measured from the bottom of the assay plate well, above which the tip of
the pipette will remain during the dispensing portion of the transfer event. This setting
helps makes sure that the tip of the pipette is below the surface of the liquid at the end
of the transfer, minimizing the possibility that undispensed drops remain on the tips.

% Note: As you configure subsequent transfers, calculate the amount of fluid added
and set the pipette height accordingly. For example, if the initial volume is 15 pL
and the first transfer dispenses 20 uL, then you can set the pipette height for the
first transfer to 25 pL. If the second transfer dispenses 15 uL, then you can set the
pipette height for the second transfer to 45 L.

In the Volume field, type a value to define the volume of liquid to be dispensed from the
source to each individual well chosen to receive that transfer.

e For a 96-well microplate, the range is 1 uL to 200 pL.
e For a 384-well microplate, the rangeis 1 uL to 30 pL.

Note: Keep in mind the maximum total volume each well can hold as you
accumulate volumes with multiple transfers.

In the Rate field, type a value of 1 to 8. This setting determines the rate at which the fluid
is dispensed into the well of the assay microplate.

* Ina96-well microplate, a setting of 1is equal to 26 pL per second and each
subsequent number increases in increments of 26 pL per second, so that a setting of
2is equal to 52 pL per second.

¢ In a 384-well microplates, a setting of 1 is equal to 6 uL per second and each
subsequent number increases in increments of 6 UL per second, so that a setting of 2
is equal to 12 uL per second.

A setting of 3 or 4 can help minimize cell damage or dislodgment. For non-contact
dispensing, use a rate of 8 to make sure that all liquid is dispensed from the pipette tip.
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* Inthe Time Point field, type a value that is equal to or greater than the value in the
Minimum Time up to 9999 seconds. This setting determines the time after the start of
the read when the fluid is scheduled to begin being dispensed. Your time point becomes
your baseline time. This is not the time interval between transfers. In Endpoint and
Kinetic reads, Time Point defines the time at which the first dispense occurs. The
Endpoint or Kinetic read begins after all transfers are made.

Note: The Time Point value cannot be smaller than the Minimum Time identified
by the software for each transfer.

e The Minimum Time field automatically displays the minimum time required before a
pipetting event can occur. This minimum time value is cumulative, not an interval
between pipetting events. The value is the minimum number of seconds of elapsed time
from the beginning of the read. It takes into account the mechanical speed of the pipette
head and the time needed to load and unload tips, aspirate and dispense fluids, triturate
fluids, and shake the microplate.

The minimum time for the second pipetting event depends on when the first pipetting
event occurred. The calculation for the second event starts at the end of the first event
and adds the total time necessary to load pipette tips, aspirate new fluids from the
compound plate, and dispense them into the assay plate.

Leave Tips On Between Columns

For a Flex read type, the pipettor returns the tips to the tip rack after all the transfers for a
column are complete, and then installs tips from the tip rack before the first transfer for the
next column. If you are using tips from the same position in the tip rack for the first and last
transfers in each column, then you can reduce the cycle time between columns by selecting
the Leave tips on between columns check box. The tip assighments are defined in the
Compound & Tips Columns settings.

Avoiding Problems

Time point calculations are based on the number of wells read, and the tip column and the
compound column used during the transfer. If you select time points that are not long
enough to be compatible with the selected volumes and transfer speed, the software notifies
you that the time point needs to be increased.

If you select transfer volumes that add up to more than the maximum that can fit in the
assay plate, an overflow warning is displayed indicating that you have exceeded the volume
limits of the assay plate.

Pay attention to the minimum time value displayed under the time point field for each
transfer, as the minimum time values are different depending on which transfer you are
configuring.

The Compound Transfer settings work together with the Compound & Tips Columns
settings. Until well assignments are made in the Compound & Tips Columns settings, the
Compound Transfer settings display No targets assigned. See Compound and Tips Columns
Settings on page 293.
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Compound Source Settings

The Compound Source settings let you select a compound source plate. Compound plates
store fluids that are aspirated (or withdrawn) from the compound plate and then dispensed
(orinjected) into the assay plate during the run.

Make sure that you select a plate type that matches the type and well configuration of the
actual compound plate you are using. It must also be compatible with the number of wells
selected in the plate type settings for the assay plate.
The well bottom height is different for different types of microplates. Select the plate type
correctly to prevent jamming the pipette tips into the bottom of the well.
e For 96-well microplates, the instrument aspirates using a pipette height of 20 uL above
the bottom of the well.
e For 384-well microplates, the instrument aspirates using a pipette height of 10 uL above
the bottom of the well.
The pipette height for the compound source plate is set automatically. The pipette height for
the assay plate is defined in the Compound Transfer settings.

Pipette Tip

Pipette Height

vell Bottom Height

Compound PMate

Figure 7-2: Well Bottom Height

A CAUTION! Selecting an incorrect compound plate type can result in the pipette tips
jamming into the wells and damaging the microplate, the tips, and the instrument.
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Pipette Tips Layout Settings

The Pipette Tips Layout settings display a column of tips in a 96-well (12 tips) or 384-well (24
tips) layout that matches the selection made in the Plate Type settings for the assay plate.

If you use a partial rack of tips, make sure that the Pipette Tips Layout settings match the
configuration of the partial rack inserted in the tip drawer. The selected tips must be
contiguous.

To select a contiguous set of tips, use your mouse to drag the pointer and select the tips to
use.

[] Select Al

To use all the tips in the rack, select the Select All check box.

If you change the selection in the Plate Type settings for the assay plate to a microplate with
a different number of wells (for example, from 96-wells to 384-wells), the selection in the
Pipette Tips Layout settings defaults to selecting the full rack of tips.

A CAUTION! Molecular Devices recommends using a full rack of tips each time you do a
fluid transfer. If you mistakenly enable a pipetting function from a tip that is not
present, your samples will not receive the intended compound. There is also a
potential of damaging the microplate, the tips, and the instrument.

Compound and Tips Columns Settings

The Compound & Tips Columns settings that are available depend on the selection made in
the Plate Type settings for the assay plate and the number of transfers defined in the
Compound Transfer settings.

If one or more transfers are enabled, then these settings let you choose the tips and
compounds to be used for each of the transfers.
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Each color-coded transfer is stacked on top of the previous transfer, with the black area at
the bottom representing the initial volume in the wells.

e For a96-well assay plate, all 12 columns are displayed.

e For 384-well columns, the first 12 columns are displayed. To view the other columns,
drag the scroll bar to the right.

You can restrict the number of columns that are available in the Read Area or Wells to Read
settings, and restrict the number of tips that are available in the Pipette Tips Layout
settings.

Each transfer is assigned a set of tips from the tip rack and a column from the source plate:

e To select a set of tips from the tip rack for a transfer, click the tip assignment indicated by
the letter t and then select the number of the tip set from the list.

e To select a column from the source plate for a transfer, click the column assignment
indicated by the letter c and then select the number of the source column from the list.

If the assay requires that no fluid is to be transferred to the assay microplate for a column
during one or more transfer operations, click the red X at the top of the drop-down list. A
color-coded drop icon is displayed for that column indicating that it will be skipped.

'3

To enable a transfer for a skipped column, click the drop icon and then assign the tip and
source columns for the transfer.

You can manually assign tips and source columns for each and every transfer.
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* Tip: To leave the tips on between columns for a Flex read type, select the same set of
tips in the tip rack for the first transfer of a column as was selected for the last transfer
of the previous column.

Assigning Compound and Tip Columns Automatically
To have the software automatically assign the tips and columns, click Auto Populate.

The SoftMax Pro Software automatically enters information in the Compound and Tip
Columns settings taking into consideration the number of transfers and the Read Area or
Wells to Read settings. The software assigns fluid to be aspirated from the compound plate
starting with the first available column. Aspirated fluid is then be dispensed to the first
available column in the assay plate as indicated in the Read Area or Wells to Read settings.

The software makes the assignments based on the following conditions:

e All columns selected in the Read Area or Wells to Read settings are to receive fluid.

e Thefluids are transferred from left to right. The read-transfer-read sequence in each
column is initiated only after the read-transfer-read event from the previous column is
completed (the total read time for that column).

e The fluid transfer targets are cumulative from transfer to transfer. That is, the targets for
the second transfer start with the next available clean tip and untargeted compound
column rather than reusing tips and compound columns targeted by the preceding fluid
transfer.

e Each fluid transfer uses a new tip.

For example, suppose the instrument is configuring for three fluid transfers as follows:

e Aselection in the Read Area or Wells to Read settings of columns 1 through 4.

e ACompound Source selection of a 12-column compound source plate, such as a 96-well
microplate.

e Aselection in the Pipette Tips Layout settings of a full rack of tips.

From this configuration, the SoftMax Pro Software selects tip and compound columns 1
through 4 for the first transfer. The second transfer uses the next four columns (5 through 8),
and the third transfer uses the remaining four unused columns (9 through 12).

Note: The SoftMax Pro Software does not assign targets beyond the limitations of the
available tips and compound source columns. After all available tips and compound
source columns have been assigned, the software stops assigning targets.
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Triturate Settings

Trituration is mixing of the contents of the wells in a microplate by using the pipettor to
alternately aspirate the fluid from a well and then dispense it back into the well. You can
choose to triturate in either the compound source plate or the assay plate, or both.

Applications for which trituration is recommended include when the compound in the
source plate needs to be resuspended before the addition, when transferring low volumes of
fluid to the assay plate, or when transferring fluid before or during an absorbance read to
make sure that the well contents are properly mixed.

The Triturate settings are based on the number of compound transfers you specified in the
Compound Transfer settings. If no transfers are enabled, no triturate settings are available.

Select the transfer during which trituration is to be done, and then select either the
Compound Source or the Assay Plate check box, or both.

Type values for the Volume of fluid in microliters to be withdrawn from the well, and for the
number of Cycles, or times, to aspirate and dispense the fluid in the well.

For the Assay Plate settings, you must also type a value for the Height at which the
trituration occurs. The height setting must take into account the defined trituration volume
and the total volume in the well, so that the tips remain below the liquid surface and do not
aspirate air.

If you have selected dispense times that are incompatible with the Triturate settings, an
error message appears. To modify the dispense time, return to the Compound Transfer
settings.
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Defining and Running a Workflow

5049092 A

The Workflow view provides you with a drag-and-drop workflow editor and tools to run and
monitor a workflow. In Workflow view you can define a workflow using the defined Plate
sections and instrument settings to run multitask kinetic reads that last hours or days.

Segin ¢ & ¥ &) - &) Frd
Set Temperature Cycle Read Delay Read
Incubator: On Cycles: Plate: LUM-kinetic 00:10:00 Plate: FL-kinetic
Plate Chamber Set Paoint: 35 °C Total Run Tirme: 04:00:00 Experiment: Multitask Experiment: Multitask
Wait: On Cycle Interval: 00:30:00

To change to the Workflow view, click the Workflow button.

Drag tasks from the menu on the left to the timeline on the right.

= g
Begin @ |\i/] End
Cycle %
Cycles: §
Total Run Tirne: 04:00:00
Cycle Intereal: 00:30:00

Define repeated tasks by placing the tasks in a defined Cycle task.

* Tip: You can gather data over long periods of time by using a Kinetic read type and
then defining the Timing settings to acquire a single point with each read. See Timing
Settings on page 260.

% Note: Place only Kinetic reads within a cycle. Using other read types causes the
software to overwrite the previously acquired data in the Plate section. You can place
an Endpoint, Well Scan, Spectrum, or Flex read before or after a cycle to preserve the
acquired data.

When you click a task in the timeline, a pencil icon appears. Click the pencil icon to edit the
settings for that task. See Editing Workflow Tasks on page 298.

) Read

Experiment: | hultitask "l
Read Plate Sectiomn: |FL-kinEti|: - E]

Plate: FL-kinetic
Experirnent: Multitask

To remove the task from the timeline, click the red X.
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In the Workflow tab of the ribbon, click the options in the Designer group to undo or redo
actions, clear all tasks from the editor, and zoom in and out of the editor. Click Mini Map to
open the Overview window that can help you navigate a long timeline. To export an image of
the timeline in JPG, PNG, GIF or XPS format, click Save as Image.

Click the options in the Execution group to start, pause, resume, and cancel the workflow.
See Running a Workflow on page 300.

The Status group displays the current status of the workflow. Click Execution Log to view the
status of the tasks of a running workflow in real time.

Editing Workflow Tasks

In the Workflow editor, drag tasks from the menu on the left to the timeline on the right and
then click the pencil icon to edit the settings for that task.

Experirnent:
Read Flate Section: E]

Plate: FL-kinetic
Experiment: Multitask

Select options from the drop-down lists or type text in the fields. When you have finished
editing the task, press ENTER or click on a blank area of the workflow editor.

Each task has its own set of options:

Read

From the Experiment drop-down list, select the name of the experiment that contains the
Plate section for the read.

From the Plate Section drop-down list, select the name of the Plate section for the read.

The read is done using the instrument settings defined for the selected Plate section. To edit

the instrument settings, click @ See Instrument Settings on page 246.

* Tip: If you have placed a Kinetic read in a Cycle for a SpectraMax i3x,
SpectraMax Paradigm, or FilterMax reader, turn off Show Pre-Read Optimization
Options for the read to prevent having the software wait for user interaction before
each read. See Show Pre-Read Optimization Options on page 287.
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Open Drawer

Mark the Wait while drawer is open check box to pause the workflow until the drawer is
manually closed. If you require the workflow to continue to the next task with the drawer
open, clear this check box.

In the Message to Show, type a message that software displays when the drawer opens.
You might want to type instructions for the operator.

Set Temperature

To set the temperature in the read chamber, click On and then type the desired temperature
in degrees Celsius in the Plate Chamber Set Point field.

Mark the Wait while the temperature changes check box to pause the workflow until the
read chamber reaches the required set point. If you require the workflow to continue to the
next task before the chamber reaches its set point, clear this check box.

To turn off temperature control, click Off.

For more information, see Setting the Temperature on page 47.

Shake

In the Shake time field, type the number of seconds to shake the microplate.

Delay

Type values for the delay in Days:Hours:Minutes:Seconds, or click one of the values and then
click the arrow button on the right to increment or decrement that value.

% Note: The Delay task continues even if the workflow has been paused.

Cycle

Total Run Time defines the total time for all the cycles to complete. Type values in
Days:Hours:Minutes:Seconds, or click one of the values and then click the arrow button on
the right to increment or decrement that value.

Cycle Interval defines the time from the start of one cycle to the start of the next cycle. Type
values in Days:Hours:Minutes:Seconds, or click one of the values and then click the arrow
button on the right to increment or decrement that value.

The number of cycles is calculated based on how many Cycle Intervals can be completed
within the Total Run Time.

To include a task in the cycle, drag the task between the start and end points of the Cycle
task.
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170
Begin @ '\i) End

Cycle

Cycles: 3

Total Run Tirne: 04:00:00
Cycle Intereal: 00:30:00

When you define the timing for a Cycle, make sure that the tasks in the Cycle can be
completed within the allotted time. The workflow editor cannot calculate the time it takes to
do aread. Ifthe read takes longer than the time allotted for the Cycle, then the next Cycle
begins immediately after the Cycle tasks have completed.

% Note: The Cycle Interval continues even if the workflow has been paused.

Running a Workflow

After you have your workflow defined and your prepared microplate inserted in the
microplate reader, you can run the workflow.

Note: Before starting a read, it is good practice to save your data file. For Imaging
reads and Western Blot reads, you must save your data file before starting the read.
See Saving Data Files on page 65.

e To run a workflow, click the Start @ button in the Workflow tab of the ribbon.

e To stop a running workflow, click the Cancel @ button.

e To temporarily stop a running workflow, click the Pause il button. Pausing a
workflow lets you work with other features in the software, such as defining protocols or
running short reads, while the software is waiting to do the next non-timing task in the
workflow.

When a workflow is paused, all delays and cycle timings continue to run. When the
workflow reaches a non-timing task, such as a read, the task is started after the workflow
is resumed. If the workflow is resumed after the scheduled time for a task to start, then
the task starts when the workflow is resumed and all subsequent tasks are rescheduled
to a later time.

For example, if a delay before a read is set for 30 minutes and the workflow is resumed
after 40 minutes, then the read starts when the workflow is resumed and all subsequent
tasks are rescheduled to start 10 minutes later than their original times.

—

o Torestart a paused workflow, click the Resumew button
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The Template Editor is a representation of the microplate or set of cuvettes shown as a grid
of wells that can be used to designate the location of blanks, standards, controls, unknowns,
empty wells, or to assign wells to other groups you create.

When you select multiple wells in the Template Editor, the selection must be a rectangular

group of contiguous wells.

1. Click a Plate section or Cuvette Set section to make it active in the workspace.

2. Click Template

in the Template Tools section of the Home tab in the ribbon or in

the toolbar at the top of the section. This opens the Template Editor.

[iid] Terplate Editor

Select wells, then add or select @ group (or blank) and assign.

[ Copy ][ Paste ¥ |
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The Template Editor contains a representation of the rows and columns of the
microplate in the active Plate section.

When you open the template editor with a Cuvette Set section active in the workspace,
the template editor window contains 96 wells in the column and row format of a 96-well
microplate. The cuvettes in the template are numbered as if they were wells in a

microplate. This representation provides easy access to the data analysis capabilities of

the SoftMax Pro Software.
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3. Define a group of wells, see Defining a Group on page 303.

* To assign wells to an existing group, select the wells to add to the group, click the
group name, and then click Assign.

* To specify wells as Plate Blank, select the wells and then click Plate Blank.

e To specify wells as Group Blank, select the wells, click Group Blank, and then click
Assign.

% Note: For more information about using blanks, see Defining Blanks on page
308.

e Toremove wells from a group, select the wells to be removed and then click Clear.
e To print the Template Editor dialog, click the Print button.

4. To assign wells to a series, select the wells and then click the Series button. See Creating
a Series on page 304.

5. Click OK to close the Template Editor and apply the template.

To save the template in a protocol file for use on future experiments, see Saving Protocol
Files on page 75.

Modifying a Template

To modify a template:

1. Click a Plate section or Cuvette Set section to make it active in the workspace.

2. Click Template Editor in Template Tools on the Home tab in the ribbon orin the
toolbar at the top of the active section.

3. Inthe Template Editor, modify the template as needed. See Configuring a Microplate
Template on page 301.

4. Click OK to close the Template Editor.
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Wells can be assigned to group types using the Template Editor. Depending on the protocol,
certain group types, such as Standard or Unknown, can be created automatically. You can

create other groups as required.

To define the group for selected wells:

1. Click a Plate section or Cuvette Set section to make it active in the workspace.

2. Click Template Editor

in Template Tools on the Home tab in the ribbon orin the

toolbar at the top of the active section. This displays the Template Editor.

2] Termplate Editar w3l
Selectwells, then add or select a group (or blank) and assign. @
Groups.
[ copy |[ Paste v ] View @ Sample Name () Descriptor Add Edit | [Delete
1 2 3 3 7 B a 10 11 12 4 Standards
Control . =
A = b= o 4 Unknowns
Unknowns
G = o . Unik_Dilution
c o1 o1 o1 .
Control
D oL 01 o1
E| o ol o1
F| o o1 o
G| o o1 o
H| o ol o1
Assignment Options
Blanks Standards
Sample 02 -
Plate Blank 3
Concentration mg/mi
‘Group Blank
Assign || Series |

The Template Editor contains a representation of the rows and columns of the

microplate in the active Plate section.

When you open the template editor with a Cuvette Set section active in the workspace,
the template editor window contains 96 wells in the column and row format of a 96-well
microplate. The cuvettes in the template are numbered as if they were wells in a
microplate. This representation provides easy access to the data analysis capabilities of
the SoftMax Pro Software.

Use your mouse to drag the pointer to select one or more wells to be defined as a group.
In the Groups area, select an existing group and click Edit.
To create a new group, click Add. See Creating a Group on page 140.

In the Group Settings dialog, if a sample descriptor has been defined for the selected
group, type an applicable value in the field for the descriptor.

Click OK to close the Group Settings dialog.
Click Assign to assign the group to the selected wells.
To define a series for the selected wells, click Series. See Creating a Series on page 304.

Click OK to close the Template Editor and apply the template.
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Creating a Series

You can define several samples as a series, letting you easily enter incremental sample
descriptors (for example, dilutions or concentrations) and sample names to the template as
long as the increment can be expressed as a mathematical operation. This lets you work with
groups of wells in the Template so that the standard value or dilution factor increases or
decreases in specified steps. The series name can be incremented as well.

You can assign the same group or sample definition (same sample name and description
within a group) to multiple wells to create replicates. For example, you might want to read
standards in replicate to ensure that anomalies can be excluded before generating a
standard curve. To create replicates, click the Assign button or use the Series dialog.

Aseries is defined in one direction (starting from left, right, top, or bottom) and therefore
samples must be configured sequentially in either ascending or descending order.

To create a series:

1. Click a Plate section or Cuvette Set section to make it active in the workspace.

2. Click Template Editor
toolbar at the top of the active section.

in Template Tools on the Home tab in the ribbon or in the

3. Inthe Template Editor dialog, click and drag the mouse to select one or more wells to be
part of the series.
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4. Inthe Groups area, select an existing group name.

Note: Aseries is related to a group. If no groups have been defined, you will need
to define a group and then define the series. To create a new group, click Add to
open the Group Settings dialog. See Using the Group Settings Dialog on page 139.

5. Click the Series button.
6. Select options in Series Layout.

e Choose a fill direction to describe how the series fills the wells from the Start From
options. Select one of Top to Bottom, Bottom to Top, Left to Right, or Right to
Left.

e In Patterns of Replicates, type the number of replicates in the Y-Direction and type
the number of replicates in the X-Direction.

The maximum number of replicates depends on the selection of wells. For example,
if you are filling down from the top and you have chosen a block of wells that is 4
wells wide by 8 wells high, the maximum number of replicates will be four. With the
same block of wells selected, filling from the left would permit eight replicates. If the
number of replicates you choose does not divide evenly into the number of rows or
columns you select, depending on the filling direction, the remaining wells that
cannot contain replicates will be labeled as more individual wells in the series. To
create a series that includes all the wells in the microplate, select all the wells, select
the fill direction, and then set the replicates to 1.

e Optionally, click Reverse Series Order to reverse the order of the series.

7. In Sample Information type the name of the first sample in the series in the Starting
Sample Name field. Subsequent replicates use this name as a base and either increment
the number within the name or append a number to it.

8. Ifasample descriptor has been defined for the selected group, type an applicable value
in the Starting Value field for the descriptor.

9. From the Step by list, select the operator for the series (+, -, *, or /) and then enter a
value for the increment. For example, with a starting value of 0.5, the division operator
(/) and the increment 2, the series will start with 0.5 and divide each subsequent sample
by 2 to produce the series 0.5, 0.25, 0.125, and so on.

10. Click OK to save the series and close the dialog.
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Incrementing the Names Only
To increment the names of a series of samples without applying a concentration or dilution:

1. Create a series in the Series dialog.
2. Ifasample descriptor has been defined for the selected group, clear the check box next
to the descriptor.

Incrementing with a Constant
To increment the names of a series of samples with a constant concentration or dilution:

1. Create a series in the Series dialog.

2. Inthe Starting Value field for the sample descriptor, type a value for the concentration
or dilution.

3. From the Step by list, select the multiplication operator (*) and then enter a value of 1
for the increment.
If sample names are set to increment automatically using the Series function, then the
SoftMax Pro Software automatically truncates the sample name to three or four
characters, including the incrementing number if the sample name starts with letters. If
the sample name is entirely numeric, it is not truncated. If sample names are very long,
and they must be kept long for reference, you need to set up your replicates manually.

Copying and Pasting Template Contents

The content of a template can be copied and pasted to a different section within the same
experiment or between different experiments. Only contiguous subsets can be copied in the
template.

Within the Same Experiment Section
The destination template is an extension of the original template and all wells on the
destination plate are considered replicates of the wells on the source plate, with the same
group and sample names.
e Changes made to the template on the destination plate are also made on the source
plate.
e Data from the two Plate sections are analyzed together.
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Between Different Experiment Sections

When copying and pasting between different Experiment sections, make sure that the group
names and sample names of the pasted template are identical to those from the source
template. Since they are in different Experiments, however, the full name is different, for
example: group@experiment#2 instead of group @experiment#1.

e Changes made to the template of the destination Plate section have no effect on the
source section.

e Data from the two Plate sections are not analyzed together.

Regions within a Template
Only contiguous subsets can be copied and pasted in a template.
To copy and paste a region of a template:

1. Click the source Plate section to make it active in the workspace.

2. Click Template Editor in Template Tools on the Home tab in the ribbon or in the
toolbar at the top of the active section.

3. Click and drag to select the wells to copy.
Click the Copy button on the left above the template.

M Template Editor M
Select wells, than add or select a group (or blank) and assign. @
Groups
copy |[Paste ¥] [ cear | View  (3)Sample Name () Descriptor
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= Unknowns
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E| o 01 01 01 01 0 0 0 o Centrol
o | o |« u | .
G| o | @ | @
H
Assignment Options
Blanks Group0l
Platz Blank 3
Concenmration ||
Group Blank

5. Click a different location in the same template and then click Paste.

Note: You can select the same footprint, or click the top-left well of the desired
target.
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6. From the menu click Paste or Paste With New Group.
e Paste adds the copied wells to the current group.
e Paste With New Group pastes a the copied cells into a new group.
If more wells are selected for pasting than were selected for copying, the extra wells are
left empty.
The real value in this method is the means to copy a complicated template and then to
analyze the data separately from the original plate.

Defining Blanks

In the Template Editor you can configure Plate Blanks and Group Blanks.
The different blank types have the following features:

o Plate Blanks are used to correct readings when all samples on a plate have been
prepared in the same buffer or matrix, and therefore can use the same correction value.
Plate blanks are subtracted from the raw data, or after pathlength correction if
PathCheck is selected.

* Group Blanks are used to correct readings when samples on a plate have been prepared
in a different buffer or matrix, and therefore have to be individually corrected. Group
blanks can be subtracted from raw data, like plate blank, or after post-reduction
calculations, for example, wavelength, kinetic reduction, and so on.

Blanks can be used in combination and have cumulative effects.

Plate Blanks
Plate Blanks can be assigned in Plate sections and in Cuvette Set sections.

Plate Sections
Wells can be assigned to a Plate Blank:

1. Click a Plate section to make it active in the workspace.

2. Click Template Editor on the Home tab in the ribbon or in the toolbar above the
active section.

3. Inthe Template Editor, select the wells to be used for the Plate Blank.

4. Click Plate Blank.

Use Plate Blanks when all samples on the plate have been prepared in the same way, and
therefore can be corrected from a single blank reading. Plate Blank subtraction can be
turned off in the Data Reduction dialog so that the data can be reviewed with or without
Plate Blank subtraction. See Doing Data Reduction on page 367.

For Kinetic and Spectrum data, the blank value is averaged and subtracted from each point
in the read.
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Cuvette Set Sections

To do a similar function to Plate Blanking for Cuvette Set sections, you can assign cuvettes to
a Blank group in the Template Editor of the Cuvette Set section and create a Template Blank:

1. Click a Cuvette Set section to make it active in the workspace.

2. Click Template Editor on the Home tab in the ribbon orin the toolbar above the

active section.
3. Inthe Template Editor, select the cuvettes to be used for the Template Blank.
4. Click Blank.

The average value of all the cuvettes in a Template Blank group is subtracted from individual
cuvette readings in the same Cuvette Set section.

For Kinetic and Spectrum data, the blank value is averaged and subtracted from each point
in the read.

Template blanks are subtracted after the cuvette reference reading is subtracted.

Group Blanks (Plates and Cuvettes)

Blank wells can be assigned within a group (other than the “Blank” group) in the Template
Editor:

1. Click a Plate section or Cuvette Set section to make it active in the workspace.

2. Click Template Editor on the Home tab in the ribbon orin the toolbar above the

active section.

3. Inthe Template Editor, select the wells or cuvettes to be used for the group blank. These
should be wells or cuvettes that are assigned to a Group, but not the “Blank” group.

4, Select a group from the Group Types list.

5. Click Group Blank and then click Assign.

In a plate blank group the average value of all the wells in the Blank group is subtracted from

each individual well value on the microplate. If you have an instrument that supports

PathCheck Pathlength Measurement Technology, the Plate Blank is subtracted after

pathlength correction. The average reduced value of the blank wells or cuvettes within that

group is subtracted from individual reduced values within that group only.

Use Group Blanks when samples on the plate have been prepared differently, and therefore
require individual blank correction.

The Group Blank function offers the options of subtraction before or after data reduction.
When a group blank has been assigned, it is automatically subtracted and you do not have
the option of reviewing the uncorrected data. To see the reduced number without the group
blank subtracted, you must mask the group blank wells or cuvettes. See Masking Wells or
Cuvettes on page 367.

Group blanks apply to all wells or cuvettes in a group and can be subtracted from wells or
cuvettes in more than one Plate section or Cuvette Set section.
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Exporting a Template

To export template information from a Plate section:

1.

Click the Plate section with the template to be exported to make it active in the
workspace.

Click Export &' in Template Tools on the Home tab in the ribbon.

In the Save As dialog, navigate to the location in the file system where you want to save
the template file.

4. Type a name for the file in the File name field

6.

From the Save as type list, select Text files (*.txt) or Excel files (*xIs).
Text files are save in tab-delimited format.
Click Save.

For information about the format of an imported or exported template file, see Template File
Formats on page 311.

Importing a Template

Template information can be imported into a Plate section from a tab-delimited ASCII text
file in Unicode (UTF-8) format. Template files can be prepared outside SoftMax Pro Software
and then imported as needed when ready to run samples.

For information about the format of an imported or exported template file, see Template File
Formats on page 311.

* Tip: Agood way to determine the correct format for importing a template is to export

a template from SoftMax Pro Software and examine the contents of the resulting file.

Click the Plate section where you want to import template information to make it active
in the workspace.

Click Import in Template Tools on the Home tab in the ribbon.
In the Open dialog, navigate to and select the text file to be imported.
Click Open.
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Template File Formats

Template information saved as a tab-delimited ASCII text file in Unicode (UTF-8) format can
be imported to or exported from Plate sections. A template file consists of ten columns of
data separated by tabs. Each line of the file provides information for a single well in the
microplate.

When template information is exported, the first line of data contains template information
for well A1, the second line of data contains template information for well A2, and so on, until
a line has been created in the export file for each well in the microplate. If no template
information exists for a well in a plate, that line is left blank.

The order for importing template information must match the export order. Similarly, blank
lines in the file are assigned to a well, providing a well with no template setting.

Atab-delimited ASCII file can be opened with a spreadsheet program, such as Microsoft
Excel. If the file is edited in Microsoft Excel, it cannot be imported back into SoftMax Pro
Software unless the layout of the cells match the correct format for importing, and the file is
saved as an ASClII text file in Unicode (UTF-8) format.

Table 7-3: ASCIl Template File Columns and Descriptions

Column Column Entry Description
A Well Location In this column, the wells do not need to be in order.
B Group Name Assigned in the Group Settings dialog. If this field is

missing, the rest of the line is ignored. A text string
can be entered in this field.

C Group Type Assigned in the Template Editor dialog. Three text
strings are supported in SoftMax Pro Software:
Standards, Unknowns, Custom.

Blank groups have an Empty column format. If this
field is left blank, no sample name will be assigned to
the well, although the sample name will be included
in the group.

D Sample Name The sample name is set in the Sample field of the
Template Editor dialog. If this field is left blank, no
sample name will be assigned to the well, although
the sample name will be included in the group.

E Descriptorl Name Assigned in the Group column name assigned to the
descriptor 1 is shown here.

F Descriptorl Value Assigned in the Group Settings dialog. A numeric
value can be entered in this field or it can be left
blank.

G Descriptorl Units Assigned in the Group Settings dialog. Supported

strings are unit/ml, mg/ml, ug/ml*, ng/ml, mg, ng, and
ml. If this column is left blank, unit/ml is assigned.

5049092 A 311



SoftMax Pro Software User Guide

Table 7-3: ASCIl Template File Columns and Descriptions (continued)

Column Column Entry Description

H Descriptor2 Name Assigned in the Group column name assigned to the
descriptor 2 is shown here.

| Descriptor2 Value Assigned in the Group Settings dialog. A numeric
value can be entered in this field or it can be left
blank.

J Descriptor2 Units Assigned in the Group Settings dialog. Supported

strings are unit/ml, mg/ml, ug/ml*, ng/ml, mg, ng, and
ml. If this column is left blank, unit/ml is assigned.

* The p symbol can be imported only if the ASCII text file is saved in Unicode (UTF-8) format.

Creating an Absorbance Mode Protocol

To create an Absorbance Mode protocol:
1. Start the SoftMax Pro Software. See Starting the Software on page 14.

2. Select an instrument. See Selecting and Connecting to an Instrument on page 16.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

T

£

3. With the plate or cuvette section active, click Settings “& on the Home tab in the
ribbon.

4. When working with a SpectraMax Paradigm Multi-Mode Microplate Reader, click the
Absorbance Detection Cartridge from the Cartridges list. When working with the
SpectraMax i3x Multi-Mode Detection Platform, use the built-in monochromator.

Click ABS to select the Absorbance read mode.
Click a Read Type.
Define the settings.
For more information about the settings, see the SoftMax Pro Application Help.
After defining the settings for the protocol, click OK to close the Settings dialog.
9. Create atemplate, if applicable. See Configuring a Microplate Template on page 301.

10. Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.

11. Set Display options, if applicable. See Setting the Data Display Options on page 358.

12. Savethe settings to a protocol file. See Saving the Settings to a Protocol File on page 338.
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Absorbance Mode Protocol Overview

Absorbance is the quantity of light absorbed by a solution. To measure absorbance
accurately, it is necessary to eliminate light scatter. If there is no turbidity, then
absorbance = optical density.

A =logiollo /1) = —logll/10)
where I, is incident light before it enters the sample, / is the intensity of light after it passes
through the sample, and A is the measured absorbance.

Applications of Absorbance

Absorbance measurements are used to quantify the concentration of an absorbing species.
It must be known at what wavelength a species absorbs light. For example, the
concentration of nucleic acids can be quantified by measuring the absorbance at 260 nm.

Optimizing Absorbance Assays

The wavelength of the incident light can be adjusted in 1 nm increments. SoftMax Pro
Software also permits reading up to six wavelengths per plate or cuvette for Endpoint and
Kinetic read types, and four wavelengths for Well Scan reads.

It is always good scientific practice to designate wells in the microplate to serve as plate
blanks or group blanks. This can be done in the Template Editor dialog of the Plate section in
the SoftMax Pro Software. See Configuring a Microplate Template on page 301.

If desired, the PathCheck Pathlength Measurement Technology feature can be used to
normalize the data to a 1 cm pathlength. See PathCheck Pathlength Measurement
Technology on page 156.

% Note: Assay optimization requires the use of a computer and SoftMax Pro Software.
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Creating a Fluorescence Intensity Mode Protocol

To create a Fluorescence Intensity protocol:

1.
2.

10.
11.
12.

314

Start the SoftMax Pro Software. See Starting the Software on page 14.

Select an instrument. See Selecting and Connecting to an Instrument on page 16.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

(o'}
With the plate or cuvette section active, click Settings = % on the Home tab in the
ribbon.

When working with the SpectraMax Paradigm Multi-Mode Microplate Reader, click one
of the Fluorescence Intensity (Fl) cartridges from the Cartridges list. When working with
the SpectraMax i3x Multi-Mode Detection Platform, use the built-in monochromator or
click one of the Fluorescence Intensity (Fl) cartridges from the Cartridges list.

Click FL to select the Fluorescence Intensity read mode.

Click a Read Type.

Define the settings.

For more information about the settings, see the SoftMax Pro Application Help.

After defining the settings for the protocol, click OK to close the Settings dialog.

Create a template, if applicable. See Configuring a Microplate Template on page 301.

Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.

Set Display options, if applicable. See Setting the Data Display Options on page 358.

Save the settings to a protocol file. See Saving the Settings to a Protocol File on page 338.
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Fluorescence Intensity Mode Overview

Fluorescence occurs when absorbed light is re-radiated at a longer wavelength. In the
Fluorescence Intensity (FL) read mode, the instrument measures the intensity of the re-
radiated light and expresses the result in Relative Fluorescence Units (RFU).

The governing equation for fluorescence is:

Fluorescence = extinction coefficient x concentration x quantum yield x
excitation intensity x pathlength x emission collection efficiency

Fluorescent materials absorb light energy of a characteristic wavelength (excitation), undergo
an electronic state change, and instantaneously emit light of a longer wavelength (emission).
Most common fluorescent materials have well-characterized excitation and emission
spectra. The following figure shows an example of excitation and emission spectra for a
fluorophore. The excitation and emission bands are each fairly broad, with half-bandwidths
of approximately 40 nm, and the difference between the wavelengths of the excitation and
emission maxima (the Stokes shift) is generally fairly small, about 30 nm. There is
considerable overlap between the excitation and emission spectra (gray area) when a small
Stokes shift is present.
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Figure 7-3: Excitation and Emission Spectra

* Tip: If the Stokes shift is small, choose an excitation wavelength that is as far away
from the emission maximum as possible while still being capable of stimulating the
fluorophore so that less of the excited light overlaps the emission spectrum,
permitting better selection and quantitation of the emitted light.

315



SoftMax Pro Software User Guide

316

Because the intensity of the excitation light is usually many tens of thousands of times
greater than that of the emitted light, some type of spectral separation is necessary to
reduce the interference of the excitation light with detection of the emitted light.

The SpectraMax readers incorporate many features designed to restrict interference from
reflected excitation light. These features include a set of long-pass emission cutoff filters that
can be set automatically by the instrument or manually by the user.
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Figure 7-4: Optimized Excitation and Emission Reading Wavelengths

The previous figure shows that the best results are often obtained when the excitation and
emission wavelengths used for reading are not the same as the peak wavelengths or maxima
of the excitation and emission spectra of the fluorophore. When the reading wavelengths for
excitation and emission are separated, a smaller quantity of excitation light passes through
to the emission monochromator (gray area) and on to the PMT, resulting in a purer emission
signal and more accurate data.

The SpectraMax readers permits scanning of both excitation and emission wavelengths,
using separate tunable monochromators. One benefit of scanning emission spectra is that
you can determine more accurately whether the emission is, in fact, the expected
fluorophore, or multiple fluorophores, and not one generated by a variety of background
sources or by contaminants. One more benefit is that you can find excitation and emission
wavelengths that prevent interference when interfering fluorescent species are present.

For this reason, it is desirable to scan emission for both an intermediate concentration of
labeled sample, as well as the background of unlabeled sample. The optimal setting is where
the ratio of the sample emission to background emission is at the maximum.
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Optimizing Fluorescence Intensity Assays

The optimal instrument settings for detection of a particular fluorophore depend on a
number of different factors. Settings that can be adjusted for assay optimization include the
excitation and emission wavelengths, emission cutoff filter, readings per well, the PMT
voltage, and the temperature of the reading chamber.

Another important factor that is independent of the instrument but can affect assay
optimization is the Stokes shift, which is the difference between the wavelengths of the
excitation and emission maxima. When the Stokes shift is very small, optimizing the
excitation and emission wavelengths and correct cutoff filter choices are very important.

e Excitation and Emission Wavelengths

The excitation and emission wavelengths can be set in 1 nm increments between 250 nm
and 850 nm. The available wavelengths are dependent on the instrument. For more
information about the available wavelengths, see the documentation for the instrument
you are using.

A procedure to optimize excitation and emission wavelengths for a given assay is
outlined in Spectral Scanning on page 318.

e Emission Cutoff Filter

The emission cutoff filters assist in reducing background. Sources of background include
stray excitation light and native fluorescence of plate materials, sample constituents, and
solvents (including water). The default setting lets the instrument and SoftMax Pro
Software determine which cutoff filter should be used in endpoint and kinetic modes.
The spectral scan mode default uses no cutoff filter.

* Readings Per Well

The number of readings per well can vary between 1 (used for a quick estimate) and 100
(for very precise measurements). The default number of readings per well varies with the
read mode: for fluorescence, the default is 6, and for luminescence the display shows 1
read per well.

e PMT Voltage

The voltage of the photomultiplier tube can be set to low (for higher concentration
samples), medium, or high (for lower concentration samples) in all read modes. In
endpoint and spectrum mode, there is a different setting, automatic, in which the
instrument automatically adjusts the PMT voltage for varying concentrations of sample
in the plate.

e Temperature Control

The chamber of the instrument is isothermal at ambient as well as at elevated
temperatures.

The temperature in the reading chamber can be adjusted from 2°C (3.6°F) above
ambient to the maximum temperature for the instrument. See the user guide for your
instrument.
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Spectral Scanning

This procedure optimizes excitation and emission wavelengths for fluorescence assays using
spectral scanning.

If you are using the SpectraMax i3x Multi-Mode Detection Platform or using the
SpectraMax Paradigm Multi-Mode Microplate Reader with a Tunable Wavelength (TUNE)
Detection Cartridge, see Spectral Optimization on page 348.

Pipette 200 pL of sample that includes the fluorophore and 200 uL of a buffer control into
separate wells of a microplate.

Do the Excitation Scan

1. Using SoftMax Pro Software, set up a Plate section for a fluorescence read, spectrum
mode, Em Fixed/Ex Scan, with no cutoff filter (default), and medium PMT.

2. Set the emission wavelength based on the tentative value from the literature (or from a
customary filter set used to measure your fluorophore). If the emission wavelength is
not known, select a tentative emission wavelength about 50 nanometers greater than
the absorbance maximum of the fluorophore. If necessary, the absorbance maximum
can be determined by performing an optical density spectral scan first.

3. Set the excitation scan to start/stop approximately 50 nm below/above the tentative
excitation value obtained from the literature (or the customary excitation filter).

4. Setthestepincrement to 2 nm or 3 nm. You can choose to do a preliminary scan with a
10 nm increment to determine the approximate peak location, and then repeat the scan
over a narrower wavelength range with a2 nm or 3 nm increment.

5. Do the scan and view the results as a plot of emission fluorescence vs. excitation

wavelength. Note the excitation wavelength at the emission peak and the maximum RFU
value.

If an error message reporting missing data points occurs, it can be due to possible
saturation reported by the SoftMax Pro Software program at the end of the spectral
scan. Reset the PMT to “low” and rescan the sample (scan the buffer blank with the PMT
set to “medium” or “high”). If the error occurs after scanning with the PMT set to “low,”
it can be necessary to dilute the sample.

If the excitation scan shows no apparent peak, change the PMT setting to “high” and
rescan the sample. If the spectral scan still shows no apparent peak, adjust the Y-scale of
the zoom plot so that the plot fills the graph.
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6. Select the optimal excitation wavelength.

* |fthe excitation peak wavelength and emission wavelength are separated by more
than 80 nm, use the excitation peak wavelength value.

o |fthe excitation and emission wavelengths are less than 80 nm apart, use the
shortest excitation wavelength that gives 90% maximal emission. Follow the plot to
the left of the peak until the RFU value falls to approximately 90% of the maximum,
and then drop a line from the 90% point on the plot to the x-axis as shown in the
following figure.

RFU at 90%
of maximum lamda

Maximum lambda

RFU

~-------90% of
maximum lambda

Wavelength

Figure 7-5: Plot of RFU and Wavelength

Do Emission Scan #1

1.

In the SoftMax Pro program, set up a second plate section for a fluorescence read,
spectrum mode, Ex Fixed/Em Scan, with no cutoff filter (default), and medium PMT.

Set the excitation wavelength to the value determined in Do the Excitation Scan on page
318.

Set the emission scan to start/stop approximately 50 nm below or above the tentative
emission value obtained from the literature (or existing filter pair).

Note: If the Stokes shift is less than 50 nm, then start the emission scan above the
excitation wavelength.

Set the step increment to 2 nm to 3 nm (or do a preliminary scan with a 10 nm increment
to determine the approximate peak location and then repeat the scan over a narrower
wavelength range usinga 2 nm to 3 nm increment.)

Do the scan and view the results as a plot of fluorescence vs. emission wavelength.
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Choose the Emission Filter

Select an emission cutoff filter that blocks as much of the residual excitation light as possible
without unduly reducing the fluorescence signal. The cutoff wavelength choices are 325, 420,
435, 475, 495, 515, 530, 550, 570, 590, 610, 630, 665, or 695 nm. The cutoff value should be
near the maximum emission wavelength (preferably between the excitation wavelength and
the maximal emission wavelength) but a minimum of 10 nm less than the emission
wavelength. If you have questions about this procedure, contact Molecular Devices
Technical Support and speak to an application scientist.

Do Emission Scan #2

1. Inthe SoftMax Pro Software, set up a third plate section for an emission scan as specified
in Do Emission Scan #1 on page 319, except selecting Manual Cutoff Filter and setting the
wavelength to that determined in Choose the Emission Filter on page 320.

2. Do the scan and view the results as a plot of fluorescence vs. emission wavelength.

Note the wavelength giving the maximum emission (the optimal emission wavelength).

3. Compare the spectra of the sample containing the fluorophore to the spectra of the
buffer blank to get an estimate of the signal-to-noise ratio. If there is significant

background interference, repeat Choose the Emission Filter on page 320 and Do
Emission Scan #2 on page 320 with a different choice of cutoff filter.

Results

The optimal excitation and emission wavelengths are those determine in Do the Excitation
Scan on page 318 and Do Emission Scan #2 on page 320.

Comments

¢ In endpoint or kinetic fluorescence modes, the AutoCutoff feature generally selects the
same cutoff filter wavelength as the previously described optimization method. If
desired, however, you can specify the cutoff filters manually.

e For emission wavelengths less than 325 nanometers, experimental iteration is usually
the best method of determining the optimal emission and excitation wavelengths. Start
the previously described optimization procedure. Try emission and excitation
wavelength combinations with the 325 cutoff or with no cutoff filter. Similarly, for
excitation wavelengths greater than 660 nanometers, try emission and excitation
wavelength combinations with the 695 cutoff or with no cutoff filter.
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The following table lists default settings for the emission cutoff filters.

Table 7-4: Emission cutoff filter default settings for SpectraMax M2, M2e, M3, M4, M5,
M5e, and FlexStation readers

Automatic Cutoff Selection

Endpoint and Kinetic Modes Emission

Wavelength (nm)

Wavelength (nm)

1 None <415

2 420 415-434
3 435 435-454
4 455 455-474
5 475 475-494
6 495 495-514
7 515 515-529
8 530 530-549
9 550 550-569
10 570 570-589
11 590 590-609
12 610 610-629
13 630 630-664
14 665 665-694
15 695 695-850
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To create a Luminescence Mode protocol:

1.
2.

10.
11.
12.

Start the SoftMax Pro Software. See Starting the Software on page 14.

Select an instrument. See Selecting and Connecting to an Instrument on page 16.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

(o'}
With the plate or cuvette section active, click Settings = % on the Home tab in the
ribbon.

When working with the SpectraMax Paradigm Multi-Mode Microplate Reader, click one
of the Luminescence (LUM) detection cartridge from the Cartridges list. When working
with the SpectraMax i3x Multi-Mode Detection Platform, use the built-in
monochromator or click one of the Luminescence (LUM) cartridges from the Cartridges
list.

Click LUM to select the Luminescence read mode.

Click a Read Type.

Define the settings.

For more information about the settings, see the SoftMax Pro Application Help.
After defining the settings for the protocol, click OK to close the Settings dialog.
Create a template, if applicable. See Configuring a Microplate Template on page 301.
Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.
Set Display options, if applicable. See Setting the Data Display Options on page 358.

Save the settings to a protocol file. See Saving the Settings to a Protocol File on page 338.
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Luminescence Mode Protocol Overview

Luminescence is the emission of light by processes that derive energy from essentially non-
thermal changes, the motion of subatomic particles, or the excitation of an atomic system by
radiation. Luminescence detection relies on the production of light from a chemical reaction
in asample.

In luminescence read mode, no excitation is necessary as the species being measured emit
light naturally. For this reason, the lamp does not flash, so no background interference
occurs. A dark estimate is done over a dark reference, and multiple readings are averaged
together into one reading per well.

The default setting for luminescence is the “zero order” position where the grating
monochromator acts as a mirror that reflects all light to the PMT detector. If wavelength
selection is desired, you can choose the wavelength where peak emission is expected to
occur. Also, multiple wavelength choices let species with multiple components be
differentiated and measured easily. In luminescence read mode, no emission cutoff filter is
used.

Optimizing Luminescence Assays

Luminescence can be read from the top or the bottom of a microplate. Solid white
microplates or white microplates with clear bottoms are recommended for luminescence
reads.

For standard luminescence a separate light path without monochromators carries the
emitted light to a dedicated PMT. The optimal emission wavelength is between 360 nm and
630 nm. In the Settings dialog the emission says All.

For wavelength-selectable luminescence, the emission monochromator is used to
differentiate the wavelengths being emitted from the well. Multiple emission wavelengths
within the specified reader range can be defined.

If reading only one luminescent event in the well, you can get the best sensitivity using the
standard luminescence measurement, without a wavelength selected.

Luminescence read times are not designated by multiple reads per well, but rather by
choosing the total integration time desired between 1 ms and 1500 ms. Typical luminescence
assays require between 500 ms and 1000 ms integration.

If wells have been incubating for a long period of time, it is a good idea to mix the plate
before reading. This can be done using the Shake setting.

If it seems that the signal is always higher in the first wells read (for example, column A), the
plate might need to be “dark adapted” to reduce the auto-luminescence of the white plastic.
To help eliminate background luminescence from a microplate that has been exposed to
light, Molecular Devices recommends dark adaptation of the microplate by placing the
sample-loaded microplate in the instrument for several minutes before starting the read.
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Creating a Time-Resolved Fluorescence Mode Protocol

To create a Time-Resolved Fluorescence Mode protocol:
1. Startthe SoftMax Pro Software. See Starting the Software on page 14.

2. Select an instrument. See Selecting and Connecting to an Instrument on page 16.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

(o'}
3. With the plate or cuvette section active, click Settings ~— “ on the Home tab in the
ribbon.

4. When working with the SpectraMax Paradigm Multi-Mode Microplate Reader or the
SpectraMax i3x Multi-Mode Detection Platform, click a TRF-capable detection cartridge
from the Cartridges list.

Click TRF to select the Time-Resolved Fluorescence read mode.
Click a Read Type.
Define the settings.
For more information about the settings, see the SoftMax Pro Application Help.
After defining the settings for the protocol, click OK to close the Settings dialog.
9. Create atemplate, if applicable. See Configuring a Microplate Template on page 301.
10. Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.
11. Set Display options, if applicable. See Setting the Data Display Options on page 358.

12. Savethe settings to a protocol file. See Saving the Settings to a Protocol File on page 338.
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Time-Resolved Fluorescence Mode Overview

In Time-Resolved Fluorescence (TRF) read mode, the instrument detects the extremely long
emission half-lives of rare earth elements called lanthanides.

Time-resolved fluorescence (TRF) is a measurement technique that depends on three
characteristics that lead to better discrimination between the specific signal, proportional to
the quantity of label, and the unspecific fluorescence resulting from background and
compound interference:

e Pulsed excitation light sources
e Time-gated electronics faster than the fluorescence lifetime
e Labels with prolonged fluorescence lifetime

The time-gating electronics introduce a delay between the cut off of each light pulse and the
start of signal collection. During the delay, the unspecific fluorescence (caused by test
compounds, assay reagents, and the microplate) vanishes while only a small portion of the
specific fluorescence from the label is sacrificed. Enough of the specific signal remains during
the decay period with the added benefit of reduced background.

The use of long-lived fluorophores combined with time-resolved detection (a delay between
excitation and emission detection) minimizes interference from fluorescence excitation light.
Assays with these long-lifetime fluorophores have the advantage of very low background
fluorescence. TRF detection is widely used in high throughput screening applications such as
kinase assays.

In normal Fluorescence Intensity mode, the readings are taken while the lamp is on. The
most common limitation to sensitivity in normal fluorescence is excitation energy or
background fluorescence that cannot be eliminated from the emission signal. Since the lamp
is the source of excitation energy, turning it off provides the best means of eliminating
background excitation. The elimination of background excitation is the critical difference
between fluorescence intensity measurements and TRF measurements.
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Optimizing Time-Resolved Fluorescence Assays

Time-resolved fluorescence is done by flashing the excitation lamp and, after it is off,
collecting the delayed emission for a period of time before the lamp is flashed again. Long-
lifetime rare-earth lanthanide dyes are generally used to provide a long-lived fluorescent
signal that persists after the lamp is turned off. Background fluorescence usually fades, while
lanthanide chelates and cryptates have fluorescent lifetimes between 100 us and 2 ms.

Time-resolved fluorescence (TRF) assays can be read from the top or bottom of a microplate.
Solid white plates are recommended for top time-resolved fluorescence reads, and white
plates with clear bottoms are recommended for bottom reads.
To optimize data collection for a particular assay, you can select when to start and end data
acquisition-the minimum is 50 ps after the lamp has been turned off, and the maximum is
1450 ps, in 50 ps or 200 ps steps.
If the time-resolved fluorescence assay you are using has low signal or gives results with high
%CV, use 100 readings per well. If a faster read speed is required, turn the settling time off
and experiment with fewer flashes per well until acceptable precision and speed are
achieved.
The important settings for getting the best results in TRF assays are integration delay and
integration time:

* Theintegration delay is the amount of time that elapses between the flash of the lamp

(excitation) and the beginning of data acquisition from the well (emission).

e Theintegration time is the amount of time that the well is read.

The integration delay and integration time are usually specified in the package insert of
commercially available TRF reagent kits. If a kit is not used, start with a delay of 50 ps and try
different delays up to 400 us with a fixed integration time of 400 us. After the optimal delay is
chosen, based on the highest ratio of a well containing a fluorophore divided by wells
containing only buffer, optimize the integration time, which is generally between 400 ps and
1000 ps.

Some examples of TRF assays are:
* IMAP®TR-FRET
o Cisbio HTRF
e LanthaScreen TR-FRET
e LANCE TR-FRET
o DELFIATRF
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Creating a FRET Mode Protocol

To create a Fluorescence Resonance Energy Transfer (FRET) protocol:
1. Startthe SoftMax Pro Software. See Starting the Software on page 14.

2. Select an instrument. See Selecting and Connecting to an Instrument on page 16.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

(o'}
3. With the plate or cuvette section active, click Settings ~— “ on the Home tab in the
ribbon.

4. When working with the SpectraMax Paradigm Multi-Mode Microplate Reader or the
SpectraMax i3x Multi-Mode Detection Platform, click a FRET-capable detection cartridge
from the Cartridges list.

Click FRET to select the FRET read mode.
Click a Read Type.
Define the settings.
For more information about the settings, see the SoftMax Pro Application Help.
After defining the settings for the protocol, click OK to close the Settings dialog.
9. Create atemplate, if applicable. See Configuring a Microplate Template on page 301.
10. Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.
11. Set Display options, if applicable. See Setting the Data Display Options on page 358.

12. Savethe settings to a protocol file. See Saving the Settings to a Protocol File on page 338.

5049092 A 327



SoftMax Pro Software User Guide

328

Fluorescence Resonance Energy Transfer Overview

Fluorescence resonance energy transfer (FRET) is a distance-dependent interaction between
the electronic excited states of two dye molecules in which excitation is transferred from a
donor molecule to an acceptor molecule without emission of a photon.

FRET relies on the distance-dependent transfer of energy from a donor molecule to an
acceptor molecule. Due to its sensitivity to distance, FRET has been used to investigate
molecular interactions. FRET is the radiationless transmission of energy from a donor
molecule to an acceptor molecule. The donor molecule is the dye or chromophore that
initially absorbs the energy and the acceptor is the chromophore to which the energy is
subsequently transferred. This resonance interaction occurs over greater than interatomic
distances, without conversion to thermal energy, and without a molecular collision. The
transfer of energy leads to a reduction in the fluorescence intensity and excited state lifetime
of the donor, and an increase in the emission intensity of the acceptor. A pair of molecules
that interact in such a manner that FRET occurs is often referred to as a donor/acceptor pair.

While there are many factors that influence FRET, the primary conditions that need to be
met for FRET to occur are relatively few:

e The donor and acceptor molecules must be in close proximity to each other.

e The absorption or excitation spectrum of the acceptor must overlap the fluorescence
emission spectrum of the donor.
The degree to which they overlap is referred to as the spectral overlap integral (J).

e The donor and acceptor transition must be approximately parallel.
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Creating a Fluorescence Polarization Mode Protocol

5049092 A

To create a Fluorescence Polarization Mode protocol:

1. Startthe SoftMax Pro Software. See Starting the Software on page 14.

2. Select an instrument. See Selecting and Connecting to an Instrument on page 16.

Note: It is not necessary to be physically connected to an instrument to create a

protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

(o'}
3. With the plate or cuvette section active, click Settings ~— “ on the Home tab in the
ribbon.

4. When working with the SpectraMax Paradigm Multi-Mode Microplate Reader or the

SpectraMax i3x Multi-Mode Detection Platform, click a Fluorescence Polarization (FP)

Detection Cartridge from the Cartridges list.
Click FP to select the Fluorescence Polarization read mode.
Click a Read Type.
Define the settings.
For more information about the settings, see the SoftMax Pro Application Help.
After defining the settings for the protocol, click OK to close the Settings dialog.
9. Create atemplate, if applicable. See Configuring a Microplate Template on page 301.

10. Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.
11. Set Display options, if applicable. See Setting the Data Display Options on page 358.
12.

Fluorescence Polarization Mode Protocol Overview

Save the settings to a protocol file. See Saving the Settings to a Protocol File on page 338.

Fluorescence polarization detection is similar to fluorescence intensity, with the important

difference that it uses plane-polarized light, rather than non-polarized light. Plate readers

measure FP of the sample by detecting light emitted both parallel and perpendicular to the

plane of excitation.

By using a fluorescent dye to label a small molecule, its binding to a different molecule of
equal or greater size can be monitored through its speed of rotation.

Fluorescence polarization mode returns two sets of data: one for fluorescence intensity

parallel (P) to the excitation plane, and the other for fluorescence intensity perpendicular (S)
to the excitation plane. These S and P values are used to calculate the Polarization (mP) and

Anisotropy (r) values in the SoftMax Pro Software.

Although the raw S and P values are the true actual values returned from the instrument,

calculated Polarization (mP) and Anisotropy (r) values are treated as the raw data. These
become the basis for further reduction calculations.

the
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You can choose to display these data types in the Plate section. When raw (S&P) is displayed,
the mP value is by default used for all reduction calculations. When exporting, the displayed
raw values are exported, whether mP, r, or Raw (S&P).

Polarization (mP) is calculated as follows:

arallel - (G % perpendicular
P = 1000 » (p (G * perp )

(parallel + (G * perpendicular))

Anisotropy (r) is calculated as follows:

(parallel - (G x perpendicular))

- (parallel + (2G * perpendicular))

Optimizing Fluorescence Polarization Assays

Fluorescence polarization for the SpectraMax i3x Multi-Mode Detection Platform, the
SpectraMax Paradigm Multi-Mode Microplate Reader, the SpectraMax M5 and M5e Multi-
Mode Microplate Readers, the FlexStation 3 Multi-Mode Microplate Reader, and the
FilterMax F3 and F5 Multi-Mode Microplate Readers can be read only from the top of a
microplate. The plastic from which a microplate is formed has an effect on the light
polarization, precluding reading from the bottom and also reading a covered plate from the
top.

Solid black plates are recommended for fluorescence polarization reads. If the assay
components seem to bind to the microplate, as evidenced by poor mP dynamic range (small
difference between bound and unbound tracer), we suggest using plates treated to minimize
binding, or polypropylene plates and adding a very small quantity of detergent, to the assay
buffer.

Background wells, containing all assay components minus the fluorophore, should be
tested. If the signal in the background wells is more than 1/10 the signal in the wells
containing fluorophore, then background wells should be run on each assay plate. The
average raw signal from the background's parallel and perpendicular readings should be
subtracted from the raw parallel and perpendicular readings of each sample well before the
mP calculation is done.

For best precision in assays using a low quantity of fluorophore (for example, <5 nm
fluorescein), set the PMT sensitivity to High and the number of readings to 100. If a faster
read speed is required, turn the settling time off and experiment with fewer flashes per well
until acceptable precision and speed are achieved.

% Note: Fewer flashes result in a higher speed, but with less precision.
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Creating an AlphaScreen Mode Protocol
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To create an AlphaScreen Mode protocol:

1.
2.

N o v ks~ w

Start the SoftMax Pro Software. See Starting the Software on page 14.

Select the SpectraMax i3x Multi-Mode Detection Platform or the SpectraMax Paradigm
Multi-Mode Microplate Reader. See Selecting and Connecting to an Instrument on page
16.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

With the plate section active, click Settings 5 “ on the Home tab in the ribbon.
Click one of the AlphaScreen Detection Cartridges from the Cartridges list.

Click Screen to select the AlphaScreen read mode.

Click a Read Type.

Define the settings.

For more information about the settings, see the SoftMax Pro Application Help.

8. After defining the settings for the protocol, click OK to close the Settings dialog.

10.
11.
12.

Create a template, if applicable. See Configuring a Microplate Template on page 301.
Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.
Set Display options, if applicable. See Setting the Data Display Options on page 358.

Save the settings to a protocol file. See Saving the Settings to a Protocol File on page 338.
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AlphaScreen Mode Protocol Overview

ALPHA stands for Amplified Luminescent Proximity Homogeneous Assay. AlphaScreen®is a
bead-based chemistry used to study molecular interactions between moieties A and B, for
example. When a biological interaction between Aand B moves beads (coated with Aand B,
respectively) together, a cascade of chemical reactions produce a greatly amplified signal.

The cascade finally resulting in signal is triggered by laser excitation (680 nm), making a
photosensitizer on the A-beads convert oxygen to an excited (singlet) state. That energized
oxygen diffuses away from the A-bead. When reaching the B-bead in close proximity, it reacts
with a thioxene derivative on the B-bead generating chemiluminescence at 370 nm. Energy
transfer to a fluorescent dye on the same bead shifts the emission wavelength into the

520 nm to 620 nm range. The limited lifetime of singlet oxygen in solvent (~4 microseconds)
lets diffusion reach up to only around 200 nm distance. Thus, only B-beads in the proximity
of A-beads yield signal, which indicates binding between moieties A and B.

An AlphaScreen measurement includes a light pulse, by turning on the laser diode for a
specified time, turning off the laser diode, followed by the measurement of the AlphaScreen
signal, as specified in the measurement protocol timing parameters.

% Note: AlphaScreen beads are light sensitive. Beads are best handled under subdued
(<100 lux) or green filtered (Roscolux filters #389 from Rosco, or equivalent) light
conditions. Do incubation steps in the dark.

For more information, see AlphaScreen Read Mode on page 189.
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Creating a Western Blot TRF Mode Protocol
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To create a Western Blot TRF Mode protocol:

1.
2.

Start the SoftMax Pro Software. See Starting the Software on page 14.

Select a SpectraMax Paradigm or SpectraMax i3x Instrument. See Selecting and
Connecting to an Instrument on page 16.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

Q
With the Plate section active, click Settings % on the Home tab in the ribbon.

In the Cartridges list, click SCANLATER WB for the ScanlLater Western Blot (WB)
Detection Cartridge.

Click TRF to select the Time-Resolved Fluorescence read mode.

Click the Membrane read type.

Define the settings.

For more information about the settings, see the SoftMax Pro Application Help.

After defining the settings for the protocol, click OK to close the Settings dialog.

Save the settings to a protocol file. See Saving the Settings to a Protocol File on page 338.
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Western Blot TRF Mode Overview

Protein detection is an important task for pharmaceutical and clinical research, and Western
Blots (WB), or protein immunoblots, are one of the most common methods employed for
this purpose. Various techniques are used to detect proteins on Western Blot membranes
including fluorescence, silver staining, and chemiluminescence. However, each technique has
its limitations, and there is a continuous need to improve quantitation, accuracy, and
dynamic range of Western Blots.

The Molecular Devices ScanLater™ Western Blot Assay Kit is a novel system for protein
analysis that is incorporated into a SpectraMax® Paradigm® or SpectraMax® i3x Multi-Mode
Detection Platform. Membranes are incubated with Eu-chelate labeled secondary antibodies
or streptavidin that bind specifically to the target protein-specific primary antibody.
Europium has a long fluorescence lifetime, on the order of 1 msec, and detection is done in
Time Resolved Fluorescence (TRF) mode which significantly reduces background from auto-
fluorescence or other sources of short lifetime emissions. The membranes are placed into a
microplate reader where they are scanned with the ScanlLater Western Blot (WB) Detection
Cartridge.

The method does not involve enzyme detection, and the Eu-chelates are resistant to photo-
bleaching, so the signal remains stable for long periods of time (weeks to months). This
permits repeat reading of membranes and the potential for comparison of band intensities
to known standards for more accurate quantitation.

The TRF detection employs photon counting, so the theoretical dynamic range is >10°. In
practice, however, dynamic range is limited by saturation of binding sites on high-abundant
bands and non-specific binding to background membrane. There is also no camera
blooming, as can occur with chemiluminescence or fluorescence detection, so the system
gives sharp bands and excellent image quality.

The SpectraMax Western Blot system is a simple, sensitive, and stable platform that
provides excellent Western Blot capability in a SpectraMax Paradigm or SpectraMax i3x
Multi-Mode Detection Platform extending the uses of these essential laboratory
instruments.
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Loading the Membrane into the Membrane Holder

Note: Handle membranes only by the edges using clean forceps. Take care to not
touch the membrane with gloved or bare hands.

To scan the membrane in a SpectraMax Paradigm or SpectraMax i3x Instrument, the
membrane must be placed in a Molecular Devices ScanLater™ Membrane Holder.The
maximum size for a membrane is 109 mm x 77 mm to let it fit in the membrane holder.

1. Place the membrane on the membrane holder with one corner of the membrane aligned
with the Al corner of the membrane holder.

2. Slide the holder clips to place them over the membrane as close to the edges of the
membrane as possible to expose the maximum scanning area of the blot.

3. Lower the holder clips into place and then gently press the end of each holder clip to
snap it into place and secure the membrane to the holder.

A CAUTION! To prevent damage to the instrument or the membrane holder, make
sure that all the holder clips are securely snapped into place before inserting the
membrane holder into the microplate reader.

4. Load the membrane holder into the microplate drawer with the Al corner in the Al
position of the drawer. See the user guide for your instrument.
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To create an Imaging mode protocol:

1.
2.

L 0 N o

10.

Start the SoftMax Pro Software. See Starting the Software on page 14.

Select the SpectraMax i3x Multi-Mode Detection Platform using the Instrument
Connection dialog. See Selecting and Connecting to an Instrument on page 16.

Note: It is not necessary to be physically connected to an instrument to create a
protocol. If you are not connected to an instrument you can select the target
instrument and work offline.

@
With the plate or cuvette section active, click Settings % on the Home tab in the
ribbon.
-

Click MiniMax —'

Click Imaging in the Read Modes list.

in the Optical Configuration list.

If you have previously acquired images and want to make changes to the analysis
settings for those images, click Re-analysis in the Read Modes list.

Define the Imaging read settings or the Re-analysis settings.

For more information about the Imaging read settings or Re-analysis settings, see the
SoftMax Pro Application Help.

After defining the settings for the protocol, click OK to close the Settings dialog.
Create a template, if applicable. See Configuring a Microplate Template on page 301.
Set Data Reduction parameters, if applicable. See Doing Data Reduction on page 367.
Set Display options, if applicable. See Setting the Data Display Options on page 358.

Save the settings to a protocol file. See Saving the Settings to a Protocol File on page 338.
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Imaging Mode Protocol Overview

Imaging read mode does whole-cell imaging assays.

Whole-cell imaging assays are cell-based, or object-based, rather than the single-point
measurements found in other types of microplate reads. These types of assays can yield
more biologically meaningful results that can discriminate the fluorescence related to
objects, such as cells or beads, from the bulk solution within a microplate well.

The measurement is primarily fluorescent with quantification of cell size, shape, area, and
intensity. Label-free quantification is also supported through brightfield, transmitted light
imaging. The camera resolution in the SpectraMax MiniMax 300 Imaging Cytometer is
sufficient to determine the approximate shape of small 8 micron objects, such as blood cells.

For more information, see Imaging Read Mode on page 197.
Optimizing Your Computer for Image Acquisition

Acquiring images requires a large portion of computer memory and resources.

Before starting an image acquisition, you must save the data file in a location with enough
capacity for the image files. When you create a data file for an imaging experiment or a
Western Blot experiment, the SoftMax Pro Software creates a folder with the same name as
the data file. See Image Data Files and Folders on page 61.

Each acquired image file for an Imaging mode read can be larger than 2 megabytes. Acquiring
the image of a single site in each well of a 96-well microplate can generate 300 megabytes of
image data. A 384-well microplate can generate 1 gigabyte of image data. Acquiring images of
multiple sites increases the data-storage requirement. Molecular Devices recommends that
you employ a data management system.

For best results, save your imaging data file on a secondary internal hard drive. You can use
an external hard drive, but this can slow the data acquisition and is not recommended.

Note: To prevent data loss, do not save your imaging data file on a USB flash drive or
to a network location. These methods are not supported by Molecular Devices.

Before starting an image acquisition, minimize the demands on computer memory and
resources by turning off all other programs. When the SoftMax Pro Software has limited
access to computer memory and resources, image acquisition can take a long time. In some
cases, images of some of the wells can be lost.

To prevent data loss, turn off all sleep and hibernation settings for the hard disk, the CPU,
and the USB ports. Also, disable automatic Windows Updates. You can update Windows
manually when the instrument is not being used by the software. You can set these options
in Windows Control Panel. See Required Computer Settings on page 11.

Molecular Devices recommends that you use Auto Save with imaging data for saving to text
files only. If you use Auto Save to save multiple imaging data files, each new data file is saved
without the related folders required for saving images and analysis results. See Setting Auto
Save Options on page 76.
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Zooming the Image in a Well

An image of the selected well is displayed in the Image Acquisition, Image Selection, and
Region of Interest categories of the Settings dialog. To view a larger version of the image
area, double-click the image to open the Zoom Well dialog.

In the Zoom Well dialog, the image area displays the acquired image from the selected well.
To zoom the acquired image in and out, right-click the image and click Zoom In or Zoom Out.
You can also hold the CTRL key down and press + or -, or use the mouse wheel to zoom in or
out. Drag the scroll bars to move the zoomed image in the image area, or click the image and
drag it into position.

To close the dialog, click Close.

Saving the Settings to a Protocol File

338

To save the settings for the experiment into a protocol file:

LA S .

6.

Click Save As.

In the Save As dialog, navigate to where you want the protocol file to be saved.

In the File name field, type a name for the file.

From the Save as type field, select Protocol Files (*.spr).

If you are working with the SoftMax Pro GxP Software, select Protocol Files (*.sprx).
Click Save.

Saving a data file as a protocol file removes the data in the file, leaving only the configuration
information.
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Collecting Data from a Microplate

You can start a read after defining the instrument settings. It is not necessary to define
groups and assign wells in the Template Editor first. The values received from the instrument
are raw values. The settings in the Template Editor have no effect on these raw values.

Note: Before starting a read, it is good practice to save your data file. For Imaging
reads and Western Blot reads, you must save your data file before starting the read.
See Saving Data Files on page 65.

To automatically read multiple Plate sections in the same experiment, see Enabling Auto
Read on page 340.

To read a microplate:

1.

5049092 A

Open the microplate drawer of the instrument by clicking Open/Close 8 on the
Operations tab in the ribbon.

The microplate carrier on the EMax Plus Microplate Reader moves in and out of the read
chamber during the read, and then returns to the home position after the read ends. If
the microplate carrier does not return to the home position, you can initialize the carrier
to return it to its home position by clicking Initialize in the Operations tab of the ribbon.
See Using the Operations Tab on page 44.

Insert the prepared microplate matching well A1 with position Al in the microplate
drawer. Make sure the microplate is flat against the drawer bottom or against the
adapter.

Click Open/Close E to close the microplate drawer.

For information about opening and closing other drawers on your instrument, see.

Open a SoftMax Pro Software data file or protocol file that contains the applicable
experiment settings for the plate read. As an alternative, create new settings by selecting
the Plate section in the SoftMax Pro Software program and configuring the instrument
settings using the Settings dialog. See Selecting Instrument Settings on page 236.

Before starting a read, it is good practice to save your data file. For Imaging reads and
Western Blot reads, you must save your data file before starting the read. See Saving
Data Files on page 65.

Click Read w on the Home tab in the ribbon.
The Read button changes to Stop 0, letting you terminate a read if required.

You can also use the controls in the Home tab to interrupt and restart a read in progress.
See Reading Data on page 38.
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8. The active Plate section is read.

e Ifyou are using the SpectraMax i3x Multi-Mode Detection Platform, the
SpectraMax Paradigm Multi-Mode Microplate Reader, or the FilterMax F3 and F5
Multi-Mode Microplate Readers and selected to do pre-read optimizations, the Pre-
Read Optimization Options dialog is displayed. See Doing Pre-Read Optimization on
page 342.

* Ifyou are using the SpectraMax i3x Multi-Mode Detection Platform or using the
SpectraMax Paradigm Multi-Mode Microplate Reader with a Tunable Wavelength
(TUNE) Detection Cartridge and selected to run spectral optimization, the Spectral
Optimization Wizard runs before the microplate is read. See Spectral Optimization
on page 348.

9. After theread is complete, the microplate drawer of the instrument opens letting you
remove the microplate. If temperature control is on, the drawer closes again after
approximately 10 seconds.

If you prefer to have the microplate remain inside the instrument after the read is complete,

you can set this option in the SoftMax Pro Options dialog. See Setting Application Options

on page 104.

% Note: If you return to the instrument and find the microplate drawer closed after a
reading has finished, click Open/Close & on the Operations tab in the ribbon or press
the Drawer button on the instrument. After the drawer opens, you can remove the
microplate.

After the read is complete, save the data. See Saving Data Files on page 65.

For information on the data-analysis tools in the SoftMax Pro Software, see Analyzing Data
on page 355.

Enabling Auto Read

Auto Read automatically advances to the next Plate section after a read in the order that the
Plate sections are displayed within a single Experiment. When you start a read for a Plate
section that is enabled to automatically advance with AutoRead, the Auto Read feature
advances to the next Plate section in the Experiment and then reads that plate. If multiple
Plate sections are enabled to automatically advance with AutoRead, the Auto Read feature
reads all enabled Plate sections until it reads a non-enabled Plate section or the last Plate
section in the Experiment. Plate sections that come before the selected Plate section are not
read.

For example, if you have five Plate sections (Plate 1, Plate 2, Plate 3, Plate 4, and Plate 5) in an
Experiment, you can enable Plate 1, Plate 2, and Plate 3 to automatically advance with Auto
Read. If you start a Read operation for Plate 2, then Plate 2, Plate 3, and Plate 4 are read in
sequence. Plate 1is not read, since it comes before Plate 2. Plate 5 is not read since Plate 4 is
not enabled to automatically advance with AutoRead.

You can set an interval, or delay time, between the plate readings, if desired.
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The SoftMax Pro Software can collect data from one or more microplates and storeitin a
single data file, using the same or different instrument settings for different microplates.
Assays requiring a read in two or more read modes or read types can be combined in a single
experiment and run with a single command in the software, by defining separate microplate

reads and enabling Auto Read.

1. Inthe Navigation Tree or the workspace, select the Experiment that has the Plate
sections that you want to enable to automatically advance with Auto Read.

2. Click Auto Read EEI¥ in the Operations tab of the ribbon.

HI. Auto Read
Select the Plate sections that you want to enable to automatically advance

a Exptl
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3. Inthe Auto Read dialog, select the Plate sections that you want to enable to

automatically advance with Auto Read.

4. Optionally, type the number of seconds to delay (the interval) between reading each

Plate section.
5. Click OK to close the dialog.

Note: If you have a Cuvette Set section following an enabled Plate section, Auto Read

will not advance to or beyond the Cuvette Set section.
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Doing Pre-Read Optimization

When using the SpectraMax i3x Multi-Mode Detection Platform, the SpectraMax Paradigm
Multi-Mode Microplate Reader, or the FilterMax F3 and F5 Multi-Mode Microplate Readers
in certain read modes, you can use pre-read optimization options. Using this function lets
you do microplate optimization and read height adjustment, when available.

The Pre-Read Optimization Options dialog is displayed when the Show Pre-Read
Optimization Options check box is selected on the More Settings tab of the Settings dialog.
In the Acquisition View, Plate Optimization can be added to the beginning of the time line.
The available optimization options are dependent on the selected instrument and the read
mode.

Note: If you are using the SpectraMax i3x Multi-Mode Detection Platform or using the
SpectraMax Paradigm Multi-Mode Microplate Reader with a Tunable Wavelength
(TUNE) Detection Cartridge and selected to run spectral optimization, the Spectral
Optimization Wizard runs before the Pre-Read Optimization Options dialog is
displayed. See Spectral Optimization on page 348.

To select pre-read optimization options:

1.

Select the Run Microplate Optimization check box to run the Microplate Optimization
Wizard before reading the microplate. See Microplate Optimization on page 343.

Select the Run Read Height Adjustment check box to run the Read Height Optimization
Wizard before reading the plate. See Read Height Optimization on page 346.

Click Run Optimization to run the selected optimization options.
If the microplate has a lid on it, you must select the Plate is Lidded check box.
Optionally, for some instruments you can select the orientation for the microplate:
e Landscape
e Portrait
e Opposite Landscape
e Opposite Portrait
Click Read Plate to start the read.
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Microplate Optimization

Microplate dimensions can vary slightly between production lots, which can have a potential
effect on measurement accuracy. SoftMax Pro Software lets microplate dimensions be
optimized by determining the centers of the four corner wells on the plate. Each time a
microplate is optimized, a new microplate definition is created with dimensions specific to
that lot.

Note: If a microplate type is to be used in different plate orientations for
measurements, microplate optimization must be done for each plate orientation
separately.

The microplate is optimized using the Microplate Optimization Wizard.

You can select to run the Microplate Optimization Wizard in the Pre-Read Optimization
Options dialog that is displayed if the Show Pre-Read Optimization Options check box is
selected on the More Settings tab of the Settings dialog. In the Acquisition View, Plate
Optimization can be added to the beginning of the time line. See Selecting Instrument
Settings on page 236.

When selected, the Pre-Read Optimization Options dialog runs after the Read button is
clicked.

To do microplate optimization:

1. Inthe Pre-Read Optimization Options dialog, select the Run Microplate Optimization
before reading the plate check box.

2. Click Run Optimization.
The Microplate Optimization Wizard takes you through the optimization process:
e Insert the Microplate on page 344
e Running Optimization on page 344
e Selecting the Centers of the Four Corner Wells on page 345
e Verifying Microplate Dimensions on page 345
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Insert the Microplate

Microplate dimensions are optimized by reading the four corner wells of the plate. The Insert
the Microplate step provides controls to load and eject the microplate from the instrument
and to select the orientation of the plate in the microplate drawer.

To insert the prepared microplate for optimization:

1. Click Open the Microplate Drawer to move the microplate drawer carrier outside the
instrument.

2. Fillthe corner wells of the plate with identical samples. To ensure accuracy, samples
must be correct for the selected read mode detection method. Sample concentration
and volume must be identical in each well.

3. Place the prepared microplate on the microplate drawer.

Click Close the Microplate Drawer to load the microplate into the instrument.

In Select the Microplate Orientation, select the orientation of the plate on the
microplate drawer. The selected orientation is displayed graphically on the right, with
well A1 marked in red. Make sure this orientation is the same as the orientation of the
microplate in the drawer selected in the Pre-Read Optimization Options dialog.

6. Click Next to start the optimization. See Running Optimization on page 344. The
optimization read starts automatically.

Running Optimization

Optimization in Progress displays the status of the optimization read and provides the
means to cancel the optimization in progress. The optimization read requires several
minutes to complete.

To cancel the optimization process and close the Microplate Optimization wizard without
saving the optimization data, click the Cancel button.

When the optimization read is complete, you can select the centers of each of the four
corner wells. See Selecting the Centers of the Four Corner Wells on page 345.
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Selecting the Centers of the Four Corner Wells

Use the Select the Center steps to precisely define the centers of the corner wells read in the
optimization. Each Select the Center step displays an image of the well generated by the
optimization read. Define the well centers by dragging the cross hairs to the position visually
identified as the center. Do a Select the Center step for each corner well individually.

To define the centers of the wells:

1. Place the pointerin the well image.

2. Click-and-drag the cross hairs to the desired center of the well.

% Note: The cross hairs are displayed after the cursor is placed in the well image.

3. Click Next to define the centers of the remaining well reads.

After all four well centers are defined, the Verify Microplate Dimensions step is displayed.
See Verifying Microplate Dimensions on page 345.

Verifying Microplate Dimensions

Use the Verify Microplate Dimensions step to verify that the xand y offsets and distances
between rows and columns are correct. The offsets, distances, and lot name can be edited in
the Verify Microplate Dimensions step.

1. If necessary, click the + next to Microplate Dimensions to display the fields in the
category.

2. Verify that the x and y offset and distances between rows and columns are correct. If
necessary, you can edit the dimension. All offsets and well-spacing dimensions are
defined in millimeters.

3. If necessary, click the + next to Microplate Name to display the default name assigned to
the new microplate definition.

4. Type a new Microplate Name, if desired.

5. Click Save to save the optimization data and create the new Microplate definition.

This new microplate definition can be selected from the plate types listed in the Plate Type

Library. For more information, see Plate Type Settings on page 250.

If you have selected the Run Read Height Adjustment check box in the Pre-Read

Optimization Options dialog, the Read Height Optimization Wizard runs before reading the

plate. See Read Height Optimization on page 346.
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Read Height Optimization

The SpectraMax i3x Multi-Mode Detection Platform and the SpectraMax Paradigm Multi-
Mode Microplate Reader feature an objective lens that can be moved up and down to
optimize the read height used in luminescence, fluorescence intensity, fluorescence
polarization, and time-resolved fluorescence protocols. Read height is the distance between
the top (using top reading) or bottom (using bottom reading) surface of the microplate being
read and the surface of the objective lens. Optimizing read height matches the focus of the
optics with the sample volume. This maximizes the raw signal, which yields the highest
precision and maximum sensitivity.

Asingle sample with a known maximum signal and volume is placed on the same type of
microplate used in the protocol. The sample is measured using the same, or very similar,
read mode used in the protocol.

The optimized read height is saved in the protocol and is used for all subsequent runs of the
protocol until reset by performing a new optimization or manually selecting a read height
option.

You can select to run the Read Height Optimization Wizard in the Pre-Read Optimization
Options dialog that is displayed if the Show Pre-Read Optimization Options check box is
selected on the More Settings tab of the Settings dialog. In the Acquisition View, Plate
Optimization can be added to the beginning of the time line. See Selecting Instrument
Settings on page 236.

When selected, the Pre-Read Optimization Options dialog is displayed after the Read
button is clicked.

To do Read Height optimization:

1. Select the Run Read Height Adjustments before reading the plate check box.
2. Select Microplate options.

3. Click Run Optimization.
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Running Read Height Optimization
Select the well to be measured to do the optimization.

Use a standard or sample position with a good signal or pipette liquid with a known
maximum signal to a well on the microplate used in the optimization. The concentration of
the optimization sample should be a minimum of ten times greater than the detection limit.
The sample volume should be the same as that of samples measured in the protocol. If using
a layout with standards, the standard well closest to the center of the plate is pre-selected. If
not using a layout with standards, the first sample is pre-selected.

Note: When optimizing read height for a fluorescence protocol, make sure the
optimization sample is the same fluorescent substance that the detection method is
configured to detect.

Load the plate into the instrument.

In the Select Well step, select the well containing the optimization sample.

Click Next to start the optimization.

The Optimization in Progress step is displayed. The optimization can take from several
seconds to several minutes depending on the detection methods used.

4. When the read is finished, the Optimization Complete step is displayed, displaying the
Optimized Read Height. To specify a different read height, type a value in the Custom
Read Height field. The read height is measured in millimeters.

5. Click Save to save the specified read height in the protocol. The specified read height is
used for all subsequent runs of the protocol until reset by performing a new
optimization or manually selecting a read height option.

When Read Height Optimization is complete and you return to the Pre-Read Optimization

dialog, you can choose to change the microplate options and rerun Microplate Optimization

or Read Height Optimization. When all you have completed all the desired optimization, click

Read Plate to start reading the plate.

After the wizard closes, the Pre-Read Optimization Options dialog is displayed.
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Spectral Optimization

Spectral optimization in spectral assays improves accuracy while reducing data acquisition
and computational burden. Spectral optimization can help to get the maximum signal-to-
background ratio for most fluorophores or luminescence labels that are compatible with the
wavelength ranges of the instrument or detection cartridge.

Spectral optimization for fluorescence intensity reads is available for the SpectraMax i3x
Multi-Mode Detection Platform using its built-in monochromator.

Spectral Optimization for both fluorescence intensity and luminescence reads is available for
the SpectraMax Paradigm Multi-Mode Microplate Reader with the Tunable Wavelength
(TUNE) Detection Cartridge.

To run the Spectral Optimization Wizard, select Unknown for the Wavelengths in the
Settings dialog.

When Unknown is selected, the Spectral Optimization Wizard dialog is displayed after the
Read button is clicked.

Running Spectral Optimization

1. Inthe Read Settings step, specify the wavelength ranges and other parameters for the
optimization.
The Start Emission Wavelength value must be a minimum of 20 nm greater than the

Start Excitation Wavelength value. Molecular Devices recommends using an emission
value that is a minimum of 40 nm greater than the excitation value.

To do Spectral Optimization, there must be a minimum of 10 data points in the range for
both the excitation and emission wavelengths. Make sure that the Wavelength
Increment permits a minimum of 10 data points in each range.

For a luminescence read, only emission values can be specified.

2. To specify the Reading Height or Integration Time, click Advanced parameters and then
type the desired values in the fields.

For Time-Resolved Fluorescence (TRF) reads, you can also specify Pulse Length, Number
of Pulses, and Measurement Delay.

3. Click Next to continue.

In the Blank Well step, select the well in the plate layout that corresponds with a well in
the microplate that contains buffer or other liquid for background correction.

Click Next to continue.

In the Sample Well step, select the well in the plate layout that corresponds with the
well in the microplate that contains your sample.

Click Next to continue.

Wait while the indicator in the Optimization in Progress step displays the operation's
progress.

5049092 A



Chapter 7: Collecting Data

9. Inthe Optimization Complete step, a 3-dimensional heat map image is displayed. The
heat map is generated using the formula (S—B) / B, where S = signal and B = background.

Note: For a luminescence read, the Spectral Optimization Wizard generates a
2-dimensional graph.

The cross hair in the image indicates the optimized peak wavelengths. To change the
wavelengths for the read, drag the cross hair to a new location or type values in the
fields.

The Emission value must be a minimum of 20 nm greater than the Excitation value.
Molecular Devices recommends using an emission value that is a minimum of 40 nm
greater than the excitation value.

For a luminescence read, only emission values can be specified.

To change the way the a 3-dimensional heat map image is displayed, select or clear the
Use LogScale check box.

¢ Ifyou have edited the Wavelength (Custom) values and want to reset the values to
the wizard-defined optimized peak, click Reset to Optimized Peak.

¢ If you want to redefine the settings and run the wizard again, click Restart Wizard.

e If you want to save the wavelength values without immediately reading the
microplate, click Cancel, and then click Yes in the message that is displayed.

Right-click on the image to display the shortcut menu, and then you can select from the
following options:

* Copy Raw Data copies the data in tab-delimited format that can be pasted into a
spreadsheet or text editor. This option is available only when using the
Monochromator of the SpectraMax i3x Instrument.

e Copy Image copies the image into a bitmap file that can be pasted into an image
editing program.

* Save Raw Data to Disk saves the data into a text file in tab-delimited format. This
option is available only when using the Monochromator of the SpectraMax i3x
Instrument.

* Save Image to Disk saves the image into a .bmp file.

10. Click Read to save the protocol with the specified excitation and emission wavelengths
and use these values to read the microplate.

If you selected to do pre-read optimizations, the Pre-Read Optimization Options dialog is

displayed before the microplate is read. See Doing Pre-Read Optimization on page 342.
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Two types of data collection are possible using a cuvette: a reference and a sample reading.

You can start a reading after defining the instrument settings. It is not necessary to define
groups and assign cuvettes in the Template Editor first, but you can use the Template Editor
to create the required number of cuvettes in the section. As an alternative, you can create a

small number of cuvettes one at a time with New Cuvette SetBJ on the Home tab in the
ribbon.

Instrument settings must be the same for all cuvettes in a Cuvette Set section.

Sample Reading

You can select a cuvette in the Cuvette Set section and choose to read it by clicking Read

0 on the Home tab in the ribbon.

The Read button changes to Stop 0, letting you terminate a reading if desired.

If you select more than one cuvette, the software starts with the left-most selected cuvette
that does not contain sample read data.

Cuvette Set sections have a limit of 96 cuvettes. If this limit is reached, create a new Cuvette
Set section.

Reference Reading

Areference reading can be taken either on air or using a cuvette containing the buffer of your
sample.

The reference can be read before or after reading samples.

If no reference has been taken in a Cuvette Set section before samples were read and you
then read a reference, the following occurs:

e Thereference reading is applied to all cuvettes in the Cuvette Set section if it is the first
reference reading.

* Insubsequent reference readings, if you select one or more cuvettes, it will selectively
replace the reference reading for those selected cuvettes.

e Thetime and date of the reading are displayed under each cuvette in the section.
* Thereference is applied to new cuvettes subsequently created in that section.

You can have more than one reference per Cuvette Set section.

To apply a different reference to cuvettes:

1. Select the cuvettes in the Cuvette Set section.

2. Place the correct reference in the cuvette port.

3. Click the Ref button.

The time and date stamp of the reference for the selected cuvettes changes.

Any new cuvettes created in the Cuvette Set section after reading a second reference use the
new reference reading.
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The reference reading is applied to all cuvettes in the Cuvette Set section, unless you have
selected specific cuvettes. The reference value is not displayed in SoftMax Pro Software. If

you want to see the reference value, you can use one of the following procedures.
Procedure 1:
1. Create a cuvette in the Cuvette Set section and Ref on air (empty cuvette port).
2. Read a cuvette containing the blanking solution.

If you want to have both reference and read values available, do the following:
3. Create a cuvette set with up to the maximum of 96 cuvettes.

Define a template blank in the Cuvette Set section.

5. Place buffer in the cuvette and click Read.

6. Click Read u again to read the remaining samples.

The optical density of the cuvette designated as the template blank is subtracted from the

optical density of all the other cuvettes in the Cuvette Set section.
Procedure 2:

1. Create a Cuvette Set with up to the maximum of 96 cuvettes.
2. Reference and read the cuvette.

3. Create a template with the applicable groups.
4. Create a column in each Group table with the formula !'wellprereadLm1.

If you have a multiple-wavelength reading and want to see the reference at each wavelength,
create more columns with the formula !wellprereadLmx where x is 2, 3, or 4, corresponding

to the wavelength for which you want to see a reference.

The OD/RFU/RLU with the reference subtracted is displayed in the Values column. The
reference value for each sample is displayed in the custom column you have created.
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Collecting Data from a Membrane Holder

You can start a read after defining the instrument settings.

Note: Before starting a read, it is good practice to save your data file. For Imaging
reads and Western Blot reads, you must save your data file before starting the read.
See Saving Data Files on page 65.

To automatically read multiple Plate sections in the same experiment, see Enabling Auto
Read on page 340.

If you are using the SoftMax Pro GxP Software, you must enable the following permissions to
complete a Western Blot membrane read:

* Read empty plates/cuvettes to start a read.
* Save data files to save the data file before the read.
e Overwrite plate/cuvette data to do a high-resolution ROl read.
See Using SoftMax Pro GxP Software Features on page 467.
To read a membrane:
1. Open the drawer of the instrument by clicking Open/Close E on the Home tab in the
ribbon.

2. Insert the prepared membrane holder matching the Al position on the membrane
holder with the Al position in the drawer in landscape orientation. Make sure the
membrane holder is flat against the drawer bottom.

A CAUTION! To prevent damage to the instrument or the membrane holder, make
sure that all the holder clips are securely snapped into place before inserting the
membrane holder into the microplate reader.

Click Open/Close E to close the drawer.

4. Open a SoftMax Pro Software data file or protocol file that contains the applicable
experiment settings for the membrane read. As an alternative, create new settings by
selecting the Plate section in the SoftMax Pro Software program and configuring the
instrument settings using the Settings dialog. See Selecting Instrument Settings on page
236.

5. Before starting a read, it is good practice to save your data file. For Imaging reads and
Western Blot reads, you must save your data file before starting the read. See Saving
Data Files on page 65.
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6. Click Read u on the Home tab in the ribbon.

The Read button changes to Stop o, letting you terminate a read if desired.
7. The active Plate section is read.

8. To select and scan a region of interest (ROI), click i on the left side of the Plate section

and then drag across the image to define the region. Click Read 0 on the Home tab in
the ribbon to scan the region using the ROI Scan Resolution defined in the Settings
dialog. The data from the ROl scan replaces the data from the original scan. See Viewing
Western Blot Membrane Data on page 443.

9. When the read is complete, click Open/Close =¥ to open the drawer letting you remove
the membrane holder.
After the read is complete, save the data. See Saving Data Files on page 65.

For information on the data-analysis tools for Western Blot images, see Viewing Western
Blot Membrane Data on page 443.
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Each SoftMax Pro Software data file has a minimum of one Plate section or one Cuvette Set
section. Most files also have an assigned plate template and related Group sections, Graph

sections, and Note sections. However, depending upon the protocol and how you want to

report the data, only some of these sections might be present in every file.

Some simple protocols, such as reading the absorbance of proteins at 280 nm in a cuvette or
in a microplate with PathCheck Pathlength Measurement Technology, let you calculate
concentration in the Plate section or Cuvette Set section. In such an example, Group
sections and Graph sections are necessary only if you want to display the data in tables or
graphically.
Many common protocols consist of data acquired in a Plate section or Cuvette Set section.
Standards and unknowns are defined in a template. Unknowns are then interpolated from a
standard curve.
For more information see:

e Calculations and Numerical Precision on page 356

e Setting the Data Display Options on page 358

¢ Doing Data Reduction on page 367

e Viewing Data in a Three-Dimensional Graph on page 382

e Graphing Data on page 388

* Analyzing a Western Blot Image on page 450
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The calculations done by the SoftMax Pro Software on real numbers use 64-bit double-
precision (15+ digits of precision) as defined by the Institute of Electrical and Electronics
Engineers standard for floating point arithmetic (IEEE 754). Computations always use the
maximum available precision. Rounding occurs only as required for display formatting
purposes, or in the evaluation of a formula in which the Round operator is used.

See “Technical Details of Numerical Calculations in the SoftMax Pro Software” in the
application help.

Numbers from Plate sections, Cuvette Set sections, Group sections, and Summaries are
displayed, printed, and exported with as many digits after the decimal point as specified by
the user. Allnumbers saved in the SoftMax Pro Software data files are stored with full 64-bit
double-precision.

The precision of the data displayed in a Plate section varies based on the space available to
view the characters.

You can customize the data display to Numeric notation or Scientific notation format, and
specify the number of Significant Figures or Decimal Places. These options can be set
separately for raw data and reduced data.

When the number of digits is increased, the font size of the values in the Plate section is
decreased. If the value becomes too long, then the numbers are cut off at the edge of the
wells.

When SoftMax Pro Software exports plate data, the values are not limited by space and can
have more digits for each well.

The values displayed in a Plate section are only a representation of the data. In both the
Plate section and in the exported data, the last digit displayed or exported is rounded based
on the actual data value.

Although the SoftMax Pro Software can display readings and numbers derived from those
readings with more than four decimal places, the resolution of the microplate reader
ultimately determines the precision of the calculations. For more information about the
numerical resolution of a reader, see the documentation for that reader.

% Note: In versions of the SoftMax Pro Software older than version 6.0, the software
used a text-conversion algorithm with a slight upward bias. This can resultin a
mismatch between the rounded values in the newer version and the older version.
For example, when rounding the raw value 14.849999... to one decimal place, versions
6.0 and newer display 14.8, while older versions display 14.9. This does not affect the
accuracy of the calculations, since rounding occurs only as required for display
formatting purposes, or in the evaluation of a formula in which the Round operator is
used. Computations always use the maximum available precision.

For information on suspending and resuming calculations, see Using the Operations Tab on
page 44.
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More information on SoftMax Pro Software calculations can be found in the following topics
or references:

For information on Optical Density and %Transmittance calculations, see Absorbance
Read Mode on page 154.

For information on pathlength calculations, see PathCheck Pathlength Measurement
Technology on page 156.

For information on Fluorescence Polarization calculations, see Fluorescence Polarization
Read Mode on page 185.

For information on kinetic and spectrum reductions, see Kinetic Data Reduction Options
on page 378 and Spectrum Data Reduction Options on page 380.

For information on curve fit calculations, see Curve Fit Functions on page 404.

For a technical discussion of calculations and numerical precision, see “Technical Details
of Numerical Calculations in the SoftMax Pro Software” in the application help.

For information on statistical functions, see the SoftMax Pro Software Formula
Reference Guide.

Calculation Hierarchy

When reducing the data collected from the instrument, the SoftMax Pro Software does
calculations hierarchically. If an option in the hierarchy has not been selected in the Settings
dialog, is not available for the instrument being used, is not applicable to the type of read
being done, or has not been defined in the Template dialog or the Reduction dialog, then
the SoftMax Pro Software continues with the next listed calculation in the hierarchy.

The following is the general hierarchy of reduction calculations:

© o N o Uk W N
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Apply Well Masking

Subtract Plate Background constant

Apply PathCheck Technology normalization
Subtract Plate Blank

Apply Smoothing

Time Alignment (Interpolate Raw Data)
Subtract Group Blank (pre-reduction option)
Calculate mP or Anisotropy

Set first data point to zero

Convert OD to %T

Apply Reduction Limits

Apply Wavelength Combination

Apply Baseline Options

Apply Kinetic or Spectrum Reduction

Subtract Group Blank (post-reduction option)
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In an active Plate section or Cuvette Set section, you can change how the data is presented

L4

by clicking Display == on the Home tab in the ribbon or in the toolbar at the top of the
section.

4 Display Options @
Specify how data is displayed. @
@ Raw Data ! Reduced Data

Raw Data Units: OD

Reduction:
D with Reduced Number Qptions: | Mumber
Raw Data Format Reduced Data Format
| Defauit - Defauit
Significant Figures 3 Significant Figures 3
Decimal Places 3 Decimal Places 3
Sample Samgple
12345 12345

| ok I[ Cancel

The choices available in the Display Options dialog include selecting between Raw Data and
Reduced Data.

For Imaging read mode Imaging Data replaces the Raw Data option.

You can customize the data display to Numeric notation or Scientific notation format, and
specify the number of Significant Figures or Decimal Places. These options can be set
separately for raw data and reduced data.

The Default format determines the number of decimal places to display based on the space
available. For example, for a plate with 96 wells or fewer, each well is limited to five digits,
plus one character for the decimal point, if applicable. For a 384-well plate, each well is limited
to four characters, including the decimal point. If the value requires greater precision than
can fit in the available space, the format changes to scientific notation.

When SoftMax Pro Software exports plate data, the values are not limited by space and can
have more digits for each well.

The values displayed in a Plate section are only a representation of the data. In both the
Plate section and in the exported data, the last digit displayed or exported is rounded based
on the actual data value.
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You can view both raw and reduced data or multiple reductions of the same data by cloning
a plate. See Cloning a Plate Section on page 127.

Viewing Raw Data

1. Click DisplayTLJ on the Home tab in the ribbon orin the toolbar at the top of the
section.
In the Display Options dialog, click Raw Data.
Optionally, click with Reduced Number to include the reduced data number on the
display.

4. Click OK.

Raw Data Options
Selecting Raw Data displays the default data type for the selected read type:
* Endpoint: Raw absorbance, fluorescence, or luminescence values.
e Kinetic: The change in raw OD/RFU/RLU values over time, displayed as a plot.
e Spectrum: Raw OD/RFU/RLU values for the range of wavelengths, displayed as a plot.
* Well Scan: Raw OD/RFU/RLU values as shades of blue to red.

To see a reduced number, select with Reduced Number.
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S
1. Click Display <=

section.

on the Home tab in the ribbon or in the toolbar at the top of the

In the Display Options dialog, click Reduced Data.
Select an option from the Options list.
Click OK.

Reduced Data Options

The reduced data display is based on the selections made in the Data Reduction dialog. See
Doing Data Reduction on page 367.

The reduced number is reported in the Group section when a template has been defined.
e Select Number to view only the reduced number.
o Select Plot for Kinetic reads to display a plot of the raw and reduced data. To also view
the reduced number, select the Reduced Number check box.

» Select Grayscale to display the raw data in eight shades of gray, changing from light, for
values less than or equal to the low limit, to dark, for values greater than or equal to the
high limit. To define the High Limit and the Low Limit for the grayscale map, type values
in the fields. To also view the reduced number, select the Reduced Number check box.

* Select Color Map to display the raw data in eight colors, changing from blue, for values
less than or equal to the low limit, to red, for values greater than or equal to the high
limit. To define the High Limit and the Low Limit for the color map, type values in the
fields. To also view the reduced number, select the Reduced Number check box.
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Viewing Imaging Data

5.

Click DisplayTLJ on the Home tab in the ribbon or in the toolbar at the top of the
section.

In the Display Options dialog, click Imaging Data.

To display reduced imaging data, see Viewing Reduced Data on page 360.

Select a Data Type. The options available in the measurement selections from the Image
Analysis Settings in the Settings dialog. See Viewing and Selecting Measurement
Statistics on page 273.

Optionally, click with Reduced Number to include the reduced data number on the
display.

Click OK.

Imaging Data Options

The Data Type list contains the measurement selections from the Image Analysis Settings in
the Settings dialog. See Viewing and Selecting Measurement Statistics on page 273.

Select from one of the Data Types that follow. Separate data types are available for each
measured wavelength and classification, if applicable.

Object Count gives the total number of objects detected in the image. This
measurement is not used for field analysis of confluent areas.

Field Count gives the total number of confluent areas detected in the image. This
measurement is not used for discrete object analysis.

Object Percentage gives the percentage the objects detected in the image by
classification. This measurement is not used for field analysis of confluent areas.
Covered Area gives the combined area of all the objects or confluent areas detected in
the image as a percentage of the entire image area.

Object Area gives the average area of the objects detected in the image expressed in
umz. This measurement is not used for field analysis of confluent areas.

Field Area gives the average area of the confluent areas detected in the image expressed
in umz. This measurement is not used for discrete object analysis.

Object Roundness gives the average roundness of each object detected in the image. A
shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all.
This measurement is not used for field analysis of confluent areas.

Field Roundness gives the average roundness of each confluent area detected in the
image. A shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round
at all. This measurement is not used for discrete object analysis.

Object Average Intensity gives the average fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).
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Field Average Intensity gives the average fluorescent signal intensity of the confluent
areas detected in the image. This measurement is not used for discrete object analysis.
This measurement is not used for transmitted light (TL).

Object Intensity gives the average total fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).

Field Intensity gives the average total fluorescent signal intensity of the confluent areas
detected in the image. This measurement is not used for discrete object analysis. This
measurement is not used for transmitted light (TL).

Total Intensity gives the combined total fluorescent signal intensity of the objects or
confluent areas detected in the image expressed in million intensity counts. This
measurement is not used for transmitted light (TL).
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Zooming the Display of a Well or Cuvette

The Zoom icon becomes active when the data in a well or cuvette is available for a zoomed

display.

To magnify the display of imaging data in a well, see Viewing the Imaging Data in a Well on

page 365.

To display the Zoom Well dialog:

1. Click the well or cuvette that you want to zoom.

2. Click Zoom “4 on the Home tab in the ribbon or Zoom "X in the toolbar at the top of the
section. You can also double-click the well to open the Zoom Well dialog.

The data from the selected well or cuvette is displayed in a zoomed graph window.
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To print the graph window, click Print.

To scale the display to the data, select Scale to Data.
To toggle between reduced and raw data, click Show Reduced or Show Raw.
To modify the reduction settings, click Reduction. The Data Reduction dialog is

displayed. See Doing Data Reduction on page 367.
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7. To modify the zoom well display settings, click Options. The Zoom Well Options dialog is

displayed.
U Zoom Well Options @
Graph Type Settings @
Show Plot Symbols Show Datz Coordinates
Characteristics
Scales K-Axis ¥-Axis
Auto Scale D |:|
Minimum | 0 | | o |
Iaximum | 600 | | 14 |
Grid Lines K-Axis -Axis
Major Grid Lines
Minor Grid Lines T [
[ ok || canca |

* Graph Type Settings lets you enable or disable connected points or plotted symbols
on the graph.

e Characteristics lets you set Auto Scale parameters and choose the minimum and
maximum values for the selected axis. You can also add or remove grid lines from the
display.

To save the settings and return to the Zoom Well dialog, click OK. These changes have
an effect on only the well graph being viewed.

8. To close the Zoom Well dialog, click Close.
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Viewing the Imaging Data in a Well

You can view a combination of the raw image and the analysis data in up to four wells from a
Plate section or the two wells from the Image Analysis Settings. See Using a Plate Section on
page 118 or Image Analysis Settings on page 266.

The Zoom icon becomes active for a Plate section when the imaging data in a well is available
for a zoomed display.

To display the SoftMax Pro MiniMax Well Viewer dialog from a Plate section, double-click
the well that you want to zoom. You can also click Zoom Q on the Home tab in the ribbon or
Zoom "4 in the toolbar at the top of the section. In the Image Analysis Settings
Measurement Selection, click Show Details.

To view more than one well in a Plate section, drag your pointer to select up to four wells
before opening the Zoom Well dialog.

It can take some time before the SoftMax Pro MiniMax Well Viewer dialog is displayed. It
can also be displayed behind the SoftMax Pro Software window. To bring the well viewer to
the front, click the SoftMax Pro MiniMax Well Viewer icon in the Windows task bar.

B Softhax Pro MiniMax Well Viewer

The SoftMax Pro MiniMax Well Viewer dialog displays a zoomed image of the well, a table
of data, and chart of the data. To choose to display one or more of these areas, select or
clear the Show Images, Show Tables, or Show Charts check boxes in the lower-left area of
the dialog.

The three areas in the dialog are interactive.
e Click the cells in the image to highlight the data in the table and the data in the chart.
e Click the data in the table to highlight the cells in the image and the data in the chart.
e Click the data in the chart to highlight the cells in the image and the data in the table.

To use an image of the SoftMax Pro MiniMax Well Viewer dialog in a Microsoft PowerPoint
presentation, click Send to PowerPoint. A new document opens in PowerPoint with an
image of the Zoom Well dialog in a slide.
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Image Area Options

The image area displays the acquired image from the selected well. To zoom the acquired
image in and out, right-click the image and click Zoom In or Zoom Out. You can also hold the
CTRL key down and press + or -, or use the mouse wheel to zoom in or out. Drag the scroll
bars to move the zoomed image in the image area, or click the image and drag it into
position.

Click the buttons above the image to switch the view of the image between wavelengths,
and to display or hide the found objects or confluent areas.

TL 341 {?13) Objects

* When a button is filled in, the related wavelength, objects, or areas are displayed in the
image.
* When a button is outlined, the related wavelength, objects, or areas are not displayed in
the image.
When you click a button above the images, it effects the display of all the images.
Use the controls below the image to separately adjust the intensity of each wavelength.

From the list on the left, select the wavelength that you want to adjust.

Drag the sliders to adjust the intensity range of the image.

-~ I ]

e The bar on the left controls the low level of intensity.

e The bar on the right controls the high level of intensity.
When you drag a bar, the intensity level is displayed above the bar.
To move the sliders to the outside edges, click the double-arrow button on the left.

From the list on the right, select the color for the view.

To automatically scale the intensity of all the wavelengths in the image, click Auto Scale All
Wavelengths.
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Table Area Options
In the table area, you can change the size the columns by dragging the separator lines. Drag
the scroll bars to view the data in the table.

To use the table data in Microsoft Excel, click Send to Excel. A new spreadsheet opens in
Excel with the data from the table in the cells.

Chart Area Options

To change the type of chart displayed in the chart area, click Histogram or Scatter Plot.
e For a histogram, you can select a data type for the X Axis Data.

e For a scatter plot, you can select data types for the X Axis Data and the Y Axis Data.

Masking Wells or Cuvettes

The Mask feature hides selected data so that they are not used for calculations and are not
reported. Masking is commonly used to suppress outliers from data reduction calculations.

Masking can be used as a “what if?” tool. For example, if you have included a group blank in
a template and want to see the data both with and without the blank, masking the group
blanks suppresses the blanking function, while unmasking them enables it again.

To mask wells or cuvettes:

1. In an active Plate section or Cuvette Set section, select a well or cuvette or select
multiple wells or cuvettes.

e To select multiple wells in a Plate section, click and drag across the desired wells.

e To select multiple cuvettes in a Cuvette Set section, hold down the Ctrl key and click
the desired wells.

2. Click Mask ## in Plate Tools or Cuvette Tools on the Home tab in the ribbon or in the
toolbar at the top of the section.

You can also right-click a well or cuvette and select Mask from the shortcut menu.
To unmask masked wells or cuvettes select them and then click Mask.

Doing Data Reduction

5049092 A

The reduction process in SoftMax Pro Software is based on formulas that reduce the raw
data to show a single number for each well or cuvette. Further analysis of this reduced
number is done in Group and Graph sections.

When reducing raw information collected from the instrument, SoftMax Pro Software does
calculations hierarchically. Only the data reduction calculations that apply to the data based
on the instrument read mode, read type, and settings are done. See Calculation Hierarchy
on page 357.

Click Reduction on the Home tab in the ribbon or in the toolbar at the top of the section to
open the Data Reduction dialog.
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=, Data Reduction

©F

Raw Data Steps

o Use Plate Blank

Group Blank Options

- @ Afer Reductien | () Before Reduction

o [] set first data point to zerc

o Raw Data Mode

) @ Optical Density () %Transmittance

Data Reduction Steps

Limits
Min QD 0 Lag Time: 1]
Max 0OD: 4 End Time: 600

Wavelength Options

[!Lml Tl

Kinetic Reduction

["u'max {milli-units per - l Vmax Points: 21 out of 21

o Group Blank Subtracted

| ok || cancet |

The Data Reduction dialog displays only the reduction options that are available for the
instrument you are using, the options that have been selected in the Settings dialog, and the
options defined in the template.

SoftMax Pro Software does the applicable calculations in the Plate section or Cuvette Set
section in the order displayed in the Data Reduction dialog. If an option has either not been
selected in the Instrument Settings dialog, is not available for the instrument you are using,
or has not been defined in the template, SoftMax Pro Software continues with the next
applicable calculation.
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Raw Data Steps

Raw data displays are calculated using the following steps that apply to the selected mode,
type, and settings:

Apply PathCheck (Absorbance Endpoint only)

PathCheck Pathlength Measurement Technology normalization calculations apply to the
data only when PathCheck has been enabled in the PathCheck settings for an Absorbance
Endpoint read. When PathCheck is enabled, this calculation can be disabled in the Data

Reduction dialog by clearing the Apply Pathcheck check box. For more information, see
PathCheck Pathlength Measurement Technology on page 156.

= Data Reduction @

)

Raw Data Steps

Pathcheck Options
Apply Pathchack Apply Plate Background OD

Lmi 0

o Use Plate Blank

Group Blank Options
() After Reduction (@ Before Reduction

o Raw Data Mode

@ Optical Density ) %Transmittance
Data Reduction Steps

Wavelzngth Options

[JLml -

| ok || cancet |

Apply Plate Background OD (Absorbance Endpoint only)

Subtraction of the Plate Background constant applies to the data only when PathCheck has
been enabled in the PathCheck settings for an Absorbance Endpoint read. To define the
constant, type a value in the field. When PathCheck is enabled, this calculation can be
disabled in the Data Reduction dialog by clearing the Apply Plate Background OD check box.
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Use Plate Blank

The Use Plate Blank calculation is available when a plate blank is specified in the template
settings for the plate. To enable subtraction of the plate blank value, select the Use Plate
Blank check box. For more information about plate blanks, see Defining Blanks on page 308.

Smoothing

Smoothing is used to reduce noise in kinetic reads for FlexStation Instrument data. This
setting takes the moving average of the raw data and displays the plot using the averaged
values.

The default is no smoothing, or a setting of 1 “averaged” point.

e Asetting of 3 provides the least amount of smoothing, where the value of the center
point is added to the values of the points on either side. The sum of these points is then
divided by three and the resulting value is substituted for the center point.

e Asetting of 9 averages the center point with the four points on each side.

When multiple wavelengths are read, smoothing is done before doing wavelength
combination calculations such as ratios or multiplication. For example, if you read at two
wavelengths and choose to take a ratio of those wavelengths, smoothing is performed on
each individual wavelength and the wavelength ratio is calculated using smoothed data.

Time Alignment

For FlexStation Instrument data, each data value is logged with its own read time. The
SoftMax Pro Software can align the time points by Wavelength or by Well and interpolate
the data against a single time point.

e Select the Time Alignment check box and then click Wavelength so that you can do
wavelength combination calculations correctly. For example, you can take a ratio of two
different wavelengths (Lm1/Lm2) in a single well that have been read at two different
time points. The Wavelength option is available only when two or more wavelengths are
present in the data.

With Wavelength selected, the SoftMax Pro Software uses quadratic interpolation to
calculate the interpolated values. This results in the loss of one point at each end of the
plot. Before starting the calculation, the software determines the starting point by
averaging the initial data points of the separate wavelengths. For example, if the first
data points of the two wavelengths have time values of 0.3 and 0.5 seconds, the
software averages these data points and uses 0.4 seconds as its initial point for
interpolation.

* Select the Time Alignment check box and then click Well to normalize the kinetic read
times of the wells in the column against the read time of the first well in the column.
Injection occurs at the same time in all the wells of a column, but each of the wells is read
sequentially. So, each well is read at a different time point during the reaction from the
injection. With Well selected, the data in the wells are interpolated against the time
point of the read of the first well.
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Group Blank Options

The Group Blank Options calculation is available when a group blank is specified in the
template settings for the plate. The subtraction of the group blank value can be selected as a
pre-reduction process or a post-reduction process.

e To enable the group blank value subtraction calculation as a pre-reduction process, click
Before Reduction.

e To enable the group blank value subtraction calculation as a post-reduction process,
click After Reduction. When After Reduction is selected under Group Blank Options,
the last step in the Data Reduction dialog shows Group Blank Subtracted.

For more information about group blanks, see Defining Blanks on page 308.
Polarization or Anisotropy (Fluorescence Polarization only)

Fluorescence polarization mode returns two sets of data: one for fluorescence intensity
parallel (P) to the excitation plane, and the other for fluorescence intensity perpendicular (S)
to the excitation plane. These S and P values are used to calculate the Polarization (mP) and
Anisotropy (r) values in the SoftMax Pro Software. Click the data type to use as the raw data
for the reduction.

G Factor

The G factor, or grating factor, is used in fluorescence polarization to correct polarization
data for optical artifacts, converting relative mP data to theoretical mP data. Optical
systems, particularly with reflective components, pass light of different polarization with
different efficiency. G factor corrects this instrumental bias. To define the G Factor, type a
value in the field.

Set first data point to zero (Kinetic only)

Select this check box to offset the first data point to (0,) and shift all other data accordingly.
Clearing this check box can cause some data points that do not fall within the reduction
limits to disappear.

To see more data and still display absolute values, increase the reduction limits for Min OD,
Min RLU, or Min RFU and the Max OD, Max RLU, or Max RFU.
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Raw Data Display Mode (Absorbance only)

For Absorbance reads, you can choose whether to display absorbance data as Optical
Density or %Transmittance.

e Optical Density: The quantity of light passing through a sample to a detector relative to
the total quantity of light available. Optical Density includes absorbance of the sample
plus light scatter from turbidity.

* % Transmittance is the ratio of transmitted light to the incident light (for absorbance
readings).

Click the data type to use as the raw data for the reduction.

Note: Separate mathematical calculations are used for handling Optical Density
(OD)and %Transmittance (%T) calculations for Pre-read plate blanking, PathCheck
Pathlength Measurement Technology, and Reference, because OD calculations are
done on a linear scale, while %T calculations are done on a logarithmic scale. However,
SoftMax Pro Software does not do other calculations differently for OD and %T
modes. Because of this, Molecular Devices recommends that %T be used only for raw
0D, raw OD with Pre-read plate blank subtraction, or raw OD readings which are
normalized by the PathCheck Pathlength Measurement Technology. Use caution
when using %T on reduced numbers or the readings that apply to other calculations
since the data might not be calculated correctly.
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Data Reduction Steps

Data Reduction display includes one or more of the following calculations:
Baseline Options
Baseline options affect the way that the data is graphed for FlexStation Instrument data.

e Absolute displays the raw data without any change in the way it is graphed. Raw data is
used in subsequent reduction calculations.

o Zero Baseline offsets the graph slightly. For example, if you type 5 for the number of
points, then the average of the first 5 points is used as the baseline value, and all raw
data are subtracted from this value.

Baseline subtraction is applied only to the reduced data. The raw data plots do not
change. To view the plot with baseline subtraction, select Reduced Plot in the Display
dialog or select Show Reduced in a Zoom Well dialog.

If two or more wavelengths are present in a reading, and you combine these
wavelengths while Zero Baseline is selected, the zero baseline applies only after the
wavelength combination.

* % Baseline makes data from a FlexStation Instrument look similar to data from a
FLIPR System. Data from a FLIPR System can be imported into the SoftMax Pro Software,
and this option modifies the plot and reduction calculations to make data from a
FlexStation Instrument comparable to data from a FLIPR System.

This method averages the first number of points you specify (the upper box), divides the
raw data by this average value, and then multiplies by 100 (%). Type a value from 0.001
t0 99999 to be used to multiply the % Baseline value.
This calculation is done only on the reduced data and only after any wavelength
combinations are calculated.
To view the modified plot, select Reduced Plot in the Display dialog or select Show
Reduced in a Zoom Well dialog.
Limits
Apply the specified reduction limits to the reduced data after this step. To specify the limits,
type values in the fields.

Limits define the data that are viewed and included in data reduction. If you change a limit to
show less data, you can always display the excluded data again by changing the limit.

The display of OD, RFU, or RLU values is relative to the first point measured for each well.

Negative Kinetic values decrease with time, and limits should be set accordingly (below 0) to
view negative Kinetic data.

e Min OD, Min RFU, or Min RLU defines the limit for the minimum value to report. Values
from the reading that are under this limit are not shown and are excluded from data
reduction. The default is 0 OD or RFU/RLU. To display negative Kinetics, the value should
be set below 0 (zero).

373



SoftMax Pro Software User Guide

* Max OD, Max RFU, or Max RLU defines the limit for the minimum value to report.
Values from the reading that are under this limit are not shown and are excluded from
data reduction. The default is 0 OD or RFU/RLU. To display negative Kinetics, the value
should be set below 0 (zero).

e Lag Time in a kinetic read defines the period of very slow growth of microorganisms or
the rate of reaction that can precede the rapid or linear phase of reaction.The lag time
specifies how many initial data points are excluded from the calculation of Vmax Rate.
Lag time truncates the data used in the calculation, but does not prevent data from
being collected. Kinetic plots do not display the data collected before the lag time.

¢ End Time in a kinetic read specifies the time at which to stop showing data in the display
and exclude it from data reduction. Values occurring after this limit are not reported in
the display and are excluded from data reduction. The default setting is the total assay
time for the kinetic read.

e Startin a spectrum read specifies the limit in nm for the minimum wavelength setting to
report. Values from the reading that are under this limit are not shown and are excluded
from data reduction.

e End in a spectrum read specifies the limit for the maximum wavelength setting to report.
Values from the reading that are above this limit are not shown and are excluded from
data reduction.
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Wavelength Options

Select an available wavelength formula from the list. To use a custom reduction, select

Custom from the list and then, click @to open the Formula Editor. See Data Reduction
Formulas on page 376.

Kinetic Reduction

Select a Kinetic reduction mode from the list. To use a custom reduction, select Custom from

the list and then, click @ to open the Formula Editor. See Data Reduction Formulas on
page 376.

For more information about kinetic reductions, see Kinetic Data Reduction Options on page
378.

The number of Vmax Points is determined by the Timing settings.
Spectrum Reduction

Select a Spectrum reduction mode from the list. To use a custom reduction, select Custom

from the list and then, click @ to open the Formula Editor. See Data Reduction Formulas
on page 376.

For more information about spectrum reductions, see Spectrum Data Reduction Options on
page 380.

Well Scan Reduction

Select Maximum, Minimum, Average, or Custom from the list. Average provides the
average value for all points in the Well Scan. To use a custom reduction, select Custom from

the list and then, click @ to open the Formula Editor. See Data Reduction Formulas on
page 376.

Group Blank Subtracted

When After Reduction is selected under Group Blank Options, the last step in the Data
Reduction dialog shows Group Blank Subtracted.

After all applicable data reduction options have been set, click OK.
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Data Reduction Formulas

The reduction process in SoftMax Pro Software is based on formulas that reduce the raw
data to show a single number for each well or cuvette. Further analysis of this reduced
number is done in Group sections and Graph sections. See Using a Group Section on page
139 and Graphing Data on page 388.

Custom Reduction Formulas

If the predefined reduction formulas do not meet your needs, you can create custom
reduction formulas. Selecting Custom from the menus or dialogs displays a Formula button
that you can click to open a Formula dialog.

Examples of some formulas that can be used when combining multiple wavelengths in a
Formula dialog are given in the following tables.

Table 8-1: Wavelength Reduction Formula Examples for Specific Wavelength

Combinations
2 Wavelengths

3 Wavelengths

4 to 6 Wavelengths

ILm1 + ILm2 Lm1+ ILm2 + ILm3 ILm1+ ILm2 + ...+ ILmn

ILm1-ILm2 (Itm1—=1Lm3)/(ILm2 - Lm3) (Itm1—1Lm6) /(ILm2 —
ILm5) / (ILm3 — ILm4)

ILm1/!Lm2 ILm1/!Lm3 ILm1/!Lmn

ILm1 * ILm2 ILm1 * ILm3 ILm1 * ILmn

Logl10(!Lm1/ILm2) Log10(!Lm1/ILm3) Log10(!Lm1/ILmn)

IPathlength IPathlength IPathlength

Formula

ILmx / constant

Table 8-2: Wavelength Reduction Formula Examples for all Wavelength Combinations

Description

For example, Lm1 / 1.44 for quantitating a polyclonal antibody
by measuring the absorbance at A280 with PathCheck
Pathlength Measurement Technology on.

Average(ILm1&!/Lm2&!Lm3)

Averages together the optical densities for multiple readings at
the same wavelength (for example, if you read the well six

times at 280 nm).

Min(ILm1&!Lm2&ILm3)

Reports the minimum OD/RFU/RLU recorded for multiple

wavelength readings in each well.

Max(!ILm1&!ILm2&!Lm3)

Reports the maximum OD/RFU/RLU recorded for multiple

wavelength readings in each well.

If(ILmz<A,makeerr(118), (if
('Lmx>B, makeerr(117), ILm1)))

Reports “low” for a well with an OD/RFU/RLU less than A,
“high” for an OD/ RFU/RLU greater than B, and the OD/
RFU/RLU of a well lies between A and B.
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Custom reduction formulas using mathematical operators or terms can be used to obtain
specific types of data. The following table provides some examples of such formulas for
Kinetic and Spectrum readings.

Table 8-3: Kinetic Reduction Formula Examples

Formula Description

Vmaxcorr(!lcombinedplot, Reports Vmax correlation coefficient for plots in all 96 wells.
IVmaxpoints,!readinterval)

Vmax(Delta(!combinedplot), Reports the Vmax Rate of the delta between each time point.
IVmaxpoints,!readinterval)

Table 8-4: Spectrum or Kinetic Reduction Formula Example

Formula Description

Nthitem(!Lm1,X) Reports the optical density at item X in the list of readings. For
example, if you have a Kinetic run with 20 time points and X is
10, it reports the OD/RFU/RLU of the 10th time point. Similarly,
if you have a Spectrum scan with 20 measurements and X is
10, it reports the OD/RFU/RLU of the 10th wavelength
measured.

The accessor names for custom reduction formulas for imaging data are enclosed in square
brackets to prevent conflicts with other formula elements.

Table 8-5: Imaging Reduction Formula Example

Formula Description
I[TypeAObjectCount] - Reports the difference between the number of Type A and
I[TypeBObjectCount] Type B cells detected in the image.

For a full discussion of custom formulas, see the SoftMax Pro Software Formula Reference
Guide.

When you finish your entry in the Calculation dialog and click OK, the formula is displayed
and becomes the default selection for the Custom option.
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Kinetic Data Reduction Options

Kinetic reductions are applied to the value at each time point after the wavelength
combination formula is applied.

Vmax

Vmax is the maximum slope of the Kinetic display of mOD/min or RFU/RLU per second. Vmax
is calculated by measuring the slopes of a number of straight lines, where Vmax Points
determines the number of contiguous points over which each straight line is defined.

This is an alternative method for analyzing non-linear Kinetic reactions that reports the
elapsed time until the maximum reaction rate is reached, rather than reporting the
maximum rate itself. Used in conjunction with Vmax Points, Time to Vmax is the time to the
midpoint of the line defined by Vmax Points and used to calculate Vmax.

Vmax Rate is reported as signal/min (milli-OD, RFU, or RLU units per minute) for a Kinetic
read. Itis calculated using a linear curve fit, y = Ax + B. A creeping iteration is done using Vmax
Points and the slope of the steepest line segment is reported as Vmax Rate. It can also be
reported as units per second (the default for Fluorescence and Luminescence modes).

Vmax (milli-units per min) and Vmax (units per sec) reductions are available for all
instruments that are capable of Kinetics. The default Kinetic reduction is Vmax (milli-units
per min).

Time to Vmax elapsed time data is useful for applications including coagulation chemistry
where the changing concentration of the reagents does not change Vmax, but rather
changes the time at which the reaction reaches the maximum rate.

The number of available Vmax Points is determined by the Timing settings. Typing a value in
the Vmax Points field defines the maximum size of the line segment used to determine the
slope of the line used in calculating the rate of the reaction. The default is the total number of
points taken in the reading.

The first slope is calculated for a line drawn that starts at the first reading as defined by Lag
Time and ends at a total number of readings equal to the Vmax Points setting. The second
and subsequent slopes are calculated to start at the second time point and end at a total
number of readings equal to the Vmax Points setting. The steepest positive or negative
slopeis reported as Vmax.

If the data plot displays fewer time points (data points) than Vmax Points, all of the time
points are used to determine the slope of the data.
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Onset Time
Onset time is a method for analyzing non-linear Kinetic reactions. Onset Time reports the
time required for a Kinetic reaction to reach a specified OD or RFU/RLU (onset OD/RFU/RLU).

This elapsed time data is useful for cascade reactions including clot formation (such as,
endotoxin testing) and clot lysis applications where the change in reagent concentration
does not have an effect on the maximum optical density change but changes the time
required for the reaction to reach completion.

Time at Minimum

This setting reports the time at the minimum OD, RFU/RLU, or %T that falls within the
reduction limits.

Time at Maximum

This setting reports the time at the maximum OD, RFU/RLU, or %T that falls within the
reduction limits.

Time at 1/2 Maximum

This setting reports the time at the half of the maximum OD, RFU/RLU, or %T that falls within
the reduction limits.

To calculate this reduction, SoftMax Pro Software determines the Kinetic point (within the
reduction limits) that has the maximum signal level (OD or %T) and divides it by 2 to get the
1/2 Maximum value. Then it finds the time value at the 1/2 Maximum.

Area Under Curve

This reduction estimates the area under the curve as defined by the data plots within the
reduction limits. The data plots are treated as a series of trapezoids with vertices at
successive data points and at the X-axis coordinates of the data points. The areas defined by
each of the trapezoids are then computed and summed.

Slope

The slope reduction option determines the slope of the combined plot (for example, the
slope of the line using linear regression after the wavelength combination reduction). This
reduction uses all visible time points in the reduction window.

Slope is the same as Vmax Rate when Vmax Rate is set to the same number of points as the
run, but is different if you have modified Vmax Points.

To use a custom reduction, select Custom from the list and then, click @| to open the
Formula Editor. See Data Reduction Formulas on page 376.
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Spectrum Data Reduction Options

The Spectrum Reduction formula is applied to the list of numbers in each well (values at each
wavelength) after the wavelength combination formula is applied. The default reduction for a
Spectrum read is Lambda at Maximum.

Maximum

This reduction reports the maximum absorbance (optical density) or percent transmittance
(%T), RFU, or RLU within the reduction limits.

Minimum

This reduction reports the minimum absorbance (optical density) or percent transmittance
(%T), RFU, or RLU within the reduction limits.

Lambda at Maximum

This reduction reports the wavelength at which maximum absorbance (optical density) or
percent transmittance (%T), RFU, or RLU within the reduction limits.

Lambda at Minimum

This reduction reports the wavelength of minimum absorbance (optical density) or percent
transmittance (%T), RFU, or RLU within the reduction limits.

Area Under Curve

This reduction estimates the area under the curve as defined by the data plots, within the
reduction limits. The data plots are treated as a series of trapezoids with vertices at
successive data points and at the X-axis coordinates of the data points. The areas defined by
each of the trapezoids are then computed and summed.

To use a custom reduction, select Custom from the list and then, click @to open the
Formula Editor. See Data Reduction Formulas on page 376.
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Imaging Data Reduction Options

The Imaging Data list contains the measurement selections from the Image Analysis
Settings in the Settings dialog. See Viewing and Selecting Measurement Statistics on page
273.

Select from one of the reduction data types that follow. Separate data types are available for
each measured wavelength and classification, if applicable.

Object Count gives the total number of objects detected in the image. This
measurement is not used for field analysis of confluent areas.

Field Count gives the total number of confluent areas detected in the image. This
measurement is not used for discrete object analysis.

Object Percentage gives the percentage the objects detected in the image by
classification. This measurement is not used for field analysis of confluent areas.

Covered Area gives the combined area of all the objects or confluent areas detected in
the image as a percentage of the entire image area.

Object Area gives the average area of the objects detected in the image expressed in
umz. This measurement is not used for field analysis of confluent areas.

Field Area gives the average area of the confluent areas detected in the image expressed
in umz. This measurement is not used for discrete object analysis.

Object Roundness gives the average roundness of each object detected in the image. A
shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all.
This measurement is not used for field analysis of confluent areas.

Field Roundness gives the average roundness of each confluent area detected in the
image. A shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round
at all. This measurement is not used for discrete object analysis.

Object Average Intensity gives the average fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).

Field Average Intensity gives the average fluorescent signal intensity of the confluent
areas detected in the image. This measurement is not used for discrete object analysis.
This measurement is not used for transmitted light (TL).

Object Intensity gives the average total fluorescent signal intensity of the objects
detected in the image. This measurement is not used for field analysis of confluent areas.
This measurement is not used for transmitted light (TL).

Field Intensity gives the average total fluorescent signal intensity of the confluent areas
detected in the image. This measurement is not used for discrete object analysis. This
measurement is not used for transmitted light (TL).

Total Intensity gives the combined total fluorescent signal intensity of the objects or
confluent areas detected in the image expressed in million intensity counts. This
measurement is not used for transmitted light (TL).
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To use a custom reduction, select Custom from the list and then, click @to open the
Formula Editor. See Data Reduction Formulas on page 376.

Viewing Data in a Three-Dimensional Graph

To view a three-dimensional graphical representation of reduced plate data, view the Plate

section and then click the o 3D Graph button in the Plate Tools area of the Home tab in the
ribbon or in the toolbar at the top of the Plate section.

You can rotate a 3D graph vertically and horizontally.

A 30 Graph (===

Plate1l o

2750

Rows

Columns

To rotate the 3D graph:

e To rotate the 3D graph vertically, drag the vertical scroll bar located to the right of the 3D
graph.

e To rotate the 3D graph horizontally, drag the horizontal scroll bar located below the 3D
graph.

e To start or stop a continuous animated horizontal rotation of the 3D graph, double-click
the 3D graph.

You can resize the 3D Graph dialog by dragging a side or a corner of the dialog.
For customization and export options, right-click on the 3D graph.

You can quickly choose a customization option from the menu, or click Customization
Dialog to change several options at the same time. See Customizing a Three-Dimensional
Graph on page 383.
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Other options in the 3D graph dialog include:

* Plotting Method lets you view the graphed data in Wire Frame, Surface, Surface with
Shading views.

e Maximize expands the 3D graph to a full screen view. To return to the normal view, click
the title bar or press Esc.

o Export dialog is displayed the Export Control dialog letting you export the graphical
image to your choice of formats, or export the data to a text format. See Exporting a
Three-Dimensional Graph on page 386.

To close the 3D Graph dialog, click Close.

Customizing a Three-Dimensional Graph

The customization dialog has five tabs that contain customization options for the current 3D
graph.

Custamization...

General | Maore ] Fort ] Colar | Style |

Main Title:  |Platel m
Sub Title: |
Border Style lErltéL:;es - o
" No Border * Line o
" Mone
" Shadow 30 Inset
Wigwing Style

{+ Color

" Monochrome

[ Rotation Animation
" Monochrome + Symbaols

Show Bounding Box

Font Size & Whil Fiotating
(* Large " Med " Smal O Alwags
" Never
ak | Cancel | Apply | Export... | Maximize...

Click a tab to work with the options under that tab.
e Forthe General tab, see General Customization Options for a 3D Graph on page 384.
* For the More tab, see More Customization Options for a 3D Graph on page 384.
e Forthe Font tab, see Font Customization Options for a 3D Graph on page 385.
e For the Color tab, see Color Customization Options for a 3D Graph on page 385.
e For the Style tab, see Style Customization Options for a 3D Graph on page 386.

After making changes to the options in this dialog, you can click Apply to view how the
changes are applied to the 3D graph.

To close the Customization dialog and save unapplied changes, click OK.

Click Export to close the Customization dialog and open the Export Control dialog that lets
you export the graphical image to your choice of formats, or to export the data to a text
format. See Exporting a Three-Dimensional Graph on page 386.

Click Maximize to close the Customization dialog and expand the 3D graph to a full screen
view. To return to the normal view, click the title bar or press Esc.
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General Customization Options for a 3D Graph

Click the General tab to customize the 3D graph with the following options:

Main Title: Type the text you want for the title of the 3D graph.

Sub Title: Type the text you want below the title of the 3D graph.

Show Annotations: To show notes, select this check box. This option is not available if
there are no notes available.

Border Style: To change the border around the outside of the graphical image, click
No Border, Line, Shadow, or 3D Inset.

Viewing Style: To change the display of the image background, click Color,
Monochrome, or Monochrome + Symbols.

Font Size: To change the font size for all the text, click Large, Med, or Small.

Grid Lines: To view both the Y and X grid lines, click Both. To view only the grid lines for
the Y-axis, click Y. To view only the grid lines for the X-axis, click X. To remove the grid
lines, click None.

Rotation Animation: To start a continuous animated horizontal rotation of the 3D
graph, select this check box.

Show Bounding Box: To display a wire-frame box around the 3D graph under specific
conditions, click While Rotating, Always, or Never.

More Customization Options for a 3D Graph

Click the More tab to customize the 3D graph with the following options:

Rotation Detail: To change the display style when the 3D graph rotates, click Wireframe
to display only the outlines of the 3D graph, Plotting Method to display the data plot in
full 3D while displaying only outlines for the grid, or Full to display the entire 3D graph in
full 3D during rotation.

Rotation Increment: To control the speed and direction of the animated rotation, select
an increment from the list. Values closer to zero rotate slower, while values farther from
zero rotate faster. To rotate counter-clockwise, select a negative value.

Shading Style: To change the display of the shading, click White or Color. This option
has no effect on the display if there is no shading in the 3D graph.

Plotting Method: To change the display of the data plot, click Wire Frame, Surface, or
Surface with Shading.
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Font Customization Options for a 3D Graph

Click the Font tab to customize the text in the 3D graph:
e Main Title includes only the title of the 3D graph.
e Sub-Titleincludes only the text directly below the title of the 3D graph, if applicable.
* Subset/Point/Axis Labels includes all of the other text in the 3D graph.

For each text area, you can select the font and select a check box to add bold, italic, and
underline styles to the text.

Asample is displayed at the bottom to help you with your selections.
Color Customization Options for a 3D Graph

Click the Color tab to customize the colors used in the 3D graph.
Changes in the Color tab are automatically applied to the 3D graph as they are selected.

Click an option from the Graph Attributes group and then click a color to apply to the
selected attribute:

e Desk Foreground includes the text of the title and subtitle of the 3D graph.
o Desk Background includes the area behind the title and subtitle of the 3D graph.

* Shadow Colorincludes the border shadowing when Shadow is select for the Border Style
in the General tab.

e Graph Foreground includes all the text other than the title and subtitle, and the border
around the 3D graph.

e Graph Background includes the area within the border and behind the 3D graph.
e X and Z Axis Planeincludes the floor of the 3D graph.
e Y Axis Planeincludes the walls of the 3D graph.
Quick Styles group lets you select from pre-defined styles for the 3D graph:
» Select the Bitmap/Gradient Styles check box to add texture to the 3D graph.

e Click the Inset, Shadow, Line, and No Border options in the Light, Medium, and Dark
columns to view what effect the selected styles have on the 3D graph.
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Style Customization Options for a 3D Graph

Click the Style tab to customize colors used in the 3D graph.
Changes in the Style tab are automatically applied to the 3D graph as they are selected.

The customizable items in the list on the left are dependent on the some of the selections in
the other tabs, and on the type of data.

Click an item in the list, and then click a color to apply to it.

Exporting a Three-Dimensional Graph

Before exporting an image of a 3D graph, make sure that you have rotated the 3D graph to
the view that you want and that you have set your customization options. See Customizing
a Three-Dimensional Graph on page 383.

For export options, right-click on the 3D graph and then click Export Dialog to open the
Export Control dialog.

Export Control @

Exsport
(« EMF " wMF  BMP (" JPG " PMG " Text/Data

Expart Destination
(* ClipBoard

" File |

" Prirter

Export Size
* Milimetars " Inches " Paoints

widh: [152400 /7 [T01.600  Milimeters
DPI: {300 - [ Large Font Cancel

Click the graphic format from the Export area. If you select Text/Data, only the data is
exported. For more information about exporting the data, see Exporting Data from a Three-
Dimensional Graph on page 387.

In the Export Destination area, select how you want to export the image or data:

e Click ClipBoard to export the image or data to the Windows clipboard so that you can
paste it into a different program like a word processor or a spreadsheet.

e Click File to save the image or data in a file on your computer or network. Click Browse
to choose the destination and give the file a name.

o Click Printer to export the image or data directly to a printer. After you click Print, you
can select the printer and printer options.
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The options in the Export Size area are dependent on the selected Export format and the
Export Destination:

Full Page is available for exporting to a Printer.

No Specific Size is available for the WMF format exported to the clipboard or a file. Click
this option to let the export operation select the size for the image.

Pixels is available for BMP, JPG, and PNG formats exported to the clipboard or a file.
Millimeters, Inches, and Points are available for EMF and WMF formats exported to the
clipboard or afile, and for all graphic formats exported to a printer.

If you have selected measurement units, type the width and height for the exported
image.

For all graphic formats exported to the clipboard or a file, select the DPI (dots per inch)
for the exported image.

For all graphic formats exported to the clipboard or a file, You can select the Large Font
check box to increase the size of the text in the exported image.

When you have finished selecting your export options, click Export or Print.

If you are exporting the data as text, then the Export dialog is displayed with more options
for formatting the exported data. See Exporting Data from a Three-Dimensional Graph on
page 387.

Exporting Data from a Three-Dimensional Graph

To export just the data from a 3D graph:

1
2.
3.

Right-click on the 3D graph and then click Export Dialog.
In the Export Control dialog, click Text/Data.
In the Export Destination area, select how you want to export the data:

e Click ClipBoard to export the data to the Windows clipboard so that you can paste it
into a different program like a word processor or a spreadsheet.
o Click File to save the data in a file on your computer or network. Click Browse to
choose the destination and give the file a name.
Click Export.
In the Export dialog, in the Select Subsets and Points area, choose to export All Data or
Selected Data.
If you choose Selected Data, you can export columns of data by clicking the numbers
that correspond to the column numbers on the microplate, or you can export rows of
data by clicking the letters that correspond to the row letters on the microplate. If you
want to export a single well or a group of wells, click the column numbers and row letters
that correspond to the well or group of wells on the microplate. To select more than one
column or row in each list, hold down the Shift or Ctrl key as you click.
In the Export What area choose to export just the Data or the Data and Labels.
If you have multiple values available in your data, choose an option from the Data to
Export area.
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8. Inthe Export Style area, click List or Table.

* When you choose to export a List, define the delimiter for the data in each line by
clicking Tab or Comma. The type of delimiter you choose must match the
requirements of the program where you want to use the exported data.

e When you choose to export a Table, you can click Subsets/Points to place the data
from the microplate column numbers into the rows of the table and the data from
the microplate row letter into the columns of the table, or click Point/Subsets to
place the data from the microplate row letters into the rows of the table and the
data from the microplate column numbers into the columns of the table.

9. Inthe Numeric Precision area, click Current Precision to export the data using the
rounding defined in the 3D graph, or click Maximum Precision to export the rounding
available in the data file.

10. Click Export to export the data to the format defined in Step 3.

Note: If you exported the data to the Windows clipboard, you need to immediately
open the program where you want to use the data and paste the data into that
program.

Graphing Data

Click New Graph [ in Sections on the Home tab in the ribbon to open the Plot Editor dialog
where you can create a graph from the collected data.

After a graph has been created, new plots can be added and deleted, the axes can be
customized, and the size and type of graph can be changed. The grid lines for the graph can
be enabled or disabled. The default setting has grid lines enabled.

Other methods of visualizing data include viewing a zoomed well plot of the data in a well in a
Plate section or a cuvette in a Cuvette Set section, and viewing a three-dimensional graphical
display of the data. See Zooming the Display of a Well or Cuvette on page 363 and Viewing
Data in a Three-Dimensional Graph on page 382.
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Graph sections are used to plot information from groups as scatter plots or bar graphs.

Chapter 8: Analyzing Data

You can create more than one Graph section within a data file, and plots in the Graph section
can be created from any Experiment in the file.

Exptl
Exprl Graphl [ A CurveFit |Quadrnc = &

Grapht

® Plotl  (Standards: MeanValue vs Canc | Weighting: Fixsd

Curve Fit: Quadratic ¥ = A + Bx +€x?

Parameter  Estimated Value Std. Error

ot
R =039

< 1342 0452 [-2.507,-0477]

Graphl @ |4

Grapht

Graph sections are divided into the following areas:

¢ The body of the Graph section.

e The Legend. See Graph Legend on page 389.

To change the name of the Graph section, right-click the Graph section in the Navigation
Tree and then click Rename. See Renaming an Experiment or a Section on page 30.

For more information about graphs, see the following topics:

e Creating a New Graph on page 392

e Editing an Existing Graph on page 394

e Selecting Curve Fit Settings on page 394

e Changing the Name of the Graph Section on page 439

e Changing the Appearance of a Graph on page 440

e Zooming the Graph Display on page 442

e Exporting an Image of a Graph Section on page 442

Graph Legend

The graph legend for a scatter plot contains information about the contents of the graph. To

view or hide the graph legend, click Curve Fit Results on the right below the graph. A bar

graph does not have a legend.
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Independent Fits

For each curve fit function:

e The formulas for the selected curve fits

e Foreach plot:

2
e R"value

e ECsyvalue (where applicable)

e For each parameter:

390

Estimated Value
Standard Error (Std. Error) of the estimate

Confidence Interval of the estimate: The confidence interval for a given
confidence level is a range such that the true value lies within the range with the
desired probability. The confidence level is usually specified as a percentage. The
greater the confidence level, the wider the resulting confidence interval.
Calculation of the confidence interval is based on sampling statistics. For
example, suppose that many data sets are obtained, and the confidence interval
is calculated for each data set based on a chosen statistic. The percentage of
those confidence intervals containing the true value is the specified confidence
level. Select the Confidence Interval Method in the Statistics tab of the Curve Fit
Settings dialog. See Curve Fit Statistics Tab on page 402.

Independence: Parameter Independence is one way to examine the suitability of
a given curve fit for the data set. It is a measure of the extent to which the best
value of one parameter depends on the best values of the other parameters,
and is a number between 0 and 1, with 1 being the ideal. In the graph fit legend,
parameter independence has been translated into bars, where 10 bars indicate a
high degree of independence. Because only very small values indicate a problem,
a nonlinear transformation is used for this translation. If one or more
parameters have few bars or no bars, the curve fit might not be a good fit for the
data set.

For example, if the data set is sigmoidal with clear lower and upper asymptotes,
4-parameter fits should be applicable with many bars for all parameters.
However, if one or both of the asymptotes is missing, the A or the D parameter
will have few bars, indicating that reliable values cannot be deduced from the
data set.
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Global Fits

e The formula for the selected curve fit

e Foreach plot:
e Estimated Relative Potency (Estimated Rel. Pot.)
e Standard Error (Std. Error) of the estimate

e Confidence Interval of the estimate (see explanation under Independent Fits on page
390)

¢ Independence (see explanation under Independent Fits on page 390)
e ECgyvalue (where applicable)
e The list of weighting formulas
 R’value
e For each parameter:
e Estimated Value
e Standard Error (Std. Error) of the estimate
» Confidence Interval of the estimate

* Independence
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Creating a New Graph

Click New Graph [l in sections on the Home tab in the ribbon to open the Plot Editor dialog
where you can create a graph from the collected data. Graphing is enabled both during data
collection and after data has been acquired for a Kinetic, Spectrum, and Well Scan read.

In the Plot Editor dialog, you can name the graph, assign specific information to be plotted
on the X and Y axes, and choose which icon and color to use.

All groups that have been created or assigned within the file are shown in the Available
Groups list.

To create a new graph:

1. Click New Graph on the Plate section Home tab to open the Plot Editor dialog.

2.
3.

E Plat Editor - StandardCurve

Graph Title  StandardCurve
Plot List Plot Properties

Add Flot Mame Flotl

Pt N—

4 Exptl
Unknowns
Unk_Dilution
Control

Define one or more plots, select a data source for each, and set plot properties.

Data Input
H-Axis

©k:

LConc

¥-Axis

MeanValue

Error | No Error

Flot Attributes

Set Color.. .

] [ Cancel

In the Graph Title field, type a name for the graph.

Select a plot.

The Plot List shows the existing plots. One plot is shown by default.

e To add a new plot to the graph, click Add.

* Toremove a plot from the list, select a plot and then click Delete.

When you select a plot from the list, the parameters for the selected plot are displayed in

the Plot Properties area of the dialog.

Optionally, type a name for the plot in the Plot Name field. The plot name changes in the

plots list.
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Select a group from the Available Groups list. Data from the selected group is plotted in
the graph.

Note: Groups are defined using the template editor. If no groups are displayed in
the list, you must go to the Template Editor dialog and define one or more
groups. See Defining a Group on page 303.

In the Data Input area, select column types from those listed to assign to the plot in the
X-Axis and Y-Axis. The list contains only the group column names available for the group
that is selected in Available Groups. When you select the Custom type, the Formula
Editor opens for you to define the custom formula.

Select a column or No Error in the Error field to define the display of error bars.

% Note: When data is displayed as a scatter plot, you can choose to display error
bars for the plot of the data for the X-axis and Y-axis. Error bars are lines that
extend outside of a plotted value in either or both directions and graphically
represent some error in plotted data.

Use the Plot Attributes area to change the appearance of the graph:

e Select the Symbol Style to define the symbol to be used to mark each data pointin a
scatter plot.

e Select the Symbol Size to define the size of the selected symbolin a scatter plot.

o Select the Line Style to define the line to be used between data points in a scatter
plot.

e Click Set Color and select the color from the color picker to define the color of the
symbol and line in a scatter plot or the color of the bar in a bar graph.

9. Click OK to apply the settings and close the New Graph dialog.

A new Graph section is added to the experiment with the resulting data plots displayed as
specified.
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Editing an Existing Graph
You can change a graph by changing the type of graph, by editing the appearance of the
graph, or by using the Plot Editor dialog to change the plots and the data or plot attributes.

You can display the data in a scatter plot or a bar graph. To change the graph type, click
Scatter or Bar Graph in the Graph Type section on the Home tab in the ribbon.

" F

Scatter Bar
Graph

To edit the appearance of the graph, see Changing the Appearance of a Graph on page 440.
To use the Plot Editor dialog to change the plots and the data or plot attributes:

s
1. With a Graph section active in the workspace, click Plot Editor\i in the Graph Tools
section on the Home tab in the ribbon orin the toolbar at the top of the Graph section.

2. Make the required changes to the graph definitions. See Creating a New Graph on page
392.

3. Click OK to apply the settings and close the Plot Editor dialog.

Note: You can add as many plots as you need during one editing session. To add
more plots click Add. To delete a plot from the graph select the plot and click Delete.

Selecting Curve Fit Settings

% Note: Curve fits are used only in scatter plots.

When you first create a graph of the data, it does not have a fit related to it. You can fit a plot
to one of the curve fit selections. These selections are shown in the Fit list in the toolbar at
the top of the Graph section. You can filter the list of curve fits by selecting a category from
the Category list. All plots on a graph must have the same type of fit.

Generally, a standard curve refers to the curve fitted to the plot of concentration compared
to the mean value for the Standard group.

After you have selected a fit type, SoftMax Pro Software determines the parameter values
that best fit the data. The function with these parameters is drawn on the graph.

Note: Ideally, the type of fit used is determined by the underlying chemistry of the
assay and can be set before data is read.

When a fit is done, the parameter values are tabulated in the legend at the bottom of the
graph. The parameter table also contains information regarding the uncertainty of the
parameters, specifically standard errors and (optionally) confidence intervals.
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A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: A
Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay, edited by Wilfrid R.
Butt (published by Marcel Dekker, Inc., New York, 1984).

Judging a Good Curve Fit

Visual inspection is always useful for evaluating a curve fit. The legend at the bottom of the
graph contains information summarizing the numerical output of the fit. This includes the
coefficient of determination Rz, a traditional measure of goodness of fit. R’is the fraction of
the variance of the y-values explained by the fit, and is 1 for a perfect fit. However, this
should not be used to determine the statistical significance of the fit, or to compare the
suitability of different curve fit functions. For such purposes, statistics such as chi-squared or
Fisher-F can be used. These statistics can be obtained from the formula system.

Even for a good fit, as judged by eye or RZ, some parameters might have high uncertainty.

To define a curve fit for the plots in a graph, click Curve Fit Settings [ in the Graph Tools
section on the Home tab in the ribbon orin the toolbar at the top of the Graph section.
The Curve Fit Settings dialog has three tabs available for defining the curve fit:
* Curve Fit, see Curve Fit Tab on page 396.
* Weighting, see Curve Fit Weighting Tab on page 401.
e Statistics, see Curve Fit Statistics Tab on page 402.
After you finish defining the curve fit, click OK.
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Curve Fit Tab

When you first create a graph of the data, it does not have a fit related to it. You can fit a plot
to one of the predefined curve-fit functions.

These selections are shown in the Fit list in the Graph section toolbar. You can filter the list of
curve fits by selecting a category from the Category list.

For information about the available curve fit functions, see Curve Fit Functions on page 404.

You can also select a plot from the graph and a curve fit to apply to that plot from the list on
the Curve Fit tab in the Curve Fit Settings dialog.

[/~ Curve Fit Settings @
Curve Fit | Weighting | Statistics

)

® Independent Fits ) Global Fit [PLA)
Fit [5td * | with Linear -

Parameter Formula Role Formula Confidence Interval
: |
: |

Choose either to fit each plot independently, or to combine all plots into ene data set for a global fit. For linear
fits, parameters can be fixed at specified values. For non-linear fits, an initial value can be specified for each
parameter. This can be designated as an initial estimate, or as the fixed value.

[ ok || cance |

All plots on a graph can have the same type of fit or each plot can have a different fit applied
individually. The Curve Fit tab of the Curve Fit Settings dialog provides the means to set a
different fit to individual plots.

To define a curve fit for the plots in a graph, click Curve Fit [ in the Graph Tools section
on the Home tab in the ribbon or in the toolbar at the top of the Graph section. You can
choose to fit each plot independently or to combine all plots into one data set for a global fit.

e Tofit each plot independently, see Independent Fits on page 398.
e To combine all plots into one data set, see Global Fit (PLA) on page 399.

Generally, a standard curve refers to the curve fitted to the plot of concentration versus
mean value for the Standard group.
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After you have selected a fit type, SoftMax Pro Software determines the parameter values
that best fit the data. The function with these parameters is drawn on the graph.

% Note: Ideally, the type of fit used is determined by the underlying chemistry of the
assay and can be set before data is read.

% Note: A good discussion of curve fitting appears in “Data Analysis and Quality Control
of Assays: A Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay,
edited by Wilfrid R. Butt (published by Marcel Dekker, Inc., New York, 1984).

e For linear fits, parameters can be fixed at specified values.

e For nonlinear fits, an initial value can be specified for each parameter. This can be
designated as an initial estimate (the seed value), or as the fixed value.

You can specify whether a Confidence Interval should be calculated for each parameter.

The confidence interval for a given confidence level is a range such that the true value lies
within the range with the desired probability. The confidence level is usually specified as a
percentage. The greater the confidence level, the wider the resulting confidence interval.
Calculation of the confidence interval is based on sampling statistics. For example, suppose
that many data sets are obtained, and the confidence interval is calculated for each data set
based on a chosen statistic. The percentage of those confidence intervals containing the true
value is the specified confidence level.
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Independent Fits

When plots in a graph are to be fit with curve fit functions independently:

1.

Ea

L 0 N o U,

Open a Graph section with multiple plots in the workspace.

Click Curve Fit Settings [ in the Graph Tools section on the Home tab in the ribbon
orin the toolbar at the top of the Graph section.

In the Curve Fit Settings dialog, in the Curve Fit tab, select Independent Fits.

Select a plot from the Fit list.

You can filter the list of curve fits by selecting a category from the Category list.

Select which curve fit function to apply to the plot from the With list.

Continue selecting plots and applying curve fit functions as needed.

If applicable, click the Weighting tab. See Curve Fit Weighting Tab on page 401.

If applicable, click the Statistics tab. See Curve Fit Statistics Tab on page 402.

When all curve fit options have been set, click OK.

Note: Forindependent fits (and global to a limited extent), you can fix values. Curve fit
parameter values can either be fixed, or "manually seeded" to start the curve fit
algorithm search.
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Global Fit (PLA)

When all the plots in a graph are to have the same curve fit functions applied:

1. Open a Graph section with multiple plots in the workspace.

2. Click Curve Fit Settings [ in the Graph Tools section on the Home tab in the ribbon
orin the toolbar at the top of the Graph section.

3. Inthe Curve Fit Settings dialog, select Global Fit (PLA).

[/~ Curve Fit Settings @
Curve Fit | Weighting | Statistics

v

V] Referemce Plot [Std v]

_) Independent Fits '@ Global Fit (PLA)

Parallel Line Anal\,'sis["'"

Parameter Formula Role Formula Confidence Interval
: |
: |

[] Calculate Relative Potency Confidence Intervals

Choose a function for parallel line analysis. Spedify whether confidence intervals should be calculated for the
relative potency factors. Choose the reference plot; relative potency factors are calculated with respect to this
plot.

[ ok |[ concar |

The available global fit is parallel line analysis. See Parallel Line Analysis on page 400.
4. Select the plot from the Fit list.
You can filter the list of curve fits by selecting a category from the Category list.
Select an option, except point-to-point or cubic spline, from the With list.
If applicable, select Relative Potency Confidence Interval.
Select a plot for the Reference Plot list.
If applicable, click the Weighting tab. See Curve Fit Weighting Tab on page 401.

L 0 N o U,

If applicable, click the Statistics tab. See Curve Fit Statistics Tab on page 402.
10. When all curve fit options have been set, click OK.
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Parallel Line Analysis

Parallel line analysis (PLA) is available for all Global fits except point-to-point and cubic spline
fits.

Determining parallelism between a standard and test compound, and subsequent
estimation of relative potency, are fundamentals of bioassay use in biopharmaceutical
development and testing. For linear data, parallelism can be evaluated by examining the
similarity between the slopes of straight lines.

Bioassay data and immunoassays in particular, have been demonstrated to fit well with a
sigmoidal shape defined by a 4-parameter or 5-parameter curve fit. The basic question of
whether a curve with a specified shape can fit both standard and test data sets when shifted
along the X-axis can be addressed following a method detailed by Gottschalk and Dunn
(Journal of Biopharmaceutical Statistics, 15:437- 463, 2005).

The parameters are those for the fit function, plus a relative potency factor for each data set
relative to one designated as a reference. Below the graph are displayed their values,
standard errors, and (optionally) confidence intervals.

Function operators are included with SoftMax Pro Software that can be used to summarize
this information in a Notes section. For more details, see the SoftMax Pro Formula Reference
Guide.
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Curve Fit Weighting Tab

For each plot, specify whether the data should be weighted and, if so, the desired weighting
formula, which must evaluate to an array of numbers.

Least-squares fitting is based on the assumption that errors are normally distributed. If the
variance of each point in the fit is known, or can be estimated by some means, its inverse
should be specified as the weight for the point. If the variances are not known, but are
believed to be non-uniform across the data, that is, a known function of y, then a weighting
function should be used to reflect this information. If a formula for the weighting is not
provided, then all points have equal weight.

The weighting feature permits independent weighting of individual plots within a Graph
section.

To apply weighting to a plot:
1. Onthegraph, select Curve Fit Settings.
2. Inthe Curve Fit Settings dialog, click the Weighting tab.

[/~ Curve Fit Settings @

Weighting | Statistics

‘Weighting

(5t =

D Apply Weighting

|:| Weights are Inverse \Variances

For each plot, specify whether the data should be weighted and, if so, the desired weighting formula, which must
evaluate to an array of numbers.

[ ok | cencel

Select a plot from the Weighting list.
Select Apply Weighting.
Click the Formula button.

S

In the Formula field, type the formula to be applied as the weighting.

If a formula for the weighting is not provided, then all points have equal weight.
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7. Ifthe data are weighted with the inverse of their variances, then select the Weights are
Inverse Variances check box.
Ifthe Apply Weighting and the Weights are Inverse Variances check boxes are both
selected in the Weighting tab for each plot, then the Profile Method (Chi-Squared
distribution) option is available in the Confidence Interval Method list in the Statistics
tab. See Curve Fit Statistics Tab on page 402.

8. Click OK.
Curve Fit Statistics Tab

In the Statistics tab, you can specify the statistics display.
[/~ Curve Fit Settings @

| Curve Fit | Weighting | Statistics |

.........

Statistics

Confidence Interval Method [Asvmptotic Approximation hd

Confidence Level 85 %

|:| Calculate Parameter Dependencies

Choose the method by which confidence intervals are calculated, and a desired level of confidence. The greater
the confidence level, the wider the resulting interval. Profile methods require more computation than the
asymptotic approximation, but are generally more accurate.

[ ok || cance |

Choose the method by which confidence intervals are calculated, and a desired level of
confidence. See Table 8-6: Confidence Interval Method on page 403.
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Confidence Interval Method

The confidence interval for a given confidence level is a range such that the true value lies
within the range with the desired probability. The confidence level is usually specified as a
percentage. The greater the confidence level, the wider the resulting confidence interval.
Calculation of the confidence interval is based on sampling statistics. For example, suppose
that many data sets are obtained, and the confidence interval is calculated for each data set
based on a chosen statistic. The percentage of those confidence intervals containing the true
value is the specified confidence level.

To specify the method used to establish the confidence interval, select a confidence interval
method from the list.

Table 8-6: Confidence Interval Method

Confidence Interval Method Description

Asymptotic Approximation Calculates Wald confidence interval, which is simply related to
the standard error.

Profile Method (F distribution) Based on model comparison with F-statistic.

Profile Method (Chi-Squared Based on model comparison with chi-squared-statistic.
distribution)
If the Apply Weighting and the Weights are Inverse Variances
check boxes are both selected in the Weighting tab for each
plot, then the Profile Method (Chi-Squared distribution)
option is available in the Confidence Interval Method list in the
Statistics tab. See Curve Fit Weighting Tab on page 401.

Profile Method (t distribution) Based on T-profile function.

Note: Profile methods require more computation than the asymptotic
approximation, but are generally more accurate.
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Confidence Level

How likely the interval is to contain the parameter is determined by the Confidence Level.
Increasing the desired confidence level usually widens the confidence interval.

Calculate Parameter Dependencies
To calculate dependencies between parameters, select Calculate Parameter Dependencies.

With this option selected, the graphical representation in the graph legend represents the
parameter independence of the curve fit. See Graph Legend on page 389.

Parameter Independence is one way to examine the suitability of a given curve fit for the
data set. It is a measure of the extent to which the best value of one parameter depends on
the best values of the other parameters, and is a number between 0 and 1, with 1 being the
ideal. In the graph fit legend, parameter independence has been translated into bars, where
10 bars indicate a high degree of independence. Because only very small values indicate a
problem, a nonlinear transformation is used for this translation. If one or more parameters
have few bars or no bars, the curve fit might not be a good fit for the data set.

For example, if the data set is sigmoidal with clear lower and upper asymptotes, 4-parameter
fits should be applicable with many bars for all parameters. However, if one or both of the
asymptotes is missing, the A or the D parameter will have few bars, indicating that reliable
values cannot be deduced from the data set.

Curve Fit Functions

Generally, a standard curve refers to the curve fitted to the plot of concentration versus
mean value for the Standard group.

After you have selected a fit type, SoftMax Pro Software determines the parameter values
that best fit the data. The function with these parameters is drawn on the graph. Ideally, the
type of fit used is determined by the underlying chemistry of the assay and can be set before
datais read.

When a fit is done, the parameter values are displayed in the legend at the bottom of the
graph. The correlation coefficient describes how well a change in x values correlates with a
changein they values. The R’ value should be used only for linear curve fits.

A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: A
Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay, edited by Wilfrid R.
Butt (published by Marcel Dekker, Inc., New York, 1984).

When you first create a graph of the data, it does not have a fit related to it. You can fit a plot
to one of the following curve-fit functions.

These selections are shown in the Fit list in the toolbar at the top of the Graph section. You
can filter the list of curve fits by selecting a category from the Category list.

No Fit

Select No Fit to apply no curve fit, and to plot the scatter of the data points.
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2-Parameter Exponential

The 2-Parameter Exponential curve fit is also known as:
e 2P Exponential
e Exponential Growth on page 406
e Exponential Decay on page 407

y:AXeBX

y = Concentration

x =Time

A=Y,

B=k

For exponential growth, B> 0
For exponential decay, B< 0

A 2-parameter exponential curve fit is commonly used for radioactive decay, first order
kinetics, and unimolecular decay. It is also used for exponential growth:

Doubling time =B xIn(2) = B X 0.693

Mathematically, a 2-parameter exponential curve fit is a special case of a 3-parameter
exponential curve fit. See 3-Parameter Exponential on page 408.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a 2-
parameter exponential curve fit algorithm is 2.
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Exponential Growth

The Exponential Growth curve fit is also known as:

e 2-Parameter Exponential on page 405

y = A X eBX
y = Concentration
x =Time

A=Y,
B=k

For exponential growth, B> 0

An exponential growth curve fit is commonly used for radioactive decay, first order kinetics,
and unimolecular decay.

Mathematically, this is a special case of a 3-parameter exponential curve fit. See 3-Parameter
Exponential on page 408.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for an
exponential growth curve fit algorithm is 2.
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Exponential Decay

The Exponential Decay curve fit is also known as:

e 2-Parameter Exponential on page 405

y = A X eBX
y = Concentration
x =Time

A=Y,
B=k

For exponential growth, B> 0
For exponential decay, B< 0

A 2-parameter exponential curve fit is commonly used for exponential growth:
Doubling time =B xIn(2) = B X 0.693
Mathematically, this is a special case of a 3-parameter exponential curve fit. See 3-Parameter

Exponential on page 408.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a 2-
parameter exponential curve fit algorithm is 2.
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3-Parameter Exponential

The 3-Parameter Exponential curve fit is also known as:

Exponential (in previous versions of the SoftMax Pro Software)

3P Exponential

One-Phase Exponential Decay, see page 409

One-Phase Exponential Association, see page 410

y=A+Bx(1-e

x = Time (usually)
y = Specific + Nonspecific Binding or Response
One-Phase Exponential Decay (B negative)

A =Y, = Y. = Plateau + Span
B =—-Span
C=1/k = 1/decay constant

One-Phase Exponential Association (B positive)

A = YO = Ymin
B=Span=Y,.,— Yo
C=1/k = 1/association constant

An exponential curve fit is commonly used for drug elimination, dissociation of ligand from a
receptor, and radioisotope decay. It is also used for pseudo-first order kinetics of
ligand/receptor interaction or substrate/enzyme interaction.

The SoftMax Pro Software expresses C as the reciprocal of k, so it has same units as X.

t,,=CxIn2=Cx0.693
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For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for an
exponential curve fit algorithm is 3.

Note: In previous versions of SoftMax Pro Software, it was possible to select a
linearized version of this fit. This option is not available in SoftMax Pro Software 6.

One-Phase Exponential Decay

The One-Phase Exponential Decay curve fit is also known as:
e 3-Parameter Exponential, see page 408
* 3P Exponential

y=A+Bx(1-e

x = Time (usually)
y = Specific + Nonspecific Binding or Response

A =Y, = Y. = Plateau + Span
B =—-Span
C=1/k = 1/decay constant

The SoftMax Pro Software expresses C as the reciprocal of k, so it has same units as X.

t,,=CxIn2=Cx0.693

A one-phase exponential decay curve fit is commonly used for drug elimination, dissociation
of ligand from a receptor, and radioisotope decay.

The curve is the same as one-phase exponential association, except B is negative instead of
positive. See One-Phase Exponential Association on page 410.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a one-phase
exponential decay curve fit algorithm is 3.
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One-Phase Exponential Association

The One-Phase Exponential Association curve fit is also known as:
e 3-Parameter Exponential, see page 408

e 3P Exponential

y=A+Bx(1-e)

x = Time (usually)

y = Specific + Nonspecific Binding or Response

A= YO = Yrnin

B=Span=Y,.,— Yo

C=1/k = 1/association constant

A one-phase exponential association curve fit is commonly used for pseudo-first order
kinetics of ligand/receptor interaction or substrate/enzyme interaction.

The curve is the same as one-phase exponential decay, except B is positive instead of
negative. See One-Phase Exponential Decay on page 409.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a one-phase
exponential association curve fit algorithm is 3.
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4-Parameter Logisitic

A 4-Parameter Logistic equation is also known as:

e Sigmoidal Dose-Response (variable slope)

e Four-Parameter Logistic Equation
¢ Four-Parameter Dose-Response Curve
e Hill Equation

D
A
C
A
D
C
_ A-D
y=D+ 1 (%)B

A = First Asymptote

B = Slope Factor/Hill Coefficient
C = ECs0/ICso

D = Second Asymptote

Chapter 8: Analyzing Data

% Note: In the SoftMax Pro Software, B is always positive, assuming neither Anor D is
fixed. Ais always the first asymptote, and D is always the last asymptote. So Aand D
can swap between top and bottom according to the shape of the curve, whether
rising or falling with increasing concentration. However, if either A or D has been fixed
in the software, the B parameter is no longer required to be positive. In such cases, A
and D might or might not be the first and last asymptotes respectively.

A 4-parameter curve fit is commonly used in dose-response studies and estimation of

ECs/1Cso values. It can also be used as standard curves.
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A 4-parameter curve fit assumes a sigmoidal data set with clear lower and upper asymptotes.
If either asymptote is not clearly defined or is missing (as in a marginal data set), it is nearly
impossible to estimate where the asymptote lies, or if exists at all. Likewise the ECs, cannot
be estimated.

The 4-parameter curve possesses rotational symmetry about the point:

{C, (A+D)/2}

This point is sometimes referred to erroneously as an inflection point. In reality, for B > 1, the
inflection point is:

(B-1)

(B+1)

(s) ((A+D)+(A-D)/B)
2

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a 4-
parameter curve fit algorithm is 4.

Note: For 3-parameter sigmoidal dose-response curves, use the 4-parameter curve fit
and fix B or one of the asymptotes to a constant. See 3-Parameter Dose-Response
Curves on page 413.

The minimization method for the 4-parameter equation is based on the Levenberg-
Marquardt Method. Discussion of these methods can be found in The Art of Scientific
Computing by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. Vetterling,
published by Cambridge University Press, New York, 1988.
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3-Parameter Dose-Response Curves

3-Parameter Dose-Response Curves are special cases of a 4-Parameter Logistic equation with
one parameter fixed. See 4-Parameter Logisitic on page 411.

3-Parameter Dose-Response Curves with a fixed slope are also known as:
» Sigmoidal Dose-Response (Fixed Slope)
e One-Site Competition
e Three-Parameter Logistic Equation
e Hill Equation (Hill Slope =-1)
3-Parameter Dose-Response Curves with a fixed asymptote are also known as:
e Sigmoidal Dose-Response (Fixed Asymptote)
e Three-Parameter Logistic Equation
e Hill Equation (Bottom Asymptote is Fixed to 0)

D
A
C
A
D
C
_ A-D
y=D+ 1+(%)B
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Fixed Slope

If B is positive:

A = First Asymptote

B = Fixed (generally to 1)
C = EC50/|C50

D = Second Asymptote

If B is negative:

A = Second Asymptote

B = Fixed (generally to —1)
C = ECso/ICso

D = First Asymptote

Fixed Asymptote

A = First Asymptote (A or D fixed)

B = Slope Factor/Hill Coefficient

C = ECqo/ICs

D = Second Asymptote (A or D fixed)

3-parameter dose-response curves are commonly used in dose-response studies and
estimation of ECs/1Cy, values. They can also be used as standard curves.

3-parameter dose-response curves assume a sigmoidal data set with clear lower and upper
asymptotes. If either asymptote is not clearly defined or is missing (as in a marginal data set),
it is nearly impossible to estimate where the asymptote lies, or if exists at all. Likewise the
ECs, cannot be estimated.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a 4-
parameter curve fit algorithm is 4.

The minimization method for the 3-parameter dose-response curves equation is based on
the Levenberg-Marquardt Method. Discussion of these methods can be found in The Art of
Scientific Computing by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T.
Vetterling, published by Cambridge University Press, New York, 1988.
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5-Parameter Logistic

A 5-Parameter Logisitic equation is also known as:

e Five-Parameter Logistic Equation

D
A
A
D
-D
y=D+

|1+ }

A = First Asymptote

B = Slope Factor

C = [no physical meaning]
D = Second Asymptote

G = Asymmetry Factor

Chapter 8: Analyzing Data

% Note: In the SoftMax Pro Software, B is always positive, assuming neither Anor D is
fixed. A is always the first asymptote, and D is always the last asymptote. So Aand D
can swap between top and bottom according to the shape of the curve, whether
rising or falling with increasing concentration. However, if either A or D has been fixed
in the software, the B parameter is no longer required to be positive. In such cases, A
and D might or might not be the first and last asymptotes respectively.

A 5-parameter curve fit is commonly used in dose-response studies and estimation of

EC/1Csy values. It can also be used as standard curves.

A 5-parameter curve fit assumes an asymmetric sigmoidal data set with clear lower and
upper asymptotes. If either asymptote is not clearly defined or is missing (as in a marginal
data set), it is nearly impossible to estimate where the asymptote lies, or if exists at all.

Likewise the EC, cannot be estimated.
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Unlike the 4-parameter logistic equation, Cis not the ICsy value. The ICs, value needs to be
calculated separately. This is described in the SoftMax Pro Software Formula Reference
Guide.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a 5-
parameter curve fit algorithm is 5.

The minimization method for the 5-parameter equation is based on the Levenberg-
Marquardt Method. Discussion of these methods can be found in The Art of Scientific
Computing by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. Vetterling,
published by Cambridge University Press, New York, 1988.
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5-Parameter Logistic Alternate

This is a re-parameterization of the standard five-parameter logistic, such that parameters B
and C have the same interpretation as in the case of the four-parameter logistic. In
particular, the ECy, value is given by C.

A 5-Parameter Logistic Alternate equation is also known as:
e Five-Parameter Alternate Logistic Equation
e 5P Alternate

D

y=D+(A-D){1+ (2%- 1)( %)B/ze(l-é%

A = First Asymptote

B = Slope Factor

C = ECso/ICso

D = Second Asymptote
G = Asymmetry Factor

% Note: In the SoftMax Pro Software, B is always positive, assuming neither Anor D is
fixed. Ais always the first asymptote, and D is always the last asymptote. So Aand D
can swap between top and bottom according to the shape of the curve, whether
rising or falling with increasing concentration. However, if either A or D has been fixed
in the software, the B parameter is no longer required to be positive. In such cases, A
and D might or might not be the first and last asymptotes respectively.

A 5-parameter logistic alternate equation is commonly used in dose-response studies and
estimation of ECs,/1C, values. It can also be used as standard curves.
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The 5-parameter logistic alternate equation is identical to the 5-parameter logistic equation,
except that it has been re-parameterized such that the C parameter is the estimated ECs/ICs,
value.

A 5-parameter logistic alternate equation assumes a asymmetric sigmoidal data set with clear
lower and upper asymptotes. If either asymptote is not clearly defined or is missing (as in a
marginal data set), it is nearly impossible to estimate where the asymptote lies, or if exists at
all. Likewise the ECs, cannot be estimated.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a 5-
parameter logistic alternate equation algorithm is 6.

Bi-Exponential

The Bi-Exponential curve fit is also known as:
e Two-Phase Exponential Decay, see page 419
* Double Exponential Decay

y=Ae¥+Ce™+G

A =Spanl

B=k1

C=Span2

D=k2

G = Plateau

When the curve is decaying, B and D are both negative.

The bi-exponential curve fit is commonly used when the decay is the result is the sum of a
fast and a slow exponential decay.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a bi-
exponential curve fit algorithm is 5.
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Two-Phase Exponential Decay

The Two-Phase Exponential Decay curve fit is also known as:

e Bi-Exponential, see page 418

e Double Exponential Decay

y=Ae¥+Ce™+G

A =Spanl
B =kl

C = Span2
D =k2

G = Plateau

When the curve is decaying, B and D are both negative.

Chapter 8: Analyzing Data

The two-phase exponential decay curve fit is commonly used when the decay is the result is

the sum of a fast and a slow exponential decay.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a two-phase

exponential decay curve fit algorithm is 5.
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Bi-Rectangular Hyperbola

The Bi-Rectangular Hyperbola curve fit is also known as:
e Two-Site Equilibrium Binding (specific binding), see page 421

¢ Michaelis-Menten with Two Isozymes, see page 422

Response

Concentration

_ _AX Cx
y_x+B+x+D

Two-Site Equilibrium Binding (specific binding)
y = Specific binding

A = Maximum binding (high affinity)

B = Kd(high)

C = Maximum binding (low affinity)

B = Kd(low)

Michaelis-Menten with Two Isozymes

Y= Vi

A =Vmax (1)

B=Km (1)

C=V,max (2)

B=Km (2)

A bi-rectangular curve fit is commonly used for estimation of maximum (specific) binding and
Kd values in the presence of two binding sites: high-affinity and low-affinity. It is also used for
evaluation of enzyme activity, as function of [S] when two isozymes are present.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a bi-
rectangular hyperbola curve fit algorithm is 4.
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Two-Site Equilibrium Binding (specific binding)

The Two-Site Equilibrium Binding (specific binding) curve fit is also known as:

e Bi-Rectangular Hyperbola on page 420

Response

Concentration

_ Ax Cx
y_x+B+x+D

y = Specific binding

A = Maximum binding (high affinity)

B = Kd(high)

C = Maximum binding (low affinity)

B = Kd(low)

A two-site equilibrium binding (specific binding) curve fit is commonly used for estimation of
maximum (specific) binding and Kd values in the presence of two binding sites: high-affinity
and low-affinity.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a two-site
equilibrium binding (specific binding) curve fit algorithm is 4.
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Michaelis-Menten with Two Isozymes

The Michaelis-Menten with Two Isozymes curve fit is also known as:

e Bi-Rectangular Hyperbola, see page 420

Response

Concentration
Cx

y = AX +

Xx+B x+D

Y= Vi

A =Vmax (1)

B=Km (1)

C=Vimax (2)

B=Km (2)

A Michaelis-Menten with two isozymes curve fit is commonly used for evaluation of enzyme
activity, as function of [S] when two isozymes are present.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a Michaelis-
Menten with two isozymes curve fit algorithm is 4.
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Brain Cousens

The Brain Cousens curve fit is also known as:

e Sigmoidal Dose-Response with Hormesis

A-D+ Gx

ST

A = First Asymptote

B = Slope Factor

C = ECs0/ICso

D = Second Asymptote
G = Hormesis Factor

Chapter 8: Analyzing Data

A brain cousens curve fit is commonly used for studies of test systems that show hormesis
(opposite responses at low and high doses). An example is when an inhibitor shows an
enhanced response at low doses and an inhibitory response at high doses.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a brain

cousens curve fit algorithm is 4.
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Cubic

A Cubic curve fit is also known as:

e Polynomial Third Order

y=A+Bx+Cx*+Dx

A cubic curve fit can be used for standard curves, but there is risk of multiple inflection
points, and so ambiguity in InterpX results.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a cubic curve
fit algorithm is 4.

Cubic Spline

A Cubic Spline curve fit is a series of cubic segments joining adjacent pairs in a set of points
such that the first and second derivatives match at the joints. There is no simple formula for
the entire function.

A cubic spline curve fit is commonly used for cosmetic curve smoothing.
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Gaussian

The Gaussian function consists of a single peak.

_( x-B )2

— C

y=Ax*e +D

A = Height-D

B = Peak Center

Cis related to the peak width

D = Baseline

Peak width at half-height = ParmC(Plot@Graph)*2*Sqrt(Ln(2))

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a gaussian
curve fit algorithm is 4.
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Linear

A Linear curve fit is also known as:

Polynomial First Order

y = A+ Bx
A = Intercept
B = Slope

Use a linear fit when the values seem to lie on or are scattered around a straight line.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a linear curve
fit algorithm is 2.
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Log-Log

The Log-Log curve fit fits the best straight line to the set of data that consists of the logarithm
of the readings on the Y-axis (the response) and the logarithm of the dose on the X-axis.

Log(y) = A+ B x Log(x)

A = Intercept

B = Slope

Log in this equation is the common or base-10 logarithm.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a log-log
curve fit algorithm is 2.

5049092 A 427



SoftMax Pro Software User Guide

Log-Logit

The Log-Logit curve fit routine uses the same equation as the 4-Parameter curve fit, but uses
a different curve fitting algorithm. It is an older method and might be considered outdated.
See 4-Parameter Logisitic on page 411.

D
A
C
A
D
C
_ A-D
y—D+—1 (%)B

A = First Asymptote

B = Slope Factor/Hill Coefficient
C = ECs0/ICso

D = Second Asymptote
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Point-to-Point

The Point-to-Point curve fit uses a linear equation to fit each pair of data points.

This curve fit is composed of multiple linear pieces joining the points. The line segment
defined by each pairis used to interpolate data between those points.

For the best results, you should always exceed the minimum number of standards required

for a curve fit. The minimum number of standards required mathematically for a point-to-
point curve fit algorithm is 2.
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Quadratic

A Quadratic curve fit is also known as:

e Polynomial Second Order

y=A+Bx+Cx

A = Intercept

B = Slope of the Curve at the Intercept

C = ameasure of the curvature of the parabola

The quadratic fit is useful for standard curves.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a quadratic
curve fit algorithm is 3.
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Quartic

A Quartic curve fit is also known as:

e Polynomial Fourth Order

y =A+Bx+ Cx?+ Dx3 + Gx*

A quartic curve fit can be used for standard curves, but there is risk of multiple inflection
points, and so ambiguity in InterpX results.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a quartic
curve fit algorithm is 5.
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Rectangular Hyperbola

A Rectangular Hyperbola curve fit is also known as:
* Michaelis-Menten, see page 433
e One-Site Equilibrium Binding (specific binding), see page 434

A
[J]
(%]
c
o
Q.
(%]
[J]
o
B Concentration
b
c
o
Q.
(%]
(O]
o
A
B Concentration
y= Ax
X+ B

For Michaelis-Menten:

y=V,

A = V,max

B =Km

For One-Site Equilibrium Binding (specific binding):
y = Specific Binding

A = Maximum Binding

B = Kd

Arectangular hyperbola curve fit is commonly used estimation of Vimax, Km, maximum

binding, and Kd.

Arectangular hyperbola curve fit is a special case of the 4-parameter curve fit where B =1,

D =0, and x is 1/concentration.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a rectangular

hyperbola curve fit algorithm is 2.



Chapter 8: Analyzing Data

Michaelis-Menten

A Michaelis-Menten curve fit is also known as:

e Rectangular Hyperbola, see page 432

Response

B Concentration

AX
X+ B

y:

y=V,

A = V,max

B =Km

A Michaelis-Menten curve fit is commonly used estimation of Vimax and Km.

A Michaelis-Menten curve fit is a special case of the 4-parameter curve fit where B=1, D=0,
and x is 1/concentration.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a Michaelis-
Menten curve fit algorithm is 2.
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One-Site Equilibrium Binding (specific binding)

A One-Site Equilibrium Binding (specific binding) curve fit is also known as:

e Rectangular Hyperbola, see page 432

Response

B Concentration

_ AX
Y=%+B

y = Specific Binding

A = Maximum Binding

B =Kd

A one-site equilibrium binding (specific binding) curve fit is commonly used estimation of
maximum binding and Kd.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a one-site
equilibrium binding (specific binding) curve fit algorithm is 2.
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Rect. Hyper. Plus Linear

A Rect. Hyper. Plus Linear (rectangular hyperbola plus linear) curve fit is also known as:
e RHPluslLinear (in previous versions of the SoftMax Pro Software)

e One-Site Equilibrium Binding (total and nonspecific), see page 436

Total
Specific

5

2

@
Nonspecific

Ligand Concentration

AX
X+ B

y = + Cx

y = Total binding

A = Specific Binding By

B = Kd (specific binding)

C = nonspecific binding coefficient

Arectangular hyperbola plus linear curve fit is commonly used for estimation of maximum
binding and Kd (of specific binding) in the presence of nonspecific binding.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a rectangular
hyperbola plus linear curve fit algorithm is 3.
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One-Site Equilibrium Binding (total and nonspecific)

A One-Site Equilibrium Binding (total and nonspecific) curve fit is also known as:

e Rectangular Hyperbola Plus Linear
e Rect. Hyper. Plus Linear, see page 435

Total
Specific

Binding

Nonspecific

Ligand Concentration

AXx
y = v + Cx

y = Total binding

A = Specific Binding B.,

B = Kd (specific binding)

C = nonspecific binding coefficient

A one-site equilibrium binding (total and nonspecific) curve fit is commonly used for
estimation of maximum binding and Kd (of specific binding) in the presence of nonspecific
binding.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a one-site
equilibrium binding (total and nonspecific) curve fit algorithm is 3.
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Semi-Log

The Semi-Log curve fit fits the best straight line to a set of data for log(x) plotted against y.

y=A+BxLog(x)

A = y-intercept at x=1

B = Slope

Log in this equation is the common or base-10 logarithm.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a semi-log
curve fit algorithm is 2.
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Two-Site Competition

The Two-Site Competition curve fit is applicable to competition studies involving two
receptor binding sites.

Competitor Concentration
B N 1-B
y=D+(A-D) X X
[z 1+(g

A =Y, = First Asymptote

B = Fraction of Sites with Affinity Associated with C
C = ECs, for One Site

G = ECs, for the Other Site

D = Second Asymptote

1 — B = Fraction of Sites with Affinity Associated with G
Assumptions include:
e Ligand has identical affinity for both receptors
e Competitor had different affinities
e Fractionl = Fraction of Receptors with (1)
e Span=Top —Bottom

Note: To obtain a one-site competition fit, use the 4-parameter logistic and fix B to —1.
See 3-Parameter Dose-Response Curves on page 413.

For the best results, you should always exceed the minimum number of standards required
for a curve fit. The minimum number of standards required mathematically for a two-site
competition curve fit algorithm is 4.
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Changing the Name of the Graph Section

To change the name of a graph.
1. Click the Graph section to make it active in the workspace.

2. Double click the name of Graph section at the top of the section to open the Rename
Section dialog.

You can also right-click the graph in the Navigation Tree and then click Rename.

e 1

Rename Section @

Mew name:

StandardCurve

| ok || cancel

2. Inthe New name field, type the name.
3. Click OK.

This changes the name of the Graph section, but does not change the title of the graph. To
change the title of the graph, see Editing an Existing Graph on page 394.
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Changing the Appearance of a Graph

With a Graph section active in the workspace, click Graph Appearance L in the Graph
Tools section on the Home tab in the ribbon or in the toolbar at the top of the section.

In the Graph Appearance dialog, you can specify labels, styles, and graphic-display options.

[4 Graph Appearance == [ sraph Appearance ==
Specify labels, styles, and graphic display elements. @ Specify labels, styles, and graphic display elements. @
Axis Labels Axis Labels

X-Axis Label | conc | X-Axis Label | Conc |

V-uis Label | MeanValue | V-Axis Label | MeanValue |

Font Styles Font Styles

Graph Title | Sample Text Type Set. Graph Title | Sample Text Type Set.

Auxis Labels | Sample Text Type Set... Axis Labels | Sample Text Type Set...

Scales

Scales
X-Axis ¥-fxis H-Auis Y-Ads
Aute Scale Auto Scale Autg Scale Aute Scale
Minimum [ g Minimum | g Minimum | g Minimum | g
Maximum | 1 Maximum | 1 Maximum | 1 Maximum |1
@ linear () Log @ Linear () Log @ Linear () Log @ Linear () Log
Grid Lines Grid Lines
X-Auis ¥-fodis X-Ais ¥-Axs
Major Major Major Major
Minar Minar Minor Minor
Plot Options Plot Options
Plot Symbols [C] Connect Paints Show Data Coordinates X Interval 1
@ Show All Labels =}
Bar Values Sow Significant Figures
@ Hrizontal
¥-Axis Label Angle 312
Orientation
Enable X Axis Custom Lsbels =)

o |

Axis Labels

Define labels for the X-Axis and Y-Axis by typing the text of the labels in the fields. These labels
are displayed in the font specified in the Font Styles area.

Font Styles

Font Styles provides separate control of the fonts used for the Graph Title and Axis Labels.
Click Set to open the Font Style dialog.

E Font Style @
Arial v

B I

-,

| ok || cencer |

After you have finished defining the font style, click OK. The defined font style is displayed in
the Sample Text Type example text.
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Scales

To automatically scale one or both axes, select the Auto Scale check box for the axis.
As an alternative, you can define Minimum and Maximum scaling values.

You can also select either a Linear or a Log display of each axis. Log is the default selection.

Grid Lines

You can choose to display the major and minor grid lines for the X-Axis and the Y-Axis
individually. To display a grid line, select the related check box.

Plot Options
For a scatter plot, you can select the following options:

o Select Plot Symbols to display the defined symbol for each data point.

You can define the size and style of the symbol, and the color of the symbol and the line,
in the Plot Editor dialog. See Creating a New Graph on page 392.

* Select Connect Points to display a line connecting each of the data points.

e Show Data Coordinates to display the coordinates for each data point when you use
your mouse to hover the pointer over the data point.

For a bar graph, you can select the following display options:

e From the X-Axis Type drop-down list, select Evenly Spaced Axis, Separated Axis, or X
Value Positioned.
For the X Value Positioned option, type a value in the X Interval field. To display all the
labels for the defined interval, select the Show All Labels check box. When this check
box is cleared, labels are displayed only for the bars that have data.

e To display the data values above each bar, select the Show Values check box and then
click Vertical or Horizontal. Select a number from the Significant Figures drop-down list.

* From the X-Axis Label Orientation drop-down list, select Horizontal, Vertical, or
Inclined.
For the Inclined option, type a value in the Angle field.

e If you want to edit the labels directly in the Graph section, then select the Enable X-Axis
Custom Labels check box.
When this option is selected, you can double-click the label in the Graph section to edit
the label. Clearing this check box returns the labels to their default values.

Note: When the Enable X-Axis Custom Labels check box is selected, the X-Axis
Label Orientation is set to Horizontal. After you edit the labels, you can change
the X-Axis Label Orientation to Vertical or Inclined.
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Zooming the Graph Display

To zoom in on a section of a graph, use your mouse to draw a rectangle over the section.
After you release the mouse button, the display zooms into the selected region.

To return to the default view, double-click the graph body.

Zooming is supported for scatter plots only.

Exporting an Image of a Graph Section

You can export a 300 DPIl image of a Graph section so that you can import the image into
another program. You can also copy the Graph section and then paste the 300 DPIl image
directly into a word processor or spreadsheet program.

To copy a Graph section, right-click anywhere on the section and then click Copy.

Note: The 300 DPl image might appear very large in the program where it is imported
or pasted. You might need to scale or resize the image in that program after importing
or pasting the Graph section image.

To export an image of a graph to a .png file:
1. Click the Graph section to make it active in the workspace.

2. Make sure that the graph is displayed the way you want, including whether or not the
graph legend is displayed. See Graph Legend on page 389.

Click Export Graph ]ﬂ in the Graph Tools section on the Home tab in the ribbon.

3
4. Inthe Save As dialog, browse to the file location where you want to save the .png file.
5. Inthe File name field, type a name for the file.

6

Click Save.

An image of the active Graph section is saved as a .png file at 300 DPI resolution.
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Viewing Western Blot Membrane Data

After scanning a membrane for Western Blot data, the data are displayed in the SoftMax Pro
Software as an image. You can use the image tools in the Plate section to zoom, crop,
colorize, and adjust the intensity of the image. You can also select a region of interest (ROI)
and rescan the membrane at a higher resolution.

5049092 A

To zoom the image in or out, drag the slider on the side of the Plate section.

To view the image at its actual size, click 1:1 on the side of the Plate section.

To fit the image to the Plate section, click Fit on the side of the Plate section.

To zoom in on a specific area of the image, click “4 on the side of the Plate section and
then drag across the image to define the area to zoom.

To move the image within the Plate section, click L | on the side of the Plate section and
then drag the image to move it.

To crop the image, click T on the side of the Plate section and then drag across the
image to define the cropped area.

To colorize the image from a look-up table (LUT), from the LUT list at the top of the Plate
section, select a color option.

To adjust the intensity of the image, in the Subtract field at the top of the Plate section,
type a value to subtract from the image intensity.

To scale the image intensity, select the Log check box.

To invert the colors of the image, similar to a photographic negative, select the Invert
check box.

To select and scan a region of interest (ROI), click i on the left side of the Plate section

and then drag across the image to define the region. Click Read 0 on the Home tab in
the ribbon to scan the region using the ROI Scan Resolution defined in the Settings
dialog. The data from the ROI scan replaces the data from the original scan.

To adjust the resolution of the scanned image, click M 10 view the image at the scanned
resolution, click 5 to view the image at a fine resolution suitable for external analysis, or
click M to view the image at a very fine resolution suitable for publishing.

To restore the image using the data from the last scan, click = on the top of the Plate
section.
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The Plate section also contains options for exporting the image for further analysis or
publishing. These tools are on the right side of the top of the Plate section

o To open the raw image data in a Microsoft Excel template for analysis, click % and then
click Excel Analysis. See Using Excel to Analyze Western Blot Data on page 445.

e To open the rawimage in the Imagel software, click “* and then click Imagel Editor. See
Analyzing a Western Blot Image on page 450.

e To open therawimage in a pre-defined image-analysis tool, click “* and then click
External Image Editor. This option is available only if you have .tif files associated with a
program other than Imagel software. See Analyzing a Western Blot Image on page 450.

% Note: If you use the Imagel software or an external image-analysis tool to make
and save changes to the original image file, the edited image is displayed in the
Plate section and the image cannot be edited from within the SoftMax Pro
Software indicated by &% at the top of the section. To restore the image using the
data from the last scan, click =

e To export the raw image data to a text file, click '1, click Export as Text, and then select
a name for the exported text file.

o To export the edited image as it is displayed in the Plate section, click "'!, click Export as
Image, and then select a name and format for the exported image file.

For information on how to locate the generated image, see Image Data Files and Folders on
page 61.
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Using Excel to Analyze Western Blot Data

You can export the Western Blot image data to a Microsoft Excel template to analyze the
image data.

To export the raw image data to an Excel template, click “* and then click Excel Analysis.

An Excel file opens displaying the exported data. There are three worksheets in the Excel file.

Data Segmentation Analysis

e The Analysis worksheet displays the data using automatic background subtraction. You
can select the bands to measure and display a bar graph showing an analysis of the
selected bands in the Analysis worksheet. See Measuring Selected Bands on page 446.

e The Segmentation worksheet displays the segmented bands with background
subtraction. The segmented bands are displayed on a white background. You can adjust
the background noise level and the minimum and maximum band size in the
Segmentation worksheet. See Defining Segmentation Criteria on page 447.

e The Data worksheet displays the TIFF image and a color rendering of the raw data. No
further analysis is shown in the Data worksheet. If the automatic background
subtraction in the Analysis worksheet is not sufficient for your data, you can manually
define the background for subtraction in the Data worksheet. See Manually Selecting
Background for Subtraction on page 449.

To save the data and analysis for future reference, save the Excel file.
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Measuring Selected Bands

You can select the bands to measure and display a bar graph showing an analysis of the
selected bands in the Analysis worksheet. To view the Analysis worksheet, click the Analysis
tab at the bottom of the Excel window.

i T N A e sl S S A .

Cleareasurements | Weasure all Bands | easure Selected Bands

]

Mean Intensity
Minimum Particle Size=10

7,000,000 ScanLater - Measure Selected Bands =]

4 bands detected Measure
Osum
Ot Reset

Use the mouse to select Excel

worksheet cells contaning the bands
@ Mezn to be measured Close

6,000,000

5,000,000

4,000,000

B Mean Intensity

3,000,000

2,000,000

- l
. Il

D suM MAX MEAN

21,768,076 633,165 334,393
70,708,952 2,100,690 1,010,128
249,163,552 8,484,870 2,966,233
519,776,443 14,422,545 5,669,301

B won e

The Analysis worksheet displays the data using automatic background subtraction.
¢ To measure all the displayed bands, click Measure All Bands.

e To select a group of bands to measure, click Measure Selected Bands, and then use your
mouse to draw a rectangle around the bands that you want to measure. In the
ScanLater - Measure Selected Bands dialog, click Measure.

4 bands detected Measure

Use the mouse to select Excel
worksheet cells containing the bands
to be measured

¢ To remove the measurement analysis from the worksheet, click Clear Measurements.
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After you select the bands to measure, a bar graph is displayed with a table below it to show
an analysis of the bands based on the analysis criteria. Labels on the blot show the locations
of the bands that are referenced in the graph and the table.

You can adjust the background noise level and the minimum and maximum band size in the
Segmentation worksheet. See Defining Segmentation Criteria on page 447.

If the automatic background subtraction is not sufficient for your data, you can manually
define the background for subtraction in the Data worksheet. See Manually Selecting
Background for Subtraction on page 449.

Defining Segmentation Criteria

The Segmentation worksheet displays the segmented bands with background subtraction.
The segmented bands are displayed on a white background. You can adjust the background
noise level and the minimum and maximum band size in the Segmentation worksheet. You
can also remove artifacts that you do not want to include in your measurements.

SegmentBands e - e ki W ey - - ﬁh?_

ScanLater - Segment Bands =]

Background Moise Leved: [ow =
Minimum Band Size: 10 Defaults
Maximum Band Size: 100 Close

Band sizes are calculated as the number of Excel worksheet cals
they occupy

To adjust the segmentation of the bands, click Segment Bands. In the ScanLater - Segment
Bands dialog, select either a Low or High background noise level to subtract, and define the
minimum and a maximum band size for the segmentation. The band size is the total number
of cells in the Excel worksheet that the band occupies. To view the result of your settings,
click Segment.
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To remove artifacts from the displayed data, use your mouse to drag a rectangle around the
artifact, and then right-click the rectangle and select Clear Contents.

T Copy
= Paste Options:

A
Paste Specizl.
[nsert,
Delete,,

Clear Contents

E Duick Analysis
Filker [
ot ]
£F Insert Comment
[ Eormat Cells..
Pick Fromn Drop-dosen List..,
Drafine Mame.,
:Elﬂ Hf:n:rl_-'l' .

You can select the bands to measure and display a bar graph showing an analysis of the
selected bands in the Analysis worksheet. See Measuring Selected Bands on page 446.

If the automatic background subtraction is not sufficient for your data, you can manually
define the background for subtraction in the Data worksheet. See Manually Selecting
Background for Subtraction on page 449.
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Manually Selecting Background for Subtraction

The Data worksheet displays the TIFF image and a color rendering of the raw data. No further
analysis is shown in the Data worksheet. If the automatic background subtraction is not
sufficient for your data, you can manually define the background for subtraction in the Data
worksheet.

To define the background for subtraction, use your mouse to drag a rectangle around the
area to use as the background. In the ScanLater - Select Background dialog, click OK.

Do youwsant to select this region as Background? If Yes Click Ol to perform

background subtraction.

Cancel

You can select the bands to measure and display a bar graph showing an analysis of the
selected bands in the Analysis worksheet. See Measuring Selected Bands on page 446.

You can adjust the background noise level and the minimum and maximum band size in the
Segmentation worksheet. See Defining Segmentation Criteria on page 447.
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Analyzing a Western Blot Image

Western Blot membrane data are saved as a TIFF image that can be analyzed by the image-
analysis tool of your choice. The SoftMax Pro Software comes with an installed version of the
Imagel software from U.S. National Institute of Health (NIH).

To view the membrane image in the Image) software, click % in the toolbar at the top of the
section and then click ImageJ Editor.

To view the membrane image in your selected image-analysis tool, click “T in the toolbar at
the top of the section and then click External Image Editor. This option is available only if
you have .tif files associated with a program other than ImageJ software. The icon used for
this tool changes depending on the selected image-analysis tool. See Defining the Membrane
Image-Analysis Tool on page 451.

% Note: If you use the Image) software or an external image-analysis tool to make and
save changes to the original image file, the edited image is displayed in the Plate
section and the image cannot be edited from within the SoftMax Pro Software
indicated by &% at the top of the section. To restore the image using the data from the
last scan, click =fJ.

To retain the editing capabilities within the SoftMax Pro Software and also edit the image
with an external editor, export the image or make a copy of the generated TIFF image to
open in the editor. For information on how to locate the generated TIFF image, see Image
Data Files and Folders on page 61.
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Defining the Membrane Image-Analysis Tool

5.

In Windows Explorer, right-click a file that has a .tif extension.
Click Open with > Choose default program.
In the Open with dialog, select the program you want to use for membrane image-
analysis.
e Ifthe program you want is listed in the Recommended Programs list, then select it.
e Ifthe program you want is not listed in the Recommended Programs list, then click
Browse. Locate and select the .exe file for the program that you want to use, and
then click Open.
The Imagel software .exe file installed with the SoftMax Pro Software can be found in
the Imagel folder within the SoftMax Pro Software installation folder.
Make sure that the Always use the selected program to open this kind of file check
box is selected.
Click OK.

The next time you open a Western Blot data file, the Image icon changes to match the
selected program.

Saving Data in a PDF File

You can save the contents of the currently selected file in PDF format. Before saving the PDF
file, you can define the header and footer of the pages and the print quality in the Printing
Options dialog, and predefine the sections that you want to exclude from the PDF file by
disabling printing for the sections in the Navigation Tree. See Setting Printing Options on
page 83 and Disabling Sections from Printing on page 84.

To save the data in a PDF file:

1.
2.

5049092 A

Click Save As PDF.
You can also select the Molecular Devices (PDF Writer) in the Print dialog.

In the Molecular Devices (PDF Writer) - Create File dialog, name the file and define the
PDF options. See Defining PDF File Settings on page 452.

Click Save to save the PDF file.
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Defining PDF File Settings

The following tables define the settings for each of the tabs in the Molecular Devices (PDF
Writer) - Create File dialog:

Table 8-7: PDF File Settings in the General Tab

Option Description

Option Set Select a pre-defined set of PDF settings from this list. To define a new
set, select <Edit>.

Format To create a PDF file, select PDF from this list. You can also select from
this list to create output in image file formats.

File Name Type the file name in the path or click [:] to browse for a folder and

name the file.

Append if output exists

Select this check box to append this file to an existing file instead of
overwriting an existing file.

Open destination folder
after creation

Select this check box to open the folder where the file is saved after
saving the file.

Open the document after
creation

Select this check box to open the file after saving the file.

Table 8-8: PDF File Settings in the Document Tab

Option Description

Author Type the name of the author in this field for displaying in the document
properties.

Title Type the title of the document in this field for displaying in the
document properties.

Subject Type the subject of the document in this field for displaying in the
document properties.

Keywords Type keywords for the document in this field for displaying in the
document properties.

Quality Select a quality option from this list to define the size of the PDF file.

Initial zoom level

Select a zoom level from this list to define how the document is
displayed each time it is opened.

Compatibility Level

Select a format from this list to make the PDF file compatible with older
versions of PDF readers. Some options might not be supported in older
version.

PDF/A-1b

Select this check box to use the PDF/A-1b archiving standard.
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Table 8-9: PDF File Settings in the Image Tab

Option
DPI

Description

When creating an image file, select the resolution for the image in dots
per inch.

Text Alpha Bits

When creating an image file, select the number of bits to use for the
alpha channel for text.

Table 8-10: PDF File Settings in the Watermark Tab

Option Description

Text Type the text that you want to be displayed in the watermark.

Font Select the typeface for the watermark.

Color Click E] to select the color for the text.

Size Type the size of the text in points.

Outline width Type the width of the text outline in pixels to have the text be displayed
in outlines. To have the text be displayed as a solid color, leave this field
blank.

Layer To have the watermark text be displayed on top of the document text,
select Stamp. To have the watermark text be displayed behind the
document text, select Watermark.

Rotation Select to display the text upward from the lower left-corner or
downward from the upper-left corner.

Vertical position Select to display the text on the top, center, or bottom of the document.

Vertical adjustment Type a percentage offset for the vertical watermark position.

Horizontal position Select to display the text on the left, center, or right of the document.

Horizontal adjustment Type a percentage offset for the horizontal watermark position.

Table 8-11: PDF File Settings in the Merge Tab

Option Description

Append PDF Type the name of the file to which you want to append this file. To
browse for the file, click E]
Position To append the new file to the end of the old file, select Bottom. To

append the new file to the start of the old file, select Top.

Background PDF

If you want to print the data on an existing file, type the file name in this
field. This can be used to print on company letterhead. To browse for

the file, click [ ... ]

Layer

To have the new file be displayed on top of the old file, select Stamp. To
have the new file be displayed behind the old file, select Watermark.
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Table 8-12: PDF File Settings in the Security Tab

Option Description

Owner password Type the password that gives owner permissions for the file.

User password Type the password that gives user permissions for the file.

Key Length Select the length of the key to be used for document encryption.

Set Permissions Select this check box to limit access to the document for the user level.

Print Select whether or not to permit printing and what print quality is
permitted.

Copy to clipboard Select this check box to permit users to copy text from the file to the
clipboard.

454 5049092 A



Chapter 9: Maintaining and Calibrating an Instrument

Instrument maintenance is described in the user guide for the instrument. For instrument
maintenance instructions, see the user guide for your instrument.

Information on configuration, maintenance, and calibration tasks that can be done using the
SoftMax Pro Software can be found in the following topics:

e Calibrating the Microplate Reader on page 455

e Configuring the Filters for the EMax and Vmax Microplate Readers on page 456
e Adjusting the Lamp for the EMax Plus Microplate Reader on page 456

e Using the Instrument Information Dialog on page 457

e Viewing Instrument Software Support on page 465

Calibrating the Microplate Reader

If the connected instrument supports the SoftMax Pro Software air-calibration process, then
the Calibration button is available in the Operation tab in the ribbon.

Note: Air-calibration applies to absorbance reads only. No microplate or cuvette is
required for the instrument calibration. If you are doing a cuvette calibration, the
cuvette chamber must be empty.

During calibration, the instrument steps through all available wavelengths one-by-one to
measure the signal that reaches the detector when there is no sample in the optical path.
The software calculates air-calibration values and stores these values in the firmware. The
stored air-calibration values are used when Speed Read is enabled or Calibrate is disabled in
the Settings dialog. See Speed Read on page 262 and Calibrate on page 285.
To calibrate the microplate reader:
1. Click Calibration on the Operations tab in the ribbon.
2. Inthe Calibration dialog, select either Plate or Cuvette.
e To calibrate for microplates, select Plate.
e To calibrate for cuvettes, select Cuvette.
3. Click Calibrate Now.
4. When the calibration indicator shows that the calibration is complete, click Close.

Note: If the Calibration button is not active in the Operations tab, then either the
instrument is not connected to the computer or the connected instrument does not
support the air-calibration process.
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Configuring the Filters for the EMax and Vmax Microplate Readers

The EMax and Vmax Microplate Readers have configurable filters. If you change the order of
the filters, or add or remove filters, you need to use the Filter Configuration dialog to define
the positions of the filters. If the filter settings in the Filter Configuration dialog are incorrect,
the microplate reader will generate incorrect data. For information about changing the
filters, see the user guide for the EMax and Vmax Microplate Readers.

To define the filter positions:
1. Click Filters on the Operations tab in the ribbon.

2. Inthe Filter Configuration dialog, type the wavelength values in the correct positions for
each installed filter.

You can define up to six filters. The permitted wavelength range is 400 nm to 750 nm.
3. After all the installed filters have been defined, click OK.

The defined filters are available for selection in the Settings dialog. See Creating an
Absorbance Mode Protocol on page 312.

Adjusting the Lamp for the EMax Plus Microplate Reader

456

To adjust the halogen lamp, click Configure on the Operations tab in the ribbon.

In the Configuration dialog, you can adjust the intensity of the lamp for each of the installed
filters in the EMax Plus Microplate Reader. You can view the positions and wavelengths of
the installed filters. This dialog also lists other instrument information like the serial number
and firmware version.

The installed filters are available for selection in the Settings dialog. See Creating an
Absorbance Mode Protocol on page 312.

To adjust the intensity of the lamp for each of the filters, click Adjust Lamp. The software and

instrument step through each filter one at a time to adjust the lamp intensity for the best
implementation of the filter wavelength.

Note: The Configuration dialog must remain open until the lamp adjustment has
completed.
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Using the Instrument Information Dialog

To view the Instrument Information dialog, go to the Operations tab in the ribbon and click
Info.

The Instrument Information dialog lists the PIC firmware version, the instrument firmware
version, the instrument serial number, and the automation device number for the selected
SpectraMax i3x or i3 Multi-Mode Detection Platform, SpectraMax Paradigm Multi-Mode
Microplate Reader, FilterMax F3 Multi-Mode Microplate Reader, or FilterMax F5 Multi-Mode
Microplate Reader. To update the PIC or instrument firmware, click the Update button. For
more information about updating firmware, contact Molecular Devices support.

The lower portion of the dialog shows instrument-specific information for either the
SpectraMax Paradigm Multi-Mode Microplate Reader or FilterMax F3 and F5 Multi-Mode
Microplate Readers.

SpectraMax i3x or i3 Multi-Mode Detection Platform Instrument Information

The software detects the installed detection cartridges and displays them in the Instrument
Information dialog. The name and serial number for the detection cartridge is displayed
under its position in the drawer.

To open or close the detection cartridge drawer, click @l to the left of the detection
cartridge definitions for the drawer.
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SpectraMax Paradigm Multi-Mode Microplate Reader Instrument Information

The software detects the installed detection cartridges and displays them in the Instrument
Information dialog. The name and serial number for the detection cartridge is displayed
under its position in the drawer.

To open or close a detection cartridge drawer, click @| to the left of the detection
cartridge definitions for that drawer.

You can lock or unlock the detection cartridge drawers when you are using the
StakMax Microplate Handling System:

e When the microplate handler is installed, the detection cartridge drawers must be
locked. To lock the cartridge drawers, click Lock Drawers for StakMax.

* When you need to open a detection cartridge drawer, remove the microplate handler
from the detection platform and then unlock the drawers. To unlock the cartridge
drawers, click Unlock Drawers for StakMax.

For more information, see the user guide for the StakMax Microplate Handling System.

To lock all the drawers closed, click Lock Instrument for Shipment and follow the on-screen
instructions. For information about preparing an instrument for shipment, contact
Molecular Devices support.

For information about unlocking the drawers, see Unlocking the SpectraMax Paradigm
Instrument on page 20.

To align the transfer position of the StakMax Microplate Handling System with the plate
drawer of the SpectraMax Paradigm Multi-Mode Microplate Reader, click StakMax
Alignment Wizard. For information about using the StakMax Alignment Wizard, see the user
guide for the StakMax Microplate Handling System.

FilterMax F3 and F5 Multi-Mode Microplate Readers Instrument Information

The software detects the installed excitation and emission filter slides and displays their
saved configurations in the Instrument Information dialog. The identification number for
the slide is displayed on the right. Each filter has its defined wavelength, bandwidth, and
read mode displayed under its position in the slide.

To eject or retract a filter slide, click @| to the left of the slide definition.

To edit the filters in a slide, or to define more slides, click Edit Slide Configuration. See
Configuring Filter Slides on page 458.

Configuring Filter Slides

The FilterMax F3 and F5 Multi-Mode Microplate Readers have configurable filter slides. If you
add or remove filter slides, or change the order of the filters in a slide, you need to use the
Filter Settings dialog to define the filters in the slide. If the defined filter settings in the
Instrument Information dialog are incorrect, the microplate reader will generate incorrect
data. For information about changing the filter slides, see the user guide for the FilterMax F3
and F5 Multi-Mode Microplate Readers.
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To view the Filter Settings dialog, go to the Operations tab in the ribbon and click Info.
Then, in the Instrument Information dialog, click Edit Slide Configuration.

The filters used to do measurements are mounted on two types of interchangeable slides.
Oneslide is reserved for excitation filters used in absorbance and fluorescence
measurements, the other is used for emission filters used in fluorescence and some
luminescence measurements. Each slide can hold up to six filters.

Note: Excitation and emission filter slides are different sizes to prevent them from
being installed in the incorrect position.

When exchanging slides, an identification code built into the slide lets the SoftMax Pro
Software recognize the new slide and filter configuration. When a slide with a new
configuration is inserted, or the filters on a slide change, the slide must be configured in the
Filter Settings dialog. Up to 31 excitation filter slides and 31 emission filter slides can be
stored in the software at one time.

e For quantitation protocols, a genomic filter slide, which contains narrow bandwidth
260 nm and 280 nm filters must be installed and configured.
e For protocols that use PathCheck Pathlength Measurement Technology, afilter slide
designed for PathCheck technology must be used.
To work with a filter slide, click Excitation or Emission to display a list of the selected type of
filter slides. To add, remove, export, or import filter slides, click a button on the left side of
the dialog.
e Click Add Slide to add a new filter slide to the list. See Adding a Filter Slide on page 460.
e Click Remove Slide to delete the selected filter slide. See Removing a Filter Slide on page
461.
¢ Click Export selected Slide to export the filter definitions for the selected filter slide. See
Exporting a Filter Slide on page 461.
e Click Import Slides to import a filter slide definition file that defines one or more filter
slides. See Importing Filter Slides on page 462.
e Click Load Slides to replace all the current filter slide definitions with the imported
definitions. See Replacing the Filter Slide Definitions on page 463.
o Click Export Slides to export all the defined filter slides. See Exporting the Filter Slide
Definitions on page 464.

Note: Molecular Devices recommends that you do not reconfigure standard filter
slides.
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Adding a Filter Slide

The filters used to do measurements are mounted on two types of interchangeable slides.
Oneslide is reserved for excitation filters used in absorbance and fluorescence
measurements, the other is used for emission filters used in fluorescence and some
luminescence measurements. Each slide can hold up to six filters.

To add a filter slide and configure the filters:

1.
2.

N o v ok

10.

11.
12.
13.
14.

Go to the Operations tab in the ribbon and click Info.
In the Instrument Information dialog, click Edit Slide Configuration.

In the Filter Settings dialog, click Excitation or Emission to display a list of the selected
type of filter slides.

Click Add Slide to add a new slide to the list.
The Filter Slide Properties pane displays information about the selected slide.
In the Slide ID field, type the identification number printed on the slide.

In the list of filter slides, click the + to the left of the filter slide name to display the list of
filters installed on the slide.

Click a filter in the list to display the Filter Properties for the selected filter.
In the Wavelength field, type the wavelength of the filter.

In the Technique(s) field, select the read mode for which the filter applies. The filter can
be used only for measurements of the selected read mode. For the FilterMax F5 Multi-
Mode Microplate Reader only, you can select Polarization for filter positions that have a
polarization filter installed.

e After a read mode is selected, the Installed field displays Yes.

e If noread mode is selected, the Installed field displays No, and the filter position
cannot be used for measurements.

% Note: The Installed and Position fields cannot be edited.

In the Bandwidth field, type the bandwidth of the filter.
In the Ordert# field, type the manufacturer's part number for the filter for your reference.
Continue configuring the rest of filters on the slide.

After the filters on the slide have been properly configured, click OK.

Note: Molecular Devices recommends that you do not reconfigure standard filter
slides.
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Removing a Filter Slide

If a filter slide is no longer used with an instrument, it can be removed from the list.

CAUTION! After you remove a filter slide from the list, it cannot be recovered. If you
think you might want to use this filter slide definition again, export the slide definition
before removing it from the list. See Exporting a Filter Slide on page 461.

To remove a filter slide from the list:

Go to the Operations tab in the ribbon and click Info.
In the Instrument Information dialog, click Edit Slide Configuration.

In the Filter Settings dialog, click Excitation or Emission to display a list of the selected
type of filter slides.

In the slide list, click the slide that you want to remove.
Click Remove Slide to remove slide from the list.
Click OK.

Note: Molecular Devices recommends that you do not reconfigure standard filter
slides.

Exporting a Filter Slide

Exported slide definitions are saved in XML files that can be imported again later or imported
into the software on a different computer.

Using the Export selected Slide feature exports the definition for a single filter slide. To
export all the current filter slide definitions, see Exporting the Filter Slide Definitions on page
464.

To export a filter slide in the list:

1
2.
3.

Go to the Operations tab in the ribbon and click Info.
In the Instrument Information dialog, click Edit Slide Configuration.

In the Filter Settings dialog, click Excitation or Emission to display a list of the selected
type of filter slides.

In the slide list, click the slide that you want to export.
Click Export selected Slide.

In the Save As dialog, navigate to the folder where you want to save the exported XML
file and type a name for the file in the File name field.

The default location for filter slide definitions is:
C:\ProgramData\Molecular Devices\SMP651\MultiMode\Detection Software\Filters

Click Save.
In the Filter Settings dialog, click OK.
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Note: Molecular Devices recommends that you do not reconfigure standard filter
slides.

Importing Filter Slides

Filter slide definitions can be imported from XML files that were previously exported or
provided by Molecular Devices. Slide definition files can contain definitions of one or more
filter slides.

Each filter slide definition must have a unique Slide ID. If the Slide ID of a filter slide that you
want to import exists in the list, rename the Slide ID or remove the slide from the list before
importing.

To import filter slide definitions into the list:

1. Gotothe Operations tab in the ribbon and click Info.

2. Inthe Instrument Information dialog, click Edit Slide Configuration.

3. In the Filter Settings dialog, click Excitation or Emission to display a list of the selected
type of filter slides.

Click Import Slides.
5. Inthe Open dialog, navigate to the folder where XML file is saved and select the file.

The default location for filter slide definitions is:
C:\ProgramData\Molecular Devices\SMP651\MultiMode\Detection Software\Filters

Click Open.
In the Filter Settings dialog, click OK.

Note: Molecular Devices recommends that you do not reconfigure standard filter
slides.
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Replacing the Filter Slide Definitions

Filter slide definitions can be imported from XML files that were previously exported or
provided by Molecular Devices. Slide definition files can contain definitions of one or more
filter slides for excitation and emission filters.

A CAUTION! When you use the Load Slides feature, all the current definitions are

deleted, and are replaced by the imported definitions for excitation and emission
filters. If you think you might want to use one or more of the current filter slide
definitions again, export the slide definitions before replacing them in the list. See
Exporting a Filter Slide on page 461 or Exporting the Filter Slide Definitions on page
464.

To replace the current filter slide definitions:

1.

iAW

Go to the Operations tab in the ribbon and click Info.

In the Instrument Information dialog, click Edit Slide Configuration.

In the Filter Settings dialog, click Load Slides.

In the message that is displayed, click Yes.

In the Open dialog, navigate to the folder where the XML file is saved and select the file.

The default location for filter slide definitions is:
C:\ProgramData\Molecular Devices\SMP651\MultiMode\Detection Software\Filters

Click Open.
In the Filter Settings dialog, click OK.

Note: Molecular Devices recommends that you do not reconfigure standard filter
slides.
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Exporting the Filter Slide Definitions

Exported filter slide definitions are saved in XML files that can be imported again later or
imported into the software on a different computer.

Using the Export Slides feature exports all the filter slide definitions in the excitation and
emission lists. If you want to export a single filter slide definition, see Exporting a Filter Slide

on page 461.

To export all the filter slide definitions in the lists:

1.

2.
3.
4

Go to the Operations tab in the ribbon and click Info.
In the Instrument Information dialog, click Edit Slide Configuration.
In the Filter Settings dialog, click Export Slides.

In the Save As dialog, navigate to the folder where you want to save the exported XML
file and type a name for the file in the File name field.

The default location for filter slide definitions is:
C:\ProgramData\Molecular Devices\SMP651\MultiMode\Detection Software\Filters

Click Save.
In the Filter Settings dialog, click OK.

Note: Molecular Devices recommends that you do not reconfigure standard filter
slides.
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Viewing Instrument Software Support

5049092 A

Each of the supported instruments has related "plug-in" support that defines the interaction
between the instrument and the SoftMax Pro Software interface. You can view a list of the of

these plug-ins for troubleshooting purposes. Generally, you would view this list after
contacting Molecular Devices technical support.

-
& Instrument Connection

[SEX)

“

Select the instrument to connect to.

Awvailable Instruments

Refresh

Offline
COM1 : SpectraMax M5

Reader  |spectrabax M5

|:| Simulatoer On

[

ok || cancel |

7

Click the Information button on the lower-left of the Instrument Connection dialog to open

a list of the plug-ins currently installed with the SoftMax Pro Software.

For alist of the instruments that are supported by this version of the SoftMax Pro Software,
see Supported Instruments on page 201.
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Molecular Devices provides a fully integrated hardware and software solution for adherence
to Good Manufacturing Practices (GMP), Good Laboratory Practices (GLP), and many other
regulatory compliance requirements including 21 CFR Part 11. The SoftMax® Pro GxP
Microplate Data Compliance Software extends the SoftMax Pro Software into regulated
laboratories working under GMP, GLP, and 21 CFR Part 11 guidelines for secure electronic
records. SoftMax Pro GxP Software provides a method for electronically signing data files,
and also automatically maintains a document-based audit trail for electronic records. This
audit trail preserves user actions and modifications for review even after microplate data is
collected and analyzed.

This integrated solution consists of the following components:
e A Molecular Devices microplate reader.
e SoftMax Pro GxP Software for data collection and analysis.
e GxP Admin Software for user management in SoftMax Pro GxP Software.
e MDC File Server (optional) for TCP/IP-based file serving of the User Accounts files.

The SoftMax Pro GxP Software connects to and controls the Molecular Devices microplate
reader, and analyzes all collected data.

Use the GxP Admin Software to set up User Accounts that can be linked to the SoftMax Pro
GxP Software through a Network File Server or the optional MDC File Server. See Setting Up
User Accounts for SoftMax Pro GxP Software on page 468.

The SoftMax Pro GxP Software is installed on individual computers that are used for data
collection or data analysis. Each user account must be linked to a User Accounts file before
users can log onto the SoftMax Pro GxP Software and use the software to collect and analyze
microplate data.
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Setting Up User Accounts for SoftMax Pro GxP Software

468

Use GxP Admin Software to create and maintain User Accounts (.edb) files. SoftMax Pro GxP
Software uses these User Accounts files to regulate user access to the features of SoftMax
Pro GxP Software and to provide traceability and accountability in electronic records. The
User Accounts file records all approved users and their related information, including the

following:

User names, user logon IDs, and passwords.

Assigned user permissions to SoftMax Pro GxP Software features.

Global settings pertaining to all listed users, such as password aging, non-network use,
guest access, and so on.

Audit histories of all administrator actions in GxP Admin, such as user creation,
modification, and so on.

If set by the administrator, SoftMax Pro GxP Software users do not require continual access
to a User Accounts (.edb) file in order to use the SoftMax Pro GxP Software for data collection
and analysis when no network connection is available, such as during a corporate network
failure or using SoftMax Pro GxP Software while traveling.

SoftMax Pro GxP Software users can be connected to a User Account file in one of two ways:

e Network File Server (File Path connection) where the User Account file is placed on a

secure, shared network file server, and the system browser is used to link each SoftMax
Pro GxP Software installation directly to the defined User Account file.

MDC File Server (TCP/IP Server connection) where the User Account file is placed on a
secure network location and each SoftMax Pro GxP Software installation is linked
indirectly to the defined User Account file using a TCP/IP address provided by the MDC
File Server.

For information about setting up User Accounts files, see the GxP Admin Software User
Guide.
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Connecting a User Accounts File

Before users can log onto the SoftMax Pro GxP Software, the installed program needs to be
connected to a User Accounts file. You can also change the related User Accounts file.
To define the User Accounts file connection:
1. Startthe SoftMax Pro GxP Software.
2. Inthe Log On dialog, click the Change button.
If the software is running with a user logged on, then go to the GxP tab in the ribbon. In

G

the User Account area, click User Log Off and then click Select Account Database

."J

3. Inthe User Accounts Connection dialog, click the Connection Type for either a File Path
or TCP/IP Server connection.

e Ifyou are setting up a File Path connection, then click the Browse button and use
the Open dialog to locate the User Accounts (.edb) file on your network. Click Open
to return to the User Accounts Connection dialog where the selected file path is
shown.

e Ifyou are setting up a TCP/IP Server connection, then type the server computer
Name or IP Address and the Port Number in the fields.

For information about setting up User Accounts files, see the GxP Admin Software User
Guide.

r_r] User &ccounts Connection @

)

-

Connection Type:
@ Filz Path [ TCRSIP Server

File Path:

Yhaccounts\GeP_Users\GxP_User_Accounts.edb Browse |

TCP | IP Server:
Mame or IP Address: 10.133.15.44

Port Number: BOSO

Connect I [ Cancel

4. Click Connect.
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5.
6.

In the Log On dialog, type your user name and password.
Click Log On.

After establishing the User Accounts file connection, the defined users can log on and start
acquiring and analyzing data with the SoftMax Pro GxP Software.

Granting TCP/IP Access to MDC File Server

When using the SoftMax Pro GxP Software with MDC File Server in a Windows 7, 64-bit
operating system, the Windows Firewall sometimes blocks user access to MDC File Server
through TCP/IP.

To grant user access through TCP/IP, create a new inbound rule and a new outbound rule in
the Windows Firewall Advanced Settings.

Accessing Windows Firewall Advanced Settings

1.

2
3.
4

Open Control Panel.
Click System and Security.
Click Windows Firewall.

In the left pane, click Advanced settings to open the Windows Firewall with Advanced
Security dialog.

Creating a New Inbound Rule

1.

470
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In left pane of the Windows Firewall with Advanced Security dialog, click Inbound
Rules.

In the right pane, click New Rule.

In the New Inbound Rule Wizard, click Port.
Click Next.

Click TCP.

Click Specify local ports.

Type 9001 in the field.

Click Next.

Complete the rest of the wizard based on your network configuration and access rules
defined by your system administrator.
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Creating a New Outbound Rule

1. Inleft pane of the Windows Firewall with Advanced Security dialog, click Outbound
Rules.

In the right pane, click New Rule.

In the New Outbound Rule Wizard, click Port.

Click Next.

Click TCP.

Click Specify local ports.

Type 9001 in the field.

Click Next.

Complete the rest of the wizard based on your network configuration and access rules
defined by your system administrator.

L ©® N o Uk~ WN
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Logging onto SoftMax Pro GxP Software

Each time you start the SoftMax Pro GxP Software, you are prompted to log on before you
can continue. If the software is running and the user has logged off, go to the GxP tab in the

ribbon, and then in the User Accounts section, click User Log On-

(C)

E Softhdax Pro 6= Log On

newton

zuest Logon is not allowed.

"

S5

Last Logged On:  Unknown

Contact:  Addy

. . . . . . . . User Account File: GxP_User_Accounts.edb

Change

[ logon || cancel

In the Log On dialog, type your user ID and your password and then click Log On.

% Note: Although the user ID is not case sensitive, the password is.

If you want to associate the installed program with a User Accounts file, or change the

related User Accounts file, click the Change button. See Connecting a User Accounts File on

page 469.

If the GxP Admin Software administrator has permitted it, those without an account can log
on as a guest. Guests can open, view, and print existing data files or protocols. They cannot
modify or save changes to existing data files or protocols. If guest log on is permitted, the

Log On dialog explicitly states this, and a Guest button is available for logging on as a guest.

For more information, see the GxP Admin Software User Guide.

Viewing the User Information

To view information about the current user, go to the GxP tab in the ribbon, and then in the

User Accounts section, click Account Information i
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The User Account Information dialog provides information about the current user.

'_t"j User Account Infarmation @

Mame: Newton

Log On Time: Fri, 2% Jun 2012 04:08 &M

Users Account File: ‘\\Accounts\GxP_Users\GxP_User_Accounts.edb

Primary Admin: &Addy

Permissions: Edit reader settings
Edit Motes text
Assien Plate layouts
Edit Sample & Group information
Read empty plates/cuvettes
Save data files
Add/Delete Groups
Edit Graphs, Summaries, and reductions
Edit Formulas
Lock/Unlock Sections
Mask/Uniask wells
Owverwrite plate/cuvette data
Save protocol files
Add/Modify Statements
Change AutoSave settings
Remove Signatures
Sign Statements

e The top section shows the user name and the time that the user logged on.

e The middle section shows the path to the related User Accounts file and the name of the
GxP Admin Software administrator.

e The lower section shows the permissions assigned to the user by the GxP Admin
Software administrator.

For more information about user accounts, see the GxP Admin Software User Guide.

To close the User Account Information dialog, click Close.
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Changing the User Password

Users cannot change their user names, but they can change their passwords. The GxP Admin
Software administrator can also define rules for requiring password changes.
To change your password:

1. Go tothe GxP tab in the ribbon, and then in the User Accounts section, click Change

Password " B |,

2. Inthe Change Password dialog, type your old password in the first field.

P )

.. Change Password @

newton

[ ook | [ Cancel

3. Typeyour new password in the second field, and then type it again in the third field to
confirm it.
The software compares the second and third field to make sure that they match exactly
before the new password is saved.

Note: The password must be between 6 and 32 characters with a minimum of one
alpha character and a minimum of one numeric character. The password is case
sensitive.

4. Click OK.

The next time you log onto the software, you will need to use the new password.
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Working with GxP Statements

A user with the correct permission can view, add, and edit GxP statements to a SoftMax Pro
GxP Software data file. You can use GxP statements to designate that an Experiment has
been reviewed, verified, or given approval.

A user with the correct permission can apply an electronic signature to a statement. See
Signing a GxP Statement on page 479. After a GxP statement is signed, the SoftMax Pro GxP
Software locks the data file to prevent further changes to the file. To unlock the file, remove
all the statement signatures.

To work with GxP statements, go to the GxP tab in the ribbon, and then in the Data section,
e/

click Statements & = .

“/ Staterments

View / Edit / Add Statemeants. @

+ = = I & @ fa

MM Setup
Michaelis Menton assay was run in simulation and is ready for approval for lab technician use.
Statement Not Signed
MM Run
Data acquired for Michaelis Menton assay.

Mote added when signed :
Acquisition Complete.
Statement signed by Newton on Mon, 02 Jui 2012 12:11 AM

In the Statements dialog, you can work with GxP statements by clicking the tools in the
toolbar at the top of the dialog.

Table 10-1: The Statements Toolbar

Tool Description

-y Add Statement (see Adding a GxP Statement on page 477)

| Edit Statement (see Editing a GxP Statement on page 477)

~ Delete Statements (see Deleting All GxP Statements on page 478)
By Copy Statement (see Duplicating a GxP Statement on page 478)

; i Paste Statement (see Duplicating a GxP Statement on page 478)
£ Sign Statement (see Signing a GxP Statement on page 479)

5049092 A 475



SoftMax Pro Software User Guide

Table 10-1: The Statements Toolbar (continued)

Tool Description

& Remove All Signatures (see Removing Signatures from All GxP Statements on
page 480)

é’; Disable printing of Statements (see Printing GxP Statements on page 481)

@ Enable printing of Statements (see Printing GxP Statements on page 481)

; Lock Statements (see Locking and Unlocking GxP Statements on page 481)

a Unlock Statements (see Locking and Unlocking GxP Statements on page 481)

To close the Statements dialog, click Close.

The statements status button in the upper-right corner of the work area displays the
number of statements in the file, and how many statements are signed.

.r"""'.' : :’__.-_..-

To quickly open the Statements dialog, click the statements status button.
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Adding a GxP Statement
A
1. Gotothe GxP tab in theribbon, and then in the Data section, click Statements = ™ .

2. Ifthereis more than one statement displayed in the Statement dialog, click the
statement directly above where you want to add the new statement.

3. Click Add Statement % in the toolbar at the top of the dialog.

[ Add Staterment @

MM Run

Data acquired for Michaelis Menton assay.

| conce

4. Inthe Add Statement dialog, click in the upper field and type a title for the statement.
Atitle is required for each statement.
Click in the lower field and type the content of the statement.
Click Add.

Editing a GxP Statement
A
1. Gotothe GxP tab in the ribbon, and then in the Data section, click Statements ™ ™ .

2. Inthe Statement dialog, click the statement that you want to edit.
3. Click Edit Statement|:# in the toolbar at the top of the dialog.

(' Edit Statement @
WM setup
Michaelis Menton assay was run in simulation and is ready for approval for lab technician use.
Commi )

4. In the Edit Statement dialog, click in the upper field and edit the title for the statement.
5. Click in the lower field and edit the content of the statement.
6. Click Save.
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Deleting All GxP Statements

E\( |

1. Gotothe GxP tab in theribbon, and then in the Data section, click Statements

2. Click Delete Statements #< in the toolbar at the top of the dialog.

CAUTION! Deleting statements deletes all the GxP statements in the SoftMax Pro
GxP Software data file. There is no undo for this. After deleting the statements,
they cannot be retrieved.

s )

Delete Staterments @

I.-“"_"“‘-. Are wau sure you want to delete "Staterments"?

W This aperation cannot be undone,

QK Cancel

3. Inthe Delete Statements message, click OK to delete all the GxP statements in the
SoftMax Pro GxP Software data file.

Duplicating a GxP Statement

1. Gotothe GxP tab in the ribbon, and then in the Data section, click Statements E\( .
2. Inthe Statement dialog, click the statement that you want to duplicate.

3. Click Copy Statement " in the toolbar at the top of the dialog.

4. Click the statement directly above where you want to paste the copied statement.

5. Click Paste Statement 1 in the toolbar at the top of the dialog.

To edit the pasted statement, click the statement to select it and then click Edit Statement
#lin the toolbar at the top of the dialog. See Editing a GxP Statement on page 477.
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Signing a GxP Statement

7.
8.

E\( |

Go to the GxP tab in the ribbon, and then in the Data section, click Statements
In the Statement dialog, click the statement that you want to sign.
When a statement is selected, it has a light gray background.

Note: If the statements are locked, they cannot be signed. To unlock the
statements, click Unlock Statements “&  in the toolbar at the top of the
Statements dialog.

Click Sign Statement £ in the toolbar at the top of the dialog.

Sign Statement is not available in the toolbar until after you click the statement that you
want to sign.

;¢’ Sign Statement @

MM Run

Data acguired for Michaelis Menton assay.

Signing Note [Opticnal) :

Acguisition Complete.

In the Sign Statement dialog, verify that the text at the top is the statement that you
want to sign.

Click in the lower field and type a signing statement, if applicable.

Click Sign.

"/ User Verification @

)

-

User ld . newton

Password : sesessse

i Werify i[ Cancel l

In the User Verification dialog, type your password.
Click Verify.

Note: After a GxP statement is signed, the SoftMax Pro GxP Software locks the data
file to prevent further changes to the file. To unlock the file, remove all the statement
signatures.
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Removing Signatures from All GxP Statements

¢/
1. Gotothe GxP tab in theribbon, and then in the Data section, click Statements = ™ .

2. Click Remove all signatures = in the toolbar at the top of the dialog.

A CAUTION! Removing signatures removes the signatures from all the GxP
statements in the SoftMax Pro GxP Software data file. There is no undo for this.
After the signatures are removed, the data file is unlocked and changes can be
made to the file.

[ Canfirm E-Signature Remowval @

Reasen for removing electronic signatures

Unlock experiment for data acquisition.

Cancel

3. Inthe Confirm E-Signature Removal dialog, type a reason for removing the signatures.
4. Click OK.

-

"/ User Verification @

Usar |d . newton

Password: sesessse

i Werify i[ Cancel l

5. Inthe User Verification dialog, type your password.
6. Click Verify.
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Printing GxP Statements

You can let the statements print or block the statements from printing in the Statements
dialog .

To change the GxP printing options, go to the GxP tab in the ribbon, and then in the Data
c

section, click Statements | | to open the Statements dialog.

* To let the statements be printed with the data file, click Enable printing of Statements
=& in the toolbar at the top of the dialog.

e To prevent the statements from printing with the data file, click Disable printing of
Statements (=l in the toolbar at the top of the dialog.
The button switches between &I and 22 to indicate whether or not statements will be
printed.

You can also select to print or not to print statements with the data file in the Print Selected
dialog. For information about printing the contents of a data file, see Printing on page 80.

Locking and Unlocking GxP Statements

You can lock the statements to prevent changes to the Statements dialog.

You cannot lock signed statements. After a GxP statement is signed, the SoftMax Pro GxP
Software locks the data file to prevent further changes to the file. To unlock the file, remove
all the statement signatures.

To change the GxP statements lock options, go to the GxP tab in the ribbon, and then in the

c

Data section, click Statements &\ to open the Statements dialog.

e To prevent changes to the statements, click Lock Statements ® in the toolbar at the
top of the dialog.

o To permit changes to the statements, click Unlock Statements 1 in the toolbar at the
top of the dialog.

The button switches between " and 1 to indicate whether or not statements are locked.
All the statements are locked or unlocked at the same time.

With the statements locked, you can still change the printing options. See Printing GxP
Statements on page 481.

481



SoftMax Pro Software User Guide

Viewing the GxP Audit Trail

The Audit Trail dialog gives you read-only access to the audit trail for the open data file, and

lets you attach a note to the audit trail.

To view the audit trail, go to the GxP tab in the ribbon, and then in the Data section, click

Audit Trail ﬂ

© Audit Trail

View Audit Trail for "Michaelis Menten”

6/29/2012 3:22:04 AM  User: Leslie  UserID: leslie
Read started for Experiment : Michaelis-Menten Section : Plate®1

6/29/2012 3:.22:17 AM  User: Leslie  UserID: leslie
Read ended for Experiment : Michaelis-Menten Section : Plate®1

6/28/2012 3:50:26 AM  User: Leslie  UserID: leslie
Template for: Michaelis-Menten : Plate#1 was changed.
Mew settings are : Well Location  Group Name Group Type

ADl Substratel Standards 08 Concentraticn
AD2 Substratel Standards 09 Concentraticn
AD3 Substratel Standards 1o Concentration
A4 Substratel Standards 03 Concentration
ADS Substratel Standards 04 Concentraticn
ADE Substratel Standards 05 Concentration
ADY Substratel Standards 06 Concentration
ADB Substratel Standards o7 Concentraticn
AD9 Substratel Standards 08 Concentraticn
AlD Substratel Standards 08 Concentration
All Substratel Standards 10 Concentration
AlZ Substratel Standards 11 Concentraticn
BO1 Substratel Standards 08 Concentration
BO2 Substratel Standards 09 Concentration
BO3 Substratel Standards 10 Concentration
BO4 Substratel Standards 03 Concentraticn
EOS Substratel Standards 04 Concentraticn
EO0G Substratel Standards 05 Concentration
BO7 Substratel Standards 06 Concentration
BOS Substratel Standards o7 Concentraticn
E0Y Substratel Standards 08 Concentration
B10 Substrate] Standards ng Concentratinn

B3
©

Sample Name  Descriptor]l Name Descriptorl Value Des

mid
05 mi
0.23 mbd
1 mbd
1 mid
1 i
1 mi
1 mid
1 i
0.5 mi
0.25 mbd
0125 mM
1 i
0.5 mid
0.25 mbd
1 i
1 i
1 i
1 mbd
1 mid
1 mi
ns mhd =

] b

‘
@ &

T

Each entry in the audit trail has a time-and-date stamp, and identifies the user performing

the task.

To add a note to the audit trail, see Adding a Note to the GxP Audit Trail on page 483.

To copy the entire audit trail to the Windows clipboard, click Copy to clipboard L'.]_j in the
lower-left corner of the dialog. You can then paste the audit trial into a text editor or word

processor for saving or printing.

To let the audit trail print or block the audit trail from printing, see Printing the GxP Audit

Trail on page 483.

To close the Audit Trail dialog, click Close.
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Adding a Note to the GxP Audit Trail

il
1. Gotothe GxP tab in theribbon, and then in the Data section, click Audit Trail E"A.
2. Inthe Audit Trail dialog, click Add Note.

(A Adda Note =

Mote

-

Experiment is ready for acquisition by lab technician.

[ oK | Ccancel

3. Inthe Add a Note dialog, type the content of the note.
4. Click OK.

The note is added to the end of the audit trail and becomes part of the permanent record for
the open data file.

Printing the GxP Audit Trail

You can let the audit trail print or block the audit trail from printing in the Audit Trail dialog .
To change the GxP printing options, go to the GxP tab in the ribbon, and then in the Data

iy
section, click Audit Trail f"’a to open the Audit Trail dialog.

¢ To let the audit trail be printed with the data file, click Enable printing of the audit trail
22 in the toolbar at the bottom of the dialog.
* To prevent the audit trail from printing with the data file, click Disable printing of the
audit trail = in the toolbar at the bottom of the dialog.
The button switches between = and ) to indicate whether or not the audit trail will be
printed.

You can also select to print or not to print the audit trail with the data file in the Print
Selected dialog. For information about printing the contents of a data file, see Printing on
page 80.
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Locking and Unlocking Sections

In the SoftMax Pro GxP Software, you can lock the individual sections in an experiment to
prevent changes to them. A locked section cannot be deleted nor have its data changed.
When a locked section is duplicated, the duplicate section is unlocked by default. Locked
sections can be printed with the data file.

To lock or unlock a section, click the section to select it and then click Lock Selection 4 at
the top of the Navigation Tree.

“ Michaelis Menten

Mavigation Tree UEQ 'T‘ <
4 M Michaelis-...
|_{L Introduction
| &, Sumrmary ia
Plate#l -
|_|_|_| Substratel ¥
|_£[ Welocity va... K
[/] Lineweave...
|/ Eadie-Hofst... 1
[ wooif 1

ol A

To lock or unlock all the sections in an Experiment, click the Experiment to select it and then
click Lock Selection &' at the top of the Navigation Tree.

When a section is locked, no direct changes can be made to it, with the following exceptions:

* |n a Plate section, the data cannot be overwritten. However, a Plate section that has no
data can have data acquired and added to the section.

e The name of a Group section can be changed indirectly in the Group Settings dialog.
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21 CFR Part 11

The FDA guidelines for trustworthy electronic records, known as 21 CFR Part 11, requires
companies to employ procedures and controls designed to ensure the authenticity,
integrity, and when applicable the confidentiality of electronic records, and to ensure that
the signer cannot readily repudiate the signed record as not genuine. To satisfy this
requirement persons must, along with other things, employ procedures and controls that
include the use of computer-generated time stamps.

Note: No software by itself can be 21 CFR Part 11 compliant. The provides features
that let users demonstrate compliance with these regulations.

See Using SoftMax Pro GxP Software Features on page 467.

A

Absorbance

Absorbance is the quantity of light absorbed by a solution. To measure absorbance
accurately, it is necessary to eliminate light scatter. If there is no turbidity, then
absorbance = optical density.

A=logulo /1) =—log(l/1o)
where /,is incident light before it enters the sample, I is the intensity of light after it passes
through the sample, and A is the measured absorbance.

See Absorbance Read Mode on page 154.
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AlphaScreen

ALPHA stands for Amplified Luminescent Proximity Homogeneous Assay. AlphaScreen®is a
bead-based chemistry used to study molecular interactions between moieties A and B, for
example. When a biological interaction between Aand B moves beads (coated with Aand B,
respectively) together, a cascade of chemical reactions produce a greatly amplified signal.

The cascade finally resulting in signal is triggered by laser excitation (680 nm), making a
photosensitizer on the A-beads convert oxygen to an excited (singlet) state. That energized
oxygen diffuses away from the A-bead. When reaching the B-bead in close proximity, it reacts
with a thioxene derivative on the B-bead generating chemiluminescence at 370 nm. Energy
transfer to a fluorescent dye on the same bead shifts the emission wavelength into the

520 nm to 620 nm range. The limited lifetime of singlet oxygen in solvent (~4 microseconds)
lets diffusion reach up to only around 200 nm distance. Thus, only B-beads in the proximity
of A-beads yield signal, which indicates binding between moieties A and B.

An AlphaScreen measurement includes a light pulse, by turning on the laser diode for a
specified time, turning off the laser diode, followed by the measurement of the AlphaScreen
signal, as specified in the measurement protocol timing parameters.

% Note: AlphaScreen beads are light sensitive. Beads are best handled under subdued
(<100 lux) or green filtered (Roscolux filters #389 from Rosco, or equivalent) light
conditions. Do incubation steps in the dark.

See AlphaScreen Read Mode on page 189.

AutoRead

Auto Read automatically advances to the next Plate section after a read in the order that the
Plate sections are displayed within a single Experiment. When you start a read for a Plate
section that is enabled to automatically advance with AutoRead, the Auto Read feature
advances to the next Plate section in the Experiment and then reads that plate. If multiple
Plate sections are enabled to automatically advance with AutoRead, the Auto Read feature
reads all enabled Plate sections until it reads a non-enabled Plate section or the last Plate
section in the Experiment. Plate sections that come before the selected Plate section are not
read.

For example, if you have five Plate sections (Plate 1, Plate 2, Plate 3, Plate 4, and Plate 5) in an
Experiment, you can enable Plate 1, Plate 2, and Plate 3 to automatically advance with Auto
Read. If you start a Read operation for Plate 2, then Plate 2, Plate 3, and Plate 4 are read in
sequence. Plate 1is not read, since it comes before Plate 2. Plate 5 is not read since Plate 4 is
not enabled to automatically advance with AutoRead.

You can set an interval, or delay time, between the plate readings, if desired.

See Enabling Auto Read on page 340.
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Auto Save

When Auto Save is enabled, the collected data is saved automatically to a user-defined
location immediately after each plate read is completed. Auto Save reduces the likelihood of
lost data, particularly when Auto Save is set to save files to corporate network volumes that
are backed up on aregular basis.

You can add as many Auto Save instances as desired, each with its own settings.

% Note: Auto Save settings are saved with each document.

See Setting Auto Save Options on page 76.

B

Baseline

Baseline reads are available for kinetic reads with injection.

The instrument collects baseline data before the injection, so that the baseline data can be
subtracted from the reads that follow the injection.

Bottom Read

You can set up a bottom read in the PMT and Optics category of the Settings dialog. Select
the Read From Bottom check box to have an instrument with bottom-read capability read
up through the bottom of the microplate rather than down from the top.

See PMT and Optics Settings on page 258.

C

Calibrate

For Absorbance reads, the Calibrate setting tells the instrument to make an air-calibration
measurement at each wavelength before reading the microplate, as determined by the type
of instrument and the read settings. If you turn calibration off, SoftMax Pro Software uses
the air-calibration values stored in the firmware of the instrument, or the values from the
previous calibration.

For Fluorescence and Luminescence reads, the instrument makes a reference read on the
internal reference chip at each wavelength before reading the microplate. If you turn
calibration off, SoftMax Pro Software uses the default values stored in the firmware of the
instrument, or the values from the previous calibration.

For kinetic readings the calibration measurement is made between readings during a run,
unless the read interval is too short to allow calibration.

See More Settings on page 285.
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Cutoff

The term cutoff refers to filters used to block unwanted residual excitation light and minimize
background interference.

No emission cutoff filter is used when a Luminescence read mode is selected. With other read
modes, choices are to enable or disable Auto Cutoff with specific filter settings available if it is
disabled (manual cutoff selection). When Auto Cutoffis enabled, the instrument sets the
cutoffs based on the wavelengths chosen for reading. When a Spectrum read type is
selected, a manual setting for the emission monochromator is required, with the default
being no cutoff filter.

See Wavelength Settings on page 247.

Cuvette Set Section

Cuvette Set sections are used to collect data from the cuvette port of the SpectraMax M2
and M2e Multi-Mode Microplate Readers, SpectraMax M5 and M5e Multi-Mode Microplate
Readers, and the SpectraMax Plus 384 Absorbance Microplate Reader. You can use a Cuvette
Set section to define an analysis template and to define data display and data reduction. The
Template Editor in the Cuvette Set section is used to describe the contents of each cuvette
within the Cuvette Set.

See Using a Cuvette Set Section on page 129.

D

Default Protocol

After the SoftMax Pro Software is installed, the Basic Endpoint protocol is set as the default
protocol with the filename default.spr. Whenever you create a new document, the
default.spr protocol file is opened as an untitled document that contains the settings from
the default protocol file.

You can save the settings of the file currently active in the workspace as the default protocol.
After you save the active protocol file as the default, whenever you create a new document,
the settings in the default.spr file that you have saved are loaded into an untitled document.

See Saving a Protocol as the Default Protocol on page 69.
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E

Emission Spectrum Scan

An emission spectrum scan measures fluorescence or luminescence across a spectrum of
wavelengths. Fluorescent reads use the emitted light from a fixed excitation wavelength. The
default value reported for each well is the wavelength of maximum emission in either RFU for
fluorescence mode or RLU for luminescence mode.

See Excitation Spectrum Scan on page 489.

End Time

End Time in a kinetic read specifies the time at which to stop showing data in the display and
exclude it from data reduction. Values occurring after this limit are not reported in the
display and are excluded from data reduction. The default setting is the total assay time for
the kinetic read.

See Doing Data Reduction on page 367.

Endpoint

In an endpoint read, a reading of each microplate well is taken in the center of each well, at a
single wavelength or at multiple wavelengths. Depending on the read mode, raw data values
are reported as optical density (OD), %Transmittance (%T), relative fluorescence units (RFU),
or relative luminescence units (RLU).

See Endpoint Read Type on page 152.

Excitation Spectrum Scan

An excitation spectrum scan measures fluorescence at a single emission wavelength for the
emitted light across a spectrum of excitation wavelengths. The default value reported for
each well is the wavelength of maximum fluorescence excitation in RFU.

See Emission Spectrum Scan on page 489.

F

Fluorescence

Fluorescence occurs when absorbed light is re-radiated at a longer wavelength. In the
Fluorescence Intensity (FL) read mode, the instrument measures the intensity of the re-
radiated light and expresses the result in Relative Fluorescence Units (RFU).

The governing equation for fluorescence is:

Fluorescence = extinction coefficient x concentration x quantum yield x
excitation intensity x pathlength x emission collection efficiency

See Fluorescence Intensity Read Mode on page 160.
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Fluorescence Polarization

Fluorescence polarization detection is similar to fluorescence intensity, with the important
difference that it uses plane-polarized light, rather than non-polarized light. Plate readers
measure FP of the sample by detecting light emitted both parallel and perpendicular to the
plane of excitation.

By using a fluorescent dye to label a small molecule, its binding to a different molecule of
equal or greater size can be monitored through its speed of rotation.

See Fluorescence Polarization Read Mode on page 185.

Fluorescence Resonance Energy Transfer (FRET)

Fluorescence resonance energy transfer (FRET) is a distance-dependent interaction between
the electronic excited states of two dye molecules in which excitation is transferred from a
donor molecule to an acceptor molecule without emission of a photon.

FRET relies on the distance-dependent transfer of energy from a donor molecule to an
acceptor molecule. Due to its sensitivity to distance, FRET has been used to investigate
molecular interactions. FRET is the radiationless transmission of energy from a donor
molecule to an acceptor molecule. The donor molecule is the dye or chromophore that
initially absorbs the energy and the acceptor is the chromophore to which the energy is
subsequently transferred. This resonance interaction occurs over greater than interatomic
distances, without conversion to thermal energy, and without a molecular collision. The
transfer of energy leads to a reduction in the fluorescence intensity and excited state lifetime
of the donor, and an increase in the emission intensity of the acceptor. A pair of molecules
that interact in such a manner that FRET occurs is often referred to as a donor/acceptor pair.

While there are many factors that influence FRET, the primary conditions that need to be
met for FRET to occur are relatively few:

e The donor and acceptor molecules must be in close proximity to each other.

e The absorption or excitation spectrum of the acceptor must overlap the fluorescence
emission spectrum of the donor.

The degree to which they overlap is referred to as the spectral overlap integral (J).
e Thedonor and acceptor transition must be approximately parallel.
See FRET Read Mode on page 178.

Fluorophore

Afluorophore is a material that absorbs light energy of a characteristic wavelength,
undergoes an electronic state change, and instantaneously emits light of a longer
wavelength.

See Fluorescence Intensity Read Mode on page 160, Time-Resolved Fluorescence Read Mode
on page 171, and Fluorescence Polarization Read Mode on page 185.
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G

G Factor

The G factor, or grating factor, is used in fluorescence polarization to correct polarization
data for optical artifacts, converting relative mP data to theoretical mP data. Optical
systems, particularly with reflective components, pass light of different polarization with
different efficiency. G factor corrects this instrumental bias.

See Data Reduction on page 187.

Gain

Gain is the quantity of increase in signal power expressed as the ratio of output to input for a
photomultiplier tube (PMT).

See PMT and Optics Settings on page 258.

Group

Wells can be assigned to group types using the Template Editor. Depending on the protocol,
certain group types, such as Standard or Unknown, can be created automatically. You can
create other groups as required.

See Defining a Group on page 303.

Imaging
Imaging read mode does whole-cell imaging assays.

Whole-cell imaging assays are cell-based, or object-based, rather than the single-point
measurements found in other types of microplate reads. These types of assays can yield
more biologically meaningful results that can discriminate the fluorescence related to
objects, such as cells or beads, from the bulk solution within a microplate well.

See Imaging Read Mode on page 197.
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Kinetic

In a kinetic read, the instrument collects data over time with multiple readings taken in the
center of each well at regular intervals. To get the shortest possible interval for multiple-
wavelength Kinetic readings, choose wavelengths in ascending order.

The values calculated based on raw kinetic data include VMax, VMax per Sec, Time to VMax,
and Onset Time. Kinetic readings can be single-wavelength or multiple-wavelength readings.

See Kinetic Read Type on page 152.

Lag Time

Lag Time in a kinetic read defines the period of very slow growth of microorganisms or the
rate of reaction that can precede the rapid or linear phase of reaction.The lag time specifies
how many initial data points are excluded from the calculation of Vmax Rate. Lag time
truncates the data used in the calculation, but does not prevent data from being collected.
Kinetic plots do not display the data collected before the lag time.

See Doing Data Reduction on page 367.

Luminescence

Luminescence is the emission of light by processes that derive energy from essentially non-
thermal changes, the motion of subatomic particles, or the excitation of an atomic system by
radiation. Luminescence detection relies on the production of light from a chemical reaction
in a sample.

See Luminescence Read Mode on page 166.

LUT

Alook-up table (LUT) determines the colors to use for the intensity values when displaying an
image.

See Viewing Western Blot Membrane Data on page 443.
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Mask
The Mask feature hides selected data so that they are not used for calculations and are not
reported. Masking is commonly used to suppress outliers from data reduction calculations.

Masking can be used as a “what if?” tool. For example, if you have included a group blank in
a template and want to see the data both with and without the blank, masking the group
blanks suppresses the blanking function, while unmasking them enables it again.

See Masking Wells or Cuvettes on page 367.

Membrane
The Membrane read type is used for a time-resolved fluorescence reading of a Western Blot
membrane.

See Membrane Read Type on page 153 and Western Blot TRF Read Mode on page 193.

(0

Onset Time

Onset time is a method for analyzing non-linear Kinetic reactions. Onset Time reports the
time required for a Kinetic reaction to reach a specified OD or RFU/RLU (onset OD/RFU/RLU).
See Kinetic Data Reduction Options on page 378.

Optical Density (OD)

Optical density (OD) is the quantity of light passing through a sample to a detector relative to
the total quantity of light available. Optical Density includes absorbance of the sample plus
light scatter from turbidity and background. You can compensate for background using
blanks.

A blank well contains everything used with the sample wells except the chromophore and
sample-specific compounds. Do not use an empty well for a blank.

Some applications are designed for turbid samples, such as algae or other micro-organisms
in suspension. The reported OD values for turbid samples are likely to be different when read
by different instruments.

See Absorbance Read Mode on page 154.
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P

PathCheck Technology

The temperature-independent PathCheck® Pathlength Measurement Technology
normalizes your absorbance values to a 1 cm path length based on the near-infrared
absorbance of water.

The Beer—Lambert law states that absorbance is proportional to the distance that light
travels through the sample:

A=¢gbc
where A is the absorbance, €is the molar absorptivity of the sample, b is the pathlength, and
cis the concentration of the sample. The longer the pathlength, the higher the absorbance.
Microplate readers use a vertical light path so the distance of the light through the sample
depends on the volume. This variable pathlength makes it difficult to do extinction-based
assays and also makes it confusing to compare results between microplate readers and
spectrophotometers.
The standard pathlength of a 1 cm cuvette is the conventional basis for quantifying the
unique absorptivity properties of compounds in solution. Quantitative analysis can be done
on the basis of extinction coefficients, without standard curves (for example, NADH-based
enzyme assays). When using a cuvette, the pathlength is known and is independent of
sample volume, so absorbance is directly proportional to concentration when there is no
background interference.

See PathCheck Pathlength Measurement Technology on page 156.

Photomultiplier Tube (PMT)

A Photomultiplier Tube (PMT) is a vacuum tube that can detect light from dim sources
through the use of photo emission and successive instances of secondary emission to
produce enough electrons to generate a useful current.

Plate Section

A Plate section is used to collect data from the instrument, and to define data display and
data reduction. If you need to read the same physical plate twice with different instrument
settings, then use two Plate sections. You can create as many Plate sections as you need.

See Using a Plate Section on page 118.

Protocol File

Protocol files are experiment template files that contain microplate well layout assignments
and all other reader configuration information and reduction parameters, but no data.
Protocol files can be useful if you repeat a particular type of experiment frequently.

See Managing Protocol Files on page 67.
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Raw Data

Raw data is the signal reported from the instrument with no changes made. This is reported
as optical density (OD), relative fluorescence units (RFU), or relative luminescence units (RLU),
depending on the read mode.

Raw Data Mode
In Absorbance (ABS) read mode or Fluorescence Polarization (FP) read mode, you can select
the type of raw data to display and use for reduction calculations.

For Absorbance reads, you can choose whether to display absorbance data as Optical
Density or %Transmittance.

Fluorescence polarization mode returns two sets of data: one for fluorescence intensity
parallel (P) to the excitation plane, and the other for fluorescence intensity perpendicular (S)
to the excitation plane. These S and P values are used to calculate the Polarization (mP) and
Anisotropy (r) values in the SoftMax Pro Software.

See Doing Data Reduction on page 367.

Read Mode

For more information on the supported read modes, see the following topics:
e Absorbance Read Mode on page 154
e Fluorescence Intensity Read Mode on page 160
e Luminescence Read Mode on page 166
e Time-Resolved Fluorescence Read Mode on page 171
e HTRF Read Mode on page 179
e FRET Read Mode on page 178
e Fluorescence Polarization Read Mode on page 185
e AlphaScreen Read Mode on page 189
e Western Blot TRF Read Mode on page 193
e Imaging Read Mode on page 197
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Read Type

For more information on the supported read types, see the following topics:
e Endpoint Read Type on page 152
¢ Kinetic Read Type on page 152
e Well Scan Read Type on page 152
e Spectrum Read Type on page 152
* Flex Read Type on page 153
e Membrane Read Type on page 153

Reduced Data

Data reduction causes the raw signal values reported by the instrument to be calculated and
displayed based on user-defined formula settings.

Reference
A reference reading can be taken either on air or using a cuvette containing the buffer of your
sample.

See Collecting Data From a Cuvette on page 350.

ROI

Aregion of interest (ROI) is a small area or region of an image where items of interest can be
found.

e For Western Blot Membrane reads, the region of interest is defined in the Plate section.
See Viewing Western Blot Membrane Data on page 443.

e For Imaging reads, the region of interest is defined in the Settings dialog. See Region of
Interest Settings on page 281.

S

Series

You can define several samples as a series, letting you easily enter incremental sample
descriptors (for example, dilutions or concentrations) and sample names to the template as
long as the increment can be expressed as a mathematical operation. This lets you work with
groups of wells in the Template so that the standard value or dilution factor increases or
decreases in specified steps. The series name can be incremented as well.

See Creating a Series on page 304.
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Slope

The slope reduction option determines the slope of the combined plot (for example, the
slope of the line using linear regression after the wavelength combination reduction). This
reduction uses all visible time points in the reduction window.

Slope is the same as Vmax Rate when Vmax Rate is set to the same number of points as the
run, but is different if you have modified Vmax Points.

See Kinetic Data Reduction Options on page 378.

Smartinject

Smartlnject™ technology is available for reads with injection.

The Smartlnject™ technology shakes the microplate during the injection and continues to
shake through the following delay step, if a Delay node follows the Smartinject node. The
microplate stops shaking before the well is read.

Spectrum

Depending on the read mode selected, a spectrum read measures optical density (OD),
%Transmittance (%T), relative fluorescence units (RFU), or relative luminescence units (RLU)
across a spectrum of wavelengths.

See Spectrum Read Type on page 152, Emission Spectrum Scan on page 489, and Excitation
Spectrum Scan on page 489.

Stokes Shift
The Stokes shift is the difference between the wavelengths of the excitation and emission
maxima, or peaks.

See Emission Spectrum Scan on page 489 and Excitation Spectrum Scan on page 489.

T

Template Editor

ATemplate is a map of the microplate or cuvette that is used to describe the location of
samples in the microplate or cuvette, and it provides the link between raw data and analysis
groups.

The Template Editor is a representation of the microplate or set of cuvettes shown as a grid
of wells that can be used to designate the location of blanks, standards, controls, unknowns,
empty wells, or to assign wells to other groups you create.

See Configuring a Microplate Template on page 301.

5049092 A 497



SoftMax Pro Software User Guide

Time-Resolved Fluorescence (TRF)

Time-resolved fluorescence (TRF) is a measurement technique that depends on three
characteristics that lead to better discrimination between the specific signal, proportional to
the quantity of label, and the unspecific fluorescence resulting from background and
compound interference:

e Pulsed excitation light sources
* Time-gated electronics faster than the fluorescence lifetime
e Labels with prolonged fluorescence lifetime

The time-gating electronics introduce a delay between the cut off of each light pulse and the
start of signal collection. During the delay, the unspecific fluorescence (caused by test
compounds, assay reagents, and the microplate) vanishes while only a small portion of the
specific fluorescence from the label is sacrificed. Enough of the specific signal remains during
the decay period with the added benefit of reduced background.

See Time-Resolved Fluorescence Read Mode on page 171.

%Transmittance

%Transmittance is the ratio of transmitted light to the incident light for absorbance reads.
T=1/l,
%T =100T

where | is the intensity of light after it passes through the sample and /, is incident light
before it enters the sample.

\"

Vmax Points

Vmax is the maximum slope of the Kinetic display of mOD/min or RFU/RLU per second. Vmax
is calculated by measuring the slopes of a number of straight lines, where Vmax Points
determines the number of contiguous points over which each straight line is defined.

This is an alternative method for analyzing non-linear Kinetic reactions that reports the
elapsed time until the maximum reaction rate is reached, rather than reporting the
maximum rate itself. Used in conjunction with Vmax Points, Time to Vmax is the time to the
midpoint of the line defined by Vmax Points and used to calculate Vmax.

See Kinetic Data Reduction Options on page 378.
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Vmax Rate

Vmax Rate is reported as signal/min (milli-OD, RFU, or RLU units per minute) for a Kinetic
read. Itis calculated using a linear curve fit, y = Ax + B. A creeping iteration is done using Vmax
Points and the slope of the steepest line segment is reported as Vmax Rate. It can also be
reported as units per second (the default for Fluorescence and Luminescence modes).

See Kinetic Data Reduction Options on page 378.

w

Well Scan

A well scan read can take readings at more than one location within a well. A well scan read
takes one or more readings of a single well of a microplate on an evenly spaced grid inside of
each well at single or multiple wavelengths.

Some applications involve the detection of whole cells in large-area tissue culture plates. Well
scan reads can be used with such microplates to permit maximum surface area detection in
whole-cell protocols. Since many cell lines tend to grow as clumps or in the corners of
microplate wells, you can choose from several patterns and define the number of points to
be scanned to work best with your particular application.

See Well Scan Read Type on page 152.

Z

77
Z'is the standard statistical parameter in the high-throughput screening community for
measuring the quality of a screening assay independent of test compounds. It is used as a

measure of the signal separation between the positive controls and the negative controls in
an assay.

The value of Z' can be determined using the following formula:
3(SDC+ )+ 3(SDC_)

N | Mean_ —Mean_ |

where SD is the standard deviation, c+ is the positive control, and c—is the negative control.

AZ value greater than or equal to 0.4 is the generally acceptable minimum for an assay.
Higher values might be desired when results are more critical.

Z’is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z’ value, you can increase the quantity of
label in the sample, if acceptable for the assay, or increase the read time per well.
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ABS
absorbance 154, 313, 485
read mode 154
absorbance
ABS 154, 313, 485
read mode 154
account database 50, 469
account information 50, 472
account setup 468
adding
audit trail note 483
column to group table 143
cuvette set 130
cuvette to aset 136
formula to a table 148
Plate section 119
plots to a graph 392
statement 477
Summary Formula 115
text frame 111
aligning
text 111
text frame 114
ALPHA
AlphaScreen 189
detection cartridge 222
read mode 189
AlphalLISA 189, 222

AlphaScreen
ALPHA 189
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application management 59
application menu 53
area under curve 379-380
artifacts in an image 275
audit trail

adding a note 483

copying 482

printing 483

saving 482

viewing 50, 482
auto read

enabling 340, 486
auto save

enabling 76, 487

options 76
automation

automation mode 56

Excel workflows 57

StakMax 56

v5.x automation scripts 56
autosizing

column 146

B

barcode reader 19

blocking 195

C

calculation
hierarchy 356
recalculate manually 46

resume 46
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suspend 46 confidence interval methods 402
calculations 104 Chi-Squared 403
calibrate 45 F-distribution 403
reader 455 T-distribution 403
settings 285, 487 confidence level 404
carriage speed settings 285 controls
celsius 47 instrument 36
change password 50, 474 copying
chi-squared 403 between experiments 306
Cisbio HTRF 171 clone plate section 127

. column content 145
classify

objects 271 cuvette 136

cuvette data 137
data 66

cloning

plate section 127
graph section 442
closing a drawer 49 ] ) .
in an experiment section 306

colorize
statements 478

membrane image 443
template contents 306

column
adding 143

crop
membrane image 443
autosizing 146
curve fit 396
judging 395

settings 394

content 145
copying content 145

deleting 146
weighting 401
formula 144
o curve fit functions
hiding 146
2-parameter exponential 405
modifying 144 P P

. 3-parameter dose-response curves 413
pasting content 145

. 3-parameter exponential 408
showing all 147

4-parameter 411
columns format 86
5-parameter logisitic alternate 417

community o
5-parameter logistic 415

export protocol 43
portp bi-exponential 418

home page 43
Pag bi-rectangular hyperbola 420

comparison view 32 .
P brain cousens 423

computer requirements 8 cubic 424
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cubic spline 424 masking 135
exponential 408 new 41

exponential decay 407 zooming the display 134
exponential growth 406 cuvette reference

gaussian 425 settings 157

linear 426 cytometer 203

log-log 427

log-logit 428 D

michaelis-menten 433

data
michaelis-menten with two isozymes 422

ing 66, 137
one-phase exponential association 410 copying 55,
display

format 116, 144
display options 121, 132, 358

formats 86-87

one-phase exponential decay 409

one-site equilibrium binding (total and
nonspecific) 436

point-to-point 429

quadratic 430 import formats 101, 103
quartic 431 pasting 66
rect. hyper. plus linear 435 reading 38
rectangular hyperbola 432, 434 data display
rectangular hyperbola plus linear 435 decimal places 116, 144
rhpluslinear 435 numeric notation 116, 144
semi-log 437 precision 116, 144
two-phase exponential decay 419 scientific notation 116, 144
two-site competition 438 significant figures 116, 144
two-site equilibrium binding (specific data files 59, 63-64
binding) 421 data formats

customer support 23 columns 86

cutoff 248, 488 plate 86

cutting xml 86
content 145 data import 99

cuvette data recovery 104
adding a set 130 data reduction
adding to aset 136 calculation hierarchy 367
copying 136 cuvette 131
data reduction 131 formulas 376
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imaging options 381 zooming a well image 365
kinetic options 378 drawer
settings 120, 367 closing 49
spectrum options 380 locking 458
database, user account 50, 469 opening 49
decimal places 116, 144 unlocking 20
decimal symbol 11 duplicate section 29
deleting
column 146 E

cuvette 136
formula 148
sections 29, 40

editing
formula 148

graphs 394

statements 478 Summary Formula 117

Summary Formula 117 text 112

text frame 114 EMax Plus

detection cartridges 218 filter positions 45, 456

ALPHA 222 home microplate transport 45
FI 225 lamp adjustment 45, 456
FP 229

enabling

injector cartridge 233 auto read 340, 486

LUM 227 syntax helper 116
refresh 45

end time 374, 489
ScanlLater WB 232

endpoint
TL 233

read type 152, 489
Western Blot 232

Excel
discontnuous kinetics 38
export imaging data 367
discrete object analysis 199, 266
export template 310

displ .
splay membrane data analysis 445

imaging data 361
modifying 121, 132-133, 358

workflows 57

experiment
raw data 359
new 39
reduced data 360
exporting

zooming a cuvette 134
cuvette section 88

zooming a well 125, 363
formats 86-87
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graph section 442
group section 98
plate section 88
template 310

F

F-distribution 403
Fl
detection cartridge 225
field analysis 199, 266
file management 59, 61
file menu 53
files
exporting data 85
imaging 61
new data file 63
new protocol 73
opening 64, 74
saving 65
western blot 61
filter slides
adding 460
configuring 458
definitions 463-464
exporting 461, 464
importing 462-463
removing 461
replacing 463
FilterMax
filter refresh 45
filter slides 458
instrument information 458
filters
cutoff 248, 488
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Emax 45, 456

EMax Plus 45, 456

FilterMax 458
refresh 45
Vmax 45, 456

find

confluent areas 267

objects 267
FL

fluorescence intensity 160, 315, 489
read mode 160, 315, 489

fluorescence intensity

FL 160, 315, 489

read mode 160, 315, 489

fluorescence polarization

FP 185, 329, 490
read mode 185

fluorescence resonance energy transfer

FRET 178
folder

location 70, 72
formats

columns 86

plate 86

xml| 86
formatting

text 113
formula

adding 148

column 144

deleting 148

editing 148

weighting 401

formulas 376
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FP
detection cartridge 229

fluorescence polarization 185, 329, 490

read mode 185
FRET

fluorescence resonance energy
transfer 178

read mode 178

G

getting help 51
ghosting 275
GLP
good laboratory practices 7, 467
GMP
good manufacturing practices 7, 467
graph (3D)
export data 387
exporting 386
viewing 124, 382
graphs
appearance 440
copying 442
creating 392
editing 394
exporting 442
fonts 440
global fits 389
grid lines 441
independent fits 389
legend 389
new 41
scales 440-441
types 440

506

zooming 442

grid lines 441

group
defining 140
settings dialog 139

group column
data display format 116, 144
data display precision 116, 144
decimal places 116, 144
nomeric notation 116, 144
scientific notation 116, 144
significant figures 116, 144

H

hardware requirements 8
help
getting 51
hiding
acolumn 146
protocols 44
replicates 147
sections 44
Hometab 34

homogeneous time-resolved fluorescence
(HTRF) 171, 179

HTRF

homogeneous time-resolved
fluorescence 171, 179

read mode 179

image acquisition settings 264
image analysis settings 266

Imagel) 450-451
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deleting 109

exporting to Excel 367

exporting to PowerPoint 365

inserting in Note 109
imaging

acquisition 337

analysis 198

data display 361

delete image files 61

file management 61

read mode 197
imaging cytometer 203
importing

atemplate 310

microplate data 99

plate format 101

XML format 103
injection

settings 244
injector cartridge 233
installing

command line 10

msi 10

remote 10

SoftMax Pro Software 9

SpectraMax Paradigm instrument 20

instrument
compatibility 59
modifying settings 120
selection 12, 36
interfering substances 159

interlaced reading

settings 288
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K

kinetic
discontinuous 38
multitask 297, 300
read type 152, 492

L

labels
axes 440
lag time 374, 492
lambda at maximum 380
lambda at minimum 380
locking
drawers 458
statements 481
log off 50
log on 50, 472
look-up table (LUT) 443
LUM
detection cartridge 227
luminescence 166, 323, 492
read mode 166

luminescence
LUM 166, 323, 492
read mode 166

M

managing
files 59

masking 135
wells 126

Max OD 374
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Max RFU 374 modifying
maximum 380 column 144
MDC File Server 12, 470 data reduction 120

measurements for imaging 273 display 121, 132, 358

template 302

membrane
blocking 195 multitask kinetics 297, 300
colorize image 443
crop image 443 N
data 127, 195, 443 navigation
Excel analysis 445 tree 29
handling 196 new
image 127, 195, 443 cuvette set 41
image analysis 450 experiment 39
image files 61 graph 41
image resolution 443 note 40, 109
read area 256 plate 40

read type 153
region of interest (ROI) 353, 443
restore image 443-444, 450

scan resolution 258

protocol folder 70
statement 477

normalization

settings 288

zoom image 443
note

method new 40, 109

confidence interval 402 .
Note section 108

microplate
library 250

read area 255

inserting images 109
inserting section images 110

numeric notation 116, 144
setup helper 27
numerical precision 356

types 250
microplate readers 7, 201 0
Min OD 373
Min RFU 373 onset time 379
Min RLU 373-374 opening a drawer 49
minimum 380 options

calculations 104

data recovery 104
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plate eject after read 104
plate height warning 104
plate setup helper 104
remote control 104

web browser 104

over splitting 275

P

parallel line analysis 400
parameter dependencies 404
password

change 50, 474
pasting

column content 145

data 66

statements 478
PathCheck technology

settings 156, 257, 494
pdf 451
Peak Pro Analysis 152
plate

cloning 127

format 86

library 250

new 40

read area 255

section 118, 494

tools 119

types 250
plate eject after read 104
plate height warning 104
plate setup helper 27, 104
plots

adding 392
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PMT and optics
settings 258
PowerPoint
exporting images 365
pre-read optimization
settings 287
precision
decimal places 116, 144
significant figures 116, 144
precision, numerical 356
printing 80
protocol
add folder location 70
community web site 43
default 42, 60, 67, 69, 488
delete folder location 72
export for sharing 43
files 42, 60, 67, 494
folders 70, 72
manager 43
predefined 42, 60, 67

R

raw data display 359
read area 255
read modes 151
ABS 154
ALPHA 189
FL 160, 315, 489
FP 185
FRET 178
HTRF 179
imaging 197
LUM 166
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TRF 171, 325
western blot 193, 334
read order settings 286

read types
endpoint 152, 489
kinetic 152, 492
membrane 153
spectrum 152, 497
well scan 152, 261, 499
reading data 38, 300
reduced data display 360
region of interest 281, 353, 443
regional and language settings 11
remote control 104
rename section 29
replicates
hiding 147
requirements
system 8
resizing
text frame 114
ribbon 34
ROI 281, 353, 443

S

saving
auto save 76, 487
data 65

scientific notation 116, 144

section images
deleting 111
inserting in Note 110
refreshing 110
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sections
cuvette set 41
deleting 29, 40
duplicating 29
graph 149, 389
note 108
plate 119
renaming 29
select account database 50, 469
sensitivity
settings 258
serial port 8
set first data point to zero 371
settings
calibrate 285, 487
carriage speed 285
cuvette 131
cuvette reference 157
data reduction 120
group 139
image acquisition 264
image analysis 266
interlaced reading 288
modifying 131
modifying display 121, 132, 358
modifying instrument settings 120
normalization 288
PathCheck technology 156, 257, 494
PMT and optics 258
pre-read optimization 287
read order 286
region of interest 281
regional and language settings 11
sensitivity 258
settling time 286
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shake 262 instrument information 458
speed read 262 unlock drawers 20
timing 260 SpectraMax Plus 384 205
TRF 258 spectrophotometers 7, 201
water constant 157 spectrum
wavelengths 247 read type 152, 497
well area 263
speed read

well scan 261 settings 262

settling time settings 286 StakMax 216

setup user account 468 alignment wizard 458

shake 48 statements
settings 262 adding 477
showing copying 478
protocols 44 deleting 478
sections 44 duplicating 478
signatures editing 477
removing 480 locking 481
signing 479 pasting 478
significant figures 116, 144 printing 481
simulation removing signatures 480
enabling 36 signing 479
slope 379 unlocking 481
Smartinject 244 viewing 50, 475

spectral optimization wizard 348 statistics 402

spectral scanning 318 summary formula

SpectraMax 190 210 adding 115
deleting 117
SpectraMax 340PC 384 210
editing 117

SpectraMax i3
hide formula 117, 148

detection cartridge refresh 45
show formula 117, 148

instrument information 457
syntax helper

SpectraMax MiniMax Imaging Cytometer 203
enabling 116

SpectraMax Paradigm )
) ) system requirements 8
detection cartridge refresh 45

installation 20
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T-distribution 403
tab groups 44
tabs

Home 34

TCP/IP
MDC File Server 470

TCP/IP access 12
technical support 23

temperature

setting 47

template

copying contents 306

dataimport 101
exporting 310
importing 310
modifying 302
text
editing 112
formatting 113
text frame
adding 111
aligning 114
deleting 114
resizing 114
tiffimage 451

time-resolved fluorescence

read mode 171, 325
TRF 171, 325, 498

time at 1/2 maximum 379

time at maximum 379

time at minimum 379

time to Vmax 378

timing

settings 260

tools

cuvette 130
plate 119
template 128, 138

transmitted light

TRF

U

detection cartridge 233

read mode 171, 325
settings 258

time-resolved fluorescence 171, 325, 498

under splitting 275

unlocking

drawers 20

statements 481

USB adapter 8
USB drivers in Windows 7 12

user

user accounts connection 469

\"

account information 50, 472

account setup 468
change password 50, 474
log off 50

log on 50, 472

select account database 50, 469
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views
Comparison 32
Document 31
show/hide 44
single document 44

Workflow 33
Vmax points 378

W

water constant
settings 157
wavelength
cutoffs 248, 488
settings 247
web browser 104
weighting
curve fit 401
formula 401
well area settings 263
well scan
read type 152, 261, 499
settings 261
wells
masking 126
zooming the display 125, 363
zooming the image 365
western blot
blocking 195
colorize image 443
crop image 443
data 127, 195, 443
detection cartridge 232
Excel analysis 445
image 127, 195, 443

5049092 A

image analysis 450

image files 61

image resolution 443
membrane handling 196

read area 256

read mode 193, 334

region of interest (ROI) 353, 443
restore image 443-444, 450
scan resolution 258

zoom image 443

Windows 8

wizard

plate setup helper 27

workflow

editor 297
running 300
view 297

workflow view 33

X

xml data format 86

4

zooming

agraph 442

cuvette data 134
membrane image 443
well data 363

well image 365
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